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Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services Lending
and Leasing. Since this section details the general options available in the User Interface,
some or all the parts of this section are applicable to you as per access provisions & licensing.

@® Note

The application can be best viewed in 1280 x 1024 screen resolution.

The document is organized into below topics:
e Audience

* Conventions Used

* Logging In

* Template and Navigation

¢ Common Operations

« Keyboard Compatibility

e Tool Tips
e Accessibility

1.1 Audience

This document is intended to all Prospective Users who would be working on the application.

1.2 Conventions Used

Table 1-1 Conventions
]

Term Refers to
The system/application Oracle Financial Services Lending and Leasing
Mnemonic The underlined character of the tab or button

1.3 Logging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system
administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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ORACLE Chapter 1
Template and Navigation

When you invoke the application, the Sign In screen is displayed.

Figure 1-1 Login page

oRacte B

Financial Services Lending and Leasing

e User ID — Specify a valid User ID.

» Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system.
Details are grouped into two categories to enable easy understanding. These include:

¢ Home Screen

e Screens

1.4.1 Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:
* Header

* Left Pane

* Right Pane/Work Area
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ORACLE Chapter 1
Template and Navigation

Figure 1-2 Home screen

ovA ~ R ©

RACLE" ‘
Financial Services Lending and Leasing

DashBoard

4 DashBoard
DashBoard
Users Productivity
System Monitor
Producer Analysic
Process Files

> Origination
» Servicing
> Collections
> WFP

» Tools
 Setup

You can view the application version details and copyright information by clicking About link at
the right bottom corner of the screen.

Figure 1-3 About

About

Orade Financial Services Lending and Leasing 14.3.1.0.0
Build OFSLL_14.3.1.0.0_8253

Copyright @ 1998,2017, Oracie andior is affiiates. All ights reserved.

Oracke and Java are registered trademarks of Oracle and/or s affiiates. Other names may be trademarks of thei respective owners,

are al t and intellectual
property laws. permited in your or allowwed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmi, distribute, exhibt, perform, pubsh or display any part,in any form, or by any means. Reverse engineering, disassembly, or decompiation of this software,
unless required by law for nteroperabilty, i prohibited.

The information contained herein is subiect to change wihout nofice and i not warranted to be error-free. If you find any errors, please report them o us in writing.

Ifthis is software or related documentation that is defivered fo the U S. Government or anyone ficensing it on behalf of the U S. Government, the following notice is
appicable:

U.S, GOVERNIENT END USERS:  including any operating system, integrated software, any programs instaled . andior

delivered to LS. 't end users are *commercial compi Acquistion Regulation and agency-
‘specific supplemental reguations. As such, use, dupication, disciosure, modification, and adaptation of the programs, Including any operating system, ntegrated
‘Software, any programs installed on the hardware, anc No.
other rights.are granted to the U 5. Government

“This software or hardware is developed for generaluse n a variety of nformation management appiations. i & not developed or intended for use in any nherently
dangerous spplcations, creste a risk of | i applations, then you shal

be responsible 1 take il appropriate faisate, backup, redundancy, and other measures {o ensure s safe use. Oracle Corporstion and s affiistes. disciaim any
Habitty for by use of t icati

may 0 or nformation on content, praducts and services from i partes. Oracie Corporation and s
affilates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and
5 afflites. wil ot be responsile for any loss, Costs, or damages ncurred due o Your access 1 or use of third-party conent, proGUEts, or Services.

| Qose

Header

In the Header, system displays the following:

* User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow, the
system displays the following options:
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ORACLE’

Figure 1-4 User ID -

Options

M Welcome, VAVAIDYA 3

Chapter 1
Template and Navigation

hange Fassword

cl
m  UserInfo

— Change Password — Click to change the current password.

Figure 1-5 Change Password

ORACLE’

Financial Services Lending and Leasing

Welcome, VAVAIDYA ~ [=)

Change Password

> DashBoard
Origination
o

> Servicng
> Collections
> wrp

> Tools

> setup

oracle

Change Pass:

cial Services Lending and Leasing

word

User Ifo Iy =

Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

— User Info — Click to view the current user info.

Figure 1-6 User Info

"

| Oracle Financial Services Lending and Leasing

User Info

Organization
Division

First Name

Last Name
Responsibility

GL Post Date
Last Login Date
Session Language

Debug Enabled Ind

DMC

Us01

VARSHA

VAIDYA

SUPERLUSER

02/10/2016

02/10/2016 03:21:07 AM
DEFAULT v

Time Zone |JSER TIME ZOME v
Level
User Time Zone UNDEFINED
Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Zone

Server Time  ASIACALCUTTA {INDIA STANDARD
Zone TIME)

Skin Family Skyros (Default) v

E&éubmit % Close
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ORACLE Chapter 1
Template and Navigation

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from the
drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the following
two types of system parameters:

Table 1-2 System Parameter
___________________________________________________________________________|
System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES_HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then
the debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database Server
Log Files.

You can click on 3= List Files button to view the list of logged files.

Figure 1-7 Database Server Log files

ORACLE " N i me, PRAKRRAO ~ o
Financial Services Lending and Leasing
DashBoard »  System Monitor s [] Close
Batch Jobs  Jobs  Services Database Server Log Files | Parked Transactions = Users -

Database Server Log Files

View v Format~  [5p Freeze  fi Detach o Wrap W) S=LstFiles  [E Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01_DB12C_2084400 b 5706 02/18/2016 06:14:11 AD ~
ALERT lob 395 02/22/2016 03:59:16 Ar_|
CSVPRC_EN_100_01 DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP 2
CSVPRC_EN_100_01_DB12C_3854338 lob 116750 02/22(2016 05:36:42 A
JSVPRC_EN_000_01_DB12C_20943562 lob 5706 02f18/2016 10:57:09 AP =
L
File Content

View v Format v reezz g Detach o] Wrap o] ) Beginning @ End = oflines 50 [=] show File

Text

11: 45:FLL:1v_use BI::¥
1

11: cmnsyp_cl_| .get_syp parameter value value: weblogic

1: emnsyp cl .get syp parameter value wvalue: http://ofss2221142.1 racle.com:

¢ cmmsyp cl | .get_syp parameter value value: http://ofss2221142. racle.com:

:11: cmnsyp cl |

.get_syp parameter value value: /scratch/work area/DEV/QRI43REL/r
¢ cmnsyp cl 000 Ol.get syp parameter value parameter: J5V _BI USER

/_ REPORT ARCHIVE DIRECTCORY
/_REPCRTS SERVER TIMECUT

:11: cmnsyp cl 000 0l.get_syp parameter value parameter:

1e parameter:

1: cmnsyp cl 000 0l.get_ syp paramete

Click on El Show File button to view the selected file contents in the File Content

%

section. You can also click
details.

Download File button to extract a copy of debug
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G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 5 of 24



ORACLE Chapter 1
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Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of this
user manual.

Click Submit to save the changes or Close to close the screen without changes.

* Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.

* NextGenUI - This is Next Generation User Interface option which is an enhanced interface
provided in OFSLL using the Oracle JavaScript Extension Toolkit (Oracle JET) frame work.
This is an additional interface supported from OFSLL to the existing system and both
intended to coexist in the system till further updates.

This option is enabled only if the corresponding system parameter is enabled in the base
system as configured by your system administrator. For more information, refer to
Appendix - Oracle JET Interface section in Servicing guide.

*  Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.

Left Window

In the left pane, system lists and provides drop-down links for various modules available in the
product. Click ~ to expand the Module Master Tabs and “ to collapse them.
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Figure 1-8 Left Pane

» DashBoard
> Origination
Servicing
Eervidng =
Customer Service
Securitization
Transaction Autharization

Post Date Checks
Escrow Transactions

m

Account Documents 4
Collateral Management
Reports

Producers

Vendors
Batch Transactions
Interfaces
AP Transactions

GL Transactions 57

» Collections
= \WFP

> Tools

» Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press Enter. The screen is
displayed in the main window/work area.
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Figure 1-9 Left Pane Search

ORACLE w B8R g sgnout &
< - = 1 % § Siar
Financial Services Lending and Leasing
Al @0 | Access » 36 Close
Appiication Retrieval (Originatior) Data Soreen Reports  Correspondence  Transaction
Application Documents(Origination)
Asset Types(Setup Products) Access Grid opadd | et || [E vew | o Audt
Aot DeametsGeanl View v Format v [} Freeze i Detach Wrap o}
U
e o i Division Company Branch Alowed
AP Transactions(Servidng Interfaces) DMC UsoL ALL AL ¥
Application Entry(Origination) oMe NLOZ AL AL Y
Audit Tables(Setup System) oMe a0z ALL AL v
Advances(Servicing Batch Transactions) oMC P04 AL AL ¥

> Origination
> Servicing
> Collections
> WEP

> Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through the
module from which the screen is accessed which is indicated in angular brackets. For example
typing VEN displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

Figure 1-10 Right Pane

opacie )

Financial Services Lending and Leasing

Close
> DashBoard Sales Lead x £l
Origination Lead Entry | Follov-Up | Maintenance

Origination
Sales Lead Applicant Information P add | Aedt | Elview |  audt
Simple Application Entry
View v Format v Freeze Detach &l Wrap
Application Entry 2 4 o @
Unsiasiaitis Lead Lead Dt Company Branch First lame Last liame Birth Dt Channel Source Type Country Address = city
ey L-00002008 115/2015 N2 g ROSEMARY BLACK 1081367 CONSULTATION  WEB ENTRY HOME UNITEDSTATES 813w Juncos
L T L-00001002 1022015 uso uskQ TEST TESTLASTRANE  01/03/1990 ESTATEAGENT  Fi UNITEDSTATES 1000 PLYMOU
s sl L-00003002 12/17/2015 usot uskg ] JanEs 01/01/1997 UNITEDSTATES 1000 BOTHEL!
s L-00002002 12/12/2015 uso1 UsHQ PHANINDRA CHODA 10/10/1982 CONSULTATION UNITED STATES 89898 IRVINE
L-00002004 12f12/2015 uso1 UsHQ BOREN ROBERT 1203/1970 UNITED STATES Juncos
L-00005002 02/03/2015 uso uskQ o] 305H1 07125/1988 CONSULTATION UNITEDSTATES  ADDL coaro
Loo003004 1211912015 uso1 uskQ ANDRES MARTINEZ 08/06/1989 ConsuLTATION UNITEDSTATES  LEAD ENTRY Loza
Lo000s002 1212312015 usor uskQ san sam 11/13/2991 oTHERS UNTEDSTATES 123 PONCE
‘endor
»
Telecoms = Comments = Documents —Requests
‘
Telecom Information A add || A Edit | 5 view || o Audit
Viewv Fomatv [ Freeze B4 Detach Wrap w®
Telecom Type Phone Current.
(CAR/MOBILE PHONE (o0sys32:3423 ¥

> Servicing
> Collections
> WEP

> Tools

> Setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.
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Figure 1-11 15 Screens
ORACLE:

Financial Services Lending and Leasing
i

P 0] < x | [Transaction Authorization x | Post Date Checks x | Escrow Transactions x || Account Documents x| Collateral Management » || Reports xc | Producers x || Advances xc | Paymentsx | Feesx | AP Transactions s || GLTransactions x. ~ 0
Dlonginatios Authorization | Authorization Histary | Reviei Requests (Pending: 0)
Servicing
Transactions Z Edt | Bl view | o audt
Vieww Formatv [ Freeze i Detach wrap @) @ Checker O Maker C) Both ® 1Day () 2Days () 5Days () AllDays  View Failed B post 5 void
Account = T Dt Transaction Status aker Intiated Dt Checer Authorized Dt Comments
20150200010030:KARTHIKRAGHAVEIL.. 02/10/2015 ACCOUNT CLOSE ERROR ViEHATIA 02/10/2016 UNGEFINED
20121000010588:BROWH PAUL/ PAULA 02/09/2016 CHARGED OFF ERROR VEROUTHU 02/09/2016 UNDEFINED
20160100014008:B00 SUMAN 02/09/2016 CHARGED OFF ERROR VEROUTHU 02/092016 UNDEFINED
Colateral Hanagement
Repwts Parameters
i View~ Format~ | B Frecee 5 Detach wer | @
Parameter value Required
TXNDATE 020812016 ¥

Transaction Processing Details
View~ Format~ B Freeze A Detach rap 5]

> Collections
> WEP
> Tools

> Setup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background. Also,
operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right window,
provided your system administrator has enabled the option 'Mac_Multi_tab_Ind' ='Y’ in
MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Applications in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications by
clicking on the following links. Each successive click, opens a new Origination tab.

e Simple Application Entry
*  Application Entry
*  Underwriting

e Funding

Line Origination Setup Guide
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Figure 1-12 Multi tab - Origination

ORACLE
Financial Services Lending and Leasing

Chapter 1
Template and Navigation

ABSHEKAR ~ i Signout &

@8] Crigination % Origination % | Crigination »¢ |~ Origination

> DashBoard
Origination Application: 0000001010: MILLEN JOHN

fiew - Freeze Detach
Pe—— Vien - Format+ (& =

Dt App # Sub Unit

imple Application Entr
i ¥ 07/26/2016 0000001010

< I

UNDEFINED
Application Entry

Underwriting
Funding
Application Retrieval
Scenario Analysis Summary | Appicant Request | Decsion  Contract

Application Documents

Image Maintenance Applicant
Reports
Producers Applicant
Vendors 1 Relation Type e
2 PRIMARY JOHN
Ratios
Ratios
Grade
Bureau
> Servicing
> Collections Bureau
> WFP Bureau Report b
ailonks 2 Be CREDIT REPORT
> Setup “«

SearchTask  Funding: 0000001010  Review Requests (Pending: 0)

Wrap @ overideck v

Status
APPROVED - FUND.

Collateral || Comments

FICO Score

JONATHAN JENKINS 536

Grigination Stage

FUNDED

Tracking

[®Close
Elvew || < Audt
Warring OK ¥ MANUAL Contract
Producer Contact =
Producer Name woopeer SO Edsting Customer Duplicate Application Contact 7
MNumber
MN-00004 : SOUT... (512)-451-2211 N ¥
»
Document | Verification | Correspondence || Tools
Last Name Birth Dt Own fRented
MILLEN 07/17/1351 UNDEFINED
Score Vhat If Pmt Amt Assets Amt Lizbilites (4 Met-Viorth Amt
[} 0.00 0.00 0.00 0.00
3 Open Auto
Tradelines # AutoTradelines # -y i BKP Notices (LIFE)  Type Dt
2 1 0 0 MANUAL 07f25
v

Few screens in Origination are identical and are linked. Hence, when multi tab option is not
enabled, you can open only one screen at a time from the group. A sample of the grouping

structure is given below, based on stages of the screens:

Origination:

e Simple Application Entry
e Application Entry

e Underwriting

e Funding

As per the above listing, you will be able to open only one screen in the corresponding list and

need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right

Splitter/Action Window while working on Application screens. You can click {and b to toggle the

view of Right Splitter/Action Window.

Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the

following:

Line Origination Setup Guide
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Figure 1-13 Right Split Window Application

Chapter 1
Template and Navigation

ORACLE #, Welcome, VAVAIDYA v o
Financial Services Lending and Leasing
Close
i origiation « EE
Search/Task  Fundings 0000000378  Review Requests (Pending: 0) B
Quick Search
Application: 0000000378 TIFFANY RUSSEL / GRACE (Bl view || 2 audit et
Vieww Fomatw [ Freeze 2 Detach wiap | @) Ovemdeok v WamingOK v e
Origination Stage b Duplicate Itiadcy
Dt App = Sub Unit Status Code Producer Name r[‘: Existing Customer Aapplication Contact * Eﬁ T é[\ear
oy/0a/2012 0000000378 UNDEFINED. APPROVED-FUNDED  FUNDED GA-00004: ADVANCE LEA.. .. Il N
, Summary
Application Documents s e
e — Advance 1500000 15,000.00
eports
Producers Summary | Applicant | Request | Decision | Contract | Collateral || Comments || Tracking | Document | Verification || Corespondence | Tools ’:““ i:“”“ ;:“"“
em
Vendors
> Applicant Grade DGRADE  Score 0
v o1seo L2 15000
Stated PTI954 Stated After DTS8.92
> Ratios Book 10,000 ileage 0
AssetDesc 2012 CHEVROLET MONTE CARLO
= 0
> Bureau
Quene FUNDED APPLICATIONS QUEUE
B Cheniaet Change Status
Status APPROVED - FUNDED
Collateral Change Status
Collateiml Add Comment
hsset Type SubType Primary  Year vake Wodel Vileage New Wholesale Value =
> Servicing VEHICLE car v 12 CHEVROLET MONTE CARLO 0 10,000.00 Blert
> Collections “Tipe
s * Sub
AWER Trade-In Type
> Tools * Comment
> Setup Trade-In - -

* Use Quick Search to search for an application based on application number, last 4 digits
of SSN (SSN of the primary applicant) or identification number. If multiple applications or
accounts are found during Identification # search, the system displays an error message
as “Multiple Matches found for the Identification #, Please use normal Search”.

*  Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate and

Term.

* Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the Change Status will be read-only.

* Use Add Comment section to post an alert or comment during Underwriting and Funding

stages.

For detailed information on the above options, refer to respective sections in the document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click = to toggle upper pane and {to toggle left pane.
To un-toggle click = and b respectively.

This section consists of the following topic:

¢« Time Zone Preference

Line Origination Setup Guide
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1.4.1.1 Time Zone Preference

Figure 1-14 User Info

| Oracle Financial Services Lending and Leasing *®

User Info
Organization DMC Time Zone USER TIME ZONE v
Division U501 Level
First Mame VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD

Branch Time TIME)
Responsibility SUPERUSER s

R i il Server Time ASIA/CALCUTTA {INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT X Skin Family Skyros (Default) v

Debug Enabled Ind

B3 submit || 3% Close

You can select any of the following three time zones from the User Info screen:
e Application Server Time Zone
e Company Branch Time Zone

e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under Division Definition.

e Inthe Display Formats tab, select Time Zone and click Edit.

Line Origination Setup Guide
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* Inthe Format field, select the required time zone from the adjoining options list and click
Save.

If Company Branch Time Zone is selected as the time zone in User Info screen, then on
save, all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:
e Navigate to Setup > Administration > User > Users.
«  Select the required User record listed in User Definition section and click Edit.

* Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If User Time Zone is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

1.4.2 Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped. As
similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on Customer
Service tab, the corresponding tabs are displayed.

Figure 1-15 Customer Service_Example

Customer Service x [Fcle
search  Customer Service: 0120200010231 PeweuRequest(venqu:n)l
Account(s): 20120200010231: YUTAKA OZAKA / AKANE Elview || o avdit
Vieww Format~ [Ep Freeze i Detach Wrap B & © cument O Showall O Group Fallow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usot UsRL UNDEFINED 2012020010231 LEASE VEHICLE 0 UsD 0.00 0.00 ACTIVE 02/10/2015
[ summary ICustomer Servicd _Account Details _Customer Details _Transaction History Pt Modes | Bankuptcy | RepofForedosure Deficiency  Collateral Bureau _Cross/lp Sell Actvties |
‘ Call Activities ~ Maintenance =~ Comments Promises Checklists Tracking Attributes ~ References  Correspondence  Letters — Document Tracking
Call Activities . Fadd || et || Eview || o audit
View= Format~ [y Freeze i Detach wrap M

Time Zone Adj Folloviup Dt Con
12/29/2015 12:30:00 PM
12/29/2015 12:30:00 PM

»

Appointr Follovup Dt
12/30/2015
12/30/2015

Promise Amt Condition
1,000.00 NONE N
1,000.00 NONE [

Cancel Promise Dt
12/30/2015
12/30/2015

Action Result Contact Reason
AT PH ANSWERING MACHINE N
AT PH ANSWERING MACHINE N

You can click » to view the hidden tabs, if any.

1.5 Common Operations
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* Basic Operations

» Basic Actions

* Personalization Options

e De-supported Special characters

»  Skip Zip Code Validation

»  Export data to Excel

1.5.1 Basic Operations

Chapter 1
Common Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic

operations available are:

e Add
e Edit
*  View
*  Audit

ok add | A Edit | 5] view || < Audit

When you click any of the operation tabs, system displays the corresponding records inline,

below the respective setup tables.

The table below gives a snapshot of them:

Table 1-3 Basic Operation

Basic Operation

Description

Add

Click to add a new record. When you click Add, the
system displays a new record enabling you to
specify the required data. It is mandatory to specify
details for the fields marked with *' symbol.

Edit

Click to edit an existing record. Select the record
you want to edit and click Edit. The system
displays an existing record in editable mode. Edit
the required details.

View

Click to view an existing record. Select the record
you want to view and click View. The system
displays the record details in display mode.

Audit

Click to view audit info. If an audit is set for a field,
then the system tracks the changes for that field.
Select the record for which you want to view the
audit info and click Audit. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to
close an unsaved, modified record, then the system
alerts you with an error message. You can click Yes
to continue and No to save the record.

1.5.2 Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

Line Origination Setup Guide
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All or few of these actions are enabled when you select any of the Basic Operations.

El Save and Add E Save and Stay El Save and Return <3 Return

The table below gives a snapshot of them:

Table 1-4 Basic Actions

_________________________________________________________________________________|
Basic Actions Description

Save And Add Click to save and add a new record. This button is
displayed when you click Add button.

Save and Stay Click to save and remain in the same page. This
button is displayed when you click Add/Edit button.

Save And Return Click to save and return to main screen. This button
is displayed when you click Add or Edit buttons.

Return Click to return to main screen without
modifications. This button is displayed when you
click Add, Edit or View buttons.

The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Table 1-5 Navigations

Basic Actions Description

Click to navigate to the first record.

o

Click to navigate to the previous record.

Click to navigate to the next record.

b |

M |

Click to navigate the last record.

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Table 1-6 Buttons for Specific actions

Basic Actions Description

Show File - Click to view the details of selected file.

E

Line Origination Setup Guide
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Table 1-6 (Cont.) Buttons for Specific actions

Basic Actions Description

List Files - Click to generate and view the list of
files maintained in the system.

Download File - Click to download the details of

E‘ selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

Figure 1-16 Personalization Operations

|\n'iewY Farmat - ﬁ Freeze HEDetach | WWrap EE!'

The table below gives a snapshot of them:

Table 1-7 Personalization Options

|
Options Description

View Click to personalize your view. The drop-down list provides the following
options of customization:
e Customize columns you wish to view

e Sort the order of displayed data
e Reorder columns
Additionally, the drop-down list provides selection of options adjoining

View.

M Format ~ | Ep Freeze £ Detach
Columns ] Show All

| R + Product |
Detach + Description |
Sort v« StartDt
Reorder Columns... + End Dt

+ Direct

+ Enabled

+ Collateral Type

+ Collateral Sub Type

Query By Example

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...
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Table 1-7 (Cont.) Personalization Options

Options

Description

Format

Click to resize columns or wrap a data in the table cells.

Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column =

Column DESCRIPTION
width [ 100 & [Pixels  [=]

| OK | Cancel

Specify the Width and unit for the selected column. Click OK to apply
changes and Cancel to revert.

Query by Example

Click to query for the data by an example. When this option is selected,
the system displays an empty row above column heads. You can specify
all or any of the details of the record you wish to query.

View » Format #.I
il |

Freeze Eff Detach ol Wrap [ee)

I | &)

Freeze

Select the column at which you need to freeze the table and click
Freeze. Function is similar to the freeze option in MS excel.

Detach

Click to detach the setup table from the screen. An example of the
detached table is provided below.

Wrap

Select the column in which the data needs to be wrapped and click
Wrap.

Loan Line Lease

Product Definition dpadd | Edt | [Fvew | of Audit
view - [Foifiak] | & | D" e [P | @) tew procuct Create Copy
|Product

[endot |pirect [Fiexte Repoyment [Enabied |colateraiType  |colateral sub Type ‘E;ff};i“;we |
W oav+E

12/31/4000 ¥ 2 ¥ "HOME COLLATERAL  REAL PROPERTY HON INSTALLMENT r

LOANSG 12/31/2000 N N 4 HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT

LOAN-UN 12/31/4000
12/31/4000
12/31/4000

UNSECURED COLLATIUNSECLRED INSTALLMENT

VEHICLE COLLATERA PERSONAL PROPERT'INSTALLMENT
VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT

LOAN-VE
MDP1

MURABAHA 03/13/2013 HOME COLLATERAL REAL PROPERTY HOM INSTALLMENT
NDs1

NPO1

12/31/2000
12/31/2000

UNSECURED COLLATIUNSECLRED INSTALLMENT
HOME COLLATERAL REAL PROPERTY HOMMORTGAGE -

<< o< <z =

Click to refresh the data in the table.
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Table 1-7 (Cont.) Personalization Options

________________________________________________________________________________|
Options Description

View Last For usability and performance, some of the data intensive screens have
View Last option to sort the volume of data being displayed on screen
based on elapsed days.

view Last ©) 1Day @) 1Week© 1Month@ By Date startDt 07/01/2017 [ EndDt 092002017 b &B

You can select the View Last option as 1 Day / 1 Week / 1 Month / By
Date. When By Date is selected you can specify a date range (within 3
months) in Start Dt and End Dt fields using the adjoining calendar and
clicking Search.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print
the contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new tab
is opened where the print content is displayed.

Detach

Figure 1-17 Detached Table

ORACLE" & Welcome, vavarova ~ EISEGRIGN <
Financial Services Lending and Leasing
& Close
e 13 " customer service =
> Origination | : 1 :0) =
Account(s): 2012020001023 1: YUTAKA OZAKA / AKANE [Elvew || 2 audit
View+ Format~ [ Freeze Pfivetach  Jwep @ & @ Cument O ShowAll O Group Follow-up
Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usot USRL UNDEFINED. 2012020010231 LEASEVEHICLE 0 usD 000 0.00 ACTIVE 02/10/2015
Summary | Customer Service | Account Details | Customer Details | Transaction History Pt Modes || Bankruptcy | RepofForeclosure || Deficiency | Collateral || Bureau || Grossfup Sell Actties
Call Activities | Maintenance || Comments || Promises || Checists | Tracking Attributes || References || Correspondence | Letters || Document Tracking
Reports
Producers E ?
Visidors Transaction Batch Information padd | S Edt || [Eview || o audit
e View Formats | B Freeze B Detach war | @ S post [ vaid
Date Honets Transaction Status Batch
Payments 02/10/2016 ADD CUSTOMER ADDRESS PHONE POSTED N
Fees g 75016 v TERMINATE ERROR [
Interfaces 01/06/2016 v TERMINATE vo u «
P Trane 010EPY6 ECENSION van L
Detached Table
View~ Format~ B} Freeze [0 Detadh rap W@ #3post [} vaid
Date Honetary Transaction Status Batch
02/10/2046 N 'ADD CUSTOMER ADDRESS PHONE POSTED
01/07/2016 Y TERIINATE ERROR i
01/06/201 v TERMINATE vom [
01/06/2016 Y EXTENSION vom i
127242015 v PAYOFF QUOTE LEASE POSTED ¥
View~ Format~ [ Freeze f Detach wep | @
> Collections rocessing Details
> wEp Direct Record Update, Transaction Posting Successful =+
> Tools
> Setup

Click Add, Edit or View button to open a new screen in expanded mode with details.
Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you provide
the alphabet, system limits the selection to the values starting with the specified alphabet.
These lists are grouped into two types:

Line Origination Setup Guide
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Drop-down list — Provides the selection option. You can either select a record from the list

or enter first alphabet of the required value.

Combo drop-down list — The LOV contains huge data and provides both selection and

search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

Figure 1-18 Combo drop-down

ORACLE'

Financial Services Lending and Leasing

& Welcome, VAVAIDYA o

> DashBoard
> Origination
Servicing

Account Documents
Collateral Management
Reports

> Collections
> WFP

> Tools

> Setup

Customer Service x £
44444 " G :0)
Account(s): 20151200010012: MADHU BOBBURL Elvien || < auit
Views Fomatv [ ([|Freere RiDetch  clwmp | @) & Cument O Showll O Group Follow-up
Company Branch Sub Unit Account & Product. Days Past Due Currency Pay Off Amt Amount Due Status. Oldest Due Dt
ustt ushig 2015120001012 | LOANVEHICLE(FR) 21050 s031861 R s criveoe guion peero... [EITTERN

Summary | Customer Ser

Call Activities | Maintenan

Transaction Batch Information

View Fomat~ | B

Date
02/10/2016
. 01/25/2016
01/22/2016
01/07/2016
1/15/2015

Transaction Batch Information

Parameters
View te

Fa
Hio data to display,

Result

Account Details || Custom: s || Transaction History Modes os' : <}

Agvanced

Freeze § Detach Wrap o'} $post [ void
Transaction ACCOUNT L

AccounT tic

ACCOUNT SUB UNIT TRANSFER P rilies

ACH HAINTENANCE

ACH ONETIME PHONE PAY

ADIUSTMEIT TO ADVANCE | PRINCIPAL - ADD

[ searct: Transaceih

Honetary
¥

N

N Search Basic
N

¥

Reset | | AddFields ~ || Reorder

Date 02/10/2016 *Transaction

* Monetary @) an or equal to o || cancel

EE we | @

Click the arrow button available before Search to toggle the search options.

Table 1-8 Search options
|

Buttons/Menu Do this

Basic Click Basic for normal search.

Advanced Click Advanced for advanced search. In this mode,
you can select the search option from drop-down
list adjoining the search criteria. Selected record
will be highlighted (Hover to select).

Match Select All to display results exactly matching the
specified characters. Select Any to display results
matching any of the specified characters.

Search Click to search for values based on the specified
search criteria. The search results are displayed
below with the details in respective columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the Match field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
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Figure 1-19 Search Memory

| * Channel | WEB ENTRY [=] * Producer Name |
NY-02 : PR : HOLTSVILLE 43125313712
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
TIF-OUOO L T TEST-00 T AOTONTAS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

1.5.4 De-supported Special characters

OFSLL does not support the following special characters while accepting data through Ul,
web service and file upload process.

<>{}N\"[I

Hence, ensure that the same is not used while processing any input data in the system.

1.5.5 Skip Zip Code Validation

While accepting data for interdependent fields through User Interface, OFSLL validates and
auto-populates the values for subsequent fields based on previous selection.

Accordingly, when a specific Country is selected from drop-down list which is populated based
on COUNTRY_CD (COUNTRY CODE) lookup code, OFSLL validates and populates the list of
corresponding zip codes maintained in Zip Code setup.

However, in case the zip code validation is to be skipped for a specific Country, then define the
Sub Code as NO_ZIP_VAL against the COUNTRY_CD in lookups screen as indicated below:

Figure 1-20 Skip Zip Code Validation

Lookups x (3] Close
Lookup Type H Add | A Edit || [F] view || & Audit
View v Format » E Freeze ;f Detach Wrap E@

Yes

& “COUNTRY%
No

System Defined

Lookup Type Description Yes/No Enabled
COUNTRY_CD COUNTRY CODE (SORT BASED ON CODE) Yes () No Y
»
Lookup Code P Add | FEdit | ] view || & Audit
View v Format « @ Freeze ;ﬂ Detach Wrap GE
é Yes
%NOY
%NO% No
Lookup Code Description Sort Sub Code SEEmEEEY Enabled
Yes/No
UK UNITED KINGDOM 1|NO_ZIP_VAL Yes (L) No Y|
SG SINGAPORE 1|NO_ZIP_VAL Yes () No Y~
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On Selecting that particular Country from drop-down in any of the Ul screen, only the default
value ‘0000000000’ is available for Zip field drop-down list. On selecting the same, the City and
State fields are set as UNDEFINED.

Figure 1-21 Skip Zip Code Validation

Producer Details
B Save and Stay B Save and Retun CJRetum

Producer # CO-00004 Address Line 12145 HWY 50 WEST Max Float 99,099
Old Producer # CO-00004 Address Line 2 Remaining Float 99999
* v
Name DALE SPRADLEY MITSUBISHI Country UNITED KINGDOM 5 Enabled
Company  ARGOL v
pEy, Zip 0000000000 hd <Subvention Participation
Branch ARO1 v ) 0000000000 UNDEFINED UNDEFINED
Zip Extn
Start Dt 05/27/1004 [y " Search..
City [ONDErTNED =i
End Dt 12/31/4000 | )
State UNDEFINED v Collection Type | STATEMENT v
Contact  JACK * Permission hlgi Collection Frequency MONTHLY 34
Group | NOT DEFINED X . Perm\ssioncic Refund Disbursement NONE v
Method
Grade hd Text o i =
egion
Type DEALER ¥ Phone 1 (719)-543-6710 N
Territory | ALL ¥
Status | ACTIVE v Bn10 i,
Sales Agent i * Permission to License Details
Underwriter DEMO UNDERWRITER v call
* Permission g
Funder v S ot Valid From |01/01/1800 [2:)
Collector ' DEMO COLLECTOR v Phone 2 Valid To 12/31/4000 B

® Note

Skipping zip code validation has significant impact in the system since the change
impacts all the Ul screens - Setup screens, Origination, Servicing and Collection
module screens, Interface, Customer Credit Limit, Collateral Management, and so on.
Hence it is recommended to be done with careful consideration and OFSLL is not
responsible for any impact/ mismatch resulting out of this change.

1.5.6 Export data to Excel

While working on any of the screens in User Interface, OFSLL provides a flexibility to Export
the data that is displayed on screen to an Excel file. This helps to download and view the data
offline especially with data intensive screens.

Clicking Export to Excel option provides option to save the data to . x| s file.

Figure 1-22 Export to Excel

Summary =~ Collections Customer Service =~ Account Details ~ Customer Details =~ Customer Preferences  Transaction History = Pmt Modes — Bankruptcy =~ RepofForeclosure | Deficien > ¥

Call Activities Comments = Promises =~ Checklists =~ Tracking Attributes ~ Field Investigation = References = Correspondence = Letters = Document Tracking = Scen: > ¥

Transaction Batch Information Padd | FEdt | [C]view | o Audit
View v Formet v  [Ep Freeze i Detach Wrap 5] %% Post [t Void | | Export to Excel
Date Monetary Transaction Status Batch
10/29/2020 Y PAID OFF POSTED N
10/23/2020 N ADD CUSTOMER ADDRESS PHONE POSTED N

Count:
2

Parameters
View v Formatv [P Freeze i Detach Wrap 0]
Parameter Value Required
TXN DATE 02/11/2020 Y
WRITE OFF INDICATOR YES Y
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However, Export to Excel option is currently available only to following screens and is also
access controlled depending on configuration defined in setup.

*  Queues/Search Results - Origination, Servicing, and Collections
e Account Information

e Balances

e Call Activities

* Maintenance

*  Promises

e Due Date History

e Collateral

e Tracking Attributes

*  Condition Details / Condition / Queue History

In additional, OFSLL displays the total count of records fetched from database. The count is
displayed in the right bottom corner of records table. However, note that this is not the total
count of all the records in the database but only the records which are fetched based on
specific selection. For example, if there are 50,000 records in database and Ul is fetching
1,000 records, then the count is displayed as 1,000.

1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as Hot Keys. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
Accessibility screen, press ‘Shift + Alt +y'.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

3. Space bar to check or uncheck Check Box.

4. Arrow Keys to hover within the drop-down list.

« Keyboard Compatibility

1.6.1 Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a change
in key combination based on the browser on which the application is running.

Table 1-9 Keyboard Compatibility
]

Browser Operating System Key Combination Action

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + Click
mnemonic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic  Click
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Table 1-9 (Cont.) Keyboard Compatibility

Browser Operating System Key Combination Action
Mozilla Firefox Mac OS X Control + mnemonic Click
Mozilla Firefox Windows Alt + Shift + mnemonic  Click
Microsoft Internet Windows Alt + mnemonic Set focus
Explorer 7
Microsoft Internet Windows Alt + mnemonic Click or set focus
Explorer 8
Apple Safari Windows Alt + mnemonic Click
Apple Safari Mac OS X Control + Option + Click
mnemonic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Table 1-10 Keyboard shortcuts
]

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.

1.7 Tool Tips

The system is facilitated with tool tip option.

When the cursor is moved on any of the user interface field in the screen, a popup is
displayed. It consists of a tip with the action that has to be performed.

1.8 Accessibility

This section consists of the following:

* Understanding Accessibility

*  Application Accessibility Preferences

« Documentation Accessibility Preferences

1.8.1 Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.
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1.8.2 Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility to
make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

The application user interface contents are readily accessible for all types of users without
the need to select special accessibility modes.

The components within the user interface are optimized for use with a screen reader by
default.

The contents are zoomable by default, eliminating the need for an application large fonts
mode.

The user interface components auto-detect if operating system (OS) is set to high contrast
mode and automatically render content that is compatible with OS high contrast,
eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built on
Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

1.8.3 Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

Addition of text equivalent to all graphics

Usage of standard fonts and avoiding shadow or reversed text

Usage of strong foreground and background color contrast

Color usages as per Oracle Accessibility guidelines have been ensured
Usage of styles and formatting elements

Documentation in simple language to ensure easy understanding

Including accurate and effective navigational features, such as cross-reference, tables of
content and bookmarks as appropriate.
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Administration System

In Administration > System, you can record setup data related to the application’s overall
functionality and performance. This data affects;

e The mechanics of the system
e The processes of the system

e The search for Location of files to complete the tasks.
Navigating to Administration System

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > System

The System drop-down link records the following data. Using the below screens, you can
control the behavior of the system from a technical perspective. For example, determine
parameter values, define what information is audited, and record default values. However, note
that the product provides default values for parameters in all these screens.

e System Parameters

e Lookups
» User Defined Tables

* Audit Tables

» User Defined Defaults

e User Defined Parameters

e Transaction Codes

« Data Files
e Events
» Batch Jobs

e Producer Cycles

* Vendors
* Reports

e Error Messages
e Translation

e Label Configuration

* Seed Data
e Data Masking
«  Webhook
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2.1 System Parameters

System parameters define information or values used throughout the system. They act as
switches that control the manner in which a function is implemented, or whether or not the
system performs a particular task. Parameters are used throughout the system to control
everything from user access to what information is stored on any given form. Parameters also
define configuration data, such as the location of the system files, the URLSs for the report and
image servers, and other administration controlled data. Some of the system parameters are
setup when the system is installed, but the values associated with the parameters need to be
reviewed and maintained.

There are three types of parameters in the system, grouped by what part of the system they
affect:

Table 2-1 Types of Parameters

|
Parameter Type Parameter Range

System parameters These parameters apply to the entire system.
Examples: batch processes, archiving, aging.

Organization parameters These parameters apply to the organization,
division, and user responsibility.

Examples: User login control, password expiration.

Company parameters These parameters apply to the company and
branch.

Examples: decision fax control, scoring model.

Hence, the System Parameters screen contains the following three tabs:

System Parameters Setup

* QOrganization Parameters

¢ Company Parameters

2.1.1 System Parameters Setup

The System Parameters Setup screen displays and records each system wide parameter,
along with its current value and whether or not it is enabled. These parameters relate to the
overall processing of the system, such as application server file locations and data purging
configuration.

@ Note

You can only define these parameters. Changing the values of any of these
parameters affects the related processing.

To set up the System Parameters

1. Click Setup > Setup > Administration > System > System Parameters > System. The
system displays the System Parameter screen.

2. Inthe System Parameters section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 2-1 System Parameters
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Transaction Code P s = v
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hl latio:
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Organization
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Access =
i = Parameter Value
Credit Bureau
Correspondence
General Ledger
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Check Details
Standard Payess
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Zip Codes
Products
i >

A brief description of the fields is given below:

Table 2-2 System Parameters setup
|

Parameter Type Parameter Range

Parameter System parameter of the specified parameter
description is displayed here.

Parameter Description Select the description of system parameter from
the drop-down list.

Parameter Value Specify the value for the system parameter
(required).

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix System Parameters chapter.

This section consists of the following topic:

« FCUBS Integration

2.1.1.1 FCUBS Integration

Oracle Financial Services Lending and Leasing (OFSLL) is integrated with Oracle FLEXCUBE
Universal Banking System (FCUBS) with the capability to integrate the centralized CIF
(Customer Information Files), ELCM (Enterprise Limits and Collateral Management) and CASA
(Current Account and Savings Account) modules.
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To work with the integrated environment functionalities, you need to enable the following core
banking indicator.

Table 2-3 FCUBS Integration
|

Parameter Parameter Description
CMN_CORE_BANK CORE BANKING INTERFACE INDICATOR
® Note

Re-qualification is pending for Core and Direct Banking Integration.

For detailed information about integration changes, you can refer to ‘FCUBS Integration
Documents’ section at OTN library (http://docs.oracle.com/cd/E59770_01/homepage.htm).

2.1.2 Organization Parameters

The Organization parameters control the system functions related to user log in, such as
passwords and expiration dates, responsibility levels and the ability to access the system
features. Individual parameters can be created with different values for uniquely defined
organizations, divisions, and responsibility combinations.

When determining which parameter to use, the system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

For example:

Assume the organization parameter UIX_APP_VIEW_ALL_APPS (VIEW ALL APPLICATIONS)
is as follows:

e If a user belongs to an organization as DMC with a responsibility of SUPERUSER and is
using the Underwriting screen of Lending menu, the system will return with a value N, and
the system will not allow the user to view all applications.

» If the user belongs to any organization with a responsibility of SUPERUSER, and is using
the Underwriting screen of Lending menu, the system will return with a value Y, and the
system will allow the user to view all applications.

@ Note

Be aware that while the system allows for Organization parameters to be defined at all
three hierarchical (organization, division, and responsibility) levels, not all will be
applicable to each parameter. For example, while you can define the
UIX_SMTP_SERVER (EMAIL SERVER FOR USER) for a responsibility, you would
normally want only to define this parameter based on organization or division.

To set up the Organization Parameters

1. Click Setup > Setup > Administration > System > System Parameters > Organization
tab.

2. Inthe Organization Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.
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Figure 2-2 Origination System Parameters Setup
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A brief description of the fields is given below:

Table 2-4 Organization Parameters

|
Field Do this

Parameter Parameter of the specified parameter description
is displayed here.

Parameter Description Select the description of system parameter from
the drop-down list.

Parameter Value Specify the value for the system parameter.

Organization Select the organization for which the parameter

will be valid from the drop-down list.

Division Select the department for which the parameter
will be valid from the drop-down list.

Responsibility Select the responsibility for which the parameter
will be valid from the drop-down list.

IMPORTANT: In selecting which organization
parameter to use, the system searches for a best
match using the following attributes:

1. Organization

2. Division

3. Responsibility

Hence, Oracle Financial Services Software
recommends creating a version of each

organization parameter, where ALL is these
fields.
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Table 2-4 (Cont.) Organization Parameters

|
Field Do this

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix System Parameters chapter.

2.1.3 Company Parameters

The Company parameters control the system processes associated with functions that may
vary for different companies or branches. These parameters address credit scoring, credit
bureau interfaces, fax services, and fax generation. Individual parameters may be set up with
different values for uniquely defined company and branch combinations.

When these parameters values are requested by the system, the system responds with the
best match based on a hierarchical sort ordered on company and branch fields, with values of
ALL being a lower order match than an exact match. For example, assume the company
parameter UIX_RUN_AAI_ACT (ONLINE ACCOUNT CREATION AND ACTIVATION) has
been defined as:

The system uses these two parameters to determine whether to create and activate an
account online.

*  When processing items for the company US01, the system will return a value N and not
create and activate an account online.

*  When processing items for the company other than US01 and within the value ALL, the
system will return with a value Y and create and activate an account online.

To set up the Company Parameters
1. Click Setup > Setup > Administration > System > System Parameters > Company tab.

2. Onthe Company Parameters screen, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 2-3 Company Parameters
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A brief description of the fields is given below:

Table 2-5 Company Parameters setup

|
Field Do this

Parameter The system displays the parameter, when you
select parameter description.

Parameter Description Select the description of system parameter from
the drop-down list.

Parameter Value Specify the value for the system parameter.

Company Select the portfolio company for which the
parameter will be valid from drop-down list.

Branch Select the portfolio branch for which the

parameter will be valid from the drop-down list
(required).

IMPORTANT: In selecting which company
parameter to use, the system searches for a best
match using the following attributes:

1. Company

2. Branch

For this reason, the Software recommends
creating a version of each company parameter
where ALL is the value in these fields.

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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For a detailed list of available parameters, refer to Appendix System Parameters chapter.

2.2 Lookups

The Lookups setup screen defines the contents in many drop-down fields used throughout the
system. Fields that make use of drop-down field will accept only entries that are stored on this
screen.

The Lookups screen contains two sections: Lookup Types and Lookup Codes. Lookup types
and codes can be system-defined or user-defined. The lookup types describe the function of
the related lookup codes.

For system-defined lookup types, only the Description field may be changed.

A system-defined lookup type (Lookup Types block, System Defined is selected) is one that
is critical to the system and cannot be changed. However, you can still modify the lookup type
description and Record indicator (Enabled/Disabled).

A user-defined lookup type (Lookup Types block, System Defined is not selected) is one that
can be modified, depending on a user's business needs. You can modify the description,
system indicator and record indicator. If a lookup type is user-defined, the lookup code
belonging to that lookup type can either be system-defined or user-defined.

A system-defined lookup code (Lookups screen, System Defined is selected) is one on which
the system processing is dependent. Without this lookup code, the process produces incorrect
results or fails.

A user-defined lookup code (Lookups screen, System Defined is not selected) is one that
can be defined or altered by a user.

WARNING: System-defined lookup types are those that are required by the system. Their
related lookup codes will also be system defined. If you update and save a user-defined lookup
type as a system-defined-lookup type (that is, change the System Defined button from No to
Yes in the Lookup Type sub screen), the system will not allow you to change the lookup type
back to user-defined in the future.

@® Note

Lookup codes cannot be deleted, as they may have been used in the past, and the
display and processing of that data is still dependent on the existing setup.

Typically, the system Administrator would modify the descriptions of lookup codes and add new
lookup codes to the existing lookup types as needed.

To set up the Lookups

1. Click Setup > Setup > Administration > System > Lookups. The system displays the
Lookups screen. The details are grouped into two:

e Lookup Types
*  Lookup Codes

2. Inthe Lookup Types section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 2-4 Lookups
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A brief description of the fields is given below:

Table 2-6 Lookups setup

|
Field Do this

Lookup Type Specify the lookup type.
Description Specify the description for the lookup type.

System Defined Yes/No Select Yes, if you wish to maintain the lookup
type as system defined and No, if you wish to
maintain lookup type as User defined.

Enabled Check this box to enable the lookup type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Lookup Codes section, you can setup individual codes that a field or process using
the related lookup type can have. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Table 2-7 Lookup Codes

|
Field Do this

Lookup Code Specify the lookup code. These are solely
dependent on the function of the Lookup Type.
Description Specify the lookup code description. This may be

changed as per your business requirement.

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 9 of 174



ORACLE’

Chapter 2
User Defined Tables

Table 2-7 (Cont.) Lookup Codes

|
Field Do this

Sort Specify the sort order for the lookup code. This
determines the order these lookup codes are
displayed or processed.

Sub Code Specify the sub code for the lookup code.

System Defined Yes/No Select Yes, if you wish to maintain the lookup
code as system defined and No, if you do not
want to maintain it as system defined. System
defined lookup codes cannot be modified, except
for changing the Description or Sorting fields. If
the lookup type is not system defined, then the
code can be modified.

Enabled Check this box to enable the lookup code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.3 User Defined Tables

In User Defined Tables you can maintain user-defined tables, such as the data attributes the
system uses on its Search screens.

In the following example, the list of attributes in the Criteria column are computed from the
User Defined Tables screen.

To set up a user-defined table, you must:
1. Define the fields on the table.
2. Join the related tables.

3. Assign the table a lookup type.
You can create tables for different products, funding, and collateral types.

After creating the user-defined tables, the system sorts the attributes to make the system
usage more efficient. These details are used with different functions of the system, including:

e Tracking follow-up items

e Creating details in bankruptcy, foreclosure/repossession, and deficiency

@® Note

Many of these tables, (ASSET TRACKING ATTRIBUTES for example) may be
configured during the initial setup of the application to provide for your specific
business needs. Others, such as APPLICATION SEARCH, may be changed
whenever your business needs change. Still others should not be changed without
consulting Oracle Financial Services Software, as changing them would require
changes to existing code for the expected results to be implemented. As a thumb
rule, it is better to add or disable information on the User Defined Tables screen
than to edit existing entries.

To set up the User Defined Tables

1. Click Setup > Setup > Administration > System > User Defined Tables. The system
displays the User Defined Tables screen. The details are grouped into two:
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* User Defined Tables
» User Defined Table Attributes

2. Inthe User Defined Tables section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-5 User Defined Tables
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A brief description of the fields is given below:

Table 2-8 User Defined Tables

|
Field Do this

Table Specify the user-defined table name.

User Table Type Select the user-defined table type from the drop-
down list. This determines where and how the
related data is being used.

Description Specify the description for user-defined table.

System Defined Yes/NO Select Yes, if you wish to maintain the User table
type as system defined and No, if you do not
want to maintain it as system defined. System
defined entries cannot be modified. If the entry is
not system defined, then it can be modified.

Enabled Check this box to enable the user-defined table
(optional).

Product Type Select the product type from the drop-down list.

Funding Type Select the funding type associated with the user-

defined table from the drop-down list.
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Table 2-8 (Cont.) User Defined Tables

|
Field Do this

Collateral Type Select the collateral type associated with the
user-defined table from the drop-down list.

View Name Specify the view name.
SQL Statement Specify the SQL version of the statement.

For Example: For SEARCH_ACC_ACCOUNTS
table, the SQL is as follows:

SELECT /*+ FIRST_ROWS */ ACC_AAD_ID
FROM ACCOUNTS WHERE

Note: For the above SQL, the where criteria is
part of the User Defined Table Attributes

Sort Specify the sort order for the user-defined table
relative to other tables of the same type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe User Defined Table Attributes section, perform any of the Basic Operations
mentioned in Navigation chapter.

Figure 2-6 User Defined Table Attributes
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A brief description of the fields is given below:
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Table 2-9 User Defined Table Attributes

Chapter 2
Audit Tables

Field

Do this

Attribute

Specify the user-defined table attribute.

Description

Specify the description for the user-defined table
attribute.

Data Type

Select the data type for the attribute
(CHARACTER, NUMBER, or DATE) from drop-
down list.

Length

Specify the maximum length of the user-defined
table attribute.

Sort

Specify the sort order of the user-defined table
attribute. If the sort order is changed it will only
affect new instances of the User Defined Table,
and will not affect existing data.

Operator

Select the operator for the user-defined table
attribute from the dropdown list.

System Defined Yes/No

Select Yes, if you wish to maintain the User table
attribute as system defined and No, if you do not
want to maintain it as system defined. System
defined entries cannot be modified. If the entry is
not system defined, then it can be modified.

Enabled

Check this box to enable the user-defined table
attribute so that the attribute will be considered
when creating new instances of the User Defined
Table.

Sub Attribute

Specify the sub-attribute for the attribute (sub
attributes are used to associate related
attributes).

LOV Type

Select the list of value (LOV) type for the user-
defined table attribute from the drop-down list.

LOV Validation Ind

Check this box to enable LOV validation of the
user-defined table attribute. This indicates
whether the data must come from the LOV.

Lookup Types

Specify the lookup type of the LOV associated
with the user-defined table attribute.

Default Value

Specify the default value for the user-defined
table attribute.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.4 Audit Tables

The system allows you to track changes in the database during line of credit origination. This

includes the tracking of:

e Application status history

e Audit history of specified fields

The Audit Tables Setup screen records the tables and columns requiring an audit. the system
stores the following details for the fields you want to audit for changes:

e Current value in field

« New value field

e User who changed the field’s content
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« Date and time when the value was changed

IMPORTANT: The system recommends that only a database administrator perform the
following steps.

To set up the Audit Tables

1. Click Setup > Setup > Administration > System > Audit Tables. The system displays
the Audit Tables screen. The details are grouped into two:

¢ Audit Tables
¢ Audit Columns

2. Inthe Audit Tables section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 2-7 Audit Tables
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A brief description of the fields is given below:

Table 2-10 Audit Tables

|
Field Do this

Table The table name on which audit trigger needs to
be created is displayed here (the system table
being audited).

Description Specify the table description.

Display Description Specify the column description to be displayed
on audit screen.
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Table 2-10 (Cont.) Audit Tables

Chapter 2
Audit Tables

Field

Do this

Display Column

Select the table column to be displayed on audit
screen from the drop-down list.

Enabled

Check this box to enable the audit table so that it
will be considered while generating the database
triggers.

Reset Row ID

Check this box to allow resetting the row
identifier.

Primary Key 1 (unlabeled)

The table primary key column 1 is displayed
here. (These columns define how to access the
data in the table.)

Primary Key 2 (unlabeled)

The table primary key column 2 is displayed
here.

Primary Key 3 (unlabeled)

The table primary key column 3 is displayed
here.

Primary Key 4 (unlabeled)

The table primary key column 4 is displayed
here.

Primary Key 5 (unlabeled)

Table primary key column 5 is displayed here.

Primary Key 6 (unlabeled)

Table primary key column 6 is displayed here.

Primary Key 7 (unlabeled)

The table primary key column 7 is displayed
here.

Primary Key 8 (unlabeled)

The table primary key column 8 is displayed
here.

Primary Key 9 (unlabeled)

The table primary key column 9 is displayed
here.

Primary Key 10 (unlabeled)

The table primary key column 10 is displayed
here.

Primary Key 11 (unlabeled)

The table primary key column 11 is displayed
here.

Primary Key 12 (unlabeled)

The table primary key column 12 is displayed
here.

Primary Key 13 (unlabeled)

The table primary key column 13 is displayed
here.

Primary Key 14 (unlabeled)

The table primary key column 14 is displayed
here.

Primary Key 15 (unlabeled)

The table primary key column 15 is displayed
here.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Audit Tables Columns section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 2-11 Audit Tables Columns

Field Do this

Column Specify the column name on which the audit
needs to be created from drop-down list (column
in the table that is being audited)

Description Specify the column description (description of

the data contained in the column).
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Table 2-11 (Cont.) Audit Tables Columns

Field

Do this

Chapter 2
User Defined Defaults

Data Type

The data type for the attribute is displayed here.

Enabled

Check this box to enable the audit column.

Perform any of the Basic Actions mentioned in Navigation chapter.

Once the required fields data is created or updated, click Generate in Audit Tables section

to initiate a trigger to update the details in the system.

2.5 User Defined Defaults

The User Defined Defaults Setup screen allows you to set up default values to automatically
populate in frequently used fields on the Application Entry screen. This streamlines the data
entry process when entering an application.

To set up the User Defined Defaults

1.

Click Setup > Setup > Administration > System > User Defined Defaults. The system
displays User Defined Defaults screen.

In the Application Defaults section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-8 Application Defaults
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A brief description of the fields is given below:
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Table 2-12 Application Defaults

Chapter 2
User Defined Defaults

Field Do this

Org Select the organization for which these defaults
are applicable from drop-down list.

Division Select the division for which these defaults are

applicable from dropdown list.

Application Defaults

Company Select the company from the drop-down list.
Branch Select the branch from the drop-down list.
Priority Select the priority from the drop-down list.
Channel Select the channel from the drop-down list.
Producer Type Select the producer type from the drop-down list.
Purpose Select the purpose from the drop-down list.
Product Select the product from the drop-down list.

Applicant Defaults

Relation Type

Select the applicant relation type from the drop-
down list.

Gender

Select the applicant gender from the drop-down
list.

Marital Status

Select the applicant marital status from the drop-
down list.

Language Select the applicant language from the drop-
down list.

ECOA Select the applicant ecoa from the drop-down
list.

Class Type Select the applicant class type from the drop-

down list.

Race National Origin

Select the applicant race or national origin from
the drop-down list.

Privacy Opt-Out

Check this box to indicate that the applicant has
elected to refrain from the non-public sharing of
information.

Address Defaults

Address Type Select the address type from the drop-down list.

Postal Type Select the postal address type from the drop-
down list

Street Pre Select the street pre type from the drop-down
list.

Street Type Select the street type from the drop-down list.

Street Post

Select the street post type from the drop-down
list.

Country

Select the country from the drop-down list.

Rent Amount

Specify the rent amount. The system defaults
this rent amount if the rent amount received from
the interface is zero.

This rent amount will be defaulted for a new
application also.

State Frequency

Select the stated frequency from the drop-down
list.

Actual Frequency

Select the actual frequency from the drop-down
list.
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Table 2-12 (Cont.) Application Defaults

Chapter 2
User Defined Defaults

Field

Do this

Ownership

Select the ownership type from the drop-down
list.

Employment Defaults

Type Select the employment type from the drop-down
list.

Occupation Select the occupation from the drop-down list.

Country Select the country from the drop-down list.

Stated Frequency

Select the stated frequency from the drop-down
list.

Actual Frequency

Select the actual frequency from the drop-down
list.

Income Defaults

Income Type

Select the income type from the drop-down list.

Frequency

Select the frequency from the drop-down list.

Liability Defaults

Liability Type

Select the liability type from the drop-down list.

Frequency

Select the frequency from the drop-down list.

Asset Defaults

Status Select the asset status from the drop-down list.

Condition Select the asset condition from the drop-down
list.

Country Select the country from the drop-down list.

Vehicle Defaults

Asset Type Select asset type from the drop-down list.
Sub Type Select asset sub type from the drop-down list.
Class Select the asset class from the drop-down list.

Valuation Source

Select the asset valuation source from the drop-
down list.

Home Defaults

Asset Type Select asset type from the drop-down list.

Sub Type Select asset sub type from the drop-down list.

Class Select the asset class from the drop-down list.
Occupancy Select the occupancy type from the drop-down

list.

Valuation Source

Select the asset valuation source from the drop-
down list.

Other Defaults

Asset Type Select asset type from the drop-down list
Sub Type Select asset sub type from the drop-down list.
Class Select the asset class from the drop-down list.

Valuation Source

Select the asset valuation source from the drop-
down list

Comment Defaults

Comment Type

Select the comment type from the drop-down list.

Comment Sub Type

Select the comment sub type from the drop-
down list.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6 User Defined Parameters

The User Defined Parameters setup screen facilitates to define field-level configurations which
helps to perform various day to day business specific calculations. In this screen you can
define parameters and logic for each field to compute and populate data.

For example, you can setup User Defined Parameters in the system to calculate Trade Equity,
Collateral Coverage Ratio, Net Rental Yield and so on.

@® Note

Currently system supports defining user defined parameters for entities like Account
and Collateral. The computed values are populated into Customer Service > Account
Details > Account Information section and Servicing > Collateral Management >
Collateral Details screen respectively on clicking Calculate Parameters button.

Defining user defined parameters basically involves identifying a scenario and creating/
configuring the required parameters. Here, a scenario can refer to what category of accounts
are to be considered for computation.

User defined parameters consists of the following two types of configurable parameters:

Table 2-13 Types of configurable parameters

_________________________________________________________________________________|
Parameter Description

Target Parameters These parameters store values for the
customizable user defined fields in user defined
tables and is used for calculation based on
Selection Criteria.

These parameters are available as per the View
Name defined in user defined tables for each
Account and Collateral Entity and persist the
calculation values into the table columns of
database after its first execution.

Formula Parameters These parameters are used for computation of the
target parameters. These contain the generic
formula/logic that can be used for any computation
based on System Defined Functions and Table
Columns. These parameters does not persist the
calculation values into the table columns of
database.

Since system supports Account and Collateral entity types, the configurable user defined
Target/Formula parameters along with selection criteria can be defined using specific table
type as indicated below:
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Table 2-14 Account and Collateral entity types

Chapter 2
User Defined Parameters

Entity Type

Parameter Type

Description

Accounts

Formula Parameters

Formula parameters are used for
computation of the target
parameters for Account Entity.

OFSLL supports predefined set
of calculation based Formula
Parameters. These parameter
definitions start with $ in User
Defined Tables.

These parameters does not have
any selection criteria.

Existing factory shipped seed
data provided by OFSLL product
like GL date, System Date,
ACC _DLQ DAYS and so on is
based on below User Defined
Table Type:

USER DEFINED: ACCOUNTS
FORMULA PARAMETERS
USER DEFINED: COMMON
FORMULA PARAMETERS
USER DEFINED: COMMON

CUSTOMER SERVICE
FORMULA PARAMETERS

Target Parameters

These calculations are based on
formula parameters and other
target parameters.

A selection criteria is available for
each calculation.

These are based on User Defined
Table Type: USER DEFINED:
ACCOUNT TARGET
PARAMETERS

Selection Criteria

These parameters define the
criteria on which accounts are
picked for calculation of defined
target parameters.

These are available only for
Target parameters and are based
on User Defined Table Type:
USER DEFINED: ACCOUNT
CRITERIA PARAMETERS
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Table 2-14 (Cont.) Account and Collateral entity types

. _________________________________________________________________________________|
Entity Type Parameter Type Description

Collateral Formula Parameters These Formula parameters are
used for computation of the target
parameters for Collateral Entity.

They are based on below User
Defined Table Type:

USER DEFINED: COLLATERAL
FORMULA PARAMETERS
USER DEFINED: COMMON
FORMULA PARAMETERS
USER DEFINED: COMMON

CUSTOMER SERVICE
FORMULA PARAMETERS

Target Parameters These are based on User Defined
Table Type: USER DEFINED:
COLLATERAL TARGET
PARAMETERS

Selection Criteria These are available only for

Target parameters and are based
on User Defined Table Type:
USER DEFINED: COLLATERAL
CRITERIA PARAMETERS

@® Note

The execution of User Defined Parameters require additional processing at the server
level and can have significant performance impact delaying the EOD processing.
Hence it is recommended to have careful consideration while defining the Target and
Formula parameter configurations.

In this framework, you can either create new parameters and/or use the available pre-defined
formula parameters to populate computed values to custom user defined fields.

For example - a formula parameter can be defined with an expression as
*$TOTAL_ITM_GRP_IEQ + $PAID_BAL_ADV which is total equity in itemizations on account
added with total advance amount paid. An expression can have a stored function (represented
with $ sign) and Account Columns (fields).

There are some formula parameters in the system with basic pre-defined calculation which can
readily be used for configuration along with account fields. Pre-defined formula parameters are
associated with specific acronyms appended with parameter name for identification. The table
below lists the available pre-defined formula parameters. However, you can also define custom
formula parameters with acronyms.

Table 2-15 Pre-defined formula parameters
]

User Defined Column Description Description
$GL_DATE Value of GL Date System Parameter
$SYSTEM_DATE Current System Date
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Table 2-15 (Cont.) Pre-defined formula parameters
]

User Defined Column Description

Description

$COLLATERAL_VALUE

Sum of all collateral current valuation

$PRIMARY_COLLATERAL_VALUE

Sum of all primary collateral current valuation

$ASE_GRAND_FATHER_POINTS

Sum of all grandfather points

$ASE_TIER_POINTS

Total Tier Points

$INTEREST_ACCRUED

Interest Accrued on Account for a specific date.
This is used to calculate Trade Equity Calculation.

$OUTSTANDING_AMOUNT

Current Account Outstanding Amount

$OUTSTANDING_BAL_ (BALANCE TYPE *)

This is a dynamic balance value calculation based

on type variable.

For example:

*  $OUTSTANDING_BAL_ADV - Will calculate
outstanding Advance/Principal amount

$PAID_BAL_(BALANCE TYPE *)

This is a dynamic balance value calculation based

on type variable.

For example:

*  $PAID_BAL_ADV - Will calculate paid
Advance/ Principal amount

$SUM_PRIN_ESC_MAX_EXPIRY_ DT

This is used to calculate sum of total principal
amount till Extended Service Warranty Max Expiry
Date.

$TOTAL_ITM_GRP_ (ITM GROUP?)

This is a dynamic itemization group value

calculation based on type variable.

For example:

e $TOTAL_ITM_GRP_IDC - Will calculate total
ITM DOWN PAYMENT CASH group amount

*  $TOTAL_ITM_GRP_IPF - Will calculate total
ITM PREPAID FEE group amount

$TOTAL_ITM_ (ITM¥)

This is a dynamic itemization value calculation

based on type variable.

For example:

¢ $TOTAL_ITM_IDC_1 - Will calculate total ITM
DOWN PAYMENT amount

e $TOTAL_ITM_IUN_4 - Will calculate total ITM
CASH DOWN amount

Both the parameters (formula and target) supports the following data types:

*  Number / Integer (both are considered as floating numbers)

e Date

e Character

While defining specific parameter, system auto-filters the variable list based on the supported

data type.

To enable any target parameters, ensure that there is at the least one enabled formula
parameter and selection criteria defined. Also while defining target parameters, ensure that
there is no circular dependency where two or more parameters are either directly or indirectly
dependent on each other. For example, If formula parameter A is defined as ACC_FIELD1 +
formula parameter B, and formula parameter B is defined as ACC_FIELD2 + formula
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parameter A. In such a case, system displays an error indicating ‘CIRCULAR DEPENDENCY
DETECTED FOR PARAMETER:<<PARAMETER NAME>>',

The user defined parameters calculation can be triggered in any of the following ways:

Table 2-16 User Defined Parameters

Option

Trigger

Action Type

User Interface

Clicking Calculate Parameters
button in Account Details screen,
Account Information section.

Target parameters of Frequency
= None and Daily are computed
and updated for an account and
all collaterals associated to the
account.

Clicking Calculate Parameters
button in Collateral Management,
Collateral Details screen.

Target parameters of Frequency
= None and Daily are computed
and updated only for the selected
collateral.

System calculates and updates
target parameter through
background job process which is
created to update UDP values
asynchronously.

Error/Validation messages
received during calculation of
user defined fields are displayed
under Background job and not
displayed in UL.

Batch Job for Account Target
Parameters update

On executing batch jobs - USER
DEFINED ROOT BATCH JOB
and USER DEFINED ACCOUNT
TARGET PARAMETER
CALCULATOR in SET-CUP batch
job-set

On execution, this batch job
calculates all target parameters
defined for Account that satisfy
the selection criteria.

Root batch job is parent batch job
and is executed first to pick all
accounts eligible for calculation
for the child batch job i.e. Account
Target Parameter Calculator. This
helps to enhance system
performance.

The batch job periodically
calculates for target parameters
of frequency other than None and
updates the Next Run Date for
parameter as per frequency
defined.

Note that, batch job picks-up
accounts only once per day and
refers to company specific GL
date.

Accounts in OFSLL are
associated to specific company -
branch combination. Hence this
batch set and job should be
configured at every company
branch level.
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Table 2-16 (Cont.) User Defined Parameters

Option

Trigger

Chapter 2
User Defined Parameters

Action Type

Batch Job for Collateral Target
Parameters update

On executing batch jobs - USER
DEFINED ROOT BATCH JOB
and USER DEFINED
COLLATERAL TARGET
PARAMETER CALCULATOR in
SET-CUP1 batch job-set

On execution, this batch job
calculates all target parameters
defined for collateral entity that
satisfy the selection criteria.

Root batch job is parent batch job
and is executed first to pick all
accounts eligible for calculation
for the child batch job i.e.
Collateral Target Parameter
Calculator. This helps to enhance
system performance.

The batch job periodically
calculates for target parameters
of frequency other than None and
updates the Next Run Date for
parameter as per frequency
defined.

Note that, batch job picks-up
accounts only once per day and
refers to company = ALL GL date.

Collateral in OFSLL are not
associated to any specific
company hence this batch set
and job should be configured for
company = All.

Event

Configured Event Action Type -

1. UPDATE ACCOUNT USER
DEFINED PARAMETERS

2. UPDATE COLLATERAL
USER DEFINED
PARAMETERS

For more details on defining
event action type, refer to Events

(New Framework) section.

Update Account/Collateral Target
Parameters of frequency = None
and Daily when specific type of
changes occurs in OFSLL for
Account/Collateral event entity.

Restful Web Service

Calculate Parameter Update
Service (available in common
Swagger module)

When third-party system post a
request to update specific or all
Target Parameters for a single
Account, single Collateral or all
collateral associated to an
account based on Entity Type
parameter updated in web
service request.

This parameter accepts only ACC
for accounts and ASE for
Collateral target parameters.
Target parameter of frequency
None and Daily are updated
through this web service.

Refer swagger documentation for
more details.
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During executing, system looks into the enabled user defined parameters, and considering
only those accounts matching the selection criteria, values are computed into the user defined

fields.

During computation of target parameters, system displays an error if there are more than one

definition defined for a target parameter.

To set up the User Defined Parameters

1. Click Setup > Setup > Administration > System > User Defined Parameters.

Figure 2-9 User Defined Parameters Setup
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2. Inthe Parameters section, do one of the following:

e Use the Create Copy feature to quickly create new parameter with the existing
parameter details. For Target Parameters, select required record and click Create
Copy. For Formula Parameters, select required record, specify New Parameter name
and click Create Copy. The new parameter created this way will be in disabled state

by default.

e Add/Edit user defined parameter by performing any of the Basic Operations mentioned
in Navigation chapter.
A brief description of the fields is given below:

Table 2-17 Parameters section

Field

Do this

Module

Select the module from the drop-down list. The
list is displayed based on the modules that
support User Defined Parameters calculation.
Currently only Customer Serving (accounts) is
supported.
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Table 2-17 (Cont.) Parameters section
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Field

Do this

Entity Type

Select the required entity for which calculation
is to be defined from the drop-down list. The
list is populated based on entity type
maintained in CUP_ENTITY_CD lookup code.

Currently, system supports ACCOUNTS and
COLLATERALS entity types.

Note that, entity can be selected only while
creating User Defined Parameter and the
same cannot be modified in Edit mode.

Parameter Type

Select the type of parameter to be defined as
either Target Parameter or Formula Parameter
from the drop-down list.

Parameter Name

For Target Parameter, system displays the list
of custom fields available in user defined table
for selection. Select the required Parameter
from the drop-down list. By default the first field
in the user defined table is selected.

For Formula Parameter, this is a text field to

record the new parameter name. Specify the
name of the formula parameter.

Description

For Target Parameter, the description is auto-
populated from user defined table and is
Read-Only.

For Formula Parameter, specify the description
of the formula parameter.

Data Type

For Target Parameter, the data type associated
for the parameter is auto-populated from user
defined table and is Read-Only.

For Formula Parameter, select the data type as
one of the following from the drop-down list -
INTEGER, DATE, NUMBER, or CHARACTER

Priority

Specify the order in which system should
evaluate the parameter definitions while
executing the batch job or on clicking
Calculate Parameters button.

For example, if a formula parameter A has
dependency on parameter B, then B has to be
calculated first in the order and priority is set
as 0.
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Table 2-17 (Cont.) Parameters section

|
Field Do this

Frequency Select the required frequency at which the
target parameters are to be calculated from
the drop-down list.

Frequency field is applicable only for Target
Parameters and the list of frequency supported
is populated based on values maintained in
CUP_FREQUENCY_TYPE_CD lookup code.

Note the following:

—  Frequency can be defined only in Edit
mode.

— Frequency is not applicable for Formula
Parameters.

—  Frequency None can be selected for
target parameters that are required to be
calculated on adhoc basis.

Run Date Next View the date on which the Target parameter is
calculated. The Run Date Next is auto
calculated based on frequency defined.

This field is applicable only for Target
parameters and for frequency other than
None.

Note the following:

—  For multi-company implementation, it is
recommended to add same User Defined
Parameter definition multiple times for
each company. This in-turn updates Run
Date Next for each company and
supports updating values at different zone
based on batch job setup.

—  Currently the Run Date Next is updated
even if not all the records are computed
based on selection criteria. Since this
impacts to restart failed records, the same
shall be addressed in subsequent patch
releases.

Enabled Check this box to enable the parameter
definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
This section consists of the following topics:

*  Formula Definition

*  Selection Criteria

2.6.1 Formula Definition

The Formula Definition section allows you to define a mathematical expression of the formula
to evaluate the parameter definition. The expression may consist of one or more sequenced
entries. All arithmetic rules apply to the formula definition. If errors exist in the formula
definition, the system displays an error message in this section when you choose Show
Expression.
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In the Formula Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.
A brief description of the fields is given below:

Table 2-18 Formula Definition

Field Do this

Seq Specify the sequence number (the order in which
the formula definition variable will be assembled
and evaluated).

( Specify a left bracket, if you need to group part of
your formula definition.

Variable Select the variable from the drop-down list which

consists of a validated list derived from user

defined table type as indicated below:

e For Number, system displays only numeric
fields

e For Date, system displays numeric + date
fields

e For String, system displays numeric +
character fields

Parameters for Account entity type in Customer
Service is derived from:

USER DEFINED: ACCOUNTS FORMULA
PARAMETERS

USER DEFINED: COMMON FORMULA
PARAMETERS

USER DEFINED: COMMON CUSTOMER
SERVICE FORMULA PARAMETERS
Parameters for Collateral entity type in
Customer Service is derived from:

USER DEFINED: COLLATERAL FORMULA
PARAMETERS

USER DEFINED: COMMON FORMULA
PARAMETERS

USER DEFINED: COMMON CUSTOMER
SERVICE FORMULA PARAMETERS

Constant Value

Specify the constant value (optional).

e For Number, system supports only numeric
constants

e For Date, system supports only numeric
constants

e For String, system supports both numeric
and character constants

Note: System displays an error indicating
‘VARIABLE OR CONSTANT VALUE IS
REQUIRED'’ if both Variable and Constant Value
or None is provided.
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Table 2-18 (Cont.) Formula Definition

|
Field Do this

Mathematical Operator Select the math operator to be used on the
adjacent formula definition rows, from the drop-
down list. The list is derived and displayed based
on data type / variable as indicated below:

e For Number, system allows all numeric
operators (+, -, X, and %).

e For Date, system supports (+ and -)
operators.

e For String, system supports concatenation
(i.e. +) operator.

) Specify a right bracket, if you are grouping part
of your formula definition.

Enabled Check this box to enable the formula and
indicate that it is included when building a
parameter definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Inthe Parameters section, click Show Expression. The mathematical expression appears
in the Formula Expression section (in sequential order) in the Expression field.

2.6.2 Selection Criteria

The sub tab is enabled only for Target Parameters and facilitates to define the selection criteria
indicating the type of accounts to be picked for computation. The parameters are derived from
user defined table - USER DEFINED: ACCOUNT CRITERIA TYPE CODE and USER
DEFINED: COLLATERAL TYPE CODE as per Account and Collateral Entity type.

1. Inthe Selection Criteria section, perform any of the Basic Operations mentioned in
Navigation chapter.

@® Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 2-19 Selection Criteria
|

Field Do this
Seq Specify sequence numbers.
( Specify left bracket.
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Field

Do this

Parameter

Select the parameter from the drop-down list.
The list is populated based on the values
maintained in user defined table - Customer
Service: USER DEFINED: CUSTOMER
SERVICE CRITERIA PARAMETERS.

Comparison Operator

Select comparison operator from the drop-down
list.

Criteria Value

Specify criteria value.

) Specify right bracket.
Logical Expression Select logical operator from the drop-down list.
Enabled Check this box to enable the selection criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Click Check Criteria for system to validate the query and display the results.

If the formula expression is mathematically incorrect when parameters are calculated, system
displays error indicating ‘INVALID FORMULA EXPRESSION: <<FORMULA PARMETER>>".

2.7 Transaction Codes

The system uses transaction codes to define the actions and tasks it can perform; for example,
activating an account, changing a due date, applying a late fee, and charging off an account.

The Transaction Codes Setup screen catalogs and defines these core system actions.

The system organizes transaction codes in Super Groups. All transaction codes within a
particular super group are processed in a similar manner. The transaction super groups in the

system are as follows:

Table 2-20 Transaction Super Group

Super Group Type

Description

ACCOUNT CONDITION TXN

These transaction codes control a user’s ability to
open and close account conditions.

ACCOUNT MONETARY TXN

These transaction codes affect the monetary value
of accounts in the system; for example, activating
accrual of interest, the assessment of fees, and
closing the account.

ACCOUNT NON MONETARY TXN

These transaction codes do not have a direct effect
on the monetary value of the account, but are used
in maintaining account information. This includes
changing a customer’s driving license, or adding
information for automated clearing house (ACH).

AMORTIZATION TXN

These transaction codes affect the amortized
balances of the accounts in the system.

CORRESPONDENCES

These transaction codes relate to the system
correspondences.

ESCROW ANALYSIS AND DISBURSEMENTS

These transaction codes allow for reviewing and
approving escrow analysis, stopping an escrow
override, and posting escrow disbursement.
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Table 2-20 (Cont.) Transaction Super Group

_________________________________________________________________________________|
Super Group Type Description

ESCROW MONETARY TRANSACTIONS These transaction codes affect the monetary value
of escrow accounts in the system; for example,
disbursing escrow to a customer and insurance,
and receiving payment.

ESCROW NON MONETARY TRANSACTIONS These transaction codes do not have a direct effect
on the monetary value of an escrow account, but
are used in maintaining account information, such
as changing insurance maturity date and adding
new escrow tax details.

FEE ASSESSMENTS These transaction codes determine if fees such as
nonsufficient funds fees or membership fees are to
be applied.

FUNDING TXN These transaction codes affect the funding of
applications and accounts within the system.

ITEMIZATION TXN These transaction codes affect the itemization of
applications and accounts within the system.

MENU TXN These transaction codes affect the menus within
the system.

PRODUCER MONETARY TXN These transaction codes relate to the monetary
transactions that apply to the system producers (or
dealers).

REPORTS These transaction codes are related to generating
the system reports.

SETUP LOCK/UNLOCK These transaction codes limit a user’s ability to

change the existing setup data, even if they are
allowed access to the form, by restricting access to
the Lock/ Unlock Record icon on the system tool

bar.

ACCOUNT CONDITION TXN These transaction codes control a user’s ability to
open and close account conditions.

CORRESPONDENCES These transaction codes relate to the system
correspondences.

MENU TXN These transaction codes affect the menus within
the system.

REPORTS These transaction codes are related to generating
the system reports.

SETUP LOCK/UNLOCK These transaction codes limit a user’s ability to

change the existing setup data, even if they are
allowed access to the form, by restricting access to
the Lock/ Unlock Record icon on the system tool
bar.

Three sub screens, Parameters, Access Grid, and Products, record any additional information
required to perform a transaction, the user types that can perform the transaction, and the
product type to which the transaction codes apply.

@® Note

The Software recommends that you restrict the access to the seed data once you are
in production.
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To set up the Transaction Codes

1. Click Setup > Setup > Administration > System > Transaction Codes. The system
displays the Transaction Codes screen.

2. In Transaction Super Group section, you can view the following information.

Figure 2-10 Transaction Super Group
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A brief description of the fields is given below:

Table 2-21 Transaction Super Group Fields

|
Field Do this

Super Group Select the Super Group you want to work with in
the Transaction Codes screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Transaction Codes section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 2-11 Transaction Codes
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A brief description of the fields is given below:

Table 2-22 Transaction Codes Fields

Field Do this

Txn Code Specify the transaction code (required).

Description Specify the description for the transaction.

Group Select the transaction group (the group within the
Transaction Super Group that the transaction
code belongs to) from the drop-down list.

Action Select the action type code for the transaction
(what action will take place when the transaction
occurs) from the drop-down list.

Monetary Check this box to maintain the transaction as a

monetary transaction. If unchecked, then the
transaction is nonmonetary.

System Defined Yes/ No

Select Yes, if you wish to maintain the
transaction code as system defined and No, if
you do not want to maintain it as system defined.
System defined entries cannot be modified. If
entry is not system defined, then it can be
modified.

Enabled

Check this box to enable the transaction.

Txn/Bal Type

Select the transaction / balance type affected by
the Transaction from the drop-down list.

Statement Txn Type

Select the statement transaction type (how the
transaction should appear on the customer
statement) from the drop-down list.

Batch

Check this box to perform the transaction in a
batch process.
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Table 2-22 (Cont.) Transaction Codes Fields

|
Field Do this

Manual Check this box, if the transaction is a manual
transaction. If you define a transaction as
manual, the system recommends that the
transaction that reverses it also be defined as

manual.

Stmt Print Check this box to print the transaction on
customer statements.

GL Check this box, if the transaction is a general
ledger transaction.

Event On selecting this check box, the particular

Monetary/Non-Monetary transaction is
considered for triggering of respective Monetary
and Nonmonetary transaction posting Event
type. The particular Monetary/Non- Monetary
transaction is available while defining Event
Actions.

For more information, refer to Events (New
Framework) section.

Recalc Master Txns Check this box for system to recalculate and
repost consolidated fee at Master Account level.
This is done automatically by identifying those
monetary transactions which should trigger
recalculation of Late Charge, Cycle Based Late
Fee and Cycle Based Collection Late Fee at
Master Account level when backdated
transaction is posted on any Associated Account
that is marked for fee consolidation.

For more information, refer to Cycle Based Fees
and Fee Consolidation sections in Contract
setup screen.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
This section consists of the following topic:

* Transaction Codes sub screens

2.7.1 Transaction Codes sub screens

@® Note

Please contact your System Administrator / Implementation Manager before making
any changes in these sub screens.

The Transaction Codes screen contains three sub screens:

« Parameters
e Access Grid

*  Products
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Here, you can define the parameter information for the associated transaction. The Parameters

apply exclusively to these super groups:
e ITEMIZATION TXN

e AMORTIZATION TXN

¢  PRODUCER MONETARY TXN

FUNDING TXN

@® Note

ACCOUNT CONDITION TXN
CORRESPONDENCES
FEE ASSESSMENTS

Treat the Transaction Parameters sub screen as containing view-only information.
This is very sensitive data and you should not change it without consulting Oracle

Financial Services Lending and Leasing.

To set up the Parameters

1. Click Setup > Setup > Administration > System > Transaction Codes > Parameters.

2. Inthe Transaction Parameters section, perform any of the Basic Operations mentioned in

Navigation chapter.
A brief description of the fields is given below:

Table 2-23 Transaction Parameters

Field

Do this

Parameter Code

Select the parameter code associated with the
transaction code, from the drop-down list.

Default

Specify the default value for the transaction
parameter (value to initially populate, or used if
no value is supplied).

Sort

Specify the sort order for the transaction
parameter.

Displayed? Yes/No

Select Yes to display the parameter and No if
you do not want to display in current use.

Required? Yes/No

Select Yes if the parameter is required and No if
you do not require the parameter. (You must
select Required as empty values are not
allowed.)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.1.2 Access Grid

The Access Grid sub screen allows you to control access to each transaction according to user
responsibility, account status, and account condition. It allows the administrator to control when
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these transactions may be conducted. Normally, you would create or modify the access based
on either the user responsibility or account condition. Account status access is left unchanged.

To set up the Access Grid sub screen

1.
2.

3.

2.7.1.3 Products

Click Setup > Setup > Administration > System > Transaction Codes > Access Grid.

In the Transaction User Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 2-24 Transaction User Access Definition

|
Field Do this

Access Type Select the access grid function type (ACCOUNT
CONDITION AND ACCOUNT STATUS) that is
being used to control the creation of the
associated transaction, from the drop-down list.

Access Value Select the access function grid value from the
drop-down list (based on a lookup associated
with the Access Type. Multiple entries for each
access type may be created as long as each has
a different access value).

Allowed? Yes/No Select Yes if the access is allowed and No if the
access is not allowed (indicates whether the
current Access Type / Access Value may create
the associated transaction).

System Defined Yes/ No Select Yes, if you wish to maintain access type
as system defined and No, if you do not want to
maintain it as system defined. System defined
entries cannot be modified. If entry is not system
defined, then it can be modified.

Perform any of the Basic Actions mentioned in Navigation chapter.

The Products sub screen allows you to define the products to which the transaction codes
apply. It allows the administrator to control if the associated transaction code will be available
for use for specific product types and or funding types.

Normally, an Access Value of ALL is defined for one or more Access Types with a given
Allowed value. Additional Access Values are then defined for the same Access Types with the
opposite Allowed value. This controls access to the associated transaction.

To set up the Products sub screen

1.
2.

Click Setup > Setup > Administration > System > Transaction Codes > Products.

In the Transaction Product Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 2-25 Transaction Product Definition

|
Field Do this

Product Type Select the product type associated with the
transaction code from the drop-down list.
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Table 2-25 (Cont.) Transaction Product Definition

|
Field Do this

Funding Type Select the funding type associated with the
transaction code from the drop-down list.

Allowed? Yes/No Select Yes if the transaction is allowed and No if
the transaction is not allowed (indicates whether
the current Access Type / Access Value may
create the associated transaction).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8 Data Files

The Data Files Setup screen organizes information pertaining to the various input/output data
files that the system can generate. The system uses the Data Files Setup screen to outline the
file layouts of each data file produced/received within the system, including the length and data
type of each column name.

These files are typically produced during the nightly process.

One major advantage for the system-defined data files is the format mask of each column
name within each data file. A format mask is like a stencil that forces data input to be of the
same format before accepting the data.

You can change the order in which the fields are displayed in the file.

@® Note

Any addition or removal of a field or change in the data type length requires the
Software involvement.

Data Files screen consists of the following two tabs:

e Output tab
e Input tab

2.8.1 Output tab

The "Output tab" in the Data Files screen allows you to define the structure of output data file
through the following sections:

» Data File Definitions

*  Record Definitions

e Column Definitions

2.8.1.1 Data File Definitions

The Data File Definitions section defines specific data files. Each is associated with a specific
Output Data Definition (ODD) batch job that gathers the data that the file will contain. While
new data file definitions may be created they will have no use unless a batch job is also
created to populate the data.
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To set up Data File Definitions
1. Click Setup > Setup > Administration > System > Data Files > Output tab.

2. Inthe Data Files Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-12 Data Files Definitions
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A brief description of the fields is given below:

Table 2-26 Data Files Definitions
]

Field

Do this

Name

Specify data file type (name of data file
definition).

Description

Specify data file description.

File Name

Specify data file name. Prefix used for files
generated for this Data File. This is the only field
on the Data File Definitions screen that can or
should be modified by your Administrator. The
generated file name will be in the form of <FILE
NAME>_<COMPANY ID>_<BRANCH
ID>_<MMDDYYYY>_<PROCESS ID>.DAT. The
inclusion of _<COMPANY ID> and _<BRANCH
ID> depends entirely on the associated batch
process.

Directory Path

Specify the directory path.

System Defined Yes/No

Select Yes, if you wish to maintain the data file
definition as system defined and No, if you do
not want to maintain it as system defined.
System defined entries cannot be modified. If the
entry is not system defined, then it can be
modified.

Enabled

Check this box to enable the data file definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.8.1.2 Record Definitions

Each data file definition is made up of one or more record definitions. These define
organization of the data. The associated batch file determines how these records are used.
The order in which the data is populated determines the order in which those records will
appear in the output file. This is generally related to the order the records appear in the Data
File Definition section.

1.

In the Record Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-27 Record Definitions
]

Field Do this

Record Type Specify the type of record being defined.

Description Specify record description.

Record Format Select the format of output data (FIXED,
VARIABLE) from the dropdown list.

Delimiter Specify the delimiter (column separator used
with VARIABLE format).

Terminator Select the record terminator code (how the end

of each record is indicated within the file --
CARRIAGE RETURN, LINE FEED, or
CARRIAGE RETURN AND LINE FEED) from the
drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.1.3 Column Definitions

Each record definition is made up of one or more column definitions. These define the output
of the data. Much of this data is informational; it indicates what data is being provided by the
associated batch job. Unless otherwise noted, the data should not be changed without
changing the associated batch job.

1.

In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-28 Column Definitions
]

Field Do this

Seq Specify the order in which the output data dump
will process the column information.

Column Name Specify name/description of the column
(informational only).

Data Type Specify the data type. This describes the type of

data the column is expected to contain
(CHARACTER, DATE, or NUMBER). This effects
how the ODD process handles the data, and
should not be changed.
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Field

Do this

Format Mask

Select the format mask for the column from the
drop-down list. For DATE or NUMBER columns,
this field defines the output format of the data.
For example; Date fields may be entered using
the MM/DD/ YYYY format, Number fields may be
entered as decimal numbers with varying
degrees of precision. Other formats for each data
type are available.

Length

Specify the column length (the maximum number
of characters of the output data to be included in
the output file). Each output data details column
may contain up to 240 characters of data. If the
output data details column contains more data
than the length value the data will be truncated.
For VARIABLE records the length should be set
to “-1” or a Delimited file will be created with
FIXED LENGTH columns.

Data Column

Specify the data column sequence. This is the
column that will be used to select the data that is
being output. This should not be changed.

Output Column

Specify the output column sequence. This is the
column that will appear in Output File. The
Output Data Dump process allows for the output
of 250 columns of data per record. No output
column should be repeated in the setup for a
record.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.2 Input tab

Oracle Financial Services Lending and Leasing facilitates processing of a input data file
received from external interface into the system through an automated batch job
(IDDPRC_BJ_000_01) triggered on regular intervals.

The "Input tab" in the Data Files screen allows you to define the input data file through the

following sections:

¢ Input Data File Definitions

¢ Column Definitions

e Configurable Bulk Upload

2.8.2.1 Input Data File Definitions

In the Input Data File Definitions section, you can define and maintain the structure of input

data file to populate data from external system.

Oracle Financial Services Lending and Leasing also supports bulk upload of data into the
system through input file processing for a set of process listed in Setup > Administration >

System > Lookups > Lookup Code section.

Lookup Type: INCOMING_FILE_TYPE_CD

Description: INCOMING LOG FILE TYPE CODE
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In addition, there is also an option for configurable bulk upload of data in which the input file
delimiter is configurable to required value. For more information, refer to Configurable Bulk

Upload section.

To set up Input Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Input tab.

2. Inthe Input Data Files Definitions section, you can make use of the copy option to copy the
Input file definition and corresponding column definitions. To do so, click on the required
record in the list, select the target company for which records needs to be created from
Company drop-down list and click Create Copy. The following records are copied:

« ITU_TXN_UPLOAD
- ASSET_ASE_UPLOAD

- ASSET_ATA |

UPLOAD

- ASSET_ATR_UPLOAD

- ASSET_AVL_

- CURE_LTR
- BKRP_NEW

UPLOAD

e BKRP_UPDATE
Records for above files are created with External Table Name as External Table
Name_Company code.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

Figure 2-13 Input Data File Definitions
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A brief description of the fields is given below:
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Field

Do this

Name

Specify a uniqgue name for the input data file.

File Name

Specify the data file name with the correct prefix.

Description

Specify data file description.

Directory Path

Specify the directory path configured within
OFSLL Database server to process the input
data file.

Delimiter

Specify the delimiter used to separate column
data. (Ex: Comma).

Record Format

System defaults the record format as
VARIABLE.

External Table Name

View the name of external table from which input
data is populated.

Company

View the company name selected in external
table.

Enabled

Check this box to enable the input data file
definition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.2.2 Column Definitions

Each input data file definition is made up of one or more column definitions. These define the
structure of data to be loaded from external system.

1. Inthe Column Definitions section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 2-30 Column Definitions

Field

Do this

Seq

Specify the order in which the input data dump
will process the column information.

Column Name

Specify name of the column.

Column Description

Specify description of the column.

Data Type

Select the data type from the drop-down list. The
selected data type describes the type of data the
column is expected to contain such as
INTEGER/DATE/NUMBER/CHARACTER. This
effects how the input data file processing handles
the data, and should not be changed.

Format Mask

Select the format mask for the column from the
drop-down list. The list displays the format
depending on the Data Type selected.

For example; Date fields may be entered using
the MM/DD/YYYY format, Number fields may be
entered as decimal numbers with varying
degrees of precision. Other formats for each data
type are available.
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Table 2-30 (Cont.) Column Definitions
|

Field Do this

Length Specify the column length (the maximum number
of characters of the data to be included in the
input file)

Each input data details column may contain up to
240 characters of data. If the output data details
column contains more data than the length value
the data will be truncated. For VARIABLE
records the length should be setto “-1” or a
Delimited file will be created with FIXED
LENGTH columns.

Sort Specify the order in which the column definitions
are to be sorted for display in the external
interface screen (Customer Service > External
Interfaces). There can be a maximum of 61
column definitions.

Enabled Default selected. If not, you can check this box to
enable the column definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.8.2.3 Configurable Bulk Upload

In the process of configurable bulk upload of data, the input file delimiter is configurable to
required value and data is processed based on the column definitions defined. This option is
supported for Transactions and Collateral uploads to create new transactions and asset
records in bulk.

For bulk upload of data, the input CSV (comma separated values) file is to be constructed in
specific format as defined in Setup > Data Files > Input screen’s Input Data File Definitions
and Column Definitions sections.

For example, consider the following Column Definition details:

Table 2-31 Column Definition Details

Seq Column Name Column Data Type Length Sort
Description
1 ASE_OPERATI OPERATION CHARACTER 30 1
ON_IND IND
2 ASE_NBR ASSET NUMERIC 30 2
NUMBER
3 ASE_REGN_D REGISTRATIO DATE 30 3
T N DATE

If the delimiter in Input Data file definitions is set as ‘,’ (comma), then the csv can be
constructed in same format and sequence of column definition as indicated below with each
row as one record:

ASE_OPERATION_IND,ASE_NBR,ASE_REGN_DT
NEW,20151200010476,12/08/2015
EXISTING,20111300010468,13/10/2011
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NEW,20101400010812,14/11/2016

The CSV file is to be paced in the directory path/work area which is the base path defined in
system parameter - Ul X_| NCOM NG _FI LE_PATH (INCOMMING FILE PATH OF APP
SERVER) by the system administrator and further appended by the configurable sub folder
name such as ITU or ICC. For example: / scr at ch/ wor k_ar ea/ <domai n nane>/i nput/
itu.

Following are the Lookup code maintained in Setup > Administration > System > Lookups >
Lookup Code section for respective process type:

Table 2-32 Lookup Code
|

Process Type Lookup Code Description
Transaction File Upload ITU TRANSACTION UPLOAD
Asset File Upload ICC INPUT CREATE COLLATERAL

e For Transaction File Upload, only one csv file can be created with multiple records and on
processing, the data is populated into Servicing > Customer Service > Transaction >
History > Transactions tab.

e For Asset File Upload, separate csv files are to be created to upload the data into
Collateral Management screen’s Collateral details, Valuation, Addons/Attributes, and
Tracking sections respectively.

On executing the scheduled batch job in SET-IFP, IDDPRC_BJ_000_02 (BULK INPUT DATA
INSERTION), the data in csv file is processed and is displayed in Servicing Customer Service
> External Interfaces tab. Such data does not need authorization and is directly uploaded on
validating the sequence, position, and format.

The status of batch job can be viewed in DashBoard > System Monitor > Batch Jobs screen.
The records which resulted in error are listed in the bad file.

2.9 Events

In the current version of Oracle Financial Service Lending and Leasing, the Events framework
has undergone changes in the processing type from earlier Engine based framework to Entity
based framework and OFSLL is enabled to support both old and new type of events
processing.

If you have upgraded from an older version of OFSLL, the existing events listed in Event
Types tab and action types listed in Event Action Types’ tab will still be functional as intended
but cannot be added or modified. Along with these two tabs, the data in Online and Batch tab
are also displayed in read-only mode. However, new events and action types can only be
created in Events tab.

» For existing events defined in the system, refer to Events (Existing Framework).

*  To work with new events framework, refer to Events (New Framework).
This section consists of the following topics:

*  Events (Existing Framework)

 Events (New Framework)

e Monitoring IMS Event Actions
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2.9.1 Events (Existing Framework)

During Origination , when an application moves from one status/sub status to another, or
changes condition, the system can trigger an event and perform the associated event actions.
This can occur either online or in batch mode.

@® Note

Only predefined events and actions can be set up on the Events Setup screen. You
cannot create new event types or action types.

As processing events and associated actions require additional processing at the server level,
the performance of the transactions, for which the events are setup, may be adversely affected
dependent upon your specific configuration.

In the Events screen you can view trigger events with associated actions which the system
performs during application entry . The fields on this screen are both system and user defined.
There are four sub screens on the Events screen to set up and maintain these events:

 Events Types

e Event Action Types
¢ Online

e Batch

Event Types and Action Types sections of this screen provide a master table for setting up the
online and batch events. This setup triggers the event, which in turn triggers the actions
associated with the events, during application entry .

Navigating to Events

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Events.

This section consists of the following topics:

 Event Types
Event Action Types

*  Online
e Batch
2.9.1.1 Event Types
1. Click Setup > Setup > Administration > System > Events > Line of credit > Events
Types.

2. Inthe Event Types tab, you can view the existing events and its details maintained in the
system.
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Figure 2-14 Events Setup
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A brief description of the fields is given below:

Table 2-33 Event Types

]
Field Do this

Event Type Code View the event type code.
Description View the event description.
Process Type View the event action processing type (BATCH or

ONLINE).

Entity Type View the entity type (ACCOUNTS or
APPLICATIONS).

Engine Type View the engine type (MONETARY
TRANSACTIONS PROCESSING, NON-
MONETARY TRANSACTION PROCESSING,
CONDITION/ASSIGNMENT PROCESSING,
APPLICATION STATUS CHANGE, CREDIT
BUREAU PROCESSING, LETTERS
PROCESSING or CORRESPONDENCE).

Enabled Y indicates event type is enabled and N indicates
disabled.
System Defined If Yes indicates that the event type is system

defined. If No indicates that the event type is user
defined.

2.9.1.2 Event Action Types

The Event Action Types section is system defined and lists the action codes supported in the
system.
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1. Click Setup > Setup > Administration > System > Events > Line of credit > Event
Action Types.
Figure 2-15 Events Action Setup
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A brief description of the fields is given below:

Table 2-34 Event Action Types

]
Field Do this

Action Code View the action code.
Description View the action description.
Process Type View the event action processing type (BATCH or

ONLINE).
Entity Type View the entity type.
Engine Type View the engine type.

Enabled Y indicates event action type is enabled and N
indicates disabled.

System Defined If Yes indicates that the event action type is system
defined. If No indicates that the event action type is
user defined.

2.9.1.3 Online

The Online tab allows you to view the online events defined in the system along with the event
criteria actions. The system supports the following online events:

1. The system processes the event’s actions during:
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* CHG OFF Reversal

e Paid Off Reversal

* BKRPis closed

BKRP Is Opened

e When Queue is Closed

*  When status/ Sub status changed to Approved- Rehashed

*  Account condition SCHG is closed

e Account condition SCHG is Opened

e Change in application status / sub status to APPROVED — REHASHING

The events that can be performed online after each of the events listed above are as follows:
e Generate correspondence for an application

e Send a credit bureau request for an application.
To view Online Event

Click Setup > Setup > Administration > System > Events >Line of credit > Online.

Figure 2-16 Online Setup
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A brief description of the fields is given below:
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Table 2-35 Online Event

Field Do this

Event Code View the event code.

Event Type View the event type.

Synchronous S indicates that the event is synchronous (i.e. any

failure in triggering the event will fail to trigger the
entire transaction). If A indicates that the event is
asynchronous (i.e. any failure in the event will not
affect the transaction, which will be successfully
completed).

Enabled Y indicates event type is enabled and N indicates
disabled.

The Event Criteria section allows you to view the query defined for an event.

A brief description of the fields is given below:

Table 2-36 Event Criteria

Field Do this

Query Name View the query name.

Description View the query description.

Enabled Y indicates event criteria is enabled and N

indicates disabled.

Criteria Details

The Criteria Details sub tab allows you to view the defined selection criteria for the event.
System uses these criteria to determine which application to include in the event action.

@® Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can have
significant performance impact delaying the EOD processing/web services. Hence it is
recommended to have careful consideration while defining the additional selection
criteria (like using user-defined tables and columns) and/or get approval from your
database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 2-37 Criteria Details

Field Do this

Seq View sequence number.

( Indicates opening bracket.

Parameter View the parameter selected for the criteria.

Comparison Operator View the comparison operator selected for the
criteria.
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Table 2-37 (Cont.) Criteria Details
]

Field Do this

Criteria Value View the criteria value.

) Indicates closing bracket.

Logical Expression View the logical operator selected for the criteria.
Enabled Y indicates event selection criteria is enabled and

N indicates disabled.

Actions

In the Actions sub tab, you can view the actions that the system performs when event is
triggered. There can be more than one event action for a particular event and the Seq field
defines the order in which the event action should occur.

A brief description of the fields is given below:

Table 2-38 Actions
]

Field Do this

Description View the event action description.

Seq View sequence number defined for the action.

Enabled Y indicates event action is enabled and N indicates
disabled.

For each event action, view the Action Parameters defined. A brief description of the fields is
given below:

Table 2-39 Action Parameters
]

Field Do this

Description View the parameter description.

Value View the parameter value.

Required Y indicates action parameter is required and N

indicates not-required

The Batch screen allows you to view the events performed as a batch transaction by the
system. The system supports the following predefined batch events for application processing.
(These batch events are listed in the Events Types tab):

* APPLICATION LEVEL BATCH EVENT #01
* APPLICATION LEVEL BATCH EVENT #02
* APPLICATION LEVEL BATCH EVENT #03
* APPLICATION LEVEL BATCH EVENT #04
* APPLICATION LEVEL BATCH EVENT #05
* APPLICATION LEVEL BATCH EVENT #06
* APPLICATION LEVEL BATCH EVENT #07
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 APPLICATION LEVEL BATCH EVENT #08
* APPLICATION LEVEL BATCH EVENT #09
* APPLICATION LEVEL BATCH EVENT #10

To view the Batch Event

Click Setup > Setup > Administration > System > Events > Line of credit > Batch.

Figure 2-17 Batch Setup
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A brief description of the fields is given below:

Table 2-40 Batch Event
]

Field Do this

Event Code View the event code.

Event Type View the event type.

Frequency View the event frequency.

Enabled Y indicates event type is enabled and N indicates

disabled.

The Events Criteria section allows you to view the query name and event description defined
for an event.

A brief description of the fields is given below:
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Table 2-41 Events Criteria
]

Field Do this

Query Name View the query name.

Description View the event description

Enabled Y indicates event criteria is enabled and N

indicates disabled.

Criteria Details

The Criteria Details sub tab allows you to view the defined selection criteria for the event.
System uses these criteria to determine which application to include in the event action.

@® Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can have
significant performance impact delaying the EOD processing/web services. Hence it is
recommended to have careful consideration while defining the additional selection
criteria (like using user-defined tables and columns) and/or get approval from your
database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 2-42 Criteria Details
]

Field Do this

Seq View sequence number.

( Indicates opening bracket.

Parameter View the parameter selected for the criteria.

Comparison Operator View the comparison operator selected for the
criteria.

Criteria Value View the criteria value.

) Indicates closing bracket.

Logical Expression View the logical operator selected for the criteria.

Enabled Y indicates event selection criteria is enabled and

N indicates disabled.

Action

In the Actions sub tab, view the actions that the system performs after the event is triggered.
There can be more than one event action for a particular event. The Seq field defines the order
in which the event action should occur. System supports the following batch event actions:

e Send letter for an application

e Generate correspondence for an application

A brief description of the fields is given below:
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Table 2-43 Action
]

Description View the event action description.

Seq View sequence number defined for the action.

Enabled Y indicates event action is enabled and N indicates
disabled.

For each event action, view the Action Parameters defined. A brief description of the fields is
given below:

Table 2-44 Action Parameters
]

Field Do this

Description View the parameter description.

Value View the parameter value.

Required Y indicates action parameter is required and N

indicates not-required

2.9.2 Events (New Framework)

Events in OFSLL refers to user/system generated actions on the system such as updating an
account condition as delinquent or moving the status of a collateral from INACTIVE to ACTIVE
and so on. Whenever such a type of event occurs some defined action can be performed by
the system.

When there is change in entities like Account, Customer and so on by performing an insert/
update operation on the base table, system can trigger a defined event with an associated
event action to expose the same for third-party applications through JMS message or perform
OFSLL actions like posting Comment/Call Activity and so on.

The Events tab serves as a common framework for Line module. In a single flow you can
define events with associated actions for entities like Account, Customer and so on with the
type of processing mode as either Online or Batch mode. Further, you can define one or more
event criteria as a trigger when the corresponding event occurs. For each defined criteria you
can define the available event action and associated action parameter(s) to initiate
corresponding action in external / internal system.
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Figure 2-18 Events Workflow
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As per the above workflow:

e During Servicing stage, when an event is triggered, the main transaction is committed and
a new parallel transaction is created to check if there is an event definition available.

e If there is an event definition available, system places an AQ (Advanced Queueing)
message in database to check for any matching event criteria. There can be one or more
criteria for an event in database which is further evaluated to get the matching criteria. On
identifying a matching criteria, the defined event with criteria is logged into event entities.

e Based on the Event Type, system executes the associated Event Actions.

— Ifthe event is configured to Batch mode, the event action is performed when the
following batch jobs - EVEPRC_BJ 100 01 (BATCH EVENTS PROCESSING for the
Entities Account/Application/Assets) and/or EVEPRC_BJ 100 03 (BATCH EVENTS
PROCESSING for the Entities Customer/Business/Vendors/Producers) is executed.

— Ifthe event is configured to Online mode, system performs the corresponding actions

immediately.
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« If the Event Action is defined as JMS, a json message is generated with the below format.
You can configure additional details into the message by using response User Defined
Tables. The data added in this table will be represented in Custom Block as illustrated in
the example below.

Figure 2-19 Events_Json_ format

i
"EventDetail”: {
"EventID": 8535,
"EventType": "ACC_CREATE",
"EventMessage": "ACO CREATE ACCOUNT LINE",
"EntityNbr": 2012000009 ",
"EventstartDt": "2019-04-05T02:48:35",
"EventProcessedDt": "2019-04-05T02:48:35%",
[ "custom": [
"CustomTabName": "User Defined Table 1",
"DateDdata" : [{
"KeyName": "CreationDate",
1] "Keyvalue": "2017-12-18T00:00:00"
"Numberpata" : [{
"KeyName": "BusinessPhoneNumber™,
1 "Keyvalue": 1234567890
"sStringbata" : [{
"KeyName": "OrgName",
"Keyvalue": "oracle"
1]
%,
"CustomTabName": "User Defined Table 2",
"DateData" : [{
"KeyName": "CreationDate",
3] "Keyvalue": "2017-12-18T00:00:00"
"Numberpata" : [{
"KeyName": "BusinessPhoneNumber”,
1 "Keyvalue": 1234567890
"stringbata” : [{
"KeyName": "OrgMName",
"Keyvalue": "oracle”
1]
1]
h
L

e The following table indicates parameters available for JMS action type definition.

Table 2-45 JMS action type definition

Parameter Description Display

EVENTID System Generated Sequence N

EVENTTYPE Lookup Code of Event Type N
Code

EVENTMESSAGE User entered event action Y
message

ENTITYNBR Entity Number. For example, N

Account / Customer Number
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Table 2-45 (Cont.) JMS action type definition
|

Parameter Description Display
EVENTSTARTDATE Event Generation Date and N

Time
EVENTPROCESSDATE Event Process Date and Time N

@® Note

The parameter marked as Y in Display column are only available in event action
screen for user configuration. Other parameters are system defined and will be
part of every event.

For each Event Action, there is a User Defined Table maintained in the system and the
same is configurable. There is also User Defined Table maintained based on Response
Parameters and the response fields can be used to configure Entity Key, Non-Key and
Data columns for custom block of json message. Following combination of Event to UDT
mapping are maintained in the system:

— Entity Type | Event | Criteria UDT Type
— Entity | Event Action | UDT Type | UDT Response Type

For complete list of the Events and Actions mapping maintained in the table
event_action_type_mapping, refer to the reference below: https://docs.oracle.com/cd/
F40454 01/pdf/irefdocs/Events_ UDT_Mapping.pdf

Navigating to Events

On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > System > Events > Events tab.

To define an Event

1.

Click Setup > Setup > Administration > System > Events > Events tab.

Figure 2-20 Define an Event
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A brief description of the fields is given below:

Table 2-46 Navigation to Events

Field Do this

Event Code Specify the unique event code.

Description Specify the event description.

Entity Type Select the entity type from the drop-down list.

The list is populated based on
EVENT_ENTITY_TYPE_CD lookup code.

Event Type Select the event identification type for the entity
from the dropdown list. The list is populated
based on EVENT_TYPE_CD lookup code.

Processing Type Specify the processing type as either ONLINE or
BATCH from the drop-down list. The list is
populated based on
EVENT_PROCESS_TYPE_CD lookup code.

e For Online events, when the event is
triggered corresponding actions are
processed immediately. Here all the event
action executions are asynchronous and
does not impact main transaction.

«  For Batch events, the event is triggered
when the following batch jobs -
EVEPRC_BJ_100_01 (BATCH EVENTS
PROCESSING for the Entities Account/
Application/Assets) and/or
EVEPRC_BJ_100_03 (BATCH EVENTS
PROCESSING for the Entities Customer/
Business/Vendors/Producers) is executed
and actions are processed.

Enabled Check this box to activate the event type.

2. Perform any of the Basic Actions mentioned in Navigation chapter. In the Event Criteria
sub tab, you can create a query to an event.

3. Inthe Event Criteria sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-47 Event Criteria

Field Do this

Query Name Specify the unique query name.
Description Specify the event criteria description.
Enabled Check this box to enable the event criteria.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
Criteria Details

The Criteria Details sub tab allows you to define the selection criteria for the event. System
uses these criteria to determine which application to include in the event action.

5. In the Criteria Details sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
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@® Note

Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 2-48 Criteria Details
|

Field Do this

Seq Specify sequence number.

( Specify the opening bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator Select comparison operator from the drop-down
list.

Criteria Value Specify the criteria value.

) Specify the closing bracket.

Logical Expression Select the logical operator from the drop-down
list.

Enabled Check this box to enable the criteria details.

Perform any of the Basic Actions mentioned in Navigation chapter.
Actions

In the Actions sub tab, you can define the event action that the system need to perform
when the event is triggered. You can define more than one event action for a particular
event and use the Seq field to define the order in which the event action should occur.

In the Action sub tab, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 2-49 Actions

|
Field Do this

Action Type Select the action type from the drop-down list.
The list is populated based on
EVENT_ACTION_TYPE_CD lookup code.

Action Code The action code is displayed as None by default.

Seq Specify the sequence number of executing the
event action.

Enabled Check this box to enable the event action.

Perform any of the Basic Actions mentioned in Navigation chapter.
Action Parameters

In the Action Parameters sub tab, you can define the action parameters with
corresponding values for each event action.
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To define the Action Parameters, in the Action sub tab, click Add or Edit. You can also
perform any of the Basic Operations mentioned in Navigation chapter.

10. Click Load Parameters. The applicable Action Parameters are loaded for update.

A brief description of the fields is given below:

Table 2-50 Action Parameters

Field

Do this

Description

System auto populate the description from user
defined table based on Action code selected.

Value Type

Select the value type as one of the following

which is to be included during event action

execution from the drop-down list. The list is

populated based on

EVENT_VALUE_TYPE_CODE lookup code.

e CONSTANT

e SYSTEM DRIVEN

. USER INPUT

¢ COLUMN VALUE (For this value type, the
Action Parameter values are displayed from
User Defined Tables based on the Event
Type. However, note that if the column value
cannot be fetched due to multiple records or
if no record exist, then action parameter
value is displayed blank/null).

Currently the Column Value is configured to refer
only Accounts table (Entity Type) and can
process the following Event Actions Type:

e POST COMMENT

*  POST MONETARY TRANSACTION

e POST NON MONETARY TRANSACTION

For SEND CORRESPONDENCE Action Type,
there are additional parameters - USER
DEFINED ELEMENT and USER DEFINED
CONSTANT available in Setup >
Correspondence screen to provide input during
execution of Event Action. The same is available
in Events screen and can be modified before
triggering the event action.

Value

If the Value Type is selected as CONSTANT,
specify the required action parameter value.

If the Value Type is selected as SYSTEM
DRIVEN, you can add the following values for
system to derive the parameter values during the
execution of the Event.

$GLDATE - GL DATE System Parameter Value

$PAYMENTAMOUNT - Account Monthly
Payment Amount

$OUTSTANDINGAMOUNT - Account Total
Outstanding Amount

$RATE - Account Rate
$TOTALTERM - Account Total Term
$AVAILABLETERM - Account Available Term

Required

Y indicates the action parameter is required, else
No.
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11. Perform any of the Basic Actions mentioned in Navigation chapter.

2.9.3 Monitoring JMS Event Actions

You can verify the status of events and event actions on the Monitor Jobs screen of the System
Monitor screen.

To monitor events

1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor > JMS Queues.
The JMS Queues screen displays the Status for all asynchronous events processed in the
system.

For more details, refer to Dashboard > System Monitor section in any of the User Guides.

2.10 Batch Jobs

Batch jobs refer to the back-end processes that automatically run at a certain time. There are
two types of batch jobs:

e Business processes (such as billing and delinquency processing)

e Housekeeping tasks (such as application aging and application purging)
e Batch Jobs

e Batch Jobs Available

2.10.1 Batch Jobs

The Batch Job screen allows you to set up, monitor, and maintain batch jobs in the system.

Batch jobs can be set up to be performed on a daily, weekly, monthly, and ad-hoc basis. Batch
jobs can also be configured to trigger an e-mail or phone message if a batch job fails.

Critical batch jobs control job flow and system date rollover to allow recovery during errors.
Errors are instances where a process did not successfully complete. Failures indicate that a
particular job encountered errors that require remedial action. The number of errors allowed
before failure is defined for each job. Some errors automatically result in a failure.

Navigating to Batch Jobs:

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Batch Jobs. The Batch Jobs details are further grouped
into two tabs:

 Batch Jobs
e Job Holidays

2.10.1.1 Batch Jobs

In the Batch Job Setup screen, you can track and maintain all batch processes within the
system. Using this form, the system administrator can configure the frequency and start time of
each batch process, as well as set the number of threads to improve performance.

Threading allows a specific job to be separated into smaller units that are processed at the
same time. This allows Oracle Financial Services Lending and Leasing to complete the job in
less time.
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You can set up multiple batch jobs within a batch set. In the Batch Job Sets section, each
process is listed with the last run date (Last Run Dt field) and the next scheduled process date
(Next Run Dt field). In the Freq Code and Freq Value fields, you can determine the frequency
of each batch set, such as daily, weekly and monthly. You can also set up batch sets to
incorporate a dependency on another batch set. This way, if the initial batch fails, the
dependent set will not be processed.

In the Batch Jobs section, you can configure the process to run on weekends and holidays
using the respective option boxes.

CAUTION: As the batch job setup widely affects the Oracle Financial Services Lending and
Leasing system, Oracle Financial Services Software suggests that the system administrator
has a clear understanding of the various functionalities within Oracle Financial Services
Lending and Leasing before creating and updating the batch processes.

For the standard job set please review the Visio document,
dbk_std_detail_design_job_sets.vsd

Configure Batch Jobs at Company Level

OFSLL is enabled to process the configured batch jobs at each Company level giving a
flexibility to schedule and run batch job or EOD processing at desired time zone. Irrespective of
Company or Branch, the batch jobs can be run independently on specific time in scheduler. For
more details on configuring the batch job at each company definition level, refer to Appendix -
Configuration at Company Level chapter.

To setup a Batch job
1. Click Setup > Setup > Administration > System > Batch Jobs.

2. Inthe Batch Job Sets section, you can make use of the copy option to copy the whole
batch job set at one go with header and detailed records for each company definition. To
do so, select the Company from drop-down list and click Create Copy. System copies the
batch job sets from the selected Company record to the Company selected from dropdown
list. All those batch job set which are not already available in the selected Company are
copied.

Note that:

e The Create Copy option can be used multiple times.

e The Company drop-down list is displayed based on the User Access defined for the
logged-in user.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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Figure 2-21 Batch Jobs
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ORACLE’ % Welcome ABSHEKAR ~  ESIOURN <
Financial Services Lending and Leasing
Batch Jobs 3 Close
Batch Jobs  Job Holidays ~
Batch Job Sets AAdd | ZEdt | [ View | o Audit
View v Formatv (B Freeze [ Detach Wrap W company ALL v Create Copy
Company Set Code Job Set Description Frequency Frequency value  Start Time Critical Enabled Last Run Dt Next
AUSO1 SET-AAL ACCOUNT CREATION DAILY DAILLY 09:00 AM N N 08/08/2003 09/1 A
ALL SET-AAL /ACCOUNT CREATION DAILY DALLY 16:00 PM N N 08/08/2003 09/1
WBW_US SET-AAL ACCOUNT CREATION DAILY DAILY 16:00 PM N N 08/08/2003 09/1
WVR USA SET-AAL ACCOUNT CREATION DAILY DAILY 16:00 PM N N 08/08/2003 09/1
NLO2 SET-AAL ACCOUNT CREATION DAILY DAILY 16:00 PM N N 08/08/2003 09/1
Uso1 SET-AAL ACCOUNT CREATION DAILY DAILY 09:00 AM N N 08/08/2003 09/1
KoL SET-AAL ACCOUNT CREATION DAILY DAILY 15:00 PM N N 08/08/2003 09/1
P04 SET-AAL ACCOUNT CREATION DAILY DAILY 23:00 PM N N 08/08/2003 09/1
IND SET-AAL ACCOUNT CREATION DAILY DAILY 19:30 PM N N 08/08/2003 09/1
¥ WVCAP SET-ACR ACCRUALS AND DELINQUENCY DAILY DAILY 22:30 PM Y N 08/07/2003 09/1v
< >
Batch Jobs PAd | ZEdt | [FView | o Audit
View > Format ~ [ Freeze [ Detach Wrap o)
Seq Job Type Job Code Job Description Threads Commit Count Errors Allowed Weekend Holiday
1.0000 PROCEDURE AAIPRC_BJ_100_01 APPLICATION TO ACCOUNT INTERFACE 1 50 Y B
2.0000 PROCEDURE TXNACT_B_100_01 ACCOUNT ACTIVATION 1 100 50 ¥; Y
= 2
Batch Job Threads PAd | ZEdt | [F] View | o Audit
View v Formatv [ Freeze i Detach Wrap 50}
Thread Trace Level Enabled
1 [ Y
v

A brief description of the fields is given below:

Table 2-51 Batch job - Setup

Field

Do this

Company

Select the company from the drop-down list. The
list is populated only with those Company
Definitions to which you have been provisioned
access.

This company is considered if system is setup to
process batch jobs at Company level. For more
information, refer to Appendix - Company Level
GL Date Configuration section.

Set Code

Specify the code for the batch job set.

Job Set Description

Specify the description for the batch job set.

Frequency

Select the frequency at which the job set is to be
executed from the drop-down list.

Frequency Value

Select the frequency value from the drop-down
list. The frequency value will be displayed based
on the frequency code selected.

Start Time Specify the start time for the job set.

Critical Check this box to set job as critical. A critical job
is one that prevents the General Ledger (GL)
post date from rolling forward, should the job fail.

Enabled Check this box to enable the job set.

Last Run Dt The system displays the last run date of the job
set.

Next Run Dt Specify the next run date for job set. You can
select the data from adjoining calendar icon.

Parent Select the parent job set from drop-down list.
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Table 2-51 (Cont.) Batch job - Setup

|
Field Do this

Dependency Select the type of dependency on the parent
from drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Batch Job section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 2-52 Batch Job - Navigation

'
Field Do this

Seq Specify the batch job sequence number.

Note: Within a job set, jobs are executed
sequentially based on the sequence number

assigned.

Job Type Select the batch job request type from the drop-
down list.

Job Code Specify the batch job request code.

Job Description Specify the batch job description.

Threads The system displays the number of threads used
by the job.

Commit Count Specify the number of rows after which auto-
commit is triggered.

Errors Allowed Specify the number of errors allowed.

Weekend Check this box to perform batch jobs on
weekend.

Holiday Check this box to perform batch jobs on a

holiday. (Holidays are defined on the Job
Holidays screen.)

Enabled Check this box to enable the batch job.

Parent Select the parent batch job from the drop-down
list.

Dependency Select the dependency clause of the batch job
from the drop-down list.

Command Specify the command line for the job (required).

RollbackSegment If you choose, use this field to specify the

rollback segment for job.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Batch Job Thread section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-53 Batch Job Thread

|
Field Do this

Thread Specify the name of thread.
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Table 2-53 (Cont.) Batch Job Thread
|

Field Do this

Trace Specify the SQL trace level (0, 1, 4, 8, 12). The
higher the number, the more activities the system
can trace.

Enabled Check this box to enable the thread.

Perform any of the Basic Actions mentioned in Navigation chapter.

2.10.1.2 Job Holidays

The system allows you to define holidays within the company on Job Holidays screen. You can
then use the Batch jobs screen to set up whether you want the system to perform batch jobs
on these days or not, using the Holiday box of Batch Jobs section.

To define job holidays

1.
2.

Click Setup > Setup > Administration > System > Batch Jobs > Job Holidays.

In the Job Holidays section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 2-22 Job Holidays

ORACLE’ % Welcome ABSHEKAR + (=)
Financial Services Lending and Leasing

Batch Jobs (3] Close
Batch Jobs  Job Holidays
Job Holidays 4 Add | 7 Edit View Audit
View v Formatv [ Freeze  Ef] Detach Wrap 2]
Holiday Dt Description Company Enabled
06/13/2020 ‘QUEENS BIRTHDAY UKO1 e
06/13/2020 ‘QUEENS BIRTH DAY AUSO01 Y
12/25/2002 CHRISTMAS ALL Y
09/21/2002 "THANKS GIVING DAY ALL Y
07/05/2002 INDEPENDENCE DAY ALL Y
12/25/2001 CHRISTMAS ALL Y
09/22/2001 "THANKS GIVING DAY ALL Y
> 07/04/2001 INDEPENDENCE DAY ALL Y

12/25/2000 CHRISTMAS ALL Y

Job Holidays

[ saveand Stay | [ Save and Retumn | (3 Return

Holiday Dt 06/13/2020 * Enabled
* ion QUEENS BIRTHDAY
Company UKO1 ™

A brief description of the fields is given below:

Table 2-54 Job Holidays
|

Field Do this

Holiday Dt Specify the date of the job holiday. You can
select the date from the adjoining calendar icon.

Description Specify the job holiday description (required).
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Table 2-54 (Cont.) Job Holidays

|
Field Do this

Company Select the company from the drop-down list. The
list is populated only with those Company
Definitions to which you have been provisioned
access.

This company is considered if system is setup to
process holiday at Company level. For more
information, refer to Appendix - Company Level
GL Date Configuration section.

Enabled Check this box to enable the holiday.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.10.2 Batch Jobs Available

The below table provides a list of Batch Jobs maintained in the system and a brief description
to each:

Table 2-55 Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
AAE Applicatio aaiprc_bj_ APPLICA No Yes No Common This
n Account 100_01 TION TO process
Interface ACCOUN periodicall
T y picks up
INTERFA applicatio
CE nsin
Approved
-Verified
status and
creates
accounts.
ACH ACH acaprc_bj ACCOUN No Yes No Common This
Accounts _100_01 T ACH process
PROCES produces
SING the ACH
file for the
eligible
customer
payments.
ACH ACH acpprc_bj PRODUC Yes Yes No Common This
Producers _100 01 ER ACH process
PROCES produces
SING the ACH
file for the
eligible
producer
payments
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
ACH ACH acvprc_bj VENDOR No Yes No Common This
Vendors 100 01 ACH process
PROCES produces
SING the ACH
file for the
eligible
vendor
payments.
ACH ACH acxprc_bj ACH Yes Yes No Common This
Producer/ _100_01 Producer/ process
Vendors/ Vendors/ producers
Customer/ Customer/ the ACH
Third Third file for the
Party Party eligible
Producer/
Vendors/
Customer/
Third
Party
AGE Aging agaapp_b APPLICA Yes No No Common This
Applicatio j_100_01 TION process
ns AGING puts
PROCES applicatio
S ns into
Aged-
Applicati
on
substatus.
AGE Aging agccon_bj CONTRA Yes No No Common This
Contracts 100 01 CT process
AGING puts
PROCES contracts
S into
Aged-
Contract
substatus.
ALTPFS ALLOTME PFSEFTP BACKUP No Yes No Common This
NT RC BJ 1 EFT process
EXTRACT 11 01 creates
FILE the
DUMP Backup
EFT file
ALTPFS ALLOTME PFSLBAP POSTING No Yes No Common This
NT RC_BJ_ 1 ALLOTME process
EXTRACT 00_01 NT posts the
FILE PAYMENT payments
DUMP S from the
allotment
file
received
from the
bank

Line Origination Setup Guide
G42451-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

September 11, 2025

Page 66 of 174



ORACLE Chapter 2
Batch Jobs

Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

ALTPFS ALLOTME PFSODD ALLOTME No Yes No Common This
NT ALT BJ 1 NT process
EXTRACT 00_01 EXTRACT sends the
FILE FILE allotment
DUMP DUMP draft
notice to
the bank

ALTPFS ALLOTME PFSNSFP NSF No Yes No Common This
NT RC_BJ_1 BATCH process
EXTRACT 00_01 posts the
FILE NSF file
DUMP received
from the

bank

API API accaai_bj APIAAlI  No Yes No Common This
Accounts _100_01 process
creates
accounts
from
validated
conversio
n
applicatio
ns/
contracts

API API accdmp_b MOVE No Yes No Common This
Accounts j 100_01 API_XX process
TO ITABS copies
data from
conversio
n API
tables to
conversio
n
applicatio
ns table
API API accval_bj VALIDATE No Yes No Loan This
Accounts _111 01 ITABS process
(LOAN) validate
all
conversio
n
applicatio
ns loan
accounts
by
running
the edits
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

API API accval_bj VALIDATE No Yes No Line This
Accounts 112 01 ITABS process
(LINE) validate
all
conversio
n
applicatio
ns line of
credit
accounts
by
running
the edits

API API acmprc_ LOAD No Yes No Common This
Accounts bj_100_ 0 API_COM process
1 MENTS creates

account
comments
from
conversio
n
applicatio
ns/
contracts
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

API API APIDMP_ LOAD API No Yes Yes Common This
Accounts BJ 100 0 RECORD process
1 S directly
reads
data from
database
folder and
using the
external
tables
loads it
into API
tables for
creating
accounts.
This
eliminates
the need/
dependen
cy of SQL
loader
and
Control
files.

Ensure
that
account
datain
Input file
has same
structure
as defined
in Setup >
Data Files
> Input
definition
specificall
y for
Loan,
Line &
Lease
accounts.
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

SETAPI2 ASYNCH ACXVAL_ VALIDATE Yes Yes Yes Common This
RONOUS BJ 100 0 IAPP process is
ACCOUN 1 TABS used to
T validate
CREATIO the data
N from the

Account
On-
Boarding
request.
This
process is
the first
stage in
processin
g
asynchron
ous
account
creation
using
Account
on-
boarding
web
service
and is
controlled
based on
value
defined in
system
parameter

ACCOUN
T_PROC
ESSING_
THRESH
OLD.
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______________________________________________________________________________________|
Servicing Collectio Product Commen

Engine Descripti
Type on

Batch
Job

Descripti Originati
on on

n

Chapter 2
Batch Jobs

t

SETAPI2 ASYNCH
RONOUS
ACCOUN
T
CREATIO
N

ACXAAI_
BJ_100 0
1

ASYNCH Yes
RONOUS
ACCOUN

T

CREATIO

N

Yes

Yes

Common This
process is
used for
asynchron
ous
accounts
creation
using
Account
on-
boarding
web
service.
This
process is
the next
stage
after
successfu
|
validation
of account
creation
request
without
any
errors.
Based on
the
request
and
system
parameter
value in
ACCOUN
T PROC
ESSING _

THRESH
OLD
accounts
are
created in
the
system
with all
the details
and with
Status of
account
as Active,
Error,
Void.

Note:
These
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

Accounts
can have
Account
Number
generated
externally
or require
OFSLL to
generate
these
number.

CoL Appointm capprc_bj APPPOIN No Yes Yes Common This
ent _100_01 TMENT process
Cancellati CANCEL cancels
on PROCES all the

SING expired
appointm
ents.

CcoL Payment cppprc_bj BROKEN No Yes No Common This
Promise _100_01 PROMISE process
Processin PROCES updates
g SING any

broken
promises
as of the
run time.

CRB Credit cbuutl_bj  CREATE No Yes No Common This
Bureau 100_01 METRO2 process
Reporting FILE creates

the
METRO2
file for
Credit
Bureau
reporting
for the
specified
date.
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

DOT Document dolprc_bj_ ACCOUN No Yes Yes Common This
Tracking  000_01 T process
Load DOCUME reads

NT LOAD acct_doc_
load
directory.
Attach the
document
sto
specified
accounts
and move
document
sto
appropriat
e
directory

DLX Accounts ODXPRC ACCOUN No Yes Yes Common This
Dialer _BJ 100_ TS process
Exclusion 01 DIALER generates

EXCLUSI a dialer

ON exclusion
file with
account
details
and
checks if
the
maintaine
d call
action
result
entry is
made on
any
account
during the
specified
time
interval.

GLP GL gliprc_bj_ GL No Yes No Common This
Interface  100_01 SUMMAR process

IZATION summariz
es GL
transactio
ns for the
day.
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Engine
Type

Descripti
on

Batch
Job

Descripti Originati
on on n

Servicing Collectio Product

Chapter 2
Batch Jobs

Commen
t

GOov

Debt
Reporting
IRS
1099A /
1099C

gdraap_bj
_100_01

IRS 1099- No Yes No
A

PROCES

SING

This
process
generates
the 1099-
A flat file
for
governme
nt
reporting.

Common

Gov

Debt
Reporting
IRS
1099A /
1099C

gdrcad_bj
_100_01

IRS 1099- No Yes No
C

PROCES

SING

This
process
generates
the 1099-
C flat file
for
governme
nt
reporting.

Common

GOV

HMDA
Reporting

ghrprc_bj
~100_01

IRS Yes No No
HMDA

PROCES

SING

This
process
generates
the HMDA
flat file for
governme
nt
reporting.

Common

Gov

Interest
Reporting
IRS 1098

girprc_bj_
100 01

IRS 1098 No Yes No
PROCES
SING

This
process
generates
the 1098
flat file for
governme
nt
reporting.

Common

JOB

Scheduler jsctst_bj_

000_01

Scheduler Yes Yes Yes

This
process
test the
job
scheduler

Common

LBP

Lockbox

Ibxprc_bj_
100_01

LOAD No Yes No
LOCKBO

X

PROCES

SING

This
process
loads any
lockbox
files
available.
This
process
can be set
to run
periodicall
y
throughou
t the day.

Common
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
LNT Lien OFDPRC OUTPUT No Yes No Common This
Tracking _BJ 111 LIEN process
03 TRACKIN generates
G FOR output file
DATA with
CHANGE changes
in
customer
informatio
n such as
Address/
Phone
no./
Borrower/
Coborrow
er name.
LNT Lien OFDPRC OUTPUT No Yes No Common This
Tracking _BJ 111 LIEN process
04 TRACKIN generates
G FOR output file
VOID for Void
ACCOUN Accounts
T to be sent
to dealer
track.
LTR Collection Icoltl_bj  GENERA No No Yes Common This
S Letter 100_01 TE FIRST process
COLLECT generates
ION the first
LETTER collection
letter for
eligible
accounts.
LTR Collection Icolt2_bj_ GENERA No No Yes Common This
S Letter 100_01 TE process
SECOND generates
COLLECT the
ION second
LETTER collection
letter for
eligible
accounts.
LTR Collection Icolt3_bj GENERA No No Yes Common This
S Letter 100_01 TE THIRD process
COLLECT generates
ION the third
LETTER collection
letter for
eligible
accounts.
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
LTR Customer lcspdf _bj  PAIDIN  No Yes No Loan This
Service 111 01 FULL process
Letter LETTER generates
the paid-
in full
letter for
the
relevant
accounts.
LTR Customer lIcspog_  PAYOFF No Yes No Common This
Service bj_111 0 QUOTE process
Letter 1 LETTER generates
the payoff
quote
letter for
the
requested
accounts.
LTR Customer lIcsstm_  CUSTOM No Yes No Common This
Service bj_100_0 ER process
Letter 1 STATEME generates
NT the
LETTER customer/
business
statement
letter for
requested
accounts.
LTR Customer lIcswel_bj_ WELCOM No Yes No Loan This
Service 111 01 E process
Letter LETTER generates
the
welcome
letter for
the newly
funded
accounts.
LTR Originatio loraco_bj_ Originatio Yes No No Loan This
nLetter 111 01 n Adverse process
Action generates
Letter the
(Condition adverse
al) (Loan) action
letter for
relevant
applicatio
ns.
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
LTR Originatio loradv_bj_ Originatio Yes No No Loan This
n Letter 111 01 n Adverse process
Action generates
Letter the
(Loan) adverse
action
letter for
relevant
applicatio
ns.
OoDD Coupon  ocnprc_bj CUSTOM No Yes No Common This
Book 100 01 ER process
Dump File COUPON generates
BOOK coupon
GENERA books, if
TION appropriat
e.
ODD Output oddprc_bj CREATE Yes Yes Yes Common This
Data _000_01 OUTPUT process
Dump File DATA creates
DUMP any
FILES defined
output
data
dump files
set in the
system.
OoDD Collection olcltl_bj COLLECT No No Yes Commom This
S Letter 100_01 ION process
LETTER generates
1 FILE the first
CREATIO collection
N letter for
eligible
accounts.
OoDD Collection olclt2_bj  COLLECT No No Yes Common This
S Letter 100_01 ION process
LETTER generates
2 FILE the
CREATIO second
N collection
letter for
eligible
accounts.
OoDD Collection olclt3_bj  COLLECT No No Yes Common This
S Letter 100_01 ION process
LETTER generates
3 FILE the third
CREATIO collection
N letter for
eligible
accounts.
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Type on Job on on n t
ODD Originatio oloaco_  ADVERS Yes No No Common This
n Letter bj_100 0 E process
1 ACTION generates
CONDITI the
ONAL adverse
LETTER action
FILE letter for
CREATIO relevant
N applicatio
ns.
OoDD Originatio oloadv_ ADVERS Yes No No Common This
n Letter bj_100 0 E process
1 ACTION generates
LETTER the
FILE adverse
CREATIO action
N letter for
relevant
applicatio
ns.
ODD Customer olspdf_bj_ PAID IN No Yes No Common This
Service 100_01 FULL process
Letter FILE generates
CREATIO the paid-
N in full
letter for
the
relevant
accounts.
ODD Customer olspoq_  PAY OFF No Yes No Common This
Service bj_100_0 QUOTE process
Letter 1 FILE generates
CREATIO the payoff
N guote
letter for
the
requested
accounts.
OoDD Customer olswel_ WELCOM No Yes No Common This
Service bj_100 0 E process
Letter 1 LETTER generates
FILE the
CREATIO welcome
N letter for
the newly
funded
accounts.
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ODD Producer opsprc_bj DEALER No Yes No Common This
Statement 100 01 STATEME process
Dump File NTS generates
GENERA the
TION dealer/
producer
statement
s at the
specified
frequency.
OoDD Customer ostprc_bj_ CUSTOM No Yes No Common This
Statement 100_01 ER process
Dump File STATEME generates
NTS the
GENERA customer/
TION business
statement
for eligible
accounts.
PRQ Payable  pcuprc_bj CUSTOM No Yes No Common This
Requistio _100_01 ER process
n REFUND creates
Customer PAYMENT requisition
REQUISI s for
TIONS customer/
business
overpaym
ent
refunds.
PRQ Payable  ppores_bj MONTH No Yes No Common This
Requisitio _100_01 END process
n DEALER creates
Producer RESERV requisition
E s for
PAYMENT dealer
REQUISI compensa
TIONS tion
payments
on month-
end.
PRQ Payable  pvnprc_bj VENDOR No Yes No Common This
Requisitio _100_01 INVOICE process
n Vendor PAYMENT creates
REQUISI requisition
TIONS s for
vendor
invoice
payments.
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Type on Job on on n t
PUR Archive pacarc_bj ARCHIVE No Yes Yes Common This
Accounts 100 01 ACCOUN process
T DATA archives
TO account
OTABLES data from
ACCOUN
TS table
to
OACCOU
NTS
table.
PUR Archive pacarc_bj ARCHIVE No Yes Yes Common This
Accounts 100 02 ACCOUN process
T DATA archives
TO account
OOTABLE data from
S OACCOU
NTS table
to
OOACCO
UNTS
table.
PUR Archive paparc_bj ARCHIVE Yes No No Common This
Applicatio _100_01 APPLICA process
ns TION archives
DATA TO applicatio
OTABLES n- related
data from
APPLICA
TIONS to
OAPPLIC
ATIONS
table.
PUR Archive paparc_bj ARCHIVE Yes No No Common This
Applicatio _100_02 APPLICA process
ns TION archives
DATA TO applicatio
OOTABLE n- related
S data from
OAPPLIC
ATIONS
to
OOAPPLI
CATIONS
table.
PUR Archive pglarc_bj_ ARCHIVE No Yes Yes Common This
GL 100_01 GL DATA process
TO archives
OTABLES General
Ledger
data from
GL tables
to OGL
tables.
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Type on Job on on n t
PUR Archive pglarc_bj_ ARCHIVE No Yes Yes Common This
GL 100_02 GL DATA process
TO archives
OOTABLE General
S Ledger
data from
OGL
tables to
O0OGL
tables.
PUR Purge Job pjrjrg_bj_  Purge Job Yes Yes Yes Common This
Requests 100_01 Requests process
purges
job
requests
from the
system.
PUR Purge pododh_b PURGE No Yes Yes Common This
Output j_100_01 OUTPUT process
Data DATA purges
Dump HEADER Output
S Data
Headers
from the
system.
PUR Archive ppaarc_bj ARCHIVE No Yes No Common This
Securitiza _100 01 POOL process
tion DATA TO archives
OTABLES securitizat
ion data
from
TABLE to
correspon
ding
OTABLE.
PUR Archive ppaarc_bj ARCHIVE No Yes No Common This
Securitiza _100_02 POOL process
tion DATA TO archives
OOTABLE securitizat
S ion data
from
OTABLE
to
correspon
ding
OOTABLE
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Type on Job on on n t
PUR Archive pprarc_bj ARCHIVE Yes Yes Yes Common This
Producers _100 01 PRODUC process
ER DATA archives
TO producer
OTABLES data from
PRODUC
ERS table
to
OPRODU
CERS
table.
PUR Archive pprarc_bj ARCHIVE Yes Yes Yes Common This
Producers _100_02 PRODUC process
ER DATA archives
TO producer
OOTABLE data from
S OPRODU
CERS
table to
OOPROD
UCERS
table.
PUR Archive ppxarc_bj ARCHIVE No Yes No Common This
Producers _100_01 PRODUC process
Txns ER TXNS archives
DATA TO producer
OTABLES transactio
n data
from
PRODUC
ERS table
to
OPRODU
CERS
table.
PUR Archive ppxarc_bj ARCHIVE No Yes No Common This
Producers _100_02 PRODUC process
Txns ER TXNS archives
DATA TO producer
OOTABLE transactio
S n data
from
OPRODU
CERS
table to
OOPROD
UCERS
table.
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PUR Archive pstarc_bj_ ARCHIVE No Yes No Common This
Statement 100_01 ACCOUN process
s T archives
STATEME account
NT AND statement
TXNS and
DATA TO transactio
OTABLES n data
from
TABLE to
correspon
ding
OTABLE.
PUR Archive pstarc_bj_ ARCHIVE No Yes No Common This
Statement 100_02 ACCOUN process
s T archives
STATEME account
NT AND statement
TXNS and
DATA TO transactio
OOTABLE n data
S from
OTABLE
to
OOTABLE
PUR Terminate ptuusr_  Terminate Yes Yes Yes Common This
User bj_100_0 User process
1 terminate
s user
satisfying
the
selection
criteria.
PUR Archive ptxarc_bj_ ARCHIVE No Yes No Common This
Txns (To 100_01 TXNS process
O tables) DATA TO archives
OTABLES data from
TXNS
table to
OTXNS
table.
PUR Archive ptxarc_bj_ ARCHIVE No Yes No Common This
Txns (To 100_02 TXNS process
(0]e] DATA TO archives
tables) OOTABLE data from
S OTXNS
table to
OOTXNS
table.
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PUR Purge pululg_bj_ Purge Yes Yes Yes Common This
User 100_01 User process
Logins Logins purges
user login
data from
the
system.

PUR Archive pvaarc_bj ARCHIVE No Yes Yes Common This
Vendor _100_01 VENDOR process
Assignme ASSIGNM archives
nts ENTS vendor

DATA TO assignme

OTABLES nt data
from
TABLE to
OTABLE.

The
criteria for
archival is
based on
following
validation
- Work
Order
Status =
Closed /
Complete
d/
Reposses
sed +
Days
mentione
din
system
parameter
PVA_AR
CHIVE_-
DAYS.
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Type on Job on on n t

PUR Archive pviarc_bj_ ARCHIVE No Yes Yes Common This
Vendor 100_01 VENDOR process
Invoices INVOICE archives
S DATA vendor
TO invoice
OTABLES data from
TABLEs
to
OTABLEs.

The
criteria for
archival is
based on
following
validation
- Invoice
Status =
Close +
Days
mentione
din
system
parameter
PVI_ARC
HIVE_-
DAYS.

PUR Archive pviarc_bj_ ARCHIVE No Yes Yes Common This
Vendor 100_02 VENDOR process
Invoices INVOICE archives

S DATA vendor
TO invoice
OOTABLE data from
S OTABLEs
to
OOTABLE
s based
on the
days
mentione
din
system
parameter
PVI_OAR
CHIVE_
DAYS.

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 85 of 174



ORACLE Chapter 2
Batch Jobs

Table 2-55 (Cont.) Batch Jobs Available
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Type on Job on on n t

PUR Archive pvearc_bj ARCHIVE No Yes Yes Common This
Vendors 100 01 VENDOR process
S DATA archives
TO vendor
OTABLES invoice
data from
TABLEs
to
OTABLEs.

The
criteria for
archival is
based on
following
validation
- Vendor
end date
is less
than
system
date -
Days
mentione
din
system
parameter
PVE_AR
CHIVE._-
DAYS.

PUR Archive pvearc_bj ARCHIVE No Yes Yes Common This
Vendors 100 _02 VENDOR process
S DATA archives
TO vendor
OOTABLE invoice
S data from
OTABLEs
to
OOTABLE
s based
on the
days
mentione
din
system
parameter
PVE_OA
RCHIVE_
DAYS.
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Type Job on on n t
QUE gecsprc_bj CUSTOM No Yes Yes Common This
Customer 100 01 ER process
SERVICE creates
QUEUE the
PROCES customer
SING service/
collection
s queues
SETQCS QCCPRC CRITERI No Yes Yes This
_BJ 100_ A BASED process
01 CONDITI facilitates
ON to post
POSTING criteria
based
conditions
on
Account.
SETQRT REAL QCCPRC CRITERI Yes Yes This batch
_BJ _100_ A BASED job
02 CONDITI processes
ON criteria
POSTING based
REAL condition
TIME posting
PROCES queues
SING marked
as real
time
based on
refresh
frequency
setup in
the job
set.
RDB1 racdmp_b Data No Yes Yes Common This
j_100_01 Dump process
Accounts transfers
the
account
data from
(OLTP)
Regular
tables to
Temporar
y T tables
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Type on Job on on n t
RDB1 RDB1 rapdmp_b LOAD Yes No No Common This
Applicatio j_100_01 APPLICA process
ns TION transfers
RELATED the
DATA applicatio
INTOT n data
TABLES from
(OLTP)
Regular
tables to
Temporar
y T tables
RDB1 RDB1 ratdmp_bj LOAD No Yes No Common This
Asset _100_01 ASSET process
Tracking RELATED transfers
DATA the
INTOT account
TABLES asset data
from
(OLTP)
Regular
tables to
Temporar
y T tables
RDB1 RDB1 rbkdmp_b LOAD No No Yes Common This
Bankruptc j_100_01 BANKRU process
y PTCY transfers
DATA TO the
T TABLES account
bankruptc
y data
from
(OLTP)
Regular
tables to
Temporar
y T tables
RDB1 RDB1 rcadmp_b LOAD No No Yes Common This
Call j_100_01 CALL process
Activities ACTIVITI transfers
ES DATA the
INTOT account
TABLES call
activity
data from
(OLTP)
Regular
tables to
Temporar
y T tables
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RDB1 RDB1 rchdmp_b LOAD No No Yes Common This
Deficiency j_100_01 DEFICIE process
NCY transfers
DATA the
INTOT account
TABLES deficiency
data from
(OLTP)
Regular
tables to
Temporar
y T tables
RDB1 RDB1 rcodmp_b LOAD Yes Yes No Common This
Contracts j 100 01 CONTRA process
CT DATA transfers
INTOT the
TABLES account
contracts
data from
(OLTP)
Regular
tables to
Temporar
y T tables
RDB1 RDB1 rfodmp_bj LOAD No No Yes Common This
Reposses _100_01 REPO process
sions FORECL transfers
OSURE the
DATA account
INTOT bankruptc
TABLES y data
from
(OLTP)
Regular
tables to
Temporar
y T tables
RDB1 RDB1 rprdmp_bj LOAD No Yes No Common This
Producers _100_01 PRODUC process
ER AND transfers
ITS TXNS the
DATA producer
INTOT and
TABLES producer
transactio
ns data
from
(OLTP)
Regular
tables to
Temporar
y T tables
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RDB1 RDB1 rstdmp_bj LOAD Yes Yes Yes Common This
Setup _100_01 SETUP process
RELATED transfers
DATA the setup
INTOT data from
TABLES (OLTP)
Regular
tables to
Temporar
y T table
RDB1 RDB1 rtxdmp_bj LOAD No Yes No Common This
Txns _100_01 TXN process
DATA transfers
INTOT the
TABLES account
transactio
ns data
from
(OLTP)
Regular
tables to
Temporar
y T tables
RDB2 RDB2 racacc_bj Load No Yes Yes Common This
Accounts _100_01 Reporting process
Tables transfers
Accounts the
account
data from
T tables
to RDB
tables
RDB2 RDB2 racdrv_bj Update No Yes Yes Common This
Accounts _100_01 Reporting process
(Derived Tables updates
Fields) Accounts the codes
with
descriptio
n for
account
RDB
tables
RDB2 RDB2 rapapp_bj Load Yes No No Common This
Applicatio _100_01 Reporting process
ns Tables transfers
Applicatio the
ns applicatio
n data
from T
tables to
RDB
tables
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RDB2 RDB2 rapdrv_bj Update Yes No No Common This
Applicatio _100_01 Reporting process
ns Tables updates
(Derived Applicatio the codes
Fields) ns with
(Derived descriptio
Fields) n for
applicatio
n RDB
tables
RDB2 RDB2 ratase_bj Load No Yes No Common This
Asset _100_01 Reporting process
Tracking Tables transfers
Asset the
Tracking account
asset
tracking
data from
T tables
to RDB
tables
RDB2 RDB2 ratdrv_bj_ Update No Yes No Common This
Asset 100_01 Reporting process
Tracking Tables updates
(Derived Asset the codes
Fields) Tracking with
(Derived descriptio
Fields) n for
account
asset
tracking
RDB
tables
RDB2 RDB2 rbkabd_  Load No No Yes Common This
Bankruptc bj_100_0 Reporting process
y 1 Tables transfers
Bankruptc the
y account
bankruptc
y data
from T
tables to
RDB
tables
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RDB2 RDB2 rcacac_bj Load No No Yes Common This
Call _100_01 Reporting process
Activities Tables transfers
Call the
Activities account
call
activities
data from
T tables
to RDB
tables
RDB2 RDB2 rchaof_bj Load No No Yes Common This
Deficiency _100_01 Reporting process
Tables transfers
Deficiency the
account
deficiency
data from
T tables
to RDB
tables
RDB2 RDB2 rcocon_bj Load Yes Yes No Common This
Contracts _100_01 Reporting process
Tables transfers
Contracts the
account
contract
data from
T tables
to RDB
tables
RDB2 RDB2 rcodrv_bj Update Yes Yes No Common This
Contracts _100_01 Reporting process
(Derived Tables updates
Fields) Contracts the codes
(Derived with
Fields) descriptio
n for
account
contract
RDB
tables
RDB2 RDB2 rfoafr_bj_ Load No No Yes Common This
Reposses 100_01 Reporting process
sions Tables transfers
Reposses the
sions account
repossess
ion data
from T
tables to
RDB
tables
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RDB2 RDB2 rprdrv_bj_ Update No Yes No Common This
Producers 100_01 Reporting process
(Derived Tables updates
Fields) Producers the codes

(Derived with

Fields) descriptio
n for
producer
and
producer
transactio
ns RDB
tables

RDB2 RDB2 rprpro_bj_ Load No Yes No Common This
Producers 100_01 Reporting process
Tables transfers
Producers the
producer
and
producer
transactio
ns data
from T
tables to
RDB
tables

RDB2 RDB2 rststp_bj_ Load Yes Yes Yes Common This
Setup 100_01 Reporting process
Tables transfers
Setup the setup
data from
T tables
to RDB
tables

RDB2 RDB2 rixdrv_bj_ Load No Yes Yes Common This
Txns 100_01 Reporting process
Tables transfers
Txns the
account
transactio
n data
from T
tables to
RDB
tables
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RDB2 RDB2 rixtxn_bj_ Update No Yes Yes Common This
Txns 100_01 Reporting process
(Derived Tables updates
Fields) TXNns the codes
(Derived with
Fields) descriptio
n for
account
transactio
ns RDB
tables
SEC Pool ssmprc_bj POOL No Yes No Common This
Summary _100_01 SUMMAR process
Y TABLE populates
POPULAT summary
ION tables for
all pools
SETOVR OVERPAY PFSTXN OVERPAY No Yes No Common This
MENT OVR_BJ_ MENT process
REALLO 100 01 REALLO handles
CATIONS CATIONS the
overpaym
ents/
overages
existing
on an
account
TPE Earning/  tamprc_bj AMORTIZ No Yes No Common This
Amortizati _100_01 ATION process
on TRANSA creates
CTIONS the
PROCES monthend
SING interest
accrual
transactio
ns on
monthend
TPE Earning/  tamprc_bj MONTH No Yes No Loan This
Amortizati _111 01 END process
on AMORTIZ creates
ATION the
TRANSA monthend
CTIONS interest
accrual
transactio
ns on
monthend
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TPE Escrow tenbmt_bj Escrow No Yes Yes Common This
Non 100 _ 01 Non process
Monetary Monetary posts
Transactio Batch escrow
ns Transactio non
ns monetary
transactio
ns in the
backgrou
nd at the
specified
time
interval.
TPE Escrow tesanl_bj_ Escrow No Yes No Common This
Analysis  100_01 Analysis process
& Posting posts all
Disburse approved
ments escrow
analysis
to the
account
TPE Escrow tesanl_bj_ Create No Yes No Common This
Analysis  100_02 batches process
& for creates
Disburse Customer company
ments Refund branch
Requests wise
batches
for
customer
refund
requests.
TPE Escrow tesanl_bj_ Create No Yes No Common This
Analysis  100_03 Transactio process
& n of populate
Disburse Customer customer
ments Refund refund
Requests request in
respective
batch
created
above
TPE Escrow tesanl_bj_ Compute No Yes No Common This
Analysis 100_04  control process
& totals for populates
Disburse customer control
ments refund totals for
request the
batches bathes
created
for
customer
refund
requests.
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TPE Escrow tesanl_bj_ Escrow No Yes No Common This

Analysis  100_05 complianc process

& e checks

Disburse checking escrowabl

ments e account
for
complianc
e

TPE Escrow tesdsb_  Escrow No Yes No Common This
Analysis  bj_100_0 disbursem process
& 5 ent posts
Disburse posting & processed
ments requisition escrow

creation disbursem
ent and
creates
requisition
S.

TPE Non tnmbmt_b NON No Yes Yes Common This
Monetary j_100_01 MONETA process
Transactio RY posts non
ns TRANSA monetary

CTIONS transactio

POSTING ns in the
backgrou
nd at the
specified
time
interval.

TPE Compens tprcom_bj Compens No Yes No Loan This
ation _111 01 ation process

creates
transactio
n for
month-
end
producer
compensa
tion

TPE Statement tprpsg_bj Producer No Yes No Loan This
_111_01 Statement process
creates
the
monthend
interest
accrual
transactio
ns on
monthend
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TPE Monetary txnacr_bj_ INTERES No Yes No Common This
Transactio 100_01 T process
ns ACCRUA posts any

L AND payment

DELINQU batches

ENCY open in

PROCES the

SING system.
This
process
can be set
to run
periodicall
y.

TPE Monetary txnact_bj_ ACCOUN No Yes No Common This job
Transactio 100_01 T activates
ns ACTIVATI new

ON accounts
ie.
changes
status
from
PENDING
to
ACTIVE.

TPE Monetary txnadv_bj Advance No Yes No Line This
Transactio _112 01 Posting process
ns posts any

advance
batches
openin
the
system.
This
process
can be set
to run
periodicall
y.

TPE Monetary txnann_bj ANNIVER No Yes No Common This
Transactio _100 01 SARY process
ns PROCES carries

SING out the
anniversa
ry
processin
g for
eligible
accounts

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 97 of 174



ORACLE Chapter 2
Batch Jobs

Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

TPE Monetary txnbmt_bj MONETA No Yes No Common This
Transactio 100 01 RY process
ns TRANSA posts

CTIONS monetary

POSTING transactio
ns in the
backgrou
nd at the
specified
time
interval.

TPE Monetary txnchg_bj Chargeoff No Yes No Common This
Transactio _100_01 Processin process
ns g charges

off eligible
or
scheduled
for
chargeoff
accounts.

TPE Monetary txnchg_bj Chargeoff No Yes No Common On
Transactio _100_03 reversal posting
ns charge off

reversal
transactio
n, this
process
moves the
remaining
expense
and fee
from
charge off
balance to
active
balance.

TPE Monetary txncls_bj_ VOID/ No Yes No Common This
Transactio 100_01 PAID process
ns ACCOUN closes

T CLOSE void and
PROCES paid off
SING accounts.
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n

Chapter 2
Batch Jobs

Commen
t

TPE

Monetary txnddt_bj_

Transactio 100 01
ns

BILLING/ No Yes
DUE

DATES

PROCES

SING

No

Common This
process
creates/
updates
the due
dates for
the
accounts
in the
system.

parameter
s defined
for Home
collateral.

For more
details,

TPE

Monetary txnfpd_bj_

Transactio 100_01
ns

FIRST No Yes
PMT

DEDUCTI

ON

PROCES

SING

No

Common This
process
posts the
first
payment
deduction

eligible
accounts.

TPE

Monetary txnfpr_bj_
Transactio 111 01
ns

FIRST No Yes
PMT

REFUND

PROCES

SING

No

Loan This
process
posts the
first
payment
deduction
payment
to the
eligible
accounts.
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen

Type on Job on on n t

TPE Monetary txnltc_bj_ LATE No Yes No Common This
Transactio 100_01 CHARGE process
ns PROCES assesses

SING late
charge
dependin
g on the
rules, for
all
accounts
in the
system.

TPE Monetary txnmtd_bj MONTH No Yes No Common This
Transactio _100_01 END process
ns PROCES populates

SING the month
end
balances
and
carries
over the
balances
to next
month.

TPE Monetary txnpmt_bj Payment No Yes No Common This
Transactio _100_01 Posting process
ns does the

daily
accrual
and
delinquen
cy
processin
g.

TPE Monetary txnprm_bj PROMOTI No Yes No Common This
Transactio _100_ 01 ON END process
ns PROCES ends the

SING promotion
on the
account.

TPE Monetary txnprm_bj TLP No Yes No Common This
Transactio _100 03 PROMOTI process
ns ON cancels

CANCEL the

PROCES promotion

SING on the
account.

TPE Monetary txnrat_bj_ RATE No Yes No Common This
Transactio 100_01 CHANGE process
ns PROCES changes

SING the
prevalent
rate on an
account.
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
TPE Monetary txnsch_bj SCHEDU No Yes No Common This
Transactio 100 01 LEFOR process
ns CHARGE puts the
D OFF Schedule
PROCES for
SING Charge
Off
condition
on eligible
accounts.
TPE Monetary txntip_bj_ TERMINA No Yes No Common This
Transactio 100_01 TION process
ns PROCES puts the
SING Paid
status on
eligible
accounts
TPE Monetary txnytd_bj_ YEAR No Yes No Common This
Transactio 100_01 END process
ns PROCES populates
SING the year
end
balances
and
carries
over the
balances
to next
year.
TPE Usage TXNUSG Billing No Yes Yes Common This
Charge _BJ_100_ Batch job process is
Processin 01 to process used to
g and post derive the
lease billing
usage/ amount to
rental be
fees on charged
account for Lease
Usage/
Rental
based
asset for
consumed
units
calculated
by the
applicable
charge
matrix.
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

TPE MOCK TXNMDT MOCK Yes Yes Yes Common This
BILLING/ _BJ 100 BILLING/ process
DUE 01 DUE generates
DATES DATES the future
PROCES PROCES dues/
SING SING balances

based on
the
parameter
s defined
in the
criteria.
This batch
jobis a
prerequisi
te run for
the mock
statement
s to get
generated

TPE CAPITALI TXNCPT_ CAPITALI Yes Yes Yes Common This
ZATION BJ_100_0 ZATION process is
PROCES 1 PROCES used to
SING SING capitalize

the
balance
on all
qualified
accounts
and is
configure
dto run
after
running
the hilling
batch job.
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Table 2-55 (Cont.) Batch Jobs Available

Engine
Type

Descripti Batch
on Job

Descripti
on

Originati
on

Servicing Collectio Product
n

Chapter 2
Batch Jobs

Commen
t

TPE

POST  TXNEGC
MATURIT _BJ 121
YEVER 01
GREEN

TRANSA

CTION

PROCES

SING

POST
MATURIT
Y EVER
GREEN
TRANSA
CTION
PROCES
SING

Yes

This
process is
used to
pick-up
accounts
matching
the
criteria for
evergreen
renewal,
waits for
maturity
date
based on
grace
days and
posts
Evergreen
Lease
transactio
n.

TPE

CYCLE TXNCBC
BASED _BJ 100_
COLLECT 01

ION LATE

FEE

PROCES

SING

CYCLE
BASED
COLLECT
ION LATE
FEE
PROCES
SING

Yes

Yes Yes Common

This
process
facilitates
to
calculate
Cycle
based
Collectio
n Late
Fee at
account
level and
update
the
balances.

TPE

CYCLE  TXNCBL_
BASED BJ_100 0
LATE FEE 1
PROCES

SING

CYCLE
BASED
LATE FEE
PROCES
SING

Yes

Yes Yes Common

This
process
facilitates
to
calculate
Cycle
Based
Late Fee
at account
level and
update
the
balances.
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

XPR DEALER XPRPST_ DEALER No Yes Yes Common This
TRACK EW_100_ TRACK process
PRODUC 01 PRODUC dumps
ER LOAD ER LOAD producer

details
maintaine
dinthe
system
into
Dealer
Track.

System
can either
use MDB
flow by
generatin
g
outbound
JMS
message
if system
parameter
OuUTBOU
ND_
DLR_
TRACK _
Qissetto
Y or use
existing
flow by
making
database
synchrono
us
outbound
calls to
producer
data
dump web
service.
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

XPR2 ROUTE XPRPST_ ROUTE No Yes Yes Common This
ONE EW_100_ ONE process
PRODUC 01 PRODUC dumps
ER LOAD ER LOAD producer

details
maintaine
din the
system
into
ROUTEO
NE.

System
can either
use MDB
flow by
generatin
g
outbound
JMS
message
if system
parameter
ouTBOU
ND_
ROUTEO
NE_Qis
setto Y or
use
existing
flow by
making
database
synchrono
us
outbound
calls to
producer
data
dump web
service.

LTR CONDITI LORACO CONDITI Yes No No Loan This
ONAL _BJ _100_ ONAL process
ADVERS 01 ADVERS generates
E E the
ACTION ACTION adverse
LETTER LETTER action
GENERA letter for
TION relevant
applicatio
ns.
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
LTR ADVERS LORADV_ ADVERS Yes No No Loan This
E BJ 100 0 E process
ACTION 1 ACTION generates
LETTER LETTER the
GENERA adverse
TION action
letter for
relevant
applicatio
ns.
RPT ACCOUN ROPACC ACCOUN No Yes No Common
TLIST _EM_100 TLIST
_01
RPT ADVANC ROPADV_ ADVANC No Yes No Common
E EM_100_ E
POSTING 01 POSTING
LIST LIST
RPT ASSET ROPATK _ ASSET No Yes No Common
TRACKIN EM_100_ TRACKIN
G 01 G
DETAILS DETAILS
RPT BANKRU ROPBNK BANKRU No Yes No Common
PTCY _EM_100 PTCY
ACCOUN _01 ACCOUN
T LIST T LIST
RPT COLLECT ROPCOL COLLECT No Yes No Common
OR _EM_100 OR
ACTIVITY 01 ACTIVITY
DETAILS DETAILS
RPT DEFICIE ROPDEF DEFICIE No Yes No Common
NCY _EM_100 NCY
ACCOUN 01 ACCOUN
TLIST TLIST
RPT DELINQU ROPDLQ DELINQU No Yes No Common
ENT _EM_100 ENT
ACCOUN _01 ACCOUN
T LIST T LIST
RPT FUNDING ROPFUN FUNDING No Yes No Common
CONTRA _EM_100 CONTRA
CTLIST _01 CTLIST
RPT GLTXN ROPGLI_ GLTXN No Yes No Common
DETAILS EM_100_ DETAILS
LIST 01 LIST
RPT APPLICA ROPORG APPLICA No Yes No Common
TIONS _EM_100 TIONS
LIST 01 LIST
RPT PAYMENT ROPPAL_ PAYMENT No Yes No Common
ALLOCAT EM_100_ ALLOCAT
ION 01 ION
POSTING POSTING
DETAILS DETAILS
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
RPT PAYMENT ROPPMT PAYMENT No Yes No Common
POSTING _EM_100 POSTING
LIST 01 LIST
RPT PAYABLE ROPPRQ PAYABLE No Yes No Common
REQUISI _EM_100 REQUISI
TION _01 TION
LIST LIST
RPT REPOSS ROPREP REPOSS No Yes No Common
SESION/ _EM_100 SESION/
FORECL _01 FORECL
OSURE OSURE
ACCOUN ACCOUN
T LIST T LIST
RPT SCHEDU ROPSCH SCHEDU No Yes No Common
LE TO _EM_100 LETO
CHARGE 01 CHARGE
OFF LIST OFF LIST
RPT TERMINA ROPTIP_ TERMINA No Yes No Common
TIONIN EM_100_ TION IN
PROGRE 01 PROGRE
SS LIST SS LIST
RPT NON ROPTNM NON No Yes No Common
MONTET _EM_100 MONTET
ARY TXN 01 ARY TXN
POSTING POSTING
LIST LIST
RPT MONTET ROPTXN MONTET No Yes No Common
ARY TXN _EM_100 ARY TXN
POSTING _01 POSTING
LIST LIST
RPT BATCH CMNBJB BATCH No Yes No Common
JOB _EM_100 JOB
SETUP 01 SETUP
RPT BATCH CMNBJB BATCH No Yes No Common
JOBLOG _EM_100 JOB LOG
_02
RPT NUMBER OUNADE NUMBER No Yes No Common
OF _EM_100 OF
CREDIT _01 CREDIT
APPLICA APPLICA
TIONS TIONS
ENTERE ENTERE
D BY D BY
USER USER
RPT CREDIT OUNADE CREDIT No Yes No Common
APPLICA _EM 100 APPLICA
TIONS _02 TIONS
IMAGES IMAGES
BY BY
STATUS STATUS
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_111 RITING
STATUS 11 STATUS
BY BY
MONTH MONTH
AND AND
PRODUC PRODUC
ER ER
(LOAN) (LOAN)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_111 RITING
STATUS 12 STATUS
BY BY
MONTH MONTH
AND AND
UNDERW UNDERW
RITER RITER
(LOAN) (LOAN)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_111 RITING
STATUS _13 STATUS
BY BY
MONTH MONTH
(LOAN) (LOAN)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_111 RITING
STATUS 14 STATUS
BY BY
UNDERW UNDERW
RITER RITER
(LOAN) (LOAN)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_112 RITING
STATUS _11 STATUS
BY BY
MONTH MONTH
AND AND
PRODUC PRODUC
ER (LINE) ER (LINE)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_112 RITING
STATUS 12 STATUS
BY BY
MONTH MONTH
AND AND
UNDERW UNDERW
RITER RITER
(LINE) (LINE)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_112 RITING
STATUS 13 STATUS
BY BY
MONTH MONTH
(LINE) (LINE)
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_112 RITING
STATUS _14 STATUS
BY BY
UNDERW UNDERW
RITER RITER
(LINE) (LINE)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_121 RITING
STATUS _11 STATUS
BY BY
MONTH MONTH
AND AND
PRODUC PRODUC
ER ER
(LEASE) (LEASE)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_121 RITING
STATUS _12 STATUS
BY BY
MONTH MONTH
AND AND
UNDERW UNDERW
RITER RITER
(LEASE) (LEASE)
RPT UNDERW OUNUND UNDERW No Yes No Common
RITING _EM_121 RITING
STATUS 13 STATUS
BY BY
MONTH MONTH
(LEASE) (LEASE)
RPT UNDERW OUNUND UNDERW Yes No No Lease
RITING _EM_121 RITING
STATUS _14 STATUS
BY BY
UNDERW UNDERW
RITER RITER
(LOAN) (LOAN)
RPT ACCOUN OFNAPY ACCOUN Yes No No Common
T _EM_100 T
PAYABLE _01 PAYABLE
(ORIGINA (ORIGINA
TION) TION)
RPT ACCOUN OFNAPY ACCOUN No Yes No Common
T _EM_100 T
PAYABLE _02 PAYABLE
(SERVICI (SERVICI
NG) NG)
RPT PRE- OFNFND PRE- Yes No No Loan
FUNDING _EM_111 FUNDING
CONTRA _01 CONTRA
CTS CTS
(LOAN) (LOAN)
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
RPT FUNDED OFNFND FUNDED Yes No No Loan
CONTRA _EM_111 CONTRA
CTS _02 CTS
(LOAN) (LOAN)
RPT PRE- OFNFND PRE- Yes No No Loan
FUNDING _EM_112 FUNDING
CONTRA _01 CONTRA
CTS CTS
(LINE) (LINE)
RPT FUNDED OFNFND FUNDED Yes No No Common
CONTRA _EM_112 CONTRA
CTS _02 CTS
(LINE) (LINE)
RPT PRE- OFNFND PRE- Yes No No Common
FUNDING _EM_121 FUNDING
CONTRA _01 CONTRA
CTS CTS
(LEASE) (LEASE)
RPT FUNDED OFNFND FUNDED Yes No No Loan
CONTRA _EM_121 CONTRA
CTS _02 CTS
(LEASE) (LEASE)
RPT ACCOUN OCSAPP ACCOUN Yes No No Loan
T _EM_100 T
PAYABLE _01 PAYABLE
LOG BY LOG BY
PRODUC PRODUC
ER ER
RPT ACCOUN OCSAPV ACCOUN Yes No No Loan
T _EM_100 T
PAYABLE 01 PAYABLE
LOG BY LOG BY
VENDOR VENDOR
RPT COLLATE OCSAST COLLATE Yes No No Common
RAL _EM_100 RAL
TRACKIN _01 TRACKIN
G LOG G LOG
RPT GL OCSGLI_ GL Yes No No Common
POSTING EM_100_ POSTING
LOG 01 LOG
RPT PAYMENT OCSPMT PAYMENT Yes No No Common
POSTING _EM_100 POSTING
(DAILY _01 (DAILY
CASH) CASH)
LOG LOG
RPT PAYMENT OCSPMT PAYMENT Yes No No Common
POSTING _EM_100 POSTING
ERROR _02 ERROR
LOG LOG
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
RPT ACCOUN OCSACC ACCOUN Yes No No Loan
T EM 111 T
LISTING 01 LISTING
(LOAN) (LOAN)
RPT EXCESS OCSPMT EXCESS Yes No No Loan
PAYMENT _EM_111 PAYMENT
(REFUND _03 (REFUND
) LOG ) LOG
(LOAN) (LOAN)
RPT PAYMENT OCSPMT PAYMENT Yes No No Loan
HISTORY _EM_111 HISTORY
(LOAN) _04 (LOAN)
RPT PAYMENT OCSPMT PAYMENT Yes No No Loan
ALLOCAT _EM_111 ALLOCAT
IONS _05 IONS
LOG LOG
(LOAN) (LOAN)
RPT PAYMENT OCSPMT PAYMENT Yes No No Loan
ALLOCAT _EM_111 ALLOCAT
IONS _06 IONS
LOG BY LOG BY
GL POST GL POST
DT DT
(LOAN) (LOAN)
RPT PRODUC OCSPSM PRODUC Yes No No Loan
ER _EM_ 111 ER
STATEME 01 STATEME
NT NT
(LOAN) (LOAN)
RPT PRODUC OCSPTX PRODUC Yes No No Loan
ER _EM_111 ER
MONETA 01 MONETA
RY TXNS RY TXNS
LOG BY LOG BY
GL POST GL POST
DT DT
(LOAN) (LOAN)
RPT SCHEDU OCSSCH SCHEDU Yes No No Loan
LED FOR _EM_111 LED FOR
CHARGE _01 CHARGE
OFF OFF
ACCOUN ACCOUN
TS LOG TS LOG
(LOAN) (LOAN)
RPT AMORTIZ OCSTAM AMORTIZ Yes No No Loan
ED TXNS _EM_111 ED TXNS
LOGBY _01 LOG BY
GL POST GL POST
DT DT
(LOAN) (LOAN)
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
RPT SCHEDU OCSTER SCHEDU Yes No No Loan
LEDFOR _EM 111 LEDFOR
TERMINA 01 TERMINA
TION TION
ACCOUN ACCOUN
TS LOG TS LOG
(LOAN) (LOAN)
RPT MONETA OCSTXN MONETA Yes No No Loan
RY TXNS _EM_111 RY TXNS
LOGBY 01 LOG BY
GL POST GL POST
DT DT
(LOAN) (LOAN)
RPT ACCOUN OCSACC ACCOUN Yes No No Loan
T _EM_112 T
LISTING _01 LISTING
(LINE) (LINE)
RPT ADVANC OCSADV ADVANC Yes No No Loan
E _EM_112 E
POSTING _01 POSTING
LOG LOG
(LINE) (LINE)
RPT ADVANC OCSADV ADVANC Yes No No Loan
E _EM_112 E
POSTING _02 POSTING
ERROR ERROR
LOG LOG
(LINE) (LINE)
RPT PAYMENT OCSPMT PAYMENT Yes No No Loan
HISTORY _EM 112 HISTORY
(LINE) _04 (LINE)
RPT PAYMENT OCSPMT PAYMENT Yes No No Common
ALLOCAT _EM_112 ALLOCAT
IONS _05 IONS
LOG LOG
(LINE) (LINE)
RPT PAYMENT OCSPMT PAYMENT Yes No No Common
ALLOCAT _EM_112 ALLOCAT
IONS _06 IONS
LOG BY LOG BY
GL POST GL POST
DT (LINE) DT (LINE)
RPT SCHEDU OCSSCH SCHEDU Yes No No Common
LEDFOR _EM_112 LED FOR
CHARGE _01 CHARGE
OFF OFF
ACCOUN ACCOUN
TS LOG TS LOG
(LINE) (LINE)

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 112 of 174



ORACLE Chapter 2
Batch Jobs

Table 2-55 (Cont.) Batch Jobs Available
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Type on Job on on n t
RPT AMORTIZ OCSTAM AMORTIZ Yes No No Common
ED TXNS _EM_112 ED TXNS
LOGBY _01 LOG BY
GL POST GL POST
DT (LINE) DT (LINE)
RPT SCHEDU OCSTER SCHEDU Yes No No Common
LED FOR _EM_112 LED FOR
TERMINA _01 TERMINA
TION TION
ACCOUN ACCOUN
TS LOG TS LOG
(LINE) (LINE)
RPT MONETA OCSTXN MONETA Yes No No Common
RY TXNS _EM_112 RY TXNS
LOGBY _01 LOG BY
GL POST GL POST
DT (LINE) DT (LINE)
RPT ACCOUN OCSACC ACCOUN Yes No No Common
T _EM_121 T
LISTING _01 LISTING
(LEASE) (LEASE)
RPT PAYMENT OCSPMT PAYMENT Yes No No Common
HISTORY _EM_121 HISTORY
(LEASE) _04 (LEASE)
RPT PAYMENT OCSPMT PAYMENT Yes No No Common
ALLOCAT _EM_121 ALLOCAT
IONS _05 IONS
LOG LOG
(LEASE) (LEASE)
RPT PAYMENT OCSPMT PAYMENT Yes No No Common
ALLOCAT _EM_121 ALLOCAT
IONS _06 IONS
LOG BY LOG BY
GL POST GL POST
DT DT
(LEASE) (LEASE)
RPT SCHEDU OCSSCH SCHEDU Yes No No Common
LED FOR _EM_121 LED FOR
CHARGE _01 CHARGE
OFF OFF
ACCOUN ACCOUN
TS LOG TS LOG
(LEASE) (LEASE)
RPT AMORTIZ OCSTAM AMORTIZ Yes No No Common
ED TXNS _EM_121 ED TXNS
LOGBY _01 LOG BY
GL POST GL POST
DT DT
(LEASE) (LEASE)
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Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
RPT SCHEDU OCSTER SCHEDU Yes No No Common
LEDFOR _EM 121 LED FOR
TERMINA 01 TERMINA
TION TION
ACCOUN ACCOUN
TS LOG TS LOG
(LEASE) (LEASE)
RPT MONETA OCSTXN MONETA Yes No No Common
RY TXNS _EM_121 RY TXNS
LOGBY 01 LOG BY
GL POST GL POST
DT DT
(LEASE) (LEASE)
RPT BANKRU OCOBNK BANKRU Yes No No Common
PTCY _EM_100 PTCY
LOG 0 LOG
RPT COLLECT OCOCOL COLLECT No No Yes Common
OR _EM_100 OR
ACTIVITY _01 ACTIVITY
(DETAILE (DETAILE
D) LOG D) LOG
RPT COLLECT OCOCOL COLLECT No No Yes Common
OR _EM_100 OR
PRODUC _02 PRODUC
TIVITY TIVITY
BY BY
QUEUE QUEUE
RPT DELINQU OCOCOL DELINQU No No Yes Common
ENCY _EM_100 ENCY
ANALYSI 03 ANALYSI
S BY S BY
PRODUC PRODUC
ER ER
RPT DELINQU OCOCOL DELINQU No No Yes Common
ENCY _EM_100 ENCY
ANALYSI _04 ANALYSI
S BY S BY
CREDIT CREDIT
GRADE GRADE
RPT DELINQU OCOCOL DELINQU No No Yes Common
ENCY _EM_100 ENCY
ANALYSI 05 ANALYSI
S BY S BY
STATE STATE
RPT PAYMENT OCOCOL PAYMENT No No Yes Common
PROMISE _EM_100 PROMISE
LOG _06 LOG
RPT COLLECT OCOCOL COLLECT No No Yes Common
OR _EM_100 OR
ACTIVITY _07 ACTIVITY
LOG LOG
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Type on Job on on n t
RPT DEFICIE OCODEF DEFICIE No No Yes Common
NCY LOG _EM_100 NCY LOG
01
RPT DELINQU OCODLQ DELINQU No No Yes Common
ENCY _EM_100 ENCY
LOG _01 LOG
RPT REPOSS OCOREP REPOSS No No Yes Common
ESSION/ _EM_100 ESSION/
FORECL _01 FORECL
OSURE OSURE
LOG LOG
RPT NON OCOTNM NON No No Yes Common
MONETA _EM_100 MONETA
RY TXNS 01 RY TXNS
LOG LOG
RPT VENDOR OCOVIN_ VENDOR No No Yes Common
INVOICE EM_100_ INVOICE
LOG 01 LOG
RPT VENDOR OCOVNA VENDOR No No Yes Common
WORK _EM_100 WORK
ORDER 01 ORDER
LOG LOG
RPT POOL OCSSEC POOL No Yes No Common
DELINQU _EM_111 DELINQU
ENCY 01 ENCY
SUMMAR SUMMAR
Y (LOAN) Y (LOAN)
RPT POOL OCSSEC POOL No Yes No Common
DEFAULT _EM_111 DEFAULT
S(NON 02 S (NON
LIQUIDAT LIQUIDAT
ED) ED)
(LOAN) (LOAN)
RPT POOL OCSSEC POOL No Yes No Common
PAYOFFS _EM_111 PAYOFFS
(LOAN) _03 (LOAN)
RPT POOL OCSSEC POOL No Yes No Common
RECOVE _EM_111 RECOVE
RY _04 RY
(LOAN) (LOAN)
RPT POOL OCSSEC POOL No Yes No Common
DELINQU _EM 111 DELINQU
ENCY _05 ENCY
(LOAN) (LOAN)
RPT POOL OCSSEC POOL No Yes No Common
REPURC _EM_111 REPURC
HASED _06 HASED
ACCOUN ACCOUN
TS TS
(LOAN) (LOAN)
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Type on Job on on n t

RPT POOL OCSSEC POOL No Yes No Common
MONTHL _EM 111 MONTHL
Y 07 Y
ACTIVITY ACTIVITY
(LOAN) (LOAN)

RPT POOL OCSSEC POOL No Yes No Common
LIQUIDAT _EM_111 LIQUIDAT
ED _08 ED
CONTRA CONTRA
CTS CTS
(LOAN) (LOAN)

RPT POOL OCSSEC POOL No Yes No Common
TXNS _EM_111 TXNS
LOGBY 09 LOG BY
GL POST GL POST
DT DT
(LOAN) (LOAN)

SETQRT Realtime QCSPRC Realtime No Yes Yes Common This batch
Queues _BJ 100_ Queues job
processin 02 processin processes
g g gueues

marked
as real
time
based on
refresh
frequency
setup in
the job
set.

TAM MONTH TPRCOM MONTH No Yes No Common
END _BJ_100_ END
COMPEN 01 COMPEN
SATION SATION
DISBURS DISBURS
EMENT EMENT
PROCES PROCES
SING SING

TAM PRODUC TPRPSG PRODUC No Yes No Common
ER _BJ 100 ER
STATEME 01 STATEME
NTS NTS

TAM PRODUC TPRSTA_ PRODUC No Yes No Common
ER BJ_100 0 ER
STATUS 1 STATUS
CHANGE CHANGE
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TAM Depreciati TAMDEP_ DEPRECI Yes Yes Yes Lease This
on BJ 121 0 ATION process is
calculator 1 RATE used to
batch job PROCES calculate
SING the delta
depreciati
on value
of the
asset
from
previous
to current
period
(current
indicator
issetas Y
by
default).
TAM Amortizati TAMIMP_ IMPUTED Yes Yes Yes Common This
on BJ_100_0 INTERES process is
schedule 1 T used to
batch job AMORTIZ generate
ATION Amortizati
TRANSA on
CTIONS schedule
PROCES based on
SING imputed
interest
rate for
loan
contracts
with
Imputed
Interest
TPE Escrow TXNCHG CHARGE No Yes No Common This
Analysis _BJ _100_ OFF package
& 02 PROCES contains
Disburse SING procedure
ments FOR s related
ACTIVE to Batch
ACCOUN Job for
TS chargeoff
processin
g
ESC ESCROW TESANL_ ESCROW No Yrs No Common This
ANALYSI BJ_100_0 ANALYSI package
S 1 S contains
POSTING POSTING procedure
s related
to Batch
Job for
escrow
analysis
processin
g
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
ESC CREATE TESANL_CREATE No Yes No Common This
BATCHES BJ 100 0 BATCHES package
FOR 2 FOR contains
CUSTOM CUSTOM procedure
ER ER s related
REFUND REFUND to Batch
REQUES REQUES Job for
T TS escrow
analysis
processin
g
ESC COMPUT TESANL_ COMPUT No Yes No Common
E BJ 100 0 E
CONTRO 4 CONTRO
LS FOR LS FOR
CUSTOM CUSTOM
ER ER
REFUND REFUND
REQUES REQUES
T T
BATCHES BATCHES
ESC ESCROW TESANL_ ESCROW No Yes No Common
COMPLIA BJ_100_0 COMPLIA
NCE 5 NCE
CHECKIN CHECKIN
G G
ESC CREATE TESDSB_ CREATE No Yes No Common
PAYABLE BJ 100 0 PAYABLE
REQUISI 1 REQUISI
TIONS TIONS
FROM FROM
APPROV APPROV
ED ED
DISBURS DISBURS
EMENT EMENT
REQUES REQUES
TS TS
PUR ARCHIVE PACARC_ ARCHIVE No Yes No Common
ACCOUN BJ_100_0 ACCOUN
T DATA 1 T DATA
TO TO
OTABLES OTABLES
EVE BATCH EVBACC BATCH Yes
EVENTS _BJ 100 EVENTS
FOR 01 FOR
ACCOUN ACCOUN
TS TS
EVE BATCH EVBAPP_ BATCH Yes
EVENTS BJ_100_ 0 EVENTS
FOR 1 FOR
APPLICA APPLICA
TIONS TIONS
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Table 2-55 (Cont.) Batch Jobs Available

Chapter 2
Batch Jobs

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
EVE MAIN EVBPRC MAIN Yes
BATCH _BJ_100_ BATCH
JOB FOR 01 JOB FOR
BATCH BATCH
EVENTS EVENTS
PROCES PROCES
SING SING
ODD2 BATCH CBUUTL_ BATCH Yes
JOBTO BJ_100_0 JOBTO
GENERA 2 GENERA
TE TE
METRO 2 METRO 2
DATA DATA
ODD2 BATCH CBUUTL_ BATCH Yes
JOB FOR BJ_100_0 JOB FOR
CREATIN 3 CREATIN
G G
METRO 2 METRO 2
DATA DATA
FILE FILE
ODD2 THIRD ACTPRC_ THIRD Yes
PARTY BJ_100_0 PARTY
ACH 1 ACH
PROCES PROCES
SING SING
ODD2 THIRD ACTPRC_ CREATE Yes This
PARTY BJ_100_0 THIRD process
OUTPUT 1 PARTY pulls the
DATA CUSTOM customer
DUMP ER FILE account
SERVICI details
NG shared in
input data
files for
processin
g.
ESC JOBTO OEDPRC JOBTO Yes
GENERA _BJ 100_ GENERA
TE 01 TE
ESCROW ESCROW
DISCLOS DISCLOS
URE URE
STATEME STATEME
NT NT
EDF ADR FILE EDFADR_ ADR FILE Yes
BJ_100_0
1
EDF IVR FILE EDFIVR_ IVR FILE Yes
BJ_100_0

1
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Chapter 2
Batch Jobs

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
TPE CONTRA TXNPRM CONTRA Yes
CTUAL ~BJ 100 CTUAL
PROMOTI 04 PROMOTI
ON ON
CANCEL CANCEL
PROCES PROCES
SING SING
TPE RATE TXNRAT_ RATE Yes
CHANGE BJ_100_0 CHANGE
PROCES 2 PROCES
SING SING
FOR FOR
BACKDAT BACKDAT
ED ED
INDEXES INDEXES
RDB1 LOAD RACDMP LOAD Yes
ACCOUN _BJ _100_ ACCOUN
T 01 T
RELATED RELATED
DATA DATA
INTOT INTOT
TABLES TABLES
TPE EXPIRED TXNINS_ EXPIRED Yes
INSURAN BJ 100 0 INSURAN
CE 1 CE
PROCES PROCES
SING SING
ADT UPDATE ADTPRC UPDATE Yes
ROWID _BJ_100_ ROWID
IN AUDIT 01 IN AUDIT
TABLE TABLE
(RUN (RUN
THIS JOB THIS JOB
AFTER AFTER
EXPORTI EXPORTI
MPORT MPORT
OF OF
TABLES) TABLES)
RDB1 LOAD RINDMP_ LOAD Yes
INSURAN BJ 100 0 INSURAN
CEDATA 1 CE DATA
TOT TOT
TABLES TABLES
AGS SALE AGSSAL_ SALE Yes
LEAD BJ_100_0 LEAD
AGING 1 AGING
BOD PROCES JOBBOD PROCES Yes
S _BJ 000_ S
PARKED 02 PARKED
TRANSA TRANSA
CTIONS CTIONS
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Chapter 2
Batch Jobs

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on t
BOD MARK JOBBOD MARK Yes
SYSTEM _BJ 000_ SYSTEM
FOR 01 FOR
BEGININ BEGININ
G OF G OF
DAY DAY
EOD SET JOBEOD SET Yes
SYSTEM _BJ 000_ SYSTEM
MODE TO 01 MODE TO
END-OF- END-OF-
DAY DAY
ACR DAILY TABACC_ DAILY Yes
TRIAL BJ_100_0 TRIAL
BALANC 1 BALANC
E DATA E DATA
GENERA
TION
LTR2 RATE LCSRAT_ RATE Yes
CHANGE BJ_100_0 CHANGE
PRE- 1 PRE-
INTIMATI INTIMATI
ON ON
LETTER LETTER
BLK BULK BLKPRP_ BULK Yes
UPLOAD BJ_100_0 UPLOAD
FOR 1 FOR
PRICING PRICING
SETUP SETUP
BLK BULK BLKGLS_ BULK Common
UPLOAD BJ_100_0 UPLOAD
FORGL 1 FOR GL
ATTRIBU ATTRIBU
TES TES
BLK BULK BLKGLS_ BULK Common
UPLOAD BJ_100_0 UPLOAD
FORGL 2 FOR GL
TRANSLA TRANSLA
TION TION
DEFINITI
ON
BLK BULK BLKGLS_ BULK Common
UPLOAD BJ_100_0 UPLOAD
FORGL 3 FOR GL
TRANSA TRANSA
CTION CTION
TYPES TYPES
DETAILS
BLK BULK BLKGLS_ BULK Common
UPLOAD BJ_100_0 UPLOAD
FORGL 4 FOR GL
TRANSA TRANSA
CTION CTION
LINKS LINKS
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Chapter 2
Batch Jobs

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
ODD2 RATE OLSRAT_ RATE Yes
CHANGE BJ 100 0 CHANGE
LETTER 1 LETTER
FILE FILE
CREATIO
N
TPE EXPIRED TXNDRW EXPIRED Yes
DRAW _BJ 111 DRAW
PERIOD 01 PERIOD
PROCES PROCES
SING SING
(STAGE (STAGE
FUNDED FUNDED
LOANS) LOANS)
ODD2 DEALER OPSSBV DEALER Common
SUBVEN _BJ_100_ SUBVEN
TION 01 TION
STATEME STATEME
NTS NTS
GENERA
TION
TAM SUBVEN TPRSBV_ SUBVEN Common
TION BJ 100 0 TION
RECEIVA 1 RECEIVA
BLE BLE
PROCES PROCES
SING SING
(PAY AS (PAY AS
GO) GO)
ODD2 PRODUC OPCPRC PRODUC Common
ER _BJ_100_ ER
CHECK 01 CHECK
PRINT PRINT
GENERA
TION
BSR BEHAVIO BSRPRC BEHAVIO Yes
RAL _BJ 100 RAL
SCORIN 01 SCORIN
G G
AGE TRANSA TXNAGE TRANSA Yes
CTIONIN _BJ 100_ CTIONIN
WAITING 01 WAITING
FOR FOR
APPROV APPROV
AL AL
AGING AGING
PROCES
S
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
ACR PREPAR TXNACR_ PREPAR Yes
E BATCH BJ_100_0 E BATCH
DATA 2 DATA
FOR FOR
INTERES INTERES
T T
ACCRUA ACCRUA
L AND L AND
DELINQU DELINQU
ENCY ENCY
PROCES
SING
PDC POST PDCPRC POST Yes
DATED _BJ_100_ DATED
CHECKS 01 CHECKS
PDC PENDING PDCPND PENDING Yes
PDC _BJ_100_ PDC
01 PROCES
SING
LTR2 PDC LCSPDC_ PDC Yes
RENEWA BJ_100_0 RENEWA
L 1 L
LETTER LETTER
GENERA
TION
DOT APPLICA DOLPRC APPLICA Yes
TION _BJ_000_ TION
DOCUME 02 DOCUME
NT LOAD NT LOAD
ODD2 ONE OLSPDP_ ONE Yes
TIME BJ_100_0 TIME
ACH 1 ACH
POST POST
DATED DATED
PAYMENT PAYMENT
LETTER LETTER
PROCES
SING
ODD2 OUTPUT OSTPRC MASTER Yes This
DATA _BJ_100_ CUSTOM process is
DUMP 02 ER used to
SERVICI STATEME generate
NG NT consolidat
GENERA ed
TION Account
statement
S
associate
d for each
Master
Account.
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Chapter 2
Batch Jobs

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
WFP BILLING WTXBIL_ BILLING Yes
BJ 132 0 PROCES
1 SING
WFP DELINQU WTXDLQ DELINQU Yes
ENCY _BJ 132 ENCY
01 PROCES
SING
WFP LATE WTXLTC_ LATE Yes
CHARGE BJ_132 0 CHARGE
1 ASSESS
MENT
WFP STATEME WTXPSG STATEME Yes
NT _BJ 132 NT
01 GENERA
TION
WFP RATE WTXRAT RATE Yes
CHANGE _BJ_132_ CHANGE
01 PROCES
SING
WFP TERMINA WTXTIP_ TERMINA Yes
TION BJ 132 0 TION
1 PROCES
SING
TPE PERIODI TXNPMF PERIODI
C _BJ 100_C
MAINTAI 01 MAINTAI
NENCE NENCE
FEE FEE
PROCES
SING
WFP UNIT WUPPRC UNIT Common
UPLOAD _BJ 132_ UPLOAD
01
ODD2 BATCH CBUUTL_ BATCH
JOB FOR BJ_100 0 JOB FOR
MONTHL 4 MONTHL
Y Y
HANDSO HANDSO
FF FILE FF FILE
FOR FOR
SIMAH SIMAH
PUR PURGE PTTPRC_ PURGE Common

ALLPTT BJ_100_0 ALLPTT
TABLES 1 TABLES
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Table 2-55 (Cont.) Batch Jobs Available
]

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
TPE BATCH TXNMAC BATCH Yes
JOBFOR _BJ 100 JOBFOR
SETTING 01 SETTING
MATURE MATURE
D D
ACCOUN ACCOUN
T T
CONDITI CONDITI
ON ON
TPE NON TXNRFD_ NON Common
REFUND BJ_ 100 0 REFUND
GL 1 GL
PROCES
SING
TPE PAYMENT TXNPAP_ PAYMENT Yes
ARRANG BJ_100_0 ARRANG
EMENT 1 EMENT
PROCES
SING
TPE DELAY TXNDLY_ DELAY Yes
FEE BJ 100 0 FEE
1 PROCES
SING
TPE STATEME TXNSTM STATEME Yes
NT PAST _BJ 100_ NT PAST
MATURIT 01 MATURIT
Y Y
PROCES
SING
TPE BLACK VEVBBK_ BLACK Common
BOOK BJ 100 0 BOOK
INTERFA 1 INTERFA
CE CE
LBT BULK TXNNSF_ BULK
NSF BJ_100_0 NSF
PAYMENT 1 PAYMENT
REVERS REVERS
ALS ALS
ACR STOP TXNACR_ STOP Yes
INTERES BJ_100_0 INTERES
T 3 T
ACCRUA ACCRUA
L L
PROCES
SING
QRT CUSTOM QCSPRC CUSTOM Yes
ER _BJ 100_ ER
SERVICE 02 SERVICE
REAL REAL
TIME TIME
QUEUE QUEUE
PROCES
SING

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 125 of 174



ORACLE’

Chapter 2
Batch Jobs

Table 2-55 (Cont.) Batch Jobs Available
]

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
ODD2 OUTBOU OCPPRC OUTBOU Yes This
ND ~BJ 100_ ND process
CUSTOM 01 CUSTOM generates
ER ER Custome
EXTRACT EXTRACT r
STO STO Payment
PAYMENT PAYMENT File
AGENCIE AGENCIE Extract
s S flle_V\{lth
individual
account
dues or
consolidat
ed dues
at Master
account
level in
column
definitions
ODD2 MASTER OMSPRC MASTER Yes Yes Yes Common This
ACCOUN BJ 100 ACCOUN process
T 01 T generates
CUSTOM CUSTOM Asset
ER ER billing
MOCK MOCK Mock
STATEME STATEME Statement
NT NT s based
GENERA GENERA on
TION TION preferenc
es defined
in
Contract.
IFP OFFLINE ICAPRC_ OFFLINE Yes
CALL BJ 100 0 CALL
ACTIVITY 1 ACTIVITY
POSTING POSTING
ACR RE- TXNACR_ RE- Yes
START BJ_100_0 START
INTERES 4 INTERES
T T
ACCRUA ACCRUA
L L
IFP UPLOAD ITUPRC_ UPLOAD Yes
TRANSA BJ 100 0 TRANSA
CTIONS 1 CTIONS
IFP POST ITUPRC_ POST Yes
UPLOAD BJ_100_0 UPLOAD
ED 2 ED
TRANSA TRANSA
CTIONS CTIONS
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
IFP INPUT ICEPRC_ CURREN Yes Yes Yes Common This
FILE BJ 100 0 CY process
PROCES 1 EXCHAN extracts
SING - GE RATE currency
CURREN FILE exchange
CY UPLOAD rates from
EXCHAN desired
GE RATE source at
FILE scheduled
UPLOAD intervals.
IFP INPUT IDDPRC_ INPUT Yes This
FILE BJ_000_0O DATA process
PROCES 1 INSERTI updates
SING - ON customer
INPUT account
DATA informatio
INSERTI n
ON correspon
ding to
the details
received
from
external
system.
Ex:
Bankruptc
y details
in
External
Interface
screen or
Cure
Letter
details in
Account
Informatio
n screen.
IFP INPUT IPIPRC_B PI Yes Yes Yes Common This
FILE J_100_01 INFORMA process
PROCES TION uploads
SING FILE input file
UPLOAD with PII
PROCES data into
SING the data
masking
screen.
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

IFP INPUT IUHPRC_ ASSET Yes Yes Yes Common This
FILE BJ 100 0 USAGE process
PROCES 1 HISTORY uploads
SING FILE asset
UPLOAD usage
details
into the
system.

Driven
through
Setup >
Data File
tab, when
placed in
correspon
ding
folder and
batch job
is run,
system
processes
the file
and loads
in
External
Interface
s tab.
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

IFP INPUT ICPPRC_ CUSTOM Yes Yes Yes Common This
FILE BJ 100 0 ER process
PROCES 1 PAYMENT uploads
SING FILE customer/

UPLOAD business
based
payment
details
and are
displayed
in
Payment
Entry
screen
with Multi
Account
check box
selected.

The
status of
Payment
batch is
updated
based on
the value
of system
parameter
PMT_BAT
CH_PO
STING
(PAYMEN
T BATCH
POSTING
PREFER
ENCE).

If the
value is
setto P
(POSTED
)
payment
job
request is
submitted
and
payment
is posted.
On
successfu
| posting,
the
payment
record is
available
in
Payment
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

Maintena
nce
screen.

IFP INPUT ISCPRC_ SECURIT Yes This
FILE BJ 100 _0O IZATION process
PROCES 1 POOL reads the
SING FILE Securitiza

UPLOAD tion
upload file
and either
attach or
detach
the
accounts
of the
Pool.

IFP INPUT IADPRC_ ACCOUN Yes This

FILE BJ_100 0 T DUES process

PROCES 1 FILE reads the

SING UPLOAD input file
to derive
future
prorated
dueona
particular
account.
For more
informatio
n refer to
Proration
of Future
Account
Dues
section in
Dashboar
d>
Process
Files.

PUR ARCHIVE PJRPAC_ PURGE Yes Yes Yes Common This
PURGE BJ_100_0 ACCOUN process
JOBSET 1 TS DATA purges

accounts
data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

PUR ARCHIVE PJRPAP_ PURGE Yes Yes Yes Common This
PURGE BJ_100_0 APPLICA process
JOB SET 1 TION purges

DATA applicatio
n data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS

PUR ARCHIVE PJRPGL_ PURGE Yes Yes Yes Common This
PURGE BJ 100 0 GL TXNS process
JOB SET 1 DATA purges

general
ledger
transactio
n data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS

PUR ARCHIVE PJRPPA_ PURGE Yes Yes Yes Common This
PURGE BJ_100 0 POOLS process
JOB SET 1 DATA purges

pools and
its
transactio
ns data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

PUR ARCHIVE PJRPPX_ PURGE Yes Yes Yes Common This
PURGE BJ 100 0 PRODUC process
JOB SET 1 ER TXNS purges

DATA producer
transactio
n data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS

PUR ARCHIVE PJRPTX_ PURGE Yes Yes Yes Common This
PURGE BJ 100 _0 TXNS process
JOB SET 1 DATA purges

account
transactio
n data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS

PUR ARCHIVE PJRPVA_ PURGE Yes Yes Yes Common This
PURGE BJ_ 100 0 VENDOR process
JOBSET 1 ASSIGNM purges

ENTS vendor

DATA assignme
nt data in
archival
tables
based on
the days
defined in
system
parameter
PAC_PUR
GE_DAYS
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

REV1 Revenue REVREC DAILY Yes Yes Yes Common This
Recogniti _BJ_100_ REVENU process is
on job set 01 E used to

RECOGN validate if
ITION Account
PROCES Revenue
SING Recogniti
on Equity
is greater
than or
equal to
Target
Revenue
Recogniti
on Equity
and
update
the
Current
Qualificati
on
Indicator.
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Table 2-55 (Cont.) Batch Jobs Available

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t

REV2 Revenue REVREC MONTH Yes Yes Yes Common This
Recogniti _BJ_100_ END process is
on job set 02 REVENU used to

E validate
RECOGN the status
ITION of
PROCES Account
SING Revenue

Recogniti

on

Qualifier

indicator
and
update
the
following
fields:

e Acco
unt
Reve
nue
Reco
gnitio
n
Qualif
ier
Mont
h End
indica
tor
(after
mont
h end
proce
ssing
)

e Acco
unt
Reve
nue
Reco
gnitio
n
Qualif
ier
Date

. Last
Acco
unt
Reve
nue
Reco
gnitio
n
Qualif
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Producer Cycles

Engine Descripti Batch Descripti Originati Servicing Collectio Product Commen
Type on Job on on n t
ier
Date
SETEVE BATCH EVEPRC BATCH Yes Yes Yes Common This
EVENTS BJ 100_ EVENTS process is
PROCES 01 PROCES used for
SING SING BATCH
EVENTS
PROCES
SING for
the
Entities
Account/
Applicatio
n/Assets.
SETEVE2 EVENTS EVEPRC BATCH Yes Yes Yes Common This
PROCES _BJ_100_ EVENTS process is
SING 03 PROCES used for
FOR SING BATCH
CUSTOM (CUSTOM EVENTS
ER AND ER AND PROCES
BUSINES BUSINES SING for
S S the
ENTITIES Entities
) Customer/
Business/
Vendors/
Producers

2.11 Producer Cycles

The Producer setup screen enables you to define the dealer or producer status cycle. This tells
the system which status a producer can cycle through. (This information is recorded in the
Status field on the Producers section of the Producer setup screen.

For example,
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Figure 2-23 Producer Cycle

[ACTIVE

| TEMPORARY | |INACTIVE

The Producer Setup screen also defines the user responsibilities capable of changing the
producer status.

® Note

The system enables only producers/dealers with a status of ACTIVE to fund contracts.

To set up Producer Cycles

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Producer Cycles.

2. The system displays the Producer Cycles screen. The producer cycle screen contains
three section:

e Cycle Definition
e Current/Next Status

e Status Change Responsibilities
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Figure 2-24 Producer Cycles
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3. Inthe Cycle Definitions section, you can view the following information.

Table 2-56 Cycle Definitions
___________________________________________________________________________________|

Field View This
Cycle Displays the cycle name.
Type Displays the cycle type.

4. In the Cycle/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-57 Cycle/Next Status
|

Field Do this

Current Code Select the current code from which you need to
perform transition, from the drop-down list.

Next Code Select the code to which you need to perform

transition, from the drop-down list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Status Change Responsibilitiess section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 2-58 Status Change Responsibilities

|
Field Do this

Responsibility Code Select the responsibility that will be capable of
executing this transition, from the drop-down list.
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Table 2-58 (Cont.) Status Change Responsibilities

|
Field Do this

Allowed Indicator Check this box to enable the responsibility to
execute the transition.

2.12 Vendors

During the life of an account, a financial institution might require the use of specialized services
of a vendor for various purposes; for example, repossessing a vehicle, retaining an attorney for
bankruptcy court proceedings, or making field calls. With the system’s Vendors screen, you
can define the following:

e Cycles Tab
¢ Vendor Services Tab

« Vendor Fees Tab

¢ Invoice Rules tab

2.12.1 Cycles Tab

The Cycle link allows you to define the various vendor cycles and the responsibilities that can
gain access to the various transactions in each cycle. The different categories are:

e You can define vendor status cycle and restrict the status change based on responsibility.

Figure 2-25 Vendor Status Cycle

ACTIVE ~—|NACTIVE

* You can define vendor invoice status cycle and restrict the status change based on
responsibility.

Figure 2-26 Vendor invoice status cycle

MEWY ——=\OPERN —————Zal| OEE

* You can define vendor assignment status cycle and restrict the status change based on
responsibility.

Figure 2-27 Vendor assignment status cycle
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You can define vendor invoice payment status cycle and restrict the status change based
on responsibility.

Figure 2-28 Vendor invoice payment status cycle
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To set up the vendor cycles

1.

Click Setup > Setup > Administration > System > Vendors > Cycles. The screen
contains three sections:

e  Status Cycle
e Current/Next Status

e Status Change Responsibilities

Figure 2-29 Vendor cycles
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In the Status Cycle section, perform any of the Basic Operations mentioned in Navigation

chapter.
A brief description of the fields are given below:

Table 2-59 Status Cycle
|

Field View this

Cycle Specify the status cycle for the vendor.

Type Displays the type of vendor assignment status
cycle.

Order Type Select the work order type for the vendor from

the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Current/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Table 2-60 Vendor cycles
|

Field Do this

Current Code Select the current code from which you need to
transition, from the drop-down list

Next Code Select the Next status code to which you need to
transition, from the drop-down list

Action Code Select the call activity action code from the drop
down list.

Result Code Depending on the call activity action code, you
can select the result code from the drop down
list.

® Note

When there is a change in status from Current to Next, system posts respective
call activity on the account based on selected Action and Result code.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Status Change Responsibilities section, perform any of the Basic Operations
mentioned in Navigation chapter:
A brief description of the fields is given below:

Table 2-61 Status Change Responsibilities

|
Field Do this

Allowed Select Yes to enable the responsibility to execute
the transition and No to disable

Responsibility Select the responsibility that will be capable of
executing this transition (from current code to the
next code), from the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

2.12.2 \Vendor Services Tab

The Vendor Service screen enables you to establish the links between the service type, vendor
group, and the work order type. It records which vendor groups can provide which type of
services and which service type belongs to which work order types.

For each service type (Service Type field), there can be multiple vendor groups and/or multiple
work order type(s).Each vendor (Group field) can belong to one or multiple vendor group(s).

Click Setup > Setup > Administration > System > Vendors > Vendor Services. The
screen contains three sections:

e Services
e Vendor Groups

e Work Order Types
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Figure 2-30 Vendor Services
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In the Services section, you can view the following information:

Table 2-62 Services

|
Field View this

Service Type Displays the service type.

Enabled Displays if the service is enabled or not.

In the Vendor Groups section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-63 Vendor Groups

|
Field Do this

Group Select the vendor group from the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Work Order Types section, perform any of the Basic Operations mentioned in
Navigation chapter:
A brief description of the fields is given below:

Table 2-64 Work Order Types

|
Field Do this

Select the work order type from the drop-down
list.

Select the associated transaction for the service
type from the drop-down list.

Work Order Type

Transaction

Perform any of the Basic Actions mentioned in Navigation chapter.
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2.12.3 Vendor Fees Tab

The Vendor Fees tab allows you to define fee structure (with specific amount) for each service
offered by specific vendor. The defined fees is auto populated as the estimated cost of the
assignment when a specific vendor and service is selected during work order creation.

To define vendor fees

1. Click Setup > Setup > Administration > System > Vendors > Vendor Fees. The screen
consists of Vendor Service Fee Definition section with option to define vendor fees.

Figure 2-31 Vendor Fees
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2. Inthe Vendor Service Fee Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 2-65 Vendor Service Fee Definition
]

Field Do this

Start Dt System defaults the current date as the start
date. You can modify the same to a future date
using the adjoining calendar.

End Dt Specify the end date from the adjoining
Calendar.

Enabled Select the check box to enable the fee structure.

Amt Specify the amount charged by the vendor for a

specific service.

Selection Criteria

Vendor Group Select the vendor group from the drop-down list.
You can also select ALL (default option) if the fee
structure is applicable across vendor groups.
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Table 2-65 (Cont.) Vendor Service Fee Definition

|
Field Do this

Vendor Select the vendor from the drop-down list. You
can also select ALL if you have selected the
Vendor Group as ALL. The listis sorted
depending on the vendor group selected.

Services Select the service from the drop-down list. The
list is sorted depending on the services offered
by the selected Vendor.

Company System defaults this value based on the vendor
selected. You can also select the required
company from the drop-down list.

Branch System defaults this value based on the vendor
selected. You can also select the required branch
from the drop-down list.

Vendor Channel System defaults this value based on the vendor
selected. You can also select the required vendor
channel from the drop-down list.

State System defaults the state in which the vendor
operates. You can also select the state from the
drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.12.4 Invoice Rules tab

The Invoice Rules tab allows you to define state specific rules with a combination of service
and work order status. This helps to decide if a particular service fees in a work order is
Collectable or Not from the customer.

When the same combination of service, work order status and state is detected during auto
invoice validation, the Collectible check box in Vendors > Invoice tab > Invoice Details section
is selected. Further, the collectible amount is posted as an expense on the customer account.

To define invoice rules
1. Click Setup > Setup > Administration > System > Vendors > Invoice Rules.

2. Inthe Invoice Rules section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 2-66 Invoice Rules

|
Field Do this

Service Select the service from the drop-down list. The
list consists of services offered by Vendors which
can be associated with a work order.

Work Order Status Select the work order status from the drop-down
list.
Close Reason Select the close reason from the drop-down list.

This field is enabled only if the work order status
is selected as CLOSE.
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Table 2-66 (Cont.) Invoice Rules

|
Field Do this

State Select the state from the drop-down list. The
selection here indicates that the state rules allow
to collect the service fee for selected service
from the customer.

Enabled Select the check box to enable the invoice rule.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.13 Reports

The Reports screen allows you to setup reports in the system.

To set up the Reports

1. Click Setup > Setup > Administration > System > Reports link. The system displays the
Report screen. The details are grouped into two:

*  Reports

*  Report Parameters

2. Inthe Reports section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 2-32 Reports
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A brief description of the fields is given below:
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Table 2-67 Reports
|

Field Do this

Code Specify the code of the report.

Description Specify the description of the report.

Package Specify the package.

Module Select the code of the report from the drop-down
list.

System Defined Yes/ No Select Yes, if you wish to maintain the Report as

system defined and No, if you do not want to
maintain it as system defined. System defined
entries cannot be modified. If the entry is not
system defined, then it can be modified.

Enabled Check this box to enable the report definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Report Parameters section,perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 2-68 Report Parameters
|

Field Do this

Parameter Specify the parameter code of the report.
Description Specify the description of the parameter.
Parameter Type Select the parameter type of the report from the

drop-down list.

Parameter Sub Type Select the parameter sub type of the report from
the drop-down list.

Default Specify the default value for the report parameter
(value to initially populate, or used if no value is
supplied) (optional).

Sort Specify the sort order for the look up code. This
determines the order these report parameters
are displayed or processed.

Enabled Check this box to enable the report definition.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14 Error Messages

In the Error Messages Setup screen, you can translate or modify the text of error messages.
the system displays all messages as they appear to the system users in the Error Message
section’s Message field.

New messages created with the Error Messages screen can then be translated with the Setup
> Setup > Administration > System > Translation > Message Translation screen.

To set up the Error Messages Setup screen

1. Click Setup > Setup > Administration > System > Error Messages. The system
displays the Error Message screen.
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2. Onthe Error Messages Setup screen’s Error Type section, use the Error Type field to
select the error type. These are the categories of error messages available for creating or
editing.

3. The error messages associated with the error type you selected appear in the Error
Message section.

4. Inthe Error Messages section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 2-33 Error Messages
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A brief description of the fields is given below:

Table 2-69 Error Messages

|
Field Do this

Region Specify the region code.
Country Specify the country code.

Customer Specify the customer code.

Engine Specify the engine code.

Error Code Specify the error code.

System Defined Displays whether the record is system defined or
not.

Enabled Check this box to enable the data error message.

Error Message Specify the error message.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.15 Translation

You can setup translation properties.

Navigating to Translation

1. Click Setup > Setup > Administration > System > Translation. The system displays the
Translation screen.

2. Inthis screen you can Setup Translation and Translate Error Messages in the following
tabs:

e Setup Translation

« Message Translation Setup

2.15.1 Setup Translation

In the Setup Translation tab, you can translate the contents of a predefined list of setup
description fields into a different language.

After you translate an entry in the Translation Data section, the system adds the new data to
the setup form.

To set up the Translation Setup
1. Click Setup > Setup > Administration > System > Translation > Setup Translation.

2. Inthe Language section, you can select the language for which you need to setup the
translation.

Figure 2-34 Translation Setup
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@® Note

For more information, refer Language setup at the end of this chapter.

3. Inthe Source Type section, you can select the source (or location in the system) of the
item you want to translate.

4. Click Populate All in the Source Type section and the system loads the setup data
descriptions in the Translation section screen for the selected source type.
If you have new entries and are unsure as to which setup items have been updated since
the last translation, click Populate All, the system loads the additional data for all items
with no impact to the previously translated data for any of the entries.

5. In the Translation Data section, Select:

e All —to view all the records (both translated and un-translated) in the Translation Data
section.

* Translated — to view all the translated records in the Translation Data section.
 Un Translated — to view all the un-translated records in the Translation Data section.

6. Inthe Translation Data section, perform any of the Basic Operations mentioned in
Navigation chapter.

@® Note

You cannot add a new record.

A brief description of the fields is given below:

Table 2-70 Translation Data
|

Field Do this

Key 1 Displays the first reference key value.

Key 2 Displays the second reference key value.

Key 3 Displays the third reference key value.

Key 4 Displays the fourth reference key value.

Key 5 Displays the fifth reference key value.

Key 6 Displays the sixth reference key value.
System Defined Select Yes, if you wish to maintain the data as

system defined and No, if you do not want to
maintain it as system defined.

Enabled Check this box to indicate that the record is
active.

Desc 1 Translation 1 Specify the first translated description.

Desc 2 Translation 2 Specify the second translated description.

Desc 3 Translation 3 Specify the third translated description.

Desc 4 Translation 4 Specify the fourth translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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In the Message Translation tab, you can translate the contents of a predefined list of error
messages into a different language.

After you translate an entry in the Error Message section, the system adds the new data to the

error message.

To set up the Message Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Message Translation.

2. Inthe Language section, you can select the language for which the translation needs to

be done.

Figure 2-35 Message Translation Setup
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@® Note

For more information, refer Language setup at the end of this chapter.

3. Inthe Error Type, you can select the type of error message you want to translate.

4. Click Populate All in the Error Type section and the system loads the error messages in
the Error Message section for the selected error type.
If you have new entries and are unsure as to which error messages have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. Inthe Error Message section, select:
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*  All —to view all the records (both translated and un-translated) in the Error Message

section.
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* Translated — to view all the translated records in the Error Message section.

* Untranslated — to view all the un-translated records in the Error Message section.

6. Inthe Error Message section, perform any of the Basic Operations mentioned in

Navigation chapter.

® Note

You cannot add a new record.

A brief description of the fields is given below:

Table 2-71 Error Message
|

Field Do this

Region Displays the region code.
Country Displays the country code.
Customer Displays the customer code.
Engine Displays the engine name.
Error Code Displays the error code.

System Defined

Check this box to indicate that the record is
system defined.

Enabled Check this box to indicate that the record is
active.
Message Specify the error message.

English Translation

Specify the English translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Language setup

On the Lookup master tab’s Lookup Types screen, you can add other languages to the
TRD_LANGUAGE_CD lookup type and perform translations for those languages.

However, translated data only appears in one language, which is defined by the User

Language parameter. This parameter can be defined in the system configuration file, typically

named DBKWEB. CFG, which defines the parameter as:

Parameter: otherparams=0RA_USER=<schema_name> USR_LANG=<native language>

@® Note

<native language> should match lookup codes in the TRD_LANGUAGE_CD lookup
type on the Administration form’s Lookups screen.

The system supports the following pre-defined list of setup items for translation:

1. Asset Sub Types
2. Asset Types
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11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24,
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.
40.

Assignments

Audit Table Columns
Audit Tables

Call Action Result Types
Call Action Types
Checklist Action Types
Checklist Types

. Commission Plans

Companies

Company Branch Departments
Company Branches
Compensation Plans

Credit Bureau Score Reasons
Credit Models

Credit Scoring Parameters
Edits

Escrow Disburse Rules
Escrow Sub Types

Flex Table Attributes

Flex Tables

GL Transaction Types

GL Translators

Job Sets

Jobs

Lookup Codes

Lookup Types

Portfolio Companies

Portfolio Company Branches
Producers

Product Instruments

Product Insurances

Product Pricings

Products

Promotions

Spreads

Standard Correspondences
Standard Document Definitions

Standard Element Definitions
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41. Standard Function Definitions
42. Transaction Codes
43. Error Messages

44. Org. Fees

2.16 Label Configuration

The Label Configuration screen facilitates for field label customizations to modify the default
field’s label which are provided as part of seed data during product installation / upgrade. Using
this screen, you can modify the field’s User Defined Label, update Tool tip, set Default Value (if
required), set display (Y/N) option and enable / disable the field. The changes done here are
populated to respective screen in the application.

® Note

e Label configuration is controlled by the value defined for system parameter
UIX_CUSTOM_LABEL_ENABLED_IND and indicates whether configurable option
is enabled or not.

e Also the Update button in Label Configuration screen is enabled only if
UIX_CUSTOM_ LABEL_ENABLED_IND is setto Y.

Field in the Ul are categorized into two types:

* Base fields - these are default fields in the Ul consisting of both mandatory and non-
mandatory fields.

« User Defined Fields - these are additional fields provided in disabled status which can be
enabled and customized as required.

Note the following:
e Configuring field details is only an optional functionality and has to be used sensitively.

*  Field customizations are to be done cautiously and is recommended to be performed by
someone who is well-versed with the product. For example, label change of a particular
field is to be done at both Section and Header block to avoid inconsistency.

e Field customizations are to be performed at your sole discretion and OFSLL is not
responsible for any impact/damage/mismatch in the data being represented or resulting
out of this change.

The Label Configuration screen displays all the Base and User defined fields provided for the
below listed screens and its sub tabs. Apart from base fields, there are additional User
Defined Fields provided with the below combination in disabled status.

10 free text fields - User Defined Field Char
¢ 30 numeric fields - User Defined Field Num

e 10 date fields - User Defined Field Date

List of screens enabled with the above User Defined Fields for configuration:
e Producer Screen

e Customer Service > Checklists > Checklist Types, Action - Regular sub tab, and Action -
Document sub tab.
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e Customer Service > Correspondence > Correspondences sub tab, Documents sub tab,
and Document Elements sub tab.

e Customer Service > Letters

e Customer Service > Collateral

e Customer Service > Account Details

e Servicing > Collateral Management > Collateral Details

e Conversion Accounts > Account Boarding > Collateral and Account Details sub tab

*  Origination > Underwriting > Bureau > Report Header sub tab and all 10 sub tabs

® Note

The corresponding web services are also enhanced to include the User Defined
Fields. Refer to swagger web service release documentation available in OTN library
(https:// docs.oracle.com/cd/F22291_01/webservice.htm).

Ensure that the field(s) for which label changes are to be done is enabled in the Ul from
Access setup screen. For more information, refer to Field Access Definition section.

You can update the field properties for all the user defined fields. For Base -non mandatory
fields, you can set the display (Y/N) option, define as mandatory / non mandatory and enable
or disable the same in UL.

The below table indicates the supported field update options based on field type.

Table 2-72 The supported field update options based on field type
]

Parameter Base Field User Defined Field Comment

Label change Allowed to modify Allowed to modify

Data Type Not allowed to modify -  Not allowed to modify -  Default data type
Display only Display only supported by the field

Default Value Allowed to modify Allowed to modify No default value

Required Not allowed to modify Allowed to modify

Display (Yes/ No) Allowed to modify for Allowed to modify for Cannot modify
non-mandatory fields non-mandatory fields mandatory Base field

The Label Configuration screen displays the field records based on specific combination of
Language and Division. By default the combination is set to ALL and can further be filtered
by selecting required combination from respective drop-down list.

Note that the Label Configuration done for a specific division (for example US01) is displayed
to those users who are mapped to the same division (US01). Else, the default labels defined
for ALL division is displayed.

After updating the required changes in Label Configuration screen, you need to logout and
relogin for changes to appear in respective Ul. This is basically to refresh session cache and
fetch the updated field information from database server. Though, there is Update option,
clicking on the same only refreshes the cache and reloads the record.

To customize Label Configuration

1. Click Setup > Setup > Administration > System > Label Configuration.
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Figure 2-36 Label Configuration
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* Default Value 0

2. Tofilter the records in Label Configuration section, select the required combination of
Language and Division from the drop-down list and click Load.

3. Select the required record and click Edit. You can also perform any of the Basic
Operations mentioned in Navigation chapter.
While looking for a specific field to customize, you might notice multiple records with similar
data since one record is populated in section and other on header. Carefully differentiate
and select the required record for update.

A brief description of the fields is given below:

Table 2-73 Label Configuration

|
Field Do this

Language View the language category of the field.
Division View the division category of the field.

Object Type View the type of object category of the field such
as Tab / Field / Button / Header / Sub header.

Object Name View the object name maintained in database.
Field Name View the field name maintained in database.

User Defined Label Specify the field label name to be updated in the
ul.

Tooltip Enter the tooltip indicating the type of value to be
populated for the field. The same is displayed on
mouse over.

Default Value Specify the default value to be populated in Ul.

Based on field type, the default value set to
UNDEFINED for varchar, 0 for Number, and
system date for Date.

Required Check this box to mark the field as mandatory for
input in UL
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Table 2-73 (Cont.) Label Configuration

|
Field Do this

Display (Yes /No) Check this box to display the field in Ul. By
default, the same checked for Base - non
mandatory fields.

Note: Option defined here takes precedence with
the display (Y/ N) option selected in Setup >
Administration > Access > Screen > Field Access
Configuration tab.

System Required Y indicates the field is system required and other
parameters such as Required, Display, and
Enabled options are disabled.

N indicates the field is user configurable.

Enabled Check this box to enable the field and apply the
label configuration changes on save.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Click Update. System refreshes the cache automatically and fetches the updated field
details from database server to display in header section.

2.17 Seed Data

Seed data in general is referred to as any data delivered with the standard product installation
and is required to be present in the production environment for application to work properly.
Seed data basically consists of Table with its associated data that are uploaded into the system
through DAT files.

Seed Data screen in Oracle Financial Services Lending and Leasing displays the seed data
details maintained in the system along with the updated seed data provided with the latest
release or patch installation.

Note that, when you upgrade OFSLL from an existing version to higher version,
* New seed data provided as part of that release is automatically updated into the system.

» Seed data which are modified from previous release to current release needs to be
manually accepted and updated into the system.

The modified seed data can have updates on base tables and/or its associated data and the
changes can either be updated or skipped depending on the need.

Navigating to Seed Data screen

1. Click Setup > Setup > Administration > System > Seed Data. The system displays the
Seed Data screen.

2. On this screen you can do the following:

* View the factory shipped seed data and update/skip the seed data differences between
existing and updated seed data in Factory Data tab.

*  View the customized (i.e. changed or configured) seed data as part of implementation
in Current Data tab.

* View the differences between Factory data and Current data in Comparison Data tab

« Download all or only the required table specific seed data in Download Data tab.

This section consists of the following topics:
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¢ Current Data

Comparison Data

« Download Data

2.17.1 Factory Data

Chapter 2
Seed Data

The Factory Data tab displays the list of both existing and updated seed data which are
provided though release/patch installation. In the Factory Data tab you can select and update
only the required seed data changes into the respective seed data tables. During update, you
can also skip the seed data changes for later updates (if required).

Accordingly, you can sort the view in Factory Data tab by selecting Skipped, Update or All
options to display the list of corresponding seed data.

In the Patch # drop-down list, you can further sort the list to display ALL the seed data or only
the additions or updates available as part of latest patch which has seed data changes.

To View Factory Data

Click Setup > Setup > Administration > System > Seed Data > Factory Data tab.

Figure 2-37 Seed Data_Factory

Financial Services Lending and Leasing
@ SeedData [ Close
FactoryData | CurrentDats | Comparison Data
> DashBoard
> Origination Factony Data Blyew
— VWARNING: INSERT will insert the new setup data and URDATE wil moify existing setup data. Please give careful consideration before changing, it might affect system behavior,
> Servicing © Insert© Update © Al
> Collections Vew v Fomatv [ Freeze i Detach ] Wrap ) Path: AL (=
> WFP &
> Tools Table Type Key Column Key Column Type  Other Calumns Other Column Types Count.
setup FLEX_TABLE_ATTRIBUTES COMBINATION... FTA_FTB_.. VARCHAR2|VARC... FTA_SORT|FTA_D... NUMBER|VARCHAR2|VARCHAR?|VARCHAR 2|VARCHAR 2INUMBER [VARCHAR 2VARCHAR2|VA... 28
085 COMBINATION... JOB_JBS_.. VARCHAR2|VARC... JOB_SORT|IOB_R.. NUMBER|VARCHAR2|VARCHARZ|VARCHARZ|VARCHAR 2]VARCHAR 2 |[VARCHAR 2|VARCHAR?] .. 1
Reparts 08_SETS COMBINATION... JBS_CODE VARCHARZ JBS_DESC|JBS_EN... VARCHARZ|VARCHAR 2[VARCHARZ[VARCHARZIVARCHAR 2|VARCHARZ|VARCHAR 2IDATEIDA... 3
Error Messages bl
Translations
e Factory Data Details Bl vew
User =
View ¥ Format ™ Fresze Detach urap
Organization E = = @
Comparies L 4
Access Select [F]
W Key Column Data Other Column Data
Users .
Credit Bureau Tl seTGRIT GRI INTERFACE JOBS|Y|ROOTIALWAYS|DAL Y [DAILY |COMPLETED 05/01/2016 10:00:00{08/08/2016 10:00:18[08/09/2003 10:00:00N
Correspondence [l sereri2 ‘GET CASE UPDATES WEBSERVICE TRIGGERINGIY |ROCT JALWAYS [MINLITE| 30MIN |COMPLETED [05/0/2016 10:00:00|08/08/2016 10:00: 18108/09/2016 10:00:00IN
General Ledger [l SETvEN VENDOR ASSIGNMENT ALLOCATION PROCESSING IV IROCT IALWAYS IDALLY IDAILY ICOMPLETED05/0 1/20 16 10:00:00108/08/2016 10:00: 18108/05/2003 10:00:001N
Queves « m v
Printers
Bank Detals -

The Factory Data section displays the list of seed data with the following details:

Table 2-74 Factory Data

Field View this

Table Displays the seed data table name.

Type Displays the category of seed data as either
System or Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type

Displays the unique identifier column data types.

Other Columns

Displays the non unique identifier column names.
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Table 2-74 (Cont.) Factory Data
]

Field View this

Other Column Types Displays the non unique identifier column data
types.

Count Displays the total count of updated records in the

seed data table.

The Factory Data Details section displays the associated data of the selected seed data table
along with the following details:

Table 2-75 Factory Data Details
]

Field View this

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch number with which the seed
data changes are identified.

Status Displays the current status of seed data as one of
the following:

INSERT: This status indicates new seed data.
UPDATE: This status indicates if there are changes
in the record when compared to the seed data
released in previous patch.

POSTED: This status indicates that the seed data
changes are updated into the main tables and is
subsequently updated from previous status -
SKIPPED OR UPDATE OR INSERT.

SKIPPED: This status indicates that the seed data
is not updated into the main tables

DEPRECATED - This status indicates that the seed
data is no longer used.

In the Factory Data tab, you can click L& (refresh) to fetch the latest details and click View to
display the detailed information of the selected record.

This section consists of the following topic:

* Update/Skip Seed Data

2.17.1.1 Update/Skip Seed Data

The Update option in the Factory Data tab allows you to replace the existing seed data with
the current update. However, ensure to double check the details before performing Update
operation since the same can have significant impact on system behaviour.

To Update/Skip Data

1. Inthe Factory Data tab, select Update. System displays those records which can be
updated to the existing seed data tables.

2. Inspect the required record in Factory Data section with the Factory Data Details in
subsequent section.
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3. Select the required record to be updated by clicking on the adjacent check box. You can
also click Select All to select all the records.

4. Do one of the following:

« Click Update Data. This action updates the existing seed data with the updated seed
data provided as part of the current patch release.

«  Click Skip Data. This action skips the seed data changes received as a part of the
patch release. The skipped records can be viewed by selecting Skipped option in
Factory Data tab. However, the same can further be updated into the system, by
selecting Update Data.

5. Click Yes in confirmation dialog to confirm the setup data changes.
On successful update, system does the following:

*  When individual records are selected and updated, the same is removed from Factory
Data Details section and the Count column in Factory Data section is updated with the
remaining number of records.

* In case of Bulk update, the record is removed from Factory Data tab.

2.17.2 Current Data

The Current data tab displays the customized seed data which are changed or configured as

part of implementation. In the Current Data tab, you can click L2 (refresh) to fetch the latest
details and click View to display the detailed information of the selected record.

Additionally you can click Refresh Data to pull the seed data details from the production
system and update the current seed data tables.

To View Current Data

Click Setup > Setup > Administration > System > Seed Data > Current Data tab.

Figure 2-38 Seed Data_Current
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The Current Data section displays the following details:
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Table 2-76 Current Data

|
Field View this

Table
Type

Displays the current seed data table name.

Displays the category of seed data as either
System or Combination Data.

Displays the unique identifier columns.
Displays the unique identifier column data types.
Displays the non unique identifier column names.

Key Column
Key Column Type
Other Columns

Other Column Types Displays the non unique identifier column data
types.
Displays the total count of records in the seed data

table.

Count

Last Refreshed Dt Displays the date and time when seed data for the

selected table was last updated in the system.

The subsequent Current Data Details section displays the associated data of the selected
seed data table along with the following details:

Table 2-77 Current Data Details

|
Field View this

Key Column Data
Other Column Data

Displays the unique identifier column names.

Displays the non unique identifier column names.

2.17.3 Comparison Data

The Comparison Data tab displays the differences between factory shipped seed data and
current customized seed data.

To View Comparison Data

Click Setup > Setup > Administration > System > Seed Data > Comparison Data tab.

Figure 2-39 Seed Data_Comparison
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The Comparison Data section displays the list of seed data records with the following details:

Table 2-78 Comparison Data
]

Field View this

Table Displays the seed data table name to be inserted
or updated.

Type Displays the category of seed data as either
System or Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data
types.

Count Displays the total count of records in the seed data
table.

The subsequent Comparison Data Details section displays the associated data of the
selected seed data table along with the following details:

Table 2-79 Comparison Data Details
]

Field View this

Key Column Data Displays the unique identifier column names.
Other Column Data Displays the non unique identifier column names.
Patch # Displays the patch release version with which the

seed data was inserted/updated.

In the Comparison Data tab, you can click L@ (refresh) to fetch the latest details and click
View to display the detailed information of the selected record.

2.17.4 Download Data

The Download Data tab allows you to download table specific seed data available in the
system in . dat format. While migrating from one environment to other, you can use the
Download Data tab to download the existing seed data and perform a bulk upload of all/
required files.

Similar to other file download process, based on the value defined for the system parameter
CWN_FI LE_PROCESS TO LOB, the seed data download file can be accessed from the
Process Files interface (if value is Y) or Database Files system (if value is N). For more
information on handling Incoming/Outgoing process files, refer to Dashboard section in User
Guides.

To Download Data

1. Click Setup > Setup > Administration > System > Seed Data > Download Data tab.
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Figure 2-40 Seed Data_Download
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The Download Data section displays the list of tables maintained in the system with Table
Name and Table Type. Click L2l (refresh) to fetch the latest details.

2. Select the check box adjacent to the required table in the list. You can choose Select All
check box to select all the tables with seed data maintained in the system.

3. Click Submit For Download button. System displays an information message in the
header indicating that the request has been submitted along with a reference number. The
reference number is generated in format - useridDDMMHHMISS# followed by table name
with . dat extension. For example, (USER1230603121517#] ookups. dat)

4. (Optional) If CMN_FI LE_PROCESS TO LOBiis set to Y, navigate to DashBoard > Process
Files screen > Outgoing Process File tab to download the selected seed data file which will
be listed with the same reference number. The file can be downloaded to Application
server.

2.18 Data Masking

Data masking screen in Oracle Financial Services Lending and Leasing facilitates to mask
Personally Identifiable Information (PII) displayed in the application to safeguard the sensitive
and confidential information while protecting them from offenders.

As part of the product installation, standard set of identified fields (seed data) which is likely to
contain either organization / customer PI information are provided for data masking in disabled
status. Based on need, the required fields can be enabled and masked for specific user
responsibility in the Data Masking screen. Also if there are additional Pl fields identified for
masking, the same can be pooled into the system using input file processing method and
masked using Data Masking screen.

The data masking process involves the following steps:

« ldentify and enable field(s) (seed data) to be masked

e Select user responsibility for whom the data has to be masked
»  Execute batch job to create data redaction policy

e Compile the data redaction policy

* (Optional) Process user identified PII data for masking.
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The following table indicates the standard pre-defined fields (seed data) identified in respective
screens/tabs which can be readily masked using the Data Masking screen.

Table 2-80 Data Masking

Tab Name Field Names
Origination
Applicant First Name, MI, Last Name, Family Name, Birth Dt,

Nationality, National ID, Visa #, Passport #, License
#, Marital status, Mother's maiden name, Passport
number, Gender, Language, Dependents, Ethnicity,
Disability, Email, Race, and Education.

Applicant > FATCA

Birth Place, Birth Country, and Permanent US
Resident Status.

Applicant > Power of Attorney

Holder Name, Address, Country, Nationality, and
Telephone Number.

Applicant

Active Military Duty, Military Effective Date, Duty
Order Number, and Active Military duty Release
date.

Addresses

Country, Postal Address Type, Address #, Street
Pre, Street Name, Street Type, Street Post, Apt #,
Address 1, Address 2, Address 3, Zip, Zip Extn,
City, State, and Phone.

Telecoms

Phone and Extn

Employments

Employer, Country, Address #, Address 1, Address
2, Zip, Zip Extn, City, State, Phone, Extn, Income
Amt - Stated, Income Amt - Actual, Salary - Stated,
Salary - Actual, and Title.

Applicant > Financials

Type, Source, Account #, and Currency.

Existing Accounts

Account # and Title.

Servicing

Customer

Name, Birth Dt, Nationality, National ID, Visa #,
Passport #, License #, Marital status, Mother's

maiden name, Passport #, Language, Disability,
Email, and Education.

Customer > FATCA

Birth Place, Birth Country, and Permanent US
Resident Status.

Customer > Power of Attorney

Holder Name, Address, Country, Nationality, and
Telephone Number.

Customer Active Military Duty, Military Effective Date, Duty
Order Number, and Active Military duty Release
date.

Addresses Country, Postal Address Type, Address #, Street

Pre, Street Name, Street Type, Street Post, Apt #,
Address 1, Address 2, Address 3, Zip, Zip Extn,
City, State, Phone, and Address.

Employments

Employer, Country, Address #, Address 1, Address
2, Zip, Zip Extn, City, State, Phone, Extn, and Title.

Assets tab

Assets

Identification #, Lien Status, Lien Event Date,
Second Lien Holder, Comments, Lien Release
Entity, and Entity Name.

Masking Format
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Oracle Financial Services Lending and Leasing supports only complete masking (not partial) of
both factory shipped and user identified PIlI data. On masking, the masked data is presented in
same structural format to facilitate internal validations. The below table indicates the default
values used for masking fields based on data type:

Table 2-81 Masking Format
|

Data Type Masking Value

NUMBER 9

VARCHAR X

DATE 31/12/9999

Phone number For Ul represented format - 000-000-0009 (Masked

with 0’s and last digit as 9) and for generic, masked
as 9999999999

Email XXXXX.XXX@<domain>.com

® Note

It is recommended to avoid modifying masked data for user(s) with masked
responsibility. However, while editing masked data (if permitted) requires to input full
data replacing the masked characters. For example, editing a masked SSN
(xxx.xx.xxxx) requires to specify all nine digits of SSN and not just the last four digits.

This section consists of the following topics:

*  Setup Data Masking

»  Create data redaction policy

*  Masking User defined data

2.18.1 Setup Data Masking

1. Click Setup > Administration > System > Data Masking.

2. Define the parameters available in following tabs.

« Data Masking Details

e User Access Detalils

2.18.1.1 Data Masking Details

On clicking Data Masking link, the Data Masking Details tab is displayed by default and allows
you to enable the required fields for masking.
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Figure 2-41 Data Masking Details
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1. Inthe Data Masking Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields are given below:

Table 2-82 Data Masking Details
___________________________________________________________________________________|

Field Do this

Table Name View the table name which contains the selected
field details.

Field Name View the selected field name.

Enabled Check this box to enable masking of the selected
field.

System Defined View the type of seed data maintained in the

system. Y indicates factory shipped seed data
and N indicates user defined seed data.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.18.1.2 User Access Details

The User Access Details tab facilitates to define the user responsibility to whom the PII data
should be masked. By default, all the selected PII data in Data Masking Details tab appears as
masked for one or more user(s) selected in this tab.

1. Click Setup > Administration > System > Data Masking > User Access Details.
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Figure 2-42 User Access Details
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2. Inthe User Access Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields are given below:

Table 2-83 User Access Details
|

Field Do this

Responsibility Select the user responsibility from the drop-down
list.

Masked Check this box to enable masking for the

selected user.

Note: Defining a user and not selecting the
masked check box will only create the record and
masking rules are not applied.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.18.2 Create data redaction policy

Once the data masking details are defined and stored in the database, you need to create a
data redaction policy which facilitates for field level masking while displaying the details to the
respective user. A data redaction policy file contains the policies on the columns enabled in the
Data Masking Details screen.

To create data redaction policy

Click Setup > Administration > System > Batch Jobs and execute the following batch job (in
single thread mode only):

Table 2-84 Create data redaction policy

. _________________________________________________________________________________|
Set Code Description Job Code
SET-RED POLICY CREATION FOR REDPRC_BJ_100_01

PERSONAL IDENTIFIABLE
INFORMATION DATA

This batch job can either be scheduled for regular run or executed on-demand and facilitates to
generate data redaction policy picking only the enabled data masking field information from
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database. On every run, the batch job drops and re-creates new set of policies in the file based
on the details updated in Data Masking Details screen.

The generated policy is either written into CLOB or sq| file depending on the following option:

e if the value of system parameter CMN_FI LE_PROCESS TO LOBis setto Y, the policy file
is generated in CLOB and can be accessed by navigating to DashBoard > Process Files
screen. For more information on handling Incoming/Outgoing process files, refer to
Dashboard section in User Guides.

e If the value of system parameter CMN_FI LE_PROCESS TO LB is N, the policy is
generated as an sq|l file and stored in the repository path as defined in the system
parameter - CMN_SERVER_ HOVE. For example, / scrat ch/ OFSLL/ <r el ease>/ sql .

Further, the policy file needs to be manually compiled into database schema to apply the
masking rules for respective fields for that particular user. Either a system administrator or any
other user having administration privileges needs to compile the policies in the database.

@® Note

For every change in the data masking details such as masking additional fields or
unmasking / disabling masked fields, a new policy is to be created by executing the
batch job.

2.18.3 Masking User defined data

Apart from factory shipped seed data, additional user identified PIl data can be masked by
uploading an input file with field details and processing it in Data Masking screen using input
file processing method.

1. On identifying the fields, create an input file (in text file format) with table name, column
name, and enabled indicator (Y/N) for each field level record. If enabled indicator is N, the
record is not processed for data masking.

For example, BUSINESS_APPL_DETAILS,BSD_LEGAL_NAME,N

2. Place the input file to the path as defined in system parameter IPI_DIRECTORY. For
example, $OFSLL_HOMEI/inputlipi

3. Navigate to Setup > Administration > System > Batch Jobs screen and execute the
following batch job:

Table 2-85 Masking User defined data

_________________________________________________________________________|
Set Code Description Job Code

SET-IFP PI INFROMATION FILE IPIPRC_BJ_100_01
UPLOAD PROCESSING

On execution, the batch job picks the file from the location, processes it and loads the seed
data into Data Masking screen. By default, all the user identified PII data from input file is
categorized separately in Data Masking screen by assigning the value of System Defined
property as N.

Once the data is available in Data Masking screen, enable the required fields, assign user
responsibility and run the processing batch job - redprc_bj 100_01 to generate a redaction
policy. For more details, refer Create data redaction policy section.
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In addition, an xml sample file with PII fields data is provided in the installation bundle
(docs folder). The same is generated through Application Data Model (ADM) and can
be imported to view the details of PIl masked fields. However to do so, you need to

have Oracle Cloud 13c installed.

2.19 Webhook

Webhook in OFSLL provides a facility to integrate with third-party external applications by
sending REST API based notifications of changes through system generated Webhook event

actions.

In the Webhook screen, you can register third-party applications to which you can notify the
changes that are done in OFSLL by triggering Webhook request as an event action.

In this type of integration, the server which is OFSLL propagates the information to the
dependant third-party applications (client) when a specific type of change has happened in
OFSLL. For example, when customer details are updated in OFSLL.

In the Webhook screen, you can maintain Webhook definition details and associate Event
Details along with Authentication Attributes.

Figure 2-43 Webhook
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This section consists of the following topics:

Webhook Definition

Event Details
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*  Authentication Attributes

*  Monitoring Webhook Events

2.19.1 Webhook Definition

In a Webhook definition, you can create a Channel with specific third party authentication
mode, provide test and service url and generate secret key.

To setup Webhook Definition
1. Select Setup > Administration > System > Webhook.

2. In the Webhook section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields are given below:

Table 2-86 Webhook Definition

|
Field Do this

Channel Specify the channel name of interfaced third-
party application for identification. The same will
be added into weblogic Key Store.

Client Secret Key The client secret key is auto generated by the
system on clicking Generate button after defining
the details. If already generated, the same can
be used to regenerate

Service URL Specify the context path of third-party
application’s Webhook Service URL used for
communication where POST request is to be
provided. You can define multiple service end-
point URLSs for the same channel.

Test Service URL Specify the GET web service Webhook URL of
third-party application to check service
availability.

Click Test button to generate sample test call.
The status, either success or error of the test call
is displayed on the screen as SERVICE URL
TEST SUCCESFUL/FAILED. Refer step 4 below
for more information.

Enabled Check this box to enable the Webhook definition.
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Field

Do this

Authentication mode

Select the authentication mode of third-party
application from the drop-down list. The list is
displayed based on lookup code
WHK_AUTH_MODE_CD. System supports the
following options:

BASIC - On selecting this option, you need to
define User Name and Password to authenticate.

OAUTHZ2.0 - On selecting this option, you need
to define additional enabled fields such as Grant
Type, Client Id, Client Secret, Identity Domain,
Token and Header Key.

ORACLE BANKING ROUTING HUB - On
selecting this option, you need to define User
Name, Password, Token Header Key, Response
Token Key, and Request Authorization Header
Prefix to authenticate.

Note: Based on the above selection, additional
Webhook definition fields are enabled and need
to be populated accordingly.

The following additional fields are available for BASIC type of Authentication mode:

User Name

Specify the Basic Authentication User Name.

Password

Specify the Basic Authentication User Password.

The following additional fields are enabled for OAUTH2.0 type of Authentication mode:

Token URL Specify the third-party OAUTH 2.0 token
generation URL.

Grant Type Select the OAUTH 2.0 grant type from the drop-
down list. The list is populated based on lookup
code WHK_GRANT_TYPE_CD.

Client Id Specify the identification name of third-party

OAUTH 2.0 client.

Client Secret

Specify the secret code of third-party OAUTH 2.0
client.

Identity Domain

Specify the domain name of the third-party
OAUTH 2.0 client.

Token Header Key

Specify the token header key of third-party
OAUTH 2.0 client.

Response Token Key

Specify the Response Token Key of third-party
OAUTH 2.0 client which is the key name of
Authentication Response Header. The same is
used to identify token value used as input for
subsequent calls.

Note: If value is not provided, system defaults to
access_token.

Request Authorization Header Prefix

Specify the Request Authorization Header Prefix
of third-party OAUTH 2.0 client This is the prefix
used to Request Authorization Header based on
token generation mechanism like Basic, Bearer,

JWT and so on.

Note: If value is not provided, system defaults to
Bearer.
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Field Do this

User Name If Authentication mode is selected as OAUTH2.0
and Grant Type as Resource Owner Password,
specify the third-party OAUTH 2.0 Resource
Owner User Name.

Password If Authentication mode is selected as OAUTH2.0

and Grant Type as Resource Owner Password,
specify the third-party OAUTH 2.0 Resource
Owner User Password.

The following additional fields are enabled for ORACLE BANKING ROUTING HUB (OBRH) type of

Authentication mode:

User Name Specify the third-party OBRH Resource Owner
User Name.
Password Specify the third-party OBRH Resource Owner

Password.

Token Header Key

Specify the token header key of third-party
OBRH client.

Response Token Key

Specify the Response Token Key of third-party
OBRH client which is the key name of
Authentication Response Header. The same is
used to identify token value used as input for
subsequent calls.

Note: If value is not provided, system defaults to
access_token. An example is indicated below
where token element is the key name:

Request Authorization Header Prefix

Specify the Request Authorization Header Prefix
of third-party OBRH client This is the prefix used
to Request Authorization Header based on token
generation mechanism like Basic, Bearer, JWT
and so on.

Note: If value is not provided, system defaults to
Bearer. An example is indicated below:

/api-gateway/cmc-obrh-services/route/dispatch

Line Origination Setup Guide
G42451-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

September 11, 2025
Page 170 of 174



ORACLE’

Chapter 2
Webhook

Table 2-86 (Cont.) Webhook Definition

|
Field Do this

Bureau <Check if required> Select the Credit Bureau from the drop-down list.
This is required if the Credit Bureau report format
is to be processed externally as defined in Setup
> Administration > User > Credit Bureau screen.

The list is populated with credit bureau details
maintained in CRB_SOURCE_CD lookup. This
field is enabled only during ADD process and is
Read-Only during EDIT.

Ensure that the selected Bureau is not already
selected for the enabled record. Else, system
displays an error indicating Record already
exist with same bureau and need to disable the
existing record and enable the new record with
the new Bureau.

Note: The Event Details section is not displayed
if the Credit Bureau report format is to be
processed externally.

Verified This check box is auto selected on verifying the
channel data by clicking TEST button and if the
test server connection is successful.

Perform any of the Basic Actions mentioned in Navigation chapter.
Click Test button to verify the configuration details of third-party application.

e Th external system generates base 64 X-Hmac header using HMAC SHA 256 and
propagate this as part of response header to OFSLL.

e Channel name is used in HMAC digest as given below. This will be passed to the
external interface using HTTP Header Key ChannelName. This value will be in base
64 encoded format.

«  System will validate this response and update the Verified indicator. Only HTTP status
code 200 is considered as success.

Format: "OFSLL": Base64 Encoded [HMAC SHA 256 of ["Http Method Types":"Base64
Encoded Channel Name": "Service URL"] with Client Secret Key]

For example:

Client Secret Key

ZXI KMGVYQW PaUpLVj FRaUxDSmhi R2Np T2l KSW6VXhNaUo5Lmv5Snpk VOl p
T21 KWFJVSkI UMD MBW 3aVEwaEJ Uaz VGVENINKI 1 VI | WVRVZTVG GTVNVNWS
Vk pHUWORK X VOUIW/A JJTWhBaUx DSnBj MD1pT2I KUFIsTK1URj | YU VKSVQwW
QUxJaXxdpW hod0l qb3hOVFUx TnpnMJ1gSXpMOpwWhRaUAgRTFOVFUY TO
RRNU1qTj kuemxMhO0l zdWduek LFRnhybl cxYXJ1 e XNVSFI i SmVQdOR5SUxvdDdU
aXZDVEFVUkt EbmbWe DIpWARI T1pJal d5aHNf SWkNaGLl V1dWZUFOYnZRunl
1X2c=

Cipher Text for HMAC SHA 256

CET: RvhURVJIOQUXJTI RFUkZBQOUt TOFVWEgYy MA==: appl i cation/json: https://
Host nane: Port/ webhook oaut hga/ servi ce/ api / resour ces/ webhook/ t est
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Generated Sample X-Hmac header

OFSLL: F/jj 07ghgM3g5z91EHU r dxYbaJ266 SRnXsBRoUxgUc=

@® Note

Configuration details for OBRH application cannot be verified using Test option
since OBRH currently does not support return of customizing HTTP header [X-
Hmac].

Clicking Generate button OFSLL generates Client Secret Key. This key is used in
generation of X-HMAC header that is sent to the third-party channel to validate origination
of the request.

System generated X-HMAC header uses base 64 encoded HMAC SHA 256 algorithm.
This algorithm uses below logic:

Format: "OFSLL": Base64 Encoded [HMAC SHA 256 of ["Http Method Types":"Base64
Encoded Payload":" Http Content Types": "Service URL"] with Client Secret Key]

For example.

Client Secret Key

TOZTTEXf Q@ JCXIRFULRf QOxJRUSUONdI bG\v bWUx

Cipher Text for HMAC SHA 256

POST: ewogl CAgl | JI ¢ XVl c3RUeXBl | j ogl kK9WEJIPVUSEI gp9: appl i cation/json: http://
Host nane: Port / webhook/ servi ce/ api / resour ces/ webhook/ basi ¢

Generated Sample X-Hmac header

OFSLL: q6xCpZr nudf B8owv YEi 2+Aac4cl MBb/ XFVTVr ChdQKA=

2.19.2 Event Details

The Event Details section acts as a single point of entry to define and update required
Webhook Events in the system. In Event Details, you can define service end points of
thirdparty application which accepts the communicated changes. Multiple end points can be
defined to a single channel for each Event Criteria. These details are displayed as Webhook
Event Action in Setup > Administration > System > Events screen.

To define Event Details

1.
2.
3.

Select Setup > Administration > System > Webhook.
Select the required definition in Webhook section.

In the Event Details section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields are given below:
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Table 2-87 Event Detalils

|
Field Do this

Event Select the event code from the drop-down list.
The list is populated based on the enabled event
codes maintained in Events setup screen.

Event Criteria Select the event criteria from the drop-down list.
The list is populated based on the enabled event
criteria maintained for the selected event in
Events setup screen.

Service End Point Specify the third-party application end point URL
which is propagated to Event Definition as an
Event Action Parameter.

Event Message Specify the event message which is propagated
to Event Definition as an Event Action Parameter.

Enabled Select this check box to enable the event details
in the system.

4. Click % button and add the event details to the list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.19.3 Authentication Attributes

For connecting to some of the third-party applications, addition Authentication attributes and
Request Header is required to be sent from OFSLL. In the Authentication Attributes, you can
define those specific attributes required for authentication. Multiple authentication attributes
can be defined to a Webhook definition.

To define Authentication Attributes
1. Select Setup > Administration > System > Webhook.

2. Select the required definition in Webhook section and click Authentication Attributes
sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields are given below:

Table 2-88 Authentication Attributes
|

Field Do this

Attribute Type Select the required Attribute Type which is used
to record HTTP header type from the drop-down
list:

*  TOKEN REQUEST HEADER: This is used
to add Authentication request header details.

e REQUEST HEADER: This is used to add
Request header details.

Attribute Key Specify the HTTP header key.
Attribute Value Specify the HTTP header value.
Enabled Select this check box to enable the

Authentication Attributes details in the system.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.19.4 Monitoring Webhook Events

You can verify the status of all Webhook Event Actions on the JMS Queues screen of the
System Monitor screen.

To monitor Webhook events

1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor > JMS Queues.
The Messages tab displays the Status for all outbound Webhook events processed to
third-party applications and their request in Response Message Details section.

For more details, refer to Dashboard > System Monitor section in any of the User Guides.
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Administration User

In the Administration > User, you can record setup data that define your organization
structure and its users. Information in this link is more data related, whereas the information
stored on the System drop-down link functions more like switches that control system behavior.

Navigating to Administration User

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User.

The User drop-down link records the following data:

Organization

Companies
Access

Users
Credit Bureau
Correspondence

Queues

Printers

Intelligent Segmentation

Bank Details
Standard Payees
Check Details

Currencies

Zip Codes
Payment Hierarchy

3.1 Organization

The Organization screen records the operational hierarchy of your business in terms of people.
It groups the human resources of your business in three categories: organization, division, and
department. The system uses this data to control access of users to applications. (The

Companies screen allows you to setup the location of these applications.)

@® Note

You can have only one active organization, so use the Organization field to define your

organization at its highest level.
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Divisions are groups within your organization that will have access to the same applications.
Larger organizations often define their divisions by region. Smaller organizations may define
division as branch offices or even departments, and might only have one division defined.

Departments are smaller units within a division. They expand on who is in the corresponding
Division field. The system uses this sub screen, for example, when setting up the Services
screen on the Utility form. At least one department must be defined for each division.

Figure 3-1 Organization Flowchart 1

Organlzatlon

DEViSlon A —I I_ lesmn B

Dept 1 Dept 2 Dept3 Dept 1 Dept 2 Dept 3
(PEOPLE)

As an example of an organization setup, Oracle Corp. might be defined as:
Organization: O-00010racle Corp.ORA

Division: OD-001Central RegionC01

Department: ODD-010riginationORG

Department: ODD-02FundingFUN

Department: ODD-03ServicingSER

Division: OD-002Eastern RegionE01

Department: ODD-11ServicingSER

Department: ODD-12CollectionCOL
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Organization
Figure 3-2 Organization Flowchart 2
— Cracle
I— Central Region (CO1) -‘ Ezstern Region (E01)
-Orig'rmtiun Funding Servicing Servicing Collections
(ORG) (RUN) (SERV) (SER) (COL)

® Note

The Short Name field on the Organization screen allows you to create the ID that
Oracle Financial Services Lending and Leasing will use when referring to the
organization, division, and department throughout the system.

To setup the Organization screen
1. Click Setup > Setup > Administration > User > Organization.

2. Inthe Organization Definition section, there can be only one active entry, so use this
screen to define your organization at its highest level. Perform any of the Basic Operations
mentioned in Navigation chapter.
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Figure 3-3 Organization Definition
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A brief description of the fields is given below:

Table 3-1 Organization Definition

Field Do this

Organization Specify the organization ID (the ID is the unique
identifier used internally by Oracle Financial
Services Lending and Leasing to represent your
organization).

Note: Do not edit this field.

Organization Name Specify the organization name.
Short Name Specify the short name for the organization.

Note: This ID represents this organization
throughout the system.

Enabled Check this box to enable the organization.

Note: Only one enabled organization is currently
allowed by Oracle Financial Services Lending
and Leasing.

Country Select the country where the organization is
located from the drop-down list.

City Specify the city where the organization is

located.
State Select the state where the organization is located
from the drop-down list.
Address Line 1 Specify the address line 1 for the organization.
Address Line 2 Specify the address line 2 for the organization.
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Table 3-1 (Cont.) Organization Definition
|

Field Do this

Zip Select the zip code of the location where the
organization is located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the
organization.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the
organization.

Extn 2 Specify the phone extension for the alternate
phone number, if specified.

Fax 1 Specify the primary fax number for the
organization.

Fax 2 Specify the alternate fax number for the

organization.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Division Definition section, you can setup the information for the groups within your
organization that will have access to the same applications and accounts. Perform any of
the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Table 3-2 Division Definition

|
Field Do this

Division Specify the division ID. The ID is the unique
identifier used internally by the system to
represent the division within the organization.

Note: Once specified, do not edit this field.

Division Name Specify the division name.
Short Name Specify the short name for the division.

Note: This ID represents this division throughout
the system (required).

Enabled Check this box to enable the division.

Country Select the country where the division is located
from the dropdown list.

City Specify the city where the division is located.

State Select the state where the division is located
from the drop-down list.

Address Line 1 Specify the address line 1 for the division.

Address Line 2 (unlabeled) Specify the address line 2 for the division.

Zip Select the zip code of the location where the
division is located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the
division.

Extn 1 Specify the extension for the primary phone
number.
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5.
6.
7.

Table 3-2 (Cont.) Division Definition

Chapter 3
Organization

Field Do this

Phone 2 Specify the alternate phone number for the
division.

Extn 2 Specify the extension for the alternate phone
number.

Fax 1 Specify the primary fax number for the division.

Fax 2 Specify the alternate fax number for the division.

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Setup > Setup > Administration > User > Organization > Department Definition.

On the Department Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.
A brief description of the fields is given below:

Table 3-3 Department Definition

Field

Do this

Department

Specify the department ID.

Note: The ID is the unique identifier used
internally by the system to represent the
department within the division.

Department Name

Specify the department name.

Short Name Specify the short name for the department.
Note: This is the ID that appears throughout the
system to represent this department.

Enabled Check this box to enable the department.

Country Select the country where the department is
located from the drop-down list.

City Specify the city where the department is located.

State Select the state where the department is located

from the dropdown list.

Address Line 1

Specify the address line 1 for the department.

Address Line 2

Specify the address line 2 for the department.

Zip Select the zip code where the department is
located from the drop-down list.

Extn Specify the zip extension where the department
is located.

Phone 1 Specify the primary phone number for the
department.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the
department.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the primary fax number for the
department.

Fax 2 Specify the alternate fax number for the

department.

Line Origination Setup Guide

G42451-01

Copyright © 2022, 2025, Oracle and/or its affiliates.

September 11, 2025
Page 6 of 100



ORACLE Chapter 3
Companies

8. Perform any of the Basic Actions mentioned in Navigation chapter.
9. Click Setup > Setup > Administration > User > Organization > Display Format.

10. On the Display Format section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-4 Display Format
|

Field Do this
Format Type Select the type of format from the drop-down list.
Format Sub Type Select the sub type of the format from the drop-

down list. The format sub type will be displayed
based on the format type selected.

Format Specify or select the format based on the format
type and format sub type selected. For Date and
Time Zone format, select the required option
from the drop-down list.

Format Mask Specify the format mask.

Format Filler Specify the format filler.

Special Data Specify the special data, if any.

Enabled Check this box to enable the display format.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

3.2 Companies

The Companies screen records the hierarchical structure of your portfolio companies and their
branches. Just as Oracle Financial Services Lending and Leasing uses the Organization
screen to determine the location of people, it uses the information on the Companies screen to
determine the location of applications. In completing the Companies screen, there can be more
than one company, and each company can have more than one branch.

Accounting is performed at the company level. applications can be sorted down to the branch
level. For this reason, branches are set up to reflect different business practices. You would set
up different branches if, for example:

e The General Ledger (GL) differs between branches
e The branches work with different accounts

e There is a difference between branches in terms of the tasks they perform (origination,
servicing, collections, and so on).
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Figure 3-4 Company Flowchart 1
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Chapter 3
Companies

As an example of the companies setup, Oracle Corp. might have the following companies

and branches defined as:

Company: C-0001TrustOne Financial CorpTOFC

Branch: CB-01TOFC - HeadquartersHQ

Branch: CB-02Kennedy Plaza KP

Company: C-0002Credtyme Credit CorpCCC

Branch: CB-11CCC - HeadquartersHQ
Branch: CB-12CCC - MissoulaMT

Figure 3-5 Company Flowchart 2

TrustOne Financial

Corp, (jFO.FC) —I

TOFC-Headquarters : Kennedy Plaza
St.Paul, MN (HQ)  St.Louis, MO(KP)

bredtyme Credit

|— Corp.(CCC) _l

CCC-Headquarters ~ CCC-Missoula

(HQ) Missoula, MT(MT)
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@® Note

Chapter 3
Companies

— The system does not limit the number of companies or associated branches
with the company you can enter.

— The Short Name field on the Companies screen allows you to create the ID
that the system will use while referring to the company and branch.

KEY CONCEPT: Note the difference between the Company screen and the Organization

screen:

— On the Organization screen, Oracle Financial Services Lending and Leasing users
belong to an organization and division.

— On the Companies screen, credit applications and accounts belong to a company and

branch.

As you can see in the following Access screen section, the information on the Organization
and Companies screens define the operational hierarchy of your companies in terms of
which Oracle Financial Services Lending and Leasing users will have access to which

applications .

To setup the Companies

1. Click Setup > Setup > Administration > User > Companies. The Companies screen
defines entities within your organization that originate and/or service Line of Credit.

2. In the Company Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

Figure 3-6 Company Definition
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A brief description of the fields is given below:
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Table 3-5 Company Definition

Chapter 3
Companies

Field

Do this

Company

Specify the portfolio company ID. (This ID is
the unique identifier used internally by the
system to represent the company).

Name

Specify the name of the portfolio company
(required).

Short Name

Specify the short name for the portfolio
company (ID displayed to represent the
company).

Currency

Select the currency of the portfolio company
from the drop-down list. The system displays
the default value as US DOLLAR.

Enabled

Check this box to enable the portfolio
company.

Country

Select the country where the portfolio
company is located from the drop-down list.
The system displays the default value as
UNITED STATES.

Address Line 1

Specify the address line 1 for the portfolio
company.

Address Line 2

Specify the address line 2 for the portfolio
company.

Zip

Select the zip code of the location where the
portfolio company is located from the drop-
down list.

Extn

Specify the extension of the zip code where
the portfolio company is located.

City

Specify the city where the portfolio company is
located.

State

Select the state where the portfolio company is
located from the drop-down list.

Company Time Zone

Select the time zone in which the company
operates using the drop down list. This time
zone is considered if system is setup to
process GL at Company level. For more
information, refer to Appendix -
Configuration at Company Level chapter.

Remittance Address section

Country

Select the remittance address country from the
drop-down list. The system displays the default
value as UNITED STATES.

Remittance Address 1

Specify the remittance address line 1, if it is
different from the company address. This
address is included as the remittance address
on statements.

Remittance Address 2

Specify the remittance address line 2.

Zip

Select the zip code of the remittance address
line 1 from the drop down list.

Extn

Specify the extension of the remittance
address zip code.

City

Specify the remittance address city.
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Table 3-5 (Cont.) Company Definition

Chapter 3
Companies

Field

Do this

State

Select the remittance address state from the
drop-down list.

Phone 1

Specify the primary phone number for the
portfolio company.

Extn 1

Specify the phone extension for the primary
phone number.

Phone 2

Specify the alternate phone number for the
portfolio company.

Extn 2

Specify the phone extension for the alternate
phone number.

Fax 1

Specify the primary fax number for the portfolio
company.

Fax 2

Specify the alternate fax number for the
portfolio company.

Tax ID #

Specify the tax identification number for the
portfolio company.

TCC

Specify the transmitter control code for the
portfolio company (1098 Electronic Filing).

Contact

Specify the contact information about the
portfolio company.

Coupon Order Code

If you are using coupons, Specify the coupon
order code to be used by a third party printing
the coupons for billing statements.

HMDA

Select the HMDA agency (Home Mortgage
Disclosure Act reporting agency for the
company).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. On the Branch Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 3-6 Branch Definition

Field

Do this

Branch

Specify the portfolio branch ID. (This ID is the
unique identifier used internally by the system
to represent the branch within your company).

Name

Specify the name of the portfolio branch
(required).

Short Name

Specify the short name for the portfolio branch
(ID displayed to represent the branch)
(required).

Enabled

Check this box to enable the portfolio branch.
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Table 3-6 (Cont.) Branch Definition

Chapter 3
Access

Field

Do this

Sub Unit

Select the Sub Unit from the drop-down list.

Sub Unit refers the entity which is the source
of funds for the credit application/Account.

System associates the selected sub unit with
the particular company/ branch combination
and displays by default when the same is
selected during an application/Account
creation.

Country

Select the country from the drop-down list. The
system displays the default value as UNITED
STATES.

City

Specify the city where the portfolio branch is
located.

State

Select the state from the drop-down list.

Address Line 1

Specify the address line 1 for the portfolio
branch.

Address Line 2

Specify the address line 2 for the portfolio
branch.

Zip

Select the zip code of the location where the
portfolio branch is located.

Zip Extn

Specify the extension of the zip code, where
the portfolio branch is located.

Phone 1

Specify the primary phone number for the
portfolio branch.

Extn 1

Specify the phone extension for the primary
phone number.

Phone 2

Specify the alternate phone number for the
portfolio branch.

Extn 2

Specify the phone extension for the alternate
phone number.

Fax 1

Specify the primary fax number for the portfolio
branch.

Fax 2

Specify the alternate fax number for the
portfolio branch.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3 Access

Using the organizations, divisions, companies, and branches created on the Organization and
Companies screens, you can control the access privileges of applications . On the Access
screen, you define which organization/division (users) can gain access to which company/

branch (applications ) locations.

Normally, for each division within an organization, you would define a record with Company
value of ALL and a Branch value of ALL, then select the Allowed box. You then define other
records for the same Organization and Division for other Company and Branch combinations

with the Allowed box cleared to restrict access.
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Figure 3-7 Access Flowchart
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To setup the Access

1. Click Setup > Setup > Administration > User > Access. The system displays the Access

screen.

2. Inthis screen, you can control the access privileges of the user for the following

categories:
¢ Data
¢ Screen
* Reports

e Correspondence

Webservice

Line Origination Setup Guide
G42451-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

September 11, 2025
Page 13 of 100



ORACLE’

3.3.1 Data

Chapter 3
Access

The Data screen allows you to restrict access to different data.

To setup the Data

1. Click Setup > Setup > Administration > User > Access > Data.

2. Inthe Access Grid section, perform any of the Basic Operations mentioned in Navigation

chapter.

Figure 3-8 Access Grid
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A brief description of the fields is given below:

Table 3-7 Access Grid
]

Field

Do this

Organization

Select the organization for which you are defining
access privileges from the drop-down list.

Division

Select the division within the organization for
which you are defining Access privileges from
the drop-down list.

Company

Select the portfolio company to which you are
defining access privileges for the organization
and division specified from the drop-down list.
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Table 3-7 (Cont.) Access Grid

|
Field Do this

Branch Select the portfolio branch of the company to
which you are defining access privileges for the
organization and division specified from the drop-
down list.

Allowed Check this box to provide access to the data
pertaining to the company and branch, for the
organization and division specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.2 Screen

In the screen, you can control the access to the following:

1. Menu - Control access at the application menu level. For example, for Setup menu you
can provide access only to an Administrator.

2. Screens — Control access to the screens available in the application.

3. Buttons — Control access based on the stage.
For example, Add and Edit buttons can be disabled once an application is funded. If you
want to restrict updating the Applicant details, then edit button has to be disabled for the
stage.

4. Fields - Control access to base and user defined fields.
The screen allows you to restrict access to different screens and fields using the following
tabs:

e Security Access Definition

*  Field Access Definition

e Security User Access Definition Details

3.3.2.1 Security Access Definition

To set the Screen Security
1. Click Setup > Setup > Administration > User > Access > Screen.

2. Inthe Security Super Group section, you can view the details of the super group you
want to work with.
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Figure 3-9 Security Super Group
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3. Inthe Security Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

® Note

You can not add a new record.

A brief description of the fields is given below:

Table 3-8 Security Access Definition

'
Field Do this

Access Code

The system displays the selected access code.
Modify the description of the access code.

Type The system displays the type of security access
definition.

Description

System Defined If Yes is selected, the security access definition

entry is system defined.

If No is selected, the security access definition
entry is manually defined.

Enabled Check this box to enable the security access

definition entry is enabled.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-9 Security User Access Details

Field Do this

Access Type Select the access type of the user who will have
access to this screen from the drop-down list.

Active Value Select the active value of the user who will have
access to this screen from the drop-down list.

Allowed Select Yes to allow access to this screen or No
to deny access to this screen.

System Defined Select Yes, if the screen user access definition

entry is system defined.

Select No, if the screen user access definition
entry is manually defined.

Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.2.2 Field Access Definition

The Field Access Definition tab facilitates for field customization in the User Interface (Ul)
screen. In this tab, you can do the following:

Enable User Defined Fields (UDFs) to be displayed in respective Ul which are provided as
part of product installation/upgrade

Allow or restrict user access to base non-mandatory fields and UDFs maintained in the
system

Regroup base fields to another section in Ul

Figure 3-10 AccessGrid_field
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Note the following:

— The Field Access Definition tab displays User defined Fields maintained in the system

for which you can specifically define access permissions based on user responsibility.
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— The base mandatory fields are loaded automatically and Access Responsibility is set
to ALL by default during product installation/upgrade. The same cannot be modified

and hence are not displayed in this tab.

— Field access and customizations are to be performed at your sole discretion and
OFSLL is not responsible for any impact/damage/mismatch in the data being

represented or resulting out of this change.

— Field labels can further be customized in Administration > System > Label

Configuration screen.

Before defining field access, refer to the table below which indicates the possible
combinations of a particular field being displayed and allowed to edit in Ul.

Table 3-10 Field Definition

View Type Access Result

VIEW NO NON VIEWABLE

VIEW YES VIEWABLE AND EDITABLE
LOCK NO READONLY

LOCK YES VIEWABLE AND EDITABLE

To add/enable new User Defined Fields

1. Inthe Field Access Definition section, click Add and populate the following details:

Table 3-11 Field Access Definition

Field

Do this

Language

Select the language of the user(s) who will
have access to this field from the drop-down
list.

Division

Select the division or group within the
organization to which the user belongs from
the drop-down list.

Object Name

Select the Object Name from the drop-down
list. You can use the search option to query
based on specific name. The list is populated
based on the combination of Language and
Division selected above.

Field Name

Select the field to be updated from the drop-
down list. The list is displayed based on the
object selected.

Access Type

Select the access type as one of the following
from the drop-down list.

View - to display and make the field editable.
Lock - to only display the field.

Note: Option defined here takes precedence
with the display (Y/N) option selected in Setup
> Administration > System > Label
Configuration tab.

System Defined

Select Yes, if the field access definition is
system defined.

Select No, if the field access definition is
manually defined.
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Table 3-11 (Cont.) Field Access Definition
|

Field Do this
Enabled Check this box to enable the field access
definition.

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Update. System refreshes the cache and automatically updates the Field Access
Details from database to display in header section.

After updating the required changes in screen, you need to logout and re-login for
changes to be effective. This is basically to refresh session cache and update Field
Access information from database server. Though, there is Update option, clicking on
the same only refreshes the cache and reloads the record.

To enable/disable Base fields

1.

In the Field Access Definition section, click Edit and populate the following details:

Table 3-12 Field Access Definition
]

Field Do this

Access Code View the access code defined for the field.

Description View the access code description. You can
modify the details if required.

Type By default, system displays the name of the

group inside which the field is displayed in Ul.
To move the field to a different group, select
the required type from the drop-down list.

System Defined Select Yes, if the screen field access definition
is system defined.

Select No, if the screen field access definition
is manually defined.

Enabled Check this box to enable the field access
definition.

3.3.2.3 Security User Access Definition Details

The Security User Access Definition Details sub tab is available only for base - non
mandatory fields and user defined fields. In the Security User Access Definition Details sub
tab you can defined field access and set restrictions to specific user responsibility.

1. Inthe Security User Access Definition Details section, perform any of the Basic
Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-13 Security User Access Definition Details

|
Field Do this

Access Type Select RESPONSIBILTY as the access type from

the drop-down list since access to field is based
on responsibility by default. This field is disabled
during edit.

Active Value Select the user role who needs to have access to

this field from the drop-down list.
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Table 3-13 (Cont.) Security User Access Definition Details

|
Field Do this

Allowed Select Yes to allow access to this field or No to
deny access to this field.

System Defined Select Yes, if the field user access definition is
system defined.

Select No, if the field user access definition is
manually defined.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.3 Reports

In the Reports screen you can control access to generate certain reports.

To set up Reports
1. Click Setup > Setup > Administration > User > Access > Reports.

2. Inthe Reports section, you can view the following information:

Figure 3-11 Reports
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A brief description of the fields is given below:
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Field

View this

Code

Displays the code of the report.

Module

Displays the code of the report from the drop-
down list.

Description

Displays the description of the report.

Enabled

Displays whether the report definition is enabled
or not.

3. Inthe Reports User Access Definition section, you can set the access rights for the
report selected in the Reports section. Perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 3-15 Reports User Access Definition

Field

Do this

Access Type

Select the access grid function type from the
drop-down list.

Access Value

Select the access function grid value from the
drop-down list.

Allowed

Select Yes to allow access or No to restrict
access to the entry based on the access type
and value.

System Defined Yes/No

Select Yes, if the report user access definition
entry is system defined.

Select No, If the report user access definition
entry is manually defined.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.4 Correspondence

The Correspondence screen allows you to restrict access to different correspondence
commands on the Letters menu, thus restricting your ability to generate certain

correspondence.

If you do not have the responsibility to create a type of correspondence, the corresponding
command on the Letters menu is unavailable (dimmed).

To setup the Correspondence

1. Click Setup > Setup > Administration > User > Access > Correspondence.

2. Inthe Correspondence Codes section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Table 3-16 Correspondence Codes

Field

Do this

Code

The system displays the correspondence code
name you want to work with.

Description

The system displays the description for the
correspondence code (display only).

Enabled

Check this box to enable the selected
correspondence code entry.

3. Inthe Correspondence User Access Definition section, perform any of the Basic

Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-17 Correspondence User Access Definition

Field

Do this

Access Type

Select the access grid function type from the
drop-down list.

Access Value

Select the access function grid value from the
drop-down list.

Allowed

Select Yes to allow access or No to restrict
access to the entry based on the access type
and value.
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Table 3-17 (Cont.) Correspondence User Access Definition

Field

Do this

System Defined Yes/No

Select Yes, if the correspondence user access
definition entry is system defined.

Select No, if the correspondence user access
definition entry is manually defined.

Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.5 Webservice

The Webservice screen in Access setup allows you to configure access to the available
RESTful webservices in the system. The associated seed data for all the RESTful webservices
are loaded during product installation and process of installing the same is detailed in the
Installation guide.

As an administrator/superuser, you can Enable/Disable Web Service access to users based on
their responsibility and ensure that only authorized user have access to specific type of data in
the system. Following list indicates some of the available RESTful webservices in the system
and the complete list is made available in swagger JSON file shared in OTN library.

Generic Post Transaction Service
Call Activity Service

Scheduler Service

Account Search Service

Account Boarding Service
Payment Posting Service
Account Detail Service
Calculator Service

Application Search Service

Get Scenario Analysis Service
Post Scenario Analysis Service
Lookup Service

Dialer Integration Service
Application GET Service
Application Entry service
Application Update Service
Application Status Change
Application Checklist

Application ACH GET Service
Application ACH POST Service
Application Comment GET Service
Application Comment POST Service

Application Document GET Service
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*  Application Document POST Service
* Account Comment GET Service

e Account Comment POST Service
e Account Document GET Service

*  Account Document POST Service
* Process File Upload Service

* Process File Download Service

* Process File List Service

*  Product Service

* Asset Service

e Asset Sub-Type Service

e Scheduler Force ReSubmit

* Remarketing GET Service

* Remarketing POST Service

* Invoice GET Service

* Invoice POST Service

To setup the Webservice access

1. Click Setup > Setup > Administration > User > Access > Webservice. The screen
consists of the following tabs:

e Security Super Group
e Security Access Definition
e Security User Access Definition Details

e Security Access Definition Details (This sub tab is available only for SERVICING AND
COLLECTION Super Group.

Figure 3-13 Webservice
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The Security Super Group section, contains the following super group categories for
selection:

« COMMOM

* INTERFACES

*  ORIGINATION

*  SERVICING and COLLECTIONS
« SETUP

*  WHOLESALE FLOOR PLANNING

Select the required Super Group and the associated data in sub tabs are categorized
accordingly.

In the Security Access Definition section, you can view the following field details and edit
only the Description and Enabled status of selected Security Access Definition.

Table 3-18 Security Access Definition
|

Field Do this

Access Code The system displays the webservice access
code.

Description The system displays the description of the

associated webservice access code and can be
edited for required changes.

Type The system displays the type of security access
definition.
System Defined If selected as Yes, the security access definition

entry is system defined. If selected as No, the
security access definition entry is manually
defined.

Enabled Check this box to enable the selected
webservice access code.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields are given below:

Table 3-19 Security User Access Details

|
Field Do this

Access Type Select Responsibility (default) as the access
type from the dropdown list. For this access type
to be available in the drop-down list, ensure that
the Lookup Type ACCESS_GRID_TYPE_CD is
maintained in the system.
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Table 3-19 (Cont.) Security User Access Details

|
Field Do this

Access Value This field is Read-only for System Defined
Security Access Definitions which are loaded as
part of seed data during installation.

For non-system defined Security Access
Definitions, select the access value which is the
user responsibility who needs to have access to
this webservice from the drop-down list.

For user responsibilities to be populated in the
drop-down list, ensure that the Lookup Type
RESPONSIBILITY_CD is maintained in the

system.

Allowed Select Yes to allow user access to this
webservice or No to deny access. By default, No
is selected.

System Defined Select Yes, if the webservice user access

definition entry is system defined.

Select No, if the webservice user access
definition entry is manually defined.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
Security Access Definition Details

If you have selected the Security Super Group as SERVICING and COLLECTIONS, there is
an additional sub section Security Access Definition Details enabled. This sub tab facilitates
you to further restrict and control access to specific type of data within the accessible RESTful
web services. The restriction can be defined based on specific Account Condition or
Account Status.

For example, out of all the account types maintained in the system you can restrict data access
to only delinquent account(s) to a particular user responsibility by selecting Access Type as
Account Condition and Access Value as Delinquent.

Controlling web service data access to permitted user(s)

For any user to access web service data, you need to define atleast one positive (allowed)
definition defined in Security Access Definition Details section. Else, webserivce data is not
displayed for that particular user even if that user responsibility has permissions to access web
service.

OFSLL supports multiple user conditions on an Account and system requires to have atleast
one account condition defined as Allowed in setup to display the data. In case, even if any one
of the account condition is defined as Not Allowed in setup, then system does not allow to
access the data.

During the following scenarios, data is either displayed/not displayed in Webservice screen:

Table 3-20 Data in Webservice screen

_________________________________________________________________________________|
Scenario Data displayed

No condition is available on the account and also ~ Data is displayed since there is no restriction.
no condition defined in setup

Condition is available on the account but not Data is not displayed since restriction is applied
defined in setup
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Table 3-20 (Cont.) Data in Webservice screen
]

Scenario Data displayed
Multiple conditions are available on the account Data is displayed
and one condition is defined in setup as Allowed

Multiple conditions are available on the account Data is not displayed
and one condition is defined in setup as Not

Allowed

Whenever user with specific responsibility tries to access the restricted data, following type of
error messages are displayed:

e For POST/PUT service, system displays error as Access denied with HTTP Error Code
401.

* For GET service with single account record, system displays error message as No data
found with http error code 400.

«  For GET service with multiple account records, of which some have access restriction and
other don't, then system displays only the unrestricted records and does not display the
restricted records. In such a case, error message is not displayed.

@® Note

When multiple user access definitions are defined in the system, while processing
the data access request to a web service OFSLL first validates for any access
restrictions on the user responsibility. If not, then validates the same against ALL
responsibility before displaying the data in Webservice screen.

For example, if data access restriction is defined for ALL and SUPERUSER responsibilities.
when logged in with SUPERUSER responsibility, the data restriction of SUPERUSER is
applied. In case, if the user logs in with any other responsibility other than SUPERUSER, then
restriction defined for ALL is applied.

To define Security Access Definition Details

1. Click Setup > Setup > Administration > User > Access > Webservice tab.

2. Select the module in Security Super section as SERVICING and COLLECTIONS.
3. Select the user responsibility in Security User Access Definition Details section.
4

In the Security Access Definition Details section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields are given below:

Table 3-21 Security Access Definition Details

|
Field Do this

Access Type Select the access function type (as either
ACCOUNT CONDITION OR ACCOUNT
STATUS) that is being used to control the user
access from the drop-down list.
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Table 3-21 (Cont.) Security Access Definition Details

|
Field Do this

Access Value Select the access value from the drop-down list.
The list is sorted based on the Access Type
selected. Also, based on a lookup associated
with the Access Type multiple entries for each
access type can be created as long as each has
a different access value.

Allowed? Yes/No Select Yes if the access is allowed and No if the
access is not allowed. This indicates whether the
selected combination of Access Type and
Access Value is allowed to access the data.

System Defined Yes/ No Select Yes, if you wish to maintain access type
as system defined and No, if you do not want to
maintain it as system defined. However, system
defined entries cannot be modified.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

3.4 Users

The Users screen allows you to create and set up an user. In the User Definition section, you
can assign a user an identification name and password to log on to the system. You can also
assign the organization, division, and department where each user is located. Additional fields
allow you to record information for contacting the user. You can also define the time frame
within which a user has access to the system to ensure compliance to the company’s
schedule. This is a very useful feature to prevent logins during scheduled maintenance.

The Responsibility field records the job function of the user and defines the level of access that
user has within the system; in particular:

What menu items does the user have access to?

*  What edits can the user perform on the Verification link during origination?

@® Note

The system’s SUPERUSER responsibility grants access to the entire system. Give
careful consideration to the number and type of users who receive this
responsibility.

To set up the Users screen

1. Click Setup > Setup > Administration > User > Users. The system displays the Users
screen.

2. Inthe User Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Table 3-22 User Definition
|

Field

Do this

User Specify the user ID.
Note: This field is a unique indicator and cannot
be updated, edited, or deleted once saved.

Organization Select the organization to which the user
belongs, from the dropdown list.

Division Select the division to which the user belongs,
from the drop-down list.

Department Select the department to which the user belongs,
from the dropdown list.

Start Dt Specify the start date for the user. You can also
select from the adjoining calender icon.

End Dt Specify the end date for the user. You can also

select from the adjoining calender icon.

System Defined

Select Yes, if the entry is system defined.
System defined entries cannot be modified.

Select No, if the entry is not system defined and
it can be modified.

Enabled Check this box to enable the user.
First Name Specify the first name of the user.
Ml Specify the middle initial of the user.
Last Name Specify the last name of the user.

Responsibility

Select the responsibility for the user from the
drop-down list.

Note: The users mapped to the role
Responsibility can only view the screens.
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Table 3-22 (Cont.) User Definition
|

Field

Chapter 3
Users

Do this

Review Request Supervisor

Select the supervisor responsibility who can also
review and respond to review requests from the
drop-down list.

The list displays the corresponding Review
Request Supervisors who are either one or more
levels higher from the above selected user
Responsibility as maintained in
RESPONSIBILITY_CD lookup code.

Phone 1 Specify the user’s primary phone number.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the user’s alternate phone number.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the user’s primary fax number.

Fax 2 Specify the user’s alternate fax number.

Replacement User

Select the user ID of the replacement user from
the drop-down list.

Dt

Specify the date from when the replacement is
effective. You can also select from the adjoining
calender icon.

Note: These two fields allow you to create a
replacement user for the current user. This is
particularly useful when a new employee
assumes the duties of a former. By completing
the Replacement User and Replacement Dt field,
the system recognizes the replacement user as
the current user on the effective date. For more
information, refer the section, Replacement
Users.

Type

Select the user type from the drop-down list.

Reference #

Specify the reference number for the user from
the drop-down list.

Email

Specify user’'s email address.

Default language

Select the default language from the drop-down
list.

Time Zone

Select the required Time Zone from the drop-
down list, The specified time zone would be
applicable at company level.

Time Zone Level

Select the time zone level (Organization,
Company or User) that would apply by default,
when specific time zone is not specified at
Company and User level.

This section consists of the following topics:

Replacement users

Perform any of the Basic Actions mentioned in Navigation chapter.

Application and Oracle Identity Manager Synchronization
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3.4.1 Replacement users

By completing the Replacement User and Dt fields on the Users screen, you can replace an
existing user with a new user. The system assigns all responsibilities of the original user to the
new user as of the date of the replacement.

The Replacement User and Dt fields allow you to designate a replacement for the current
user in the User ID field. When you complete the Replacement User and Dt fields, save your
entry, and then enable the record, the system replaces the original user. The system changes
the End Dt field to the date when the original user was replaced (the same date in the Dt field).

The system assigns the queues of the original user to only those replacement users who have
the same user responsibilities (or Super User responsibility) as set in the system.

The system updates the following when replacing users:

1. Assigns all applications in the replaced user’s underwriting queue with the status NEW to
the replacement user’s queue.

2. Assigns all applications in the replaced user’s funding queue with a status other than
FUNDED to the replacement user’s queue. The system currently stores the collector name
in the back end tables, which are updated with the replacement users ID in the case of the
replacement of any user.

3. Also updates the Producer Management screen with the replacement user in the
Underwriter and Collector fields. The system assigns all applications routed to the
original user to the replacement user. This also includes any future applications for the
replaced user.

4. The system automatically updates the Collector ID field in all accounts to the replacement
user and routes all accounts assigned to the original user to the replacement user.

® Note

The system will not update the replacement user ID for accounts that are closed.

5. On the queue setup of Customer Service screen’s Responsibilities sub screen, the record
for the original user will be disabled and a new record will be created for the replacement
user. If the replacement user already exists in the setup, The system will not create a new
record. It updates the user ID and routes all accounts that were assigned to the original
user, based on the account condition, to the replacement user.

3.4.2 Application and Oracle Identity Manager Synchronization

Oracle Identity Manager is for user administration. Oracle Financial Services Lending and
Leasing has been developed in such a way that it can be implemented with or without Oracle
Identity Manager. In case OID has been employed, the user definition is done in OID and then
synchronized to the Oracle Financial Services Lending and Leasing Users table using a utility
JAR called OID Synchronization JAR. In OID, users are defined across various groups
belonging to a realm which is nothing but the directory structure in OID. A user can be
configured to belong to multiple groups in a realm. Every time the user tries to login to Oracle
Financial Services Lending and Leasing or OBIEE, the system validates the login ID and the
password with OID and provides access to those applications.
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3.5 Credit Bureau

In the system, an important part of the origination process is pulling a credit report from a credit
bureau and scoring that information against a user-defined risk model. These credit reports
can be pulled both automatically and manually.

After you enter an application, the system compares its contents against pre-screen criteria. If
the application passes a pre-screen edits check, the system advances the status of the
application and automatically pulls a credit report.

You can manually request a credit report for an applicant or any other party included on the
application, such as co-signers and spouses by selecting the bureau from which you want to
pull the report. If more than one report type is defined for the selected bureau, then you can
indicate the type of report you want to pull.

The following are few additional Credit Bureau Setup details:

*  The credit bureau from which the report is pulled is determined by the applicant’s zip code.
The credit bureau interface searches the information in the Credit Bureau Zip Matrix tab
and matches the applicant’s zip code to determine the bureau(s) from which to request a
report.

e The number of credit reports automatically pulled per applicant is controlled through the
credit request parameter CRB_MAX_BUREAU_PULL. If this parameter is set to 1, a credit
bureau request will be made for the Bureaul credit bureau from the zip code matrix.
Likewise, if this parameter is set to 2, a credit bureau request will be made for the Bureaul
and the Bureau?2 credit bureaus from the zip code matrix.

*  The system automatically pulls credit reports for only the primary applicant and the primary
applicant's spouse (for joint applications) unless the CRB_ALL_APL_BUREAU_PULL
credit request parameter is set to Y. However, if the parameter is set to Y, the system pulls
credit reports for all of the applicants on the Line of credit, regardless of their relationship to
the primary borrower.

e Passwords, default report formats, and other required information from the credit bureaus
are set up in the Report Formats screen.

»  For identity scan data to flow into Equifax ACRO/ACRO Plus credit reports, the add-on has
to be enabled at contract level. Please speak to your representative for enabling the add-
on.

Member codes and passwords when switching credit bureau access methods (moving from
dial-up to Net Connect). The member codes and passwords are not dependent on the
connection method used to access the bureau.

Frame relay access is from the database server to the Experian host though a TCP/IP socket
connection. The connection is outbound only and it is to a specific port (699 or 700) on the
Experian host.

The credit bureau service will be accessing Experian Net Connect service through HTTP to the
ECALS URL supplied by Experian as well as by the HTTPS to the URL returned as a response
to the ECALS URL inquiry (the credit request URL). This access is from the database server
access.

This section consists of the following topics:

e  Credit Bureau

e Special Metro Il Code reporting
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e Oracle Wallet Manager setup

e Oracle JVM Security setup

e |mporting a trusted certificate into an Oracle Wallet

* Importing the Certificates into an Oracle Wallet

e De-duping Credit Bureau data

3.5.1 Credit Bureau

Navigating to Credit Bureau

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Credit Bureau.

The setup for Credit Bureau spans across the following links:
* Report Formats

*  Connections

e Zip Matrix

» Parameters

e Score Reasons

* Reporting
3.5.1.1 Report Formats

The Reports Formats screen captures and tracks the attributes related to the multiple types of
reports offered by the credit bureau agencies. When a company enlists the service of a credit
bureau, the credit bureau provides a membership code and password. This information needs
to be entered on the Reports Formats screen before you can request a credit report. You must
define at least one report for each credit bureau from which you want to pull reports.

The information on the Report Formats screen is location-specific. If the business requires
different membership codes for each location, be it a company or branch, then individual
records must be set up.

The Score Type, Additional Product, and Inquiry Limit fields on the Credit Report Setup section
are optional. They may not apply to all credit bureau types and even if they do apply, you may
want to leave them blank and rely on a default value set up at the credit bureau.

@® Note

For more information, refer to the application Installation Guides.

To setup Report Formats
1. Click Setup > Setup > Administration > User > Credit Bureau > Report Formats.

2. Inthe Credit Bureau section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-15 Credit Bureau Report Formats
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A brief description of the fields is given below:

Table 3-23 Credit Bureau Report Formats

Field

Do this

Bureau Name

Specify the name of the credit bureau company.

Short Name Specify the abbreviated or short name for the
bureau.

Source Select the credit bureau source from the drop-
down list.

Country Select the country of the credit bureau address
from the drop-down list.

City Specify the city for the credit bureau address.

State Select the state of the credit bureau address

from the drop-down list.

Address Line 1

Specify the address line 1 for the credit bureau.

Address Line 2

Specify the address line 2 for the credit bureau.

Zip Select the zip code for the credit bureau address
from the dropdown list.

Extn Specify the extension of the zip code for the
credit bureau address.

Phone 1 Specify the primary phone number for the credit
bureau.

Extn 1 Specify the extension for the primary phone
number.

Phone 2 Specify the secondary phone number for the
credit bureau.

Extn 2 Specify the extension for the secondary phone
number.

Fax 1 Specify the primary fax number for the credit

bureau.
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Table 3-23 (Cont.) Credit Bureau Report Formats
|

Field Do this
Fax 2 Specify the alternative fax number for the credit
bureau.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Credit Bureau Report Formats section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-24 Credit Bureau Report Formats
|

Field Do this

Company Select the portfolio company that will be using
the above credit bureau from the drop-down list.

Branch Select the portfolio branch from the company

that will be using the above credit bureau from
the drop-down list.

Description Specify the credit report format description.

Member Code Specify the credit bureau member code
(assigned by bureau).

Password Specify the credit bureau password.

Customer Code Specify the customer code.

Auth Password Change Dt Display the last authorization password change

date. The Experian Net Connect product requires
that the Auth Password (or SSP Password in
Experian jargon) be changed every 90 days (or
sooner). Equifax may have similar requirements,
but they were not known at the time of this
writing. Use the date displayed in this field to
identify when the password needs to be
changed.

Note: The password needs to be changed both
in the system and at the credit bureau. Changing
the password does not initiate or perform a
change at the bureau. Changing the password at
the bureau must be done outside the system.
Contact the credit bureau for the procedure for
changing the password (display only).

Auth User ID Displays the authorization user ID (display only).
Auth Password Displays the authorization password (display
only).

Note: This field is not displayed to the user and
is also encrypted before being stored in the
database (display only).

Change Authorization User Id/Password section
New Auth User Id Specify the authorization user ID.
New Auth User Password Specify the authorization user password.

TransUnion Details section
(Note: This is only applicable for TransUnion.)

Market Specify the TransUnion market id.
Sub Market Specify the TransUnion Sub Market id.
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Table 3-24 (Cont.) Credit Bureau Report Formats

|
Field Do this

Industry Specify the TransUnion Industry code.

Experian Details section
(Note: This is only applicable for Experian.)

Preamble Specify the Experian preamble code.
Host Code Specify the Experian host ID.
uIC Specify the Experian UIC.

Equifax Details section
(Note: This is only applicable for Equifax.)

Service Name Specify the equifax service name. The service
name will be provided to you by Equifax when
your company's Internet System to System
account is created. Possible values for pulling
credit reports are acrotest (for access to the test
system) and acro (for access to the production
system).

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Report Format Details section, you can choose the various parameters of report
format and also indicate if the report is to be processed internally or externally.
To support geography specific Credit Bureau integration, external interface is also
supported in OFSLL. In such case, a webhook request for Credit Bureau Onboarding
report is initiated from OFSLL. The same is processed in external bureau service
depending on the endpoint configuration (type of bureau to be used as defined in Setup >
Administration > System > Webhook screen).

Based on the response received the Credit Bureau Put web service is triggered to update
the details. Also on processing CREDIT_REQUEST_DETAILS the Status of the request
received in CRL_CRB_REP_STATUS_CD is updated in Bureau tab of Origination and
Servicing screens in the following combination:

Table 3-25 Report Format Details
|

CRL_CRB_REP_STATUS_CD Bureau Details > Status
Primary Secondary

Completed Completed Completed

Completed Failed Failed

Failed Completed Failed

Failed Failed Failed

Submitted Completed Submitted

Completed Submitted Submitted

7. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:
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Field

Do this

Report

Specify the report name to be accessed from the
credit bureau.

Report Type

Select the report type of the credit bureau report
from the drop-down list.

Report Class

Select the report class as either Consumer or
Business from the dropdown list.

Multi Request Allowed

Check this box to allow report request from
multiple bureaus.

Score Type

Select the credit score type from the drop-down
list.

Add! Product

Select the product code from the drop-down list.

Inquiry Limit

Select the inquiry limit for the credit report from
the drop-down list.

Default

Check this box set this as default report format.

External Report

Check this box if the Credit Bureau Onboarding
report request format is to be processed from
external system. If selected, the encoding and
decoding of request details and pooling of data
into report is handled externally.

By default, this check box is not selected and
Credit Bureau Onboarding report request is
processed within the system.

8. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Table 3-27 Report Output

Field

Do this:

Report

Specify the report name to be accessed from the
credit bureau.

Report Type

Select the report type of the credit bureau report
from the drop-down list.

Score Type

Select the credit score type from the drop-down
list.

AddI Product

Select the product code from the drop-down list.

Inquiry Limit

Select the inquiry limit for the credit report from
the drop-down list.

Enabled

Check this box to enable the report as default.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.2 Connections

The Connections screen records and supports various connections to the credit bureau to
receive reports from the agencies. The system supports connections to the bureaus through
one or more modems attached to the database server, network accessed modem server, or

direct network connection (usually frame relay).
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For modem-based connections, multiple credit bureaus can be accessed over the same
modem. If there are multiple requests in the queue, the order in which the bureaus are listed
determines the order in which the requests are processed.

For example,

If the credit bureau service checks the submitted credit requests and finds three Experian, one
Equifax, and two TransUnion credit requests and the connections setup is Bureaul=TUC,
Bureau2=EFX, and Bureau3=EXP, the two TransUnion requests will be processed first, the
Equifax request next, and then the three Experian requests.

@® Note

For this above example, adding two more modems and assigning a specific bureau to
each one would help to avoid the delay caused by queuing all requests through a
single modem.

IMPORTANT: Direct network connections must be set up for only one bureau.

Like the Credit Bureau section on the Report Formats screen, the data fields used on the
Connections screen are generic and not all fields are used for all access methods. The
following table summarizes the data needed for each access method:

Figure 3-16 Credit Bureau_Methods Table
Method Name Bureau 1 | Bureau Bureau Device Device Speed
2 3
Dial-up Required Required Crptional Optional Required (can be either | Recuired for
(can he (cari be (can he alocal seral port device | locally attached
EXP, EZF, EEP, ot a1 [P address and modems
TUC, or TUC, or TUC, or pott murher of &
EFX) EFX) EFX tetwrork mode m)
Expetian Fequited | MIustbe Leave Leawe Dust be the IF address | Mot applicable
Frame-relay EZP blatik blank and pott number of
Experian host
Equifax Fequired Must be Leave Leawe DMust be the [P address Not applicable
Frame-relay EFX blark blank and port number of
Equifax host
TransUnion Feguired Ilust be Leave Leawe Diust be the [P addtess | Mot applicable
Frame-relay TOGC blatik blank and pott number of
TranslUnion host
Experian Net Feguired Must be Leave Leawve Dust be the ECALS Mot applicable
Connect EXP blank blank URL provided by
Expetian
Equifax Reguired Izt be Leave Leawe Diust be the URL Mot applicable
Intetnet EFX hlank blank provided by Equifax for
System to connecting to the
System Internet System to
System service
CAC Intermet Feguired Must be Leave Leave DIust be the URL Mot applicable
(16 blanlk blank provided by C3C
CredcoConnect | Reguired Iust be Leave Leave Dfuet be the URL Mot applicable
ZRD hlatik blank provided by Credso

For frame relay access, specify the IP address provided by the bureau followed by a space
and then the port number (for example, 192.168.36.2.700).

Experian Net Connect
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At the time of this writing, the Experian product ECALS URL is:

http:// www. experian. conl | ookupSer vl et 1?l ookupServi ce
Nanme=AccessPoi nt & ookupSer vi ceVer si on=1. 0&ser vi ceName=Net
Connect &servi ceVer si on=2. 0&r esponseType=t ext/pl ai n

@® Note

The URL given above is one continuous string. This can be verified by entering the
URL with a browser. The displayed value will be an HTTPS URL.

Enter the entire ECALS URL provided by Experian into the Device field. Notice that this URL
does not start with https. The ECALS URL is a URL used by the credit bureau service to
request the HTTPS URL. The HTTPS URL is not displayed on any setup screen and is only
known to the credit bureau interface at runtime.

Equifax Internet System to System

At the time of this writing, the Equifax Internet System to System URL is:

https://transport5. ec. equi fax. conl servl et/ st spost

CSC Tri-Merge
At the time of this writing, the CSC URL is:

https://ww. enort gage. Equi f ax. coni cgi - bi n/ emspop. exe

To setup the Connections
1. Click Setup > Setup > Administration > User > Credit Bureau > Connections.

2. Inthe Credit Bureau Connections section, perform any of the Basic Operations
mentioned in Navigation chapter.
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Figure 3-17 Credit Bureau Connections
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A brief description of the fields is given below:

Table 3-28 Credit Bureau Connections
|

Field Do this

Name Specify connection name.

Bureau 1 Select first credit bureau from the drop-down list.
Bureau 2 Select 2nd credit bureau from the drop-down list.
Bureau 3 Select 3rd credit bureau from the drop-down list.

Note: The Bureaul, Bureau2, and Bureau3 fields
in the Credit Bureau Connections section specify
which bureau types can be accessed over the
connection.

Device Specify the connection device name. The Device
field lists the physical device name for a modem,
or the IP address for a network accessed
connection.

Device Speed Select the connection device speed. The Device
Speed field is only applicable to server-attached
modems. It is used to specify the
communications speed between the server and
the modem.

Enabled Check this box to enable the connection.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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3.5.1.3 Zip Matrix

The system uses the zip code of the applicant’s current home address to determine which
credit bureau to use when automatically pulling a report. The Zip Matrix screen allows you to
record the credit bureau from which a report is pulled based on a range of zip codes, as well as
the company, branch and country of the account.

When searching for a zip code match, the system:
1. Reads the first credit bureau defined in the matrix

2. Reads the credit report format to get the appropriate membership code and password for
the user’s location

3. Requests a credit report.

If the system cannot pull a report from the first bureau, it pulls one from the second. If the zip
code you entered does not fall in the matrix setup, then the system uses a default zip matrix
(0000000000 to 0000000000) to select the required bureau.

To set up the Zip Matrix
1. Click Setup > Setup > Administration > User > Credit Bureau > Zip Matrix

2. Inthe Credit Bureau Zip Code Matrix section, perform any of the Basic Operations
mentioned in Navigation chapter.

Figure 3-18 Credit Bureau Zip Code Matrix
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Table 3-29 Credit Bureau Zip Code Matrix

Field Do this

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down

list. The branch will be displayed based on the
company selected.

Country Select the country from the drop-down list.
From Zip Specify the starting zip code (From).

To Zip Specify the ending zip code (To).

Bureau 1 Select the preferred bureau #1 (first bureau

pulled), from the drop-down list. You must enter
at least one credit bureau in the Bureau 1 field
for each zip code range. The bureau entered in
the Bureau 1 field for each range is the primary
bureau. For any given range, do not list the same
credit bureau in more than one field.

Bureau 2 Select the preferred bureau #2 (second bureau
pulled) from the dropdown list.
Bureau 3 Select the preferred bureau 3 (third bureau

pulled) from the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.4 Parameters

The Parameters screen records parameters specifically dealing with credit bureau information.
These parameters are divided into three groups:

« Parsing parameters
+ Request parameters

e Configuration parameters

Parameters can be defined at the company or branch level. The following credit bureau
parameters are configured during the installation:

PARSING PARAMETERS FOR CREDIT BUREAU SERVICE
CONFIGURATION PARAMETERS FOR CREDIT BUREAU SERVICE

The following credit bureau parameters are configured during implementation:
REQUEST PARAMETERS FOR CREDIT BUREAU SERVICE

To setup the Parameters
1. Click Setup > Setup > Administration > User > Credit Bureau > Parameters.

2. Inthe Credit Bureau Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.
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Figure 3-19 Credit Bureau Parameters
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A brief description of the fields is given below:

Table 3-30 Credit Bureau Parameters

'
Field Do this

Company Select the portfolio company from the drop-down
list.
Branch Select the portfolio branch from the drop-down

list. The branch will be displayed based on the
company selected.

Parameter Group Select the credit bureau parameter group from
the drop-down list.

Parameter Select the credit bureau parameter from the
drop-down list

Parameter Value Specify the credit bureau parameter value.

Enabled Check this box to enable the credit bureau
parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.5 Score Reasons

The Score Reasons screen allows you to define or modify the scoring reason codes and
descriptions for the predefined scoring models used by the credit bureau agencies.
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@® Note

This information is not associated with the user-defined scores determined by the
internal Oracle Financial Services Lending and Leasing model during product setup.

To setup the Score Reasons
1. Click Setup > Setup > Administration > User > Credit Bureau > Score Reasons.

2. Inthe Score Models section, you can view the following information.

Figure 3-20 Score Models
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A brief description of the fields is given below:

Table 3-31 Score Models

'
Field Do this

Score Model Displays the credit bureau score model (display

only).

Enabled Displays if the credit bureau score model is

enabled or not.

3. Onthe Score Reasons sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 3-32 Score Reasons

|
Field Do this

Reason Code Specify the reason code.

Specify the description.

Description

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.1.6 Reporting

The system reports to the credit bureau agencies in the Metro 2 format with the payment and
account status information of each account holder. The Credit Bureau Reporting screen
contains the program identifier to be reported to the bureaus.

To setup the Reporting

1. Click Setup > Setup > Administration > User > Credit Bureau > Reporting.

2. Inthe Credit Bureau Reporting section, perform any of the Basic Operations mentioned
in Navigation chapter.

Figure 3-21 Credit Bureau Reporting
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A brief description of the fields is given below:
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Table 3-33 Credit Bureau Reporting
|

Field Do this

Company Select the portfolio company from the drop-down
list.

Bureau Select the bureau from the drop-down list.

Program Identifier Specify the program identifier. The customer

receives this from the bureau and uses it to
identify itself to that bureau. You will need to
update this information.

Enabled Check this box to enable the program.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.2 Special Metro Il Code reporting

The system allows you to report the following special Metro 1l segments to the credit bureau
output file:

e Consumer Information Indicator Code (CIIC)
e Compliance Condition Code (CCCD)
e Special Comment Code (SPCC).

The system users will need to use call Action/Results and Reason fields on the Call Activities
sub screen of the Customer Service form (Lending > Customer Service > Customer Service (2)
master tab > Account Details tab > Call Activities sub tab) to place specific account conditions
where these Metro Il segments are to be reported. The specific segment reported for a given
condition will be based on the account condition and call activity reason codes.

@® Note

It is the responsibility of the Administrator or individual user to setup Special Metro Il
Code reporting functionality.

When users open one of the following conditions:

Table 3-34 Special Metro Il Code reporting
|

Code Description

Clic CONSUMER INFORMATION INDICATOR CODE
(METRO2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METROZ2)

SPCC SPECIAL COMMENT CODE (METRO2)

The system recognizes the condition, processes the selected Metro Il reporting call activity
reason code, and generates the Metro Il reporting segment in the Metro Il reporting output file.
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@® Note

You are responsible for selecting the correct Metro Il reporting segment reason
code to be reported. If you do not select a Metro Il reporting segment reason code,
the system will not generate information to Metro Il output file. If you select an
incorrect Metro Il reporting segment reason code, the system will report the
selected Metro 1l reporting segment. the system does not validate the contents of
the Reason field with the contents of the Condition field.

To end the reported Special Metro Il Special Code, close the open Special Metro Il
Condition (no reason code needed). The system recognizes the closing of the
open Special Metro 1l Condition and will not create a Metro Il reporting segment in
the output file.

The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system
parameter determines if output file is generated and created daily or output file is
written with daily data and output monthly.

To setup Metro Il Code reporting

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Queues > Call Action Results to open and close the
following system defined condition codes:

Table 3-35 Metro Il Code reporting
|

Action Code Description

Clic CONSUMER INFORMATION INDICATOR CODE
(METRO2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO2)

When setup is completed, you can open and close Special Metro Il code conditions.

®

Note

Opening and closing Special Metro 1l Code reporting is a manual process.

The CBU_FILE_FREQUENCY (METRO 2 FILE FREQUENCY) Company system
parameter determines, if output file is generated and created daily or output file is written
with daily data and output monthly.

3.5.3 Oracle Wallet Manager setup

The Experian Net Connect, Equifax Internet System to System, and CSC interfaces within the
system credit bureau service use functionality provided by the Oracle Wallet feature. Use the
Oracle Wallet Manager on the database server to create and export a wallet for use by the
credit bureau service.
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@® Note

All of the above mentioned interfaces use the same Oracle wallet. If a wallet already
exists and is in use by one of the credit bureau interfaces, there is no need to create
another wallet. Due to differing certificate requirements, there may be a need to import
additional trusted certificates into the wallet, but there will not be a need to create a
new one. The credit bureau parameter ORA_WALLET_PATH contains the location of
the Oracle Wallet used by the credit bureau service.

To create and export a wallet suitable for use by the credit bureau

Refer to the Oracle documentation for more detailed instructions on how to use the Oracle
Wallet Manager to create and manage a wallet:

1.

If a wallet does not already exist, create one somewhere on the database server. The
location must be readable and writable by the Oracle user. Make a note of the full path
where the wallet is stored (for example, / et ¢/ ORACLE/ WALLETS/ or acl e or
C:\oracl e\ WALLETS).

For Transunion credit bureau, a separate wallet file is needed under transunion folder
inside the main wallet path (for example: / et ¢/ ORACLE/ WALLETS/ or acl e/
transuni on or C:\ or acl e\ WALLETS\ t r ansuni on).

The wallet needs to contain the public key for the certificate authority that issued the server
certificate for each HTTPS web site that will be connected to by the credit bureau interface.
At the time of this document, those sites are:

Table 3-36 Credit Bureau Location

|
Location Credit Bureau

Experian Credit Bureau (https:// Experian
dml.experian.com/netconnect2_0Demo/servlets/
NetConnectServlet)

Equifax Credit Bureau (https:// Equifax
api.uat.equifax.com/business/sts-reports/v1l/

report)

CSC Credit Bureau (https://emsws.equifax.com/ CSC
emsws/services/post/MergeCreditWWW)

Transunion Credit Bureau (https://netaccess- TUC
test.transunion.com)

This list may change. Use the URL provided to you by the credit bureau when they set up your
service. To get the proper Experian HTTPS URL, enter the ECALS URL that was provided by
Experian into a web browser. The response returned to the browser is the HTTPS URL that will
be used to communicate with Experian.

1.

Import the necessary certificate authority’s certificate files into the Oracle wallet that was
created in Step 1. See the appendix of this chapter for detailed instructions of how to
download and install a trusted certificate.

Test the wallet by connecting to each web site with a simple command issued from
SQLPlus.

SQ.> select utl_http.request('https://ssl.experian.coni, NULL,
"file:/etc/ ORACLE/ WALLETS/ oracl e', 'password') fromdual;
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Replace the URL in the above command with each HTTPS URL given to you for use by
the credit bureaus. Also replace the wallet path with the path to your wallet and your wallet
password. The output from the command is not important, what is important is that it runs
without displaying an Oracle error. If there is an Oracle error, then something is wrong with
the contents of the wallet, the path to the wallet, and/or the wallet password.

3. When the wallet contains all of the required trusted certificates, export the wallet to a text
file. On the Operations menu of the Oracle Wallet Manager, choose Export All Trusted
Certificates. The text file MUST be located in the same directory as the wallet and the
filename MUST be def aul t . t xt . Anytime a change is made to the trusted certificates in
the wallet, the wallet must be re-exported to the same text file.

4. In the Setup > Setup > Credit Bureau > Parameters set the ORA WALLET PATH and
ORA_WALLET_ PASSWORD parameters.

3.5.4 Oracle JVM Security setup

The Experian Net Connect interface within the credit bureau service requires the use of the
Oracle Java Virtual Machine (JVM) that is resident in the Oracle database. Furthermore,
specific permissions must be granted to the Java classes used by the credit bureau service.
These permissions have been added to the set_java_perms.sql script that is part of the
distribution. This script (as well as many other useful SQL scripts) is available from the Oracle
Financial Services Software technical support Oracle Financial Services Lending and Leasing
patches web site.

The set_java_perms.sqgl script needs to run as the SYS user (or a user with SYS privileges).
The script will prompt for SYS user id and password. Be prepared to provide it when prompted.
Also, the script will select the value of the ORA_WALLET_PATH parameter from the credit
bureau parameters table. Make sure that it has been updated with the proper wallet path
before running the set_java_perms.sql script (although the script can be safely run again if
necessary).

Credit Bureau Service operation

The basic operation of the credit bureau service has not changed. Once setup, there is no
operational difference between accessing the credit bureaus via dial-up, frame relay, or the
Internet.

3.5.5 Importing a trusted certificate into an Oracle Wallet

The HTTPS servers used by Experian, Equifax, and CSC for their Internet based credit report
services (as well as all HTTPS servers) contain a site certificate signed by a trusted Certificate
Authority (CA). The CA is an entity that guarantees the identity of the HTTPS server. If the
client trusts the CA, and the CA says that the HTTPS server is who they say they are, then the
client inherently trusts the HTTPS server. Normally, a client tool such as Microsoft Internet
Explorer has a large store of trusted CA certificates which makes secure communication
between a client and a trusted HTTPS server relatively seamless and uneventful.
Unfortunately, the store of CA certificates in the default Oracle wallet is rather small and it is
likely that it will not contain the certificate of the CA that is certifying one or more of the credit
bureau web sites. This means that the CA certificate must be imported into the wallet. To do
this, the certificates must first be exported from a browser and then imported into the Oracle
wallet using the Oracle Wallet Manager.

Using Microsoft Internet Explorer to Export a Certificate

1. Use Microsoft Internet Explorer and connect to one of the HTTPS URLSs referenced in the
Oracle Wallet Manager Setup section of this document.
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If the web site asks for a user id and password, cancel the dialog box and remain on the
top-level HTTPS screen.

2. Once connected, from the browser’s File menu, choose Properties.
3. Click the Certificates button.

4. Click the Certification Path tab. The bottom-most certificate is the one generated by the
host itself. The one or more certificates above the bottom-most one are of greater
importance to this task. The screen shot below displays a web site with two CAs (an
intermediate, and a primary). Whether it is an intermediate CA or a primary one, the steps
are the same for saving the certificate as a text file.

Figure 3-22 CreditBureau_Certificate
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‘ | 2]

View Certificate. . l

Cerificate statius:
Thiz certificate iz OF..

5. Click the first certificate above the bottom-most certificate (it may be the only certificate
above the bottom-most certificate).

6. Click the View Certificate button.
7. Click the Details tab.

8. Click the Copy to File button.

9. Click the Next button.

10. Choose the Base 64 encoded format.
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11. Click the Next button.

12. Enter a filename and location for the file.
13. Click the Next button.

14. Click the Finish button.

15. Repeat steps 5 through 14 for the next certificate in the certification path, if any.

3.5.6 Importing the Certificates into an Oracle Wallet

1. Copy the certificates exported and saved during the process described above onto the
database server (not the iAS server).

2. As the Oracle user (or Administrator on Windows), start the Oracle Wallet Manager.

3. Open the wallet that will be used by the credit bureau service. Create a new wallet if one
does not already exist.

4. View the list of Trusted Certificates in the wallet.

5. Check the list of certificates against the list of certificates that are in use on the HTTPS
servers used by the credit bureaus (and that were exported and saved during the export
process described above).

6. Click the Trusted Certificates heading in the left list box of the Oracle Wallet Manager.
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Figure 3-23 Oracle Wallet Manager

] =iLn)
ORACLE
Certficates WeySize  Expire Date
R Class 1 Public Primary Certfication Authority 1024 January 7, 2020
ﬁ Class 2 Public Primary Certification Authority 1024 January 7, 2004
& Class 3 Public Primary Certfication Authority 1024 January 7, 2004
ﬁ Secure SBerver Certification Autharity 1000 January 7, 2010
ﬁ, GTE CyberTrus! Root 1024 February 23, 2006
53, GTE CyberTrust Global Root 1024 August13, 2018
=3 Entrustnel Secure Server Certfication Authorly 1024 May 25, 2019
52 Entrustnet Certication Authortty (2048) 2048 Decermber 24, 2019
53 Entrustnet Secure Server Certification Authorlly 1024 February 4, 2020
53 Class 3Public Primary Centficaion Authority 1024 August1, 2028
=3, wwwyerisign com/CRS Incorp by Ref LIABILIT. 1024 Orlober 24,2011

7. Use Microsoft Internet Explorer to view the certificate details for the HTTPS web sites (File
> Properties > Certificates > Certification Path > View Certificate > General) that will
be contacted by the credit bureau service. Look through the list of certificates shown in the
right panel of the Oracle Wallet Manager and look for a match between the Issued To and
Valid To dates shown in the Internet Explorer View Certificate screen.

The screen shot below shows a certificate that is already in the wallet’s list of trusted
certificates (see the last entry for the www.verisign.com/CPS certificate).
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Figure 3-24 Certificate
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8. Onthe Operations menu, choose Import Trusted Certificate and follow the prompts for
locating and loading the files that were copied onto the database server in step 1 for any
certificate not already stored in the wallet.

9. On the Wallet menu, choose Save when finished loading certificates.

3.5.7 De-duping Credit Bureau data

Oracle Financial Services Lending and Leasing allows you to remove duplicate (de-dupe)
liabilities data from the credit bureau information.

De-duping logic

The de-duping logic is based on a number of parameters that the system compares among
tradelines (only) to determine if they are duplicates. The following fields are used to determine
if two tradelines are duplicates:

Table 3-37 De-duping logic

|
Field Description

Account # The account number of the consumer with the
lender for the particular account.
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Table 3-37 (Cont.) De-duping logic
]

Field Description
Open Date The date the account was opened.
Member Code The subscriber code of the lender with the

respective credit bureau.

Note: Since member codes for the same lender
differ across bureaus, this field is used only for
tradelines reported by the same bureau. Since
reports obtained from CSC can have tradelines
from different bureaus, this field is only for reports
pulled from the credit bureaus.

All available bureau reports pulled later than DEDUP_CRB_EXPIRATION_DAYS days old will
be used.

The following system parameters will be set up to provide switches to allow the functionality to
be turned on and off:

Figure 3-25 System Parameters

Parameter Description Valid Setup
Values Value
JOMT_DEDURP_SPOUSE_LIABILITIES | De-deup the tracdelines with spouse YoM Y
JOMT _DEDUP_ALLAPL_LIABILITIES De-deun the tradelines with spouse | %, M Y
and secondary applicams(z).
DEDUP _CRB_EXPIRATION DAYS Credi report edpivation days Mu ket a0

Whenever two (or more) items are identified as duplicates, Oracle Financial Services Lending
and Leasing uses the following hierarchy to pick one of the items as the correct one:

1. Last Reported Date: The row that has been reported most recently is used.

2. Owner: In case of a tie on the last reported date, one of the tradelines is picked in the
descending order of priority depending on who the tradeline belongs to: Primary, Spouse,
then Secondary.

Debt Ratio combination

Oracle Financial Services Lending and Leasing uses the system parameter
DBR_JOINT_INC_DEBT_WITH_SPOUSE to decide whether to combine debt ratios of the
spouse with the primary applicant. The DBR_JOINT_INC_DEBT_WITH_COAPP parameter
decides whether to do the same on a non-spousal joint application.

When this indicator is checked, all liabilities in the Liability section on the Summary sub screen
of the Applicant (2) master tab with the Include box selected will be used in the debt ratio
calculation.

The following system parameter will be set up to provide switches to allow the functionality to
be turned on and off:

De-duping process

The de-duping logic will be integrated into the system decision-making process in the following
manner:
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Initial credit pulls on new applications

If the JOINT_DEDUP_SPOUSE_LIABILITIES/ JOINT_DEDUP_ALLAPL_LIABILITIES
system parameters are set to Y, uses the de-duping logic described above to uncheck the
duplicate liabilities in the spouse's/co-applicant’s liabilities.

If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/
DBR_JOINT_INC_DEBT_WITH_ALLAPL parameters are set to Y, the system includes the
liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

The system will use all available credit reports at the time.

Subsequent credit pulls (manual)

To remove duplicate liabilities from the calculation, choose the Dedup Liabilities button on
the Underwriting form (Applicants master tab > Summary sub screen > Liability
section). (Potential record locking situations force the action to remain manual versus the
system automatically doing it).

If the Populate Debt and Include Debt boxes are selected in the Applicant/Customer
Detail section on the Bureau master tab on the Underwriting form for the credit request
and the JOINT_DEDUP_SPOUSE_LIABILITIES/ JOINT_DEDUP_ALLAPL_LIABILITIES
system parameters are set to Y, the system will use the de-duping logic described above
to uncheck the duplicate liabilities in the spouse's/co-applicant's liabilities.

If the DBR_JOINT_INC_DEBT_WITH_SPOUSE/ DBR_JOINT_INC_DEBT_WITH_COAPL
parameters are set to Y, the system will include the liabilities of the spouse/ co-applicant
while calculating the debt ratio of the primary applicant.

The system will use all available credit reports at the time of the request that have been
requested within the number of days specified in the DEDUP_CRB_EXPIRATION_DAYS
parameter.

Restrictions

The de-duping logic will be limited based upon the discussion above. If the system cannot
identify two tradelines as duplicates based upon the logic mentioned above, the individual
tradelines will be retained. In such circumstances, both tradelines will be used in the debt ratio
calculation and it will be the user’s responsibility to disregard one of them by clearing the
Include check box.

3.6 Correspondence

The Correspondence screen enables you to setup the system’s correspondence.

The system provides two types of correspondence: predefined and ad hoc. The following chart
provides a quick summary of both:

Figure 3-26 Correspondence Types

TYPE OF CORRESPONDENCE: AD HOC | PREDEFINED

Created automatically

Created manually

Generated for accounts

Generated for applications

i el e Bt

Set up with the Correspondence link

ool Bead ol e o

set up with the Letters link on the Product link

>
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This chapter explains how to setup ad hoc correspondence with the Correspondence form.

The Correspondence screens provide a cost-effective and easy to use method to build custom
documents that draw information from the system’s database without additional programming.
You can choose what to include in a letter, create a template, and then use this template to
produce a letter.

The core of the Correspondence module is the document element -- the information stored in
the database merged into the correspondence. The system has document elements defined
for commonly used data elements in correspondence, such as account numbers, account
balances, customer addresses, telephone numbers, and due dates.

Correspondence consists of a document file with text of your choice and the document
elements from the system’s database.

You can create a correspondence set that consists of one or more documents. If a
correspondence set consists of more than one document, such as the account details letter
and a payment overdue letter, it prints both documents every time the system generates
correspondence for a customer.

The Correspondence module creates the following standard ad hoc correspondence:
e Microsoft Word (RTF)
e Adobe Acrobat (PDF/XFDF)

@® Note

In this document and in the system, the term BANKERS SYSTEM is synonymous with
Adobe Acrobat.

This section consists of the following topics:

»  Correspondence

» Creating Correspondence

*  Generating Correspondence

3.6.1 Correspondence

Navigating to Correspondence

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Correspondence.

The Correspondence screen contains the following sub screens:

e System Functions

 Elements

e E-Form Elements

e Documents

e Correspondence

Line Origination Setup Guide

G42451-01

September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 56 of 100



ORACLE’

3.6.1.1 System Functions

Chapter 3
Correspondence

The System Functions screen enables you to view the predefined functions for the appropriate
Line of credit product in the system. These are attributes from the database.

Functions define how the system retrieves data to include in correspondence. The data is
retrieved as elements which are either specific database columns or calculated values.
Elements are recorded on the Elements screen.

To view the predefined system functions

1. Click Setup > Setup > Correspondence > Line of credit > System Functions.

2. In the Function Definition section, you can view the following information.

Figure 3-27 Correspondence - System Functions

ORACLE’
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& welcome, DEMOSUPR + I8 Signout O

DashBoard
> Origination
> Servicing
*» Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendors
Collection Cydles
Reports
Error Massages
Translations
User
Organization
Companies
Access
Users.
Credit Bureau
Correspandence
General Ledger
Queuas
Printers.
Bank Details
Check Details
Standard Payess
Currendies
Zip Codes
Products
Asset Types

Correspondence 5
Common  Loan  Lime | Lease

Elements

Function Definition

E-Form Elements | Documents

View ~ Fomatv [ Freeze  E} Detach
Function Name Description
GET_ACC 112 DTS Get ACC Details (Loan OE)

GET_APP_CON_112 DTLS
GET_CON_112 DTLS

Function Parameters

View w Formatv  [Ep Freeze

Psition Parameter
1 iv_L0_ACE_id
2 iv_name_ar
3 iv_value_ar

Get APP Details (Loan OF)
Get Application Decisions (Loan Open Ended)
Get Application CON Details {Loan OE)

Get CON Details (Lozn OF)

& Detach
Description
Account 1D
Parameter Name
Parameter value

Wrap

(3] Close
Correspondence
Function Type Source Program
COR_ELM_PROC CGNACC_EL 112.01
COR_ELM_PROC 1
COR_ELM_PROC
COR_ELM_PROC

COR_ELM_PROC

A brief description of the fields is given below:

Table 3-38 Function Definition

Field

View this

Function Name

Displays the function name.

Description

Displays the function description.

Function Type

Displays the function type.

Source Program

Displays the source program.

3. Inthe Functions Parameters section, you can view the following information.

A brief description of the fields is given below:
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Table 3-39 Functions Parameters

|
Field View this

Position Displays the parameter position.
Parameter Displays the function parameter.
Description Displays the function parameter description.

3.6.1.2 Elements

The Elements screen displays the predefined document elements retrieved from the database
when the correspondence is generated.

In the Element Definitions section, you can update or edit only the Description field.
To view the Elements

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit >
Elements

2. On the Element Definitions screen, perform any of the Basic Operations mentioned in
Navigation chapter. You cannot add a new record.

Figure 3-28 Correspondence_Line_Elements
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A brief description of the fields is given below:
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Field

Do this

Level0 Type

Displays the element LevelO type.

Element Name

Displays the element name.

Element Type

Displays the element type.

Description

Specify the element description.

Data Type

Displays the element data type.

Source Function

Displays the element function.

Enabled

Displays if the element is enabled or not.

Default Value

Displays the default value.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.1.3 E-Form Elements

The E-forms Elements screen defines elements included when the system generates online
correspondence with a browser. The E-forms screen is set up only for PDF elements using the
XFDF format. These definitions translate the external element required by the vendor to a

systems correspondence element.

For example,

Table 3-41 E-Form Elements

Type

Details

Vendor Element

AlIBorrowers.FullNameStreetCityStateZip

(Contains names of all borrowers with address of
primary customer)

The system’s Elements

PRIM_APL_NAME
SPOUSE_APL_NAME
PRIM_APA ADDRESS1
PRIM_APA_ADDRESS?2
PRIM_APA ADDRESS3

Translation

PRIM_APL_NAME ||, || SPOUSE_APL_NAME ||
', || PRIM_APA_ADDRESSL1 || ;||
PRIM_APA_ADDRESS2 || ;" ||
PRIM_APA_ADDRESS3

To setup the E-forms Elements

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit > E-

Form Elements.

2. Inthe E-form Elements Definitions section, perform any of the Basic Operations

mentioned in Navigation chapter.
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Figure 3-29 Correspondence - E-Form Elements
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A brief description of the fields is given below:

Table 3-42 E-form Elements Definitions

Field Do this

LevelO Type Select the element LevelO type from the drop-
down list.

Source Code Select the element e-form source code from the

drop-down list.

Element Name Specify the element name (the name used in the

external form).

Description

Specify the element description.

Data Type Code

Select the element data type code from the drop-
down list.

Translation

Select the translation for the e-form element
(SQL statement fragment defining the element
data), from the drop-down list.

Enabled

Check this box to enable the e-form element.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.1.4 Documents

The Documents screen enables you to set up the various documents and the data fields that
the system compiles together when creating a correspondence. The system provides two
different document formats: Word or XFDF: XML-based form.
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@® Note

Oracle Financial Services Software assumes that the user is familiar with Word and

the Merge Document command. If the user is creating e-form documents with XFDF,
then Oracle Financial Services Software assumes that person is familiar with Adobe
forms.

To setup documents to be compiled in correspondence

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit >
Documents.

2. In the Document Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-30 Correspondence - Documents
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A brief description of the fields is given below:

Table 3-43 Document Definition

'
Field Do this

Code Specify the document code to define the name
for the new document.
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Table 3-43 (Cont.) Document Definition

|
Field Do this

Description Specify the document description for the new
document. This entry appears in the
Correspondence section on the Request
screen, when you generate an ad hoc
correspondence.

File Name Specify the document file name for the resulting
file (Word or XFDF document).

Ensure that the name specified here is same as
the BIP Template name since system refers to
this file name for generating the correspondence.

Level0 Type Select the levelO type from the drop-down list.

E-form Source Select the element e-form source from the drop-
down list.

Product Select the document product from the drop-down
list.

Source Select the document source type from the drop-
down list.

Enabled Check this box to enable the document definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Document Elements section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-44 Document Elements
|

Field Do this

Seq Specify the sequence number to order the
document elements.

Type Select element type from the following from the
drop-down list. This list provides the following
options:

System-defined — If you select, the value is
supplied by the system and cannot be changed
in the Correspondence Request screen.

Constant.

User Defined Element — If you select, you can
choose the value and change it in the
Correspondence Request screen.

User Defined Constant — If you choose, you
can choose the value, but you cannot change it
in the Correspondence Request screen.

Translated Element — If a document contains an
e-form element and you do not select this option,
then the value will not be translated.

Element Name Select the element name from the drop-down list.
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Field

Do this

Description

Specify element description.
Notes:

1. Check that the element name does not have
blank spaces or special characters, such as the
forward slash “/” or backward slash “\".

2. If the element is system-defined, then the
system will automatically complete this field.

Data Type

Select the element data type from the drop-down
list.

Format Mask

Select the element format mask from the drop-
down list.

Default Value

Specify the element default value.

Enabled

Check this box to include the element in the
document.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Document Template section, you can set the information about the template which
is attached to the correspondence documents. The template thus saved is similar to the
template functionality available in MS word. Perform any of the Basic Operations

mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-45 Document Template

Field

Do this

File Name

Specify the file name to define the name for the
new template.

Product

Select the product for which the template is valid,
from the dropdown list.

Customer State

Select the customer state for which the product
is valid, from the drop-down list.

Producer State

Select the Producer state for which the product is
valid, from the drop-down list.

App/Acc St

Select the Applicant/Account state for which the
product is valid, from the drop-down list.

New Template

Check this box to load the template as a new
template.

Loaded

Check this box to indicate that the template is
loaded.

Enabled

Check this box to enable the template.

® Note

You can define multiple templates for each document and the template file name
(BIP template) is picked based on following criteria — Product and Producer /

Account / Customer State.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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The Document Elements sub screen records the system’s application or account
information that appears in the ad hoc correspondence.

To generate a data file for a document

1. Inthe Document Definition section of Setup > Setup > Administration > User >
Correspondence >Line of credit > Documents, select the record for which you want to
generate a data file.

2. Click Gen. Data File button.
The system displays a new screen with the following options:

Figure 3-31 Generate a data file

Opening CODE1 2

You have chosen to open:

L CoDEL

which is & Adobe Acrobat Document
from: https://10,184,132.155:7013

What should Firefox do with this file?

@ Openwith | Adobe Acrobat (default) -

Save File

[7] Do thiz autom atically for files like this from now on,

OK Cancel

*  Open with — Select to view the data file in the format you want. The adjacent drop-
down list provides a list of formats compatible with the system. The system downloads
the file and displays it.

* Save File — Select to save the data file on your system.

3. Check the box Do this automatically for files like this from now on to apply selected
properties for the files which are similar to the current one.

3.6.1.5 Correspondence

The Correspondence screen enables you to define who will receive the documents you
created on the Document Definition screen by creating correspondence sets. Each document
must belong to a set, and a set can have more than one document.

To set up a correspondence set

1. Click Setup > Setup > Administration > User > Correspondence > Line of credit >
Correspondence. The correspondence setup is classified into two:

¢ Documents
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In the Correspondence section, perform any of the Basic Operations mentioned in

Navigation chapter.

Figure 3-32 Correspondence
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A brief description of the fields is given below:

Table 3-46 Set up a correspondence set

Field

Do this

Code

Specify the correspondence code.

Description

Specify the correspondence description
(required).

Print Schedule

Select the correspondence output schedule type
from the dropdown list.

Level Select the correspondence level type from the
drop-down list.

Group Select correspondence group from the drop-
down list.

Company Select the correspondence company from the
drop-down list.

Branch Select the correspondence branch from the drop-
down list.

Product Select the correspondence product from the
drop-down list.

Enabled Check this box to enable the correspondence.
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Perform any of the Basic Actions mentioned in Navigation chapter.

Click Setup > Setup > Administration > User > Correspondence > Line of credit >
Correspondence > Documents.

In the Documents section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 3-47 Documents
|

Field Do this

Document Select the correspondence document from the
drop-down list.

Recipients Select the recipients for the document from the
drop-down list.

Enabled Check this box to enable the recipient selected.

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Setup > Setup > Correspondence > Line of credit > Correspondence >
Functions.

In the Functions sub screen, you can define the functions that should be executed before
or after correspondence is generated. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Table 3-48 Functions

|
Field Do this

Function Select the correspondence functions from the
drop-down list.

Execute When? Select when to execute the correspondence
function from the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.2 Creating Correspondence

1.

To create a correspondence add a record in the document definition block. For example:
SAMPLE_LOAN_APP

In the Document Elements section, add the elements required in the correspondence.

Click on Gen.Data File to generate PDF file of the report.
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Figure 3-33 To generate PDF file of the report
) SAMPLE LOAN.APP (1)pd - Adobe Reater o |- 5 e

File Edit View Window Help

@8R2eB8E L [Ja|c=HB e@IE

Tools : Sign Commen

ORACLE
Financial Services Lending and Leasing

<?xml version="1.0" encoding="UTF-8" ?>

<xs:schema xmins:xs="http://www.w3.0rg/2001/XMLSchema" version="1.0">

<xs:element name="SAMPLE_LOAN_APP">

<xs:element name="PRIM_APL_BIRTH_DT" type="xs:string"/>
<xs:element name="PRIM_APL_NAME" type="xs:string"/>
<xs:element name="APP_REQ_ADV_AMT_100" type="xs:string"/>

<xs:element name="APP_APPROX_CASH_PRC_111" type="xs:string"/>

<xs:element name="ASE_APP_DESC_100" type="xs:string"/>
<xs:element name="PRIM_APL_SSN" type="xs:string"/>
<xs:element name="APA_ADDRESS1" type="xs:string"/>
<xs:element name="APA_ADDRESS2" type="xs:string"/>
<xs:element name="APA_ADDRESS3" type="xs:string"/>
<xs:element name="APE_NAME" type="xs:string"/>

<xs:element name="APA_PHONE" type="xs:string"/>

<xs:element name="APE_ADDRESS1" type="xs:string"/>
<xs:element name="APE_ADDRESS2" type="xs:string"/>
<xs:element name="APE_ADDRESS3" type="xs:string"/>
<xs:element name="APE_PHONE" type="xs:string"/>

<xs:element name="APL_EMAIL_ADDRESS1" type="xs:string"/>
<xs:element name="APL_NO_OF_DEPENDENTS" type="xs:string"/>
<xs:element name="APE_ACTUAL_MTHLY_AMT" type="xs:string"/>
<xs:element name="APP_PRO_NAME" type="xs:string"/>
</xs:element>

</xs:schema>

4. Copy and save the content in the pdf file as an xml file. The saved xml file should have the
same name as entered in the Code column of Document Definition section. For Example:
SAMPLE_LOAN_APP.xml.

5. Open MS Word.

® Note

Oracle Financial Services Software assumes that BIP Desktop Tool is installed
and the user is familiar with the BIP Report Tool.

6. In Bl Publisher Tab in MS Word, click on Sample XML and import the saved xml file. For
Example: SAMPLE_LOAN_APP.xml.

7. Create the template by inserting required elements tag.
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APP_REQ_ADV_AMT_100
APP_PRO_NAME
APP_APPROX_CASH_PRC_111
ASE_APP_DESC_100
PRIM_APL_NAME
PRIM_APL_BIRTH_DT
PRIM_APL_SSN

APE_NAME

APE_ADDRESS1

APE_ADDRESS2

APE_ADDRESS3
APE_PHONE
APE_ACTUAL_MTHLY_AMT
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APA_ADDRESS1
APA_ADDRESS2
APA_ADDRESS3
APA_PHONE

APL_EMAIL_ADDRESS1

8. The template created in MS Word should be saved with . rt f extension. For Example:
SAMPLE_LOAN_APP.rtf
® Note
The . xm and . rtf file should be saved with the same name as entered in the
Code column of Document Definition section.
9. Uploadthe rtf template in the BIP and create the data model with SQL query as sel ect
CDO_XM._DOCUNMENT from correspondence_docs where cdo_id = :docld.
10. After the data model creation, launch the correspondence screen and click
Correspondence tab.
11. You can setup a correspondence with the created doc.

3.6.3 Generating Correspondence

1.

To generate a correspondence open the application for which the correspondence should

be generated.

2. Click Correspondence tab. In the Correspondence section, click on Add.

3. Select the created Correspondence. Click Save and Add to save and add a new record.
Click Save and Return to save and return to main screen. Click Return to return to main
screen without modifications.
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Figure 3-35 Correspondence
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4,
view the Correspondence in PDF format.
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Figure 3-36 Generated Correspondence

ORACLE’
APPLICATION FOR PURCHASE OF ASSET Financial Services Lending and Leasing

BANK
LOAN APPLICATION FOR PURCHASE OF ASSET

Requested Loan Amount : 20000.00

Dealer

Approx Value of Asset : .00

Description of Asset : 2005 TOYOTA CAMRY
Name of Applicant ] ANDREW WATT

Date of Birth i 07/15/1975

SSN H XXXXX2147

Name & Address of Employer

58, EAST 19TH STREET

HOLTSVILLE NY 00544

Employer Phone : 0

Monthly Salary (Gross) 3 552230.00

Number of dependants : 0

Residence Address 3 34, WEST69THSTN BCHN

NEW YORK MA 01730 US

Address Phone : 0

E-mail i ANDREW.WATT@XYZ.COM

| declare that the information given in the application is true to the best of my knowledge and belief

Signature of the Applicant

3.7 Queues

When processing an application, various users might work on the application to complete
different tasks. A data entry person might complete the Application Entry screen before an
underwriter works on the application using the Applications screen. Later, another user might
use the Applications screen to fund the application.

The application processing workflow facilitates the movement of the application from one
person to another with queues. Queues create a work section of accounts waiting for a
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particular and common task to be performed, such as application entry or verification. The
system’s powerful queuing module automates this otherwise manual process.

In the Queues setup screen, you can setup and manage workflow and work assignments on a
daily basis to ensure that all applications are in the queues of the appropriate users at all
times.

Any time an application’s status is changed, the system checks whether the application is in
the right queue.

The system will sort queues based on an application’s status and sub status.

e Origination Tab
e User Groups Tab

3.7.1 Origination Tab

The Origination screen on the Queue Setup form allows you to set up queues that direct
applications to users during the line of credit origination cycle. Origination queues are based on
an application’s status and sub status. Whenever an application changes its status/sub status,
the system moves the application to a queue based on the information on this screen.

You can define the line of credit origination queues and the corresponding selection criteria
based on:

e Application status

e Application sub status
*  Product type

e Funding type

*  Product

* Underwriter

* State

e Channel

e Producer type

*  Producer

With line of credit origination queues set up, the applications in your work queue automatically
appear on the Results screen when you open the Underwriting or Funding screen. The queue
to which you are assigned appears in the Queue Name field. You would then begin processing
the applications in the order of which they are listed, double-clicking the application at the top
of the list to load it.

On the Setup > Setup > Queues screen, you can determine the direction of the applications to
users who process then. Whenever there is a change in the status or sub status of the
application, the system places the application in a appropriate queue based on the information
available in this screen.

Applications are further filtered based on the following criteria:
e Selection Criteria

e Sort Order

e Responsibilities and Users

e Data Node Assignments
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e Group Assignment
To setup Origination Queues

You can either define new Queue Definition details or specify a new name in the New Queue
field and click Create Copy to create a copy of selected queue definition with header and child
tab details (except Group Assignment tab).

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Queues > Origination.

2. Inthe Origination Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-37 Origination Definition

ORACLE" | ¥ . NextGenUl 15 Welcome, ABSHEKAR ~ [ Gign Out [prap] O
Financial Services Lending and Leasing

Queues x 3] Close
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View v Formatv  [Ep Freeze I Detach ol wrap &) New Queue Create Copy

Queue Name Queue Desc Override Responsibility Priority Company Branch Enabled
DATA_ENTRY_QUEUE DATA ENTRY APPLICATIONS Q_ NO RESPONSIBILITY 1AL ALL ¥
TST_NEW_APP_QUEUE NEW APPLICATIONS QUEUE  NO RESPONSIBILITY 1AL ALL N

TESTABHIZ31 DATA ENTRY APPLICATIONS Q_ NO RESPONSIBILITY 1AL ALL N

TESTOLL DATA ENTRY APPLICATIONS Q... NO NSIBILITY 1AL ALL N

NEW_APP_QUEUE NEW APPLICATIONS QUEUE  NO NSIBILITY 1AL AL ¥

NEW APP_MAC NEW APPLICATIONS QUEUE PONSIBILITY 1AL ALL N
APPROVED_APP_QUEUE APPROVED / CONDITIONED AP NO RESPONSIBILITY 2 ML ALL ¥

REJECTED_QUEUE REJECTED APPLICATIONS QUE . NO RESPONSIBILITY 3 AL ALL ¥ -

Selection Criteria | Sert | Responsibilities and Users || Data Node Assignments  Group Assignment

Application Status  Selection Criteria

Application Status dpadd | ALedi | Evew | o agdi
View » Formatw Gp Freeze A Detach Wrap 50}
Status Sub Status Enabled
NEW BACK TO DEALER ¥
NEW ENTRY COMPLETE ¥
HEW PREQUALIFY ¥
HEW PREQUALIFY APPROVED ¥
HEW PRESCREEN ¥
NEW PRESCREEN APPROVED ¥
NEW BLANK ¥

A brief description of the fields is given below:

Table 3-49 Origination Definition

Field Do this
Queue Name Specify queue name.
Queue Description Specify queue description.

Note: The system uses this entry when referring
to the queue on other forms.

Override Responsibility Select an override responsibility code from the
drop-down list.

The system uses this data to determine the User
who holds the override responsibility for the
specified queue, if an application triggers an
override edit.
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Table 3-49 (Cont.) Origination Definition

|
Field Do this

Priority Specify the priority number.
The system sorts applications by the higher
number. For example, an application with a
priority # 5 is considered to have a higher priority
than the one with a priority # 3.

Company Select the company from the drop-down list.
Branch Select the branch drop-down list.
Enabled Check this box to enable the queue.

Perform any of the Basic Actions mentioned in Navigation chapter.

This section consists of the following topics:

Selection Criteria

Sort

Responsibilities and Users

Data Node Assignments

Group Assignment

3.7.1.1 Selection Criteria

Here, you can further filter the applications in a particular queue. This criteria is generally used
by organizations to categories and allocate large number of applications to different queues.

@® Note

If you want to execute search on like operators, then use %.

To setup Selection Criteria

1.
2.

Click Setup > Setup > Queues > Origination > Selection Criteria > Application Status.

In the Application Status section, use the Status and Sub Status fields to define the
credit application status/sub status combinations that should be considered for the queue.

To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-50 Setup Selection Criteria
|

Field Do this

Status Select application status from drop-down list.

Sub Status Select application sub status drop-down list.

Enabled Select the check box to enable the application
status.

Perform any of the Basic Actions mentioned in Navigation chapter.
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@® Note

All is the default value for each field.

Click Setup > Setup > Queues > Origination > Selection Criteria > Selection Criteria.
In the Selection Criteria section, use the fields to define the credit application that should
be considered for the queue.

To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-51 Selection Criteria
]

Field Do this

Product Type Select the product type as line of credit from the
drop-down list.

Funding Type Select funding type from the drop-down list.

Product Select product from the drop-down list.

State Select state from the drop-down list.

Channel Select channel from the drop-down list

Underwriter Select underwriter from the drop-down list.

Producer Type Select producer type from the drop-down list.

Producer Group Select producer Group from the drop-down list

Producer Select producer from the drop-down list.

Region Select region of the producer from the drop-down
list.

Territory Select territory of the producer from the drop-
down list.

Sales Agent Select sales agent for the producer from the
drop-down list.

Funder Select funder for the producer from the drop-

down list.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Sort sub tab of Queue Definition, the new applications which are in origination queue are
displayed here based on sort criteria defined. In case of any overrides, applications would be
sorted automatically without the need of a setup definition. However, there is no impact if sort

is not defined for a queue.
To setup Sort Criteria

1.
2.
3.

Click Setup > Setup > Queues > Origination > Selection Criteria > Sort.

In the Sort section, use the Seq, Sort field, and Order to rearrange the queue.

To setup, perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:
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Table 3-52 Setup Sort Criteria
|

Field Do this

Seq Specify the sequence number representing the
sorting priority.

Sort Field Select the sort criteria from the list of parameters
available in the dropdown list.

Order Select either ascending or descending as the
sort order.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.3 Responsibilities and Users

1. Click Setup > Setup > Queues > Origination > Responsibilities and Users.

2. Inthe Responsibilities section, use the Responsibilities field to define the
responsibilities roles which are authorized to work on the queues.

3. To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-53 Responsibilities and Users
|

Field Do this
Responsibility Select the responsibility from the drop-down list.
Enabled Check this box to enable the responsibility.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Users section, use the User field to define the users who are authorized to work on
the queue.

6. To setup, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-54 Users
]

Field Do this
User Select user from the drop-down list.
Enabled Check this box to enable.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.4 Data Node Assignments

Data node Assignments provides user with the flexibility to view the tabs in origination. User
will have option to enable disable Tabs. All the enabled tabs will be displayed when application
is in that particular queue. Disabled tabs for the tabs will not be shown when applications is in
respective queue.

For example: Application entry Queue

If summary tab to be disabled, the search for the ULN Summary tab and Disable. IN
application Entry summary will not be shown.
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Click Setup > Setup > Queues > Origination > Node Assignments. You can enable the
administrator to configure the User interface nodes that should be made available for the
applications that are being processed in that particular origination queue.

In the Node Assignments section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 3-55 Node Assignments
|

Field Do this
Node Select the node from the drop-down list.
Enabled Check this box to enable the record.

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Load Queue Nodes to display the respective Ul nodes in the origination module.

3.7.1.5 Group Assignment

The Group Assignment sub tab allows you to add user groups to Origination Queue.

@® Note

Modification of user details (adding or disabling users) within a user group which is
added to Group Assignment will implicitly be updated in Responsibilities and Users tab
also.

To add User Group to Group Assignment

1.

3.

On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > Origination > Group Assignment.

In the User Group section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-56 User Group

|
Field Do this

Group Name Select the user group name from the drop-down
list. The list displays the pre-defined user groups
available in the system.

Enabled Check this box to enable the user group.

Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.2 User Groups Tab

The User Groups tab in Queues is a centralized repository which allows you to define user
groups, add and remove users from user groups.

The User Groups tab consists of User Group Definition section listing the defined User Groups
and User section below listing the associated users of the selected User Group.
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Figure 3-38 User Groups
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To define a User Group

1.

3.

On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > User Groups.

In the User Groups section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-57 User Groups
|

Field Do this
Name Specify user group name.
Description Specify an appropriate user group description.

The same is used while referring this User Group
on other screens.

Responsibility Select the responsibility of the user group from
the drop-down list. You can later add only those
Users who have the selected responsibility into
the user group.

Enabled Check this box to enable the user group.

Perform any of the Basic Actions mentioned in Navigation chapter.

To add Users to User Group

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > User > Queues > User Groups.

In the User Groups section, select the required User Group.

In the Users section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-58 Users

|
Field Do this

Name Select the user from the drop-down list, The list
displays the available users based on the
responsibility defined for the user group.

Enabled Check this box to enable the user.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.8 Printers

The Printers screen allows you to set up an unlimited number of network printers and fax
devices to be used with the system server. The system uses the information on this screen
while selecting a printer, when the printing process involves a batch job or uses a job
scheduler. Examples include printing reports and correspondence.

The printers and fax devices can be set up at each organization, division, or department to
promote efficient printing of documents, and reports. The system uses this information during
product setup and on the Letters screen in the Batch Printer field.

Special printer names

The following printer names are predefined and have specific functions within the system:

Table 3-59 Printer names

]
Name Description

UNDEFINED Indicates that the document to be printed is to be
previewed in your browser instead of actually
printing the document.

ARCHIVE Instead of sending an item to the printer, the
system generates a PDF document and saves it in
the archive directory on your server.

EMAIL For Line of Credit origination correspondences that
can be faxed, the system e-mails the document as
a PDF attachment to the consumer for direct Line
of Credit or to the producer in the case of in-direct
Line of Credit.

FAX For Line of Credit origination correspondences that
can be faxed, the system generates a PDF
document and will send to the fax server defined in
System Parameters.

Additionally, you may set up composite entries in the Printer Name field to perform two or more
functions at the same time. This can be done by defining a printer name with the following
format:

PRI NTER NAME = <PRI NTER_NAME1> + <PRI NTER_NAME2>

For example, if a printer named JET4050 was previously defined, as were the special printer
names listed above, then the following additional printers could be defined:
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Name

Description

JET4050+ARCHIVE

Prints the document with the jet4050 printer and
archives the document.

FAX+ARCHIVE

Faxes and archives the document.

EMAIL+ARCHIVE+JET4050

E-mails, archives, and prints the document with the
jet4050 printer.

To set up the Printers

1. Click Setup > Setup > Administration > User > Printers. The system displays the

Printers screen.

2. Inthe Printers section, perform any of the Basic Operations mentioned in Navigation

chapter.

Figure 3-39 Printers
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A brief description of the fields is given below:
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Table 3-61 Printers

|
Field Do this

Printer Name Specify the printer name. The name of the printer
as defined by the server. For a UNIX server, the
name might be JET4050, while to access the
same printer from a Windows server the name
would be: \ \ ser ver nane\ j et 4050.

Description Specify the description for the printer.

Organization Select the organization to which the printer
belongs, from the dropdown list.

Division Select the division to which the printer belongs,

from the drop-down list. The division will be
displayed based on the organization selected.

Department Select the department to which the printer
belongs, from the drop-down list. The
department will be displayed based on the
division selected.

IMPORTANT: When you select a printer to use,
the system searches for a best match using the
following attributes:

1. Organization
2. Division
3. Department

Hence, Oracle recommends creating a version of
each edit, where ALL is the value in these fields.

It is also recommended that, you define a default
printer for an Organization, Division and

Department.

Default Check this box to set the printer as a default
printer.

Enabled Check this box to enable the printer and that the

printer is active.
Note: Never disable the UNDEFINED printer

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.9 Intelligent Segmentation

OFSLL is equipped to leverage the Machine Learning (ML) feature of Oracle Database to
suggest and create Customer Servicing Queues by analysing the current system data. Using
this functionality, system automatically identifies the possible Queue/Segmentation for Account
data using the Machine Learning Algorithm thereby creating an Intelligent Segmentation.

This helps to automate the manual process of queue creation which is otherwise done by
identifying different segments of Accounts and assigning day to day Customer Service
Activities. Further queue processing workflow continues as detailed in Queues section.

*  Machine Learning for Queue Creation

*  Machine Learning Data visualization

* View Machine Learning Generated Queue

« Create ML Based Queue
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3.9.1 Machine Learning for Queue Creation

The Intelligent Segmentation screen in OFSLL is based on the Oracle JavaScript Extension
Toolkit (Oracle JET) framework. This facilitates to identify different clusters of data and create
queues.

In order to access the Intelligent Segmentation screen from the User Interface menu link, you
need to enable the system parameter FLL_SET JET INTELLIGENTSEG_URL (JET
INTELLIGENT SEGMENTATION URL). For more details on installing and deploying this
feature in OFSLL, refer to Installation Manual.

@® Note

The input data for Machine Learning (ML) data set cluster creation is provided by the
Batch Job QMLPRC_BJ_100_03 (ML DATASET CREATION FOR INTELLIGENT
SEGMENTA TION) available in batch job set SET-QCS.

In this screen, you do the following:

Figure 3-40 Intelligent Segmentation - Workflow

Identify Create View

Conditions Clusters Hierarchy

* ldentify Cluster of Data for a given Account Condition.
*  View hierarchy of cluster and list of accounts falling into different levels of cluster.

« Create a queue by selecting Cluster.

3.9.2 Machine Learning Data visualization

The data generated by the system is represented in the following view formats.
e Cluster view

e Segment View

e Insights View
e Selection Criteria Attributes
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Figure 3-41 Cluster view
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3.9.2.2 Segment View

Figure 3-42 Segment View
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Figure 3-43 Insights View
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Cuserio s Clusterla:> Cluster6: 10 Cluster et 11
Recors Coun: 95 Recors Coun: 131
Custeric:6 Cluster 29
Recore Record Count: 33
Recors Court: 31 Recora Count: 31

3.9.2.4 Selection Criteria Attributes

Clicking on any of the data segment system displays dynamic record details (Attribute Name

and Attribute Value) along with the option to create queue.

Figure 3-44 Selection Criteria Attributes

Records of Cluster - 7

ATTRIBUTE_NAME
ACC_COLLATERAL_TYPE_CD
ACC_DLQ_CATEGORY
ACC_DLQ_DAYS
ACC_DUE_TOTAL_AMT

ACC_OUTSTANDING_TOTAL_AMT

ATTRIBUTE_VALUE

HOME

180

211.857 to 392.714

Dto 29612.1

-10985 to 62604.5

3.9.3 View Machine Learning Generated Queue

To view ML based queue
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1. Click Setup > Setup > Administration > User > Intelligent Segmentation. The following
screen is displayed:

Figure 3-45 View Machine Learning Based Queue

oRAcLE

Financial Services Lending and Leasing

a

Intelligent Segmentation x (3] Close

Company * Branch * Account Conditions *

select v select select r

No data to display ﬂ-

2. Select the following option:

Table 3-62 View Machine Learning Generated Queue

Field Do this

Company Select the company from the drop-down list. The
list is populated only with those Company
Definitions to which you have been provisioned
access.

Branch Select the branch within the company from the
drop-down list. This may be ALL or a specific
branch. This must be ALL, if you have selected
ALL in the Company field.

Account Conditions Select the required account conditions. There
are various Account Conditions which are either
posted automatically by the system (like
updating DELQ delinquency condition on
account) or manually through a transaction or
call activity.

3. Click Submit. System generates different data segments based on above selected
combination using a background job process. By default, the data is represented in
clusters and can be viewed on other view formats as detailed in Machine Learning Data
visualization section.

3.9.4 Create ML Based Queue

On generating the data segments in the Intelligent Segmentation screen, you can further drill
down to each cluster and view details with different selection criteria. However, the details of
each record is based on the data maintained in the system.
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Table 3-63 Create ML Based Queue

|
Button Action

Create Clicking on this option creates a Queue in OFSLL
and the selection criteria of the Queue is populated
with the Cluster Attributes. The queue sequence is
based on Queue name/Description and is
displayed as a confirmation message in the format
Queue ML <Account Condition > <Date
YYYYMMDD > <Time HHMMSS> created
successfully.

@ Queue Created Successfully X

Queue ML_DELQ_20201209_011239 created successfully

The newly created queue is available in Setup >
Administration > User > Queues screen.

Note that following with ML generated Queues:

e All Queues are created in Disabled status with Selection Criteria Enabled.
e Priority is defaulted to O.

« Company/Branch is defaulted to selected combination.

e Hard Assigned/Group Follow-up/Near Real-Time/Dialler actions are marked as disabled.

3.10 Bank Detalils

The Banks screen defines the banks, a company/branch uses for processing Automatic
Clearing House (ACH) and lock box payments.

® Note

This is behind the scenes information that the system uses for payments and does
not appear on any other forms.

To set up the Banks

1. Click Setup > Setup > Administration > User > Bank Details link. The system displays
the Bank Details screen.

2. In the Banks Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 3-46 Banks Definition

ORACLE'
Financial Services Lending and Leasing
i Close
T Bank Details . Ha
" Origination . .
S e Bank Definition dadd | Fedt | [E view | oF auar
Servicing
i View Formaty [P Freeze Efi Detach Wrap [0
o ol ionss Code Name Short Name Enabled Account # Routing # BIC IBAN Country City.
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B P BANK P8 Y 0000(1115 831232246 NOT PROVIDED WEQE JAPAN TOFE
Setup NLB NL BANK NLE Y 300008779 884447474 NETHERLANDS AME W
Setup SAB SA BANK SAB Y 300006468 755665678 SAUDI ARABIA JED
Administration ~ < >
System
System Parameter Bank Definition
Lookups
Save and Add Save and Sta) Save and Return Retum
User Defined Tables d @ | d 2| Hs L
Audit Tables . R
User Defined Defauls: Code ﬂ Phone 1 (000)-000-0000
Transaction Codes * Name: Bxtn 1
o o * Short Name Phone 2
edupe i
Securitization Enabled [] =zp = Bafn2

Events
Eraj::rb;cla d Creditor 1d Fax 2
vandors Bic 3 *City * ACH Format [v]
Collection Cydes 184N o =
Reports
Error Messages ACH | Lock Box
Translations
User e -
Organization ACH Definition qeadd | AEdt | [Eview | F Audit
Companies View v Formate [ Freeze &l Detach Wrap o)
Arcess Company Branch ACH Identifier Enabled
Users No data to display.
Credit Bureau
Comespondence
General Ledger

B *Fax1 (000)-000-0000

= Routing #

Queues
Printers.
Bank Detzils
Check Details
Standard Payees
Currencies
Zip Codes
Products
Asset Types v

A brief description of the fields is given below:

Table 3-64 Banks Definition

|
Field Do this

Code Specify the bank code (ID used internally by
Oracle Financial Services Lending and Leasing
to represent the bank).

Name Specify the name for the bank.

Short Name Specify the short name for the bank (1D
displayed to represent the bank. This may be
included in any output files).

Enabled Check this box to enable and indicate this as an
active bank
Account # Specify the account number used for banking

transactions with the bank.

Note: If the organizational parameter
UIX_HIDE_RESTRICTED_- DATA is set to Y, this
appears as a masked number; for example,

XXXXX1234.
Routing # Specify the routing number of the bank.
BIC Select the Business Identifier Code from the

drop-down list. The list displays the BIC codes
defined in the system.
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Field

Do this

IBAN

Specify the IBAN (International Bank Account
Number). IBAN is used for identifying bank
accounts across national borders with a minimal
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-
digit validation based on modulo 97. On save,
system automatically validates the IBAN number
length based on country code, characters, white
spaces, and checksum. Validation is also done
during posting non-monetary transaction (ACH
Maintenance).

You can maintain the IBAN length and other
details required as per the country code in the
user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for NL country code

(IBAN_FORMAT_NL) is defined by default with
length of IBAN as 18.

Country

Select the country where the bank is located,
from the drop-down list.

City

Specify the city where the bank is located.

State

Select the state where the bank is located, from
the drop-down list.

Address Line 1

Specify the address line 1 for the bank.

Address Line 2

Specify the address line 2 for the bank.

Zip

Specify the zip code where the bank is located,
from the drop-down list.

Extn Specify the extension of the zip code where the
bank is located.

Creditor Id Specify the creditor identification details.

Phone 1 Specify the primary phone number of the bank.

Extn 1 Specify the phone extension for the primary
phone number.

Phone 2 Specify the alternate phone number for the bank.

Extn 2 Specify the phone extension for the alternate
phone number.

Fax 1 Specify the primary fax number for the bank.

Fax 2 Specify the alternate fax number for the bank.

ACH Format Select the ACH format accepted by this bank

from the drop-down list. The list displays the
following options:
*  NACHA Format

. SEPA Format

3. Perform any of the Basic Actions mentioned in Navigation chapter.
4. Click Setup > Setup > Administration > User > Bank Details > ACH.

5. On the ACH Definition sub screen, you can create ACH files for the bank listed in the
Banks section. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:
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Table 3-65 ACH Definition
]

Field Do this

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list.

ACH ldentifier Specify the lock box ID provided by the bank.
This field is used in the ACH files to identify the
bank.

Enabled Check this box to enable the ACH and indicate

this as an active ACH identifier.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7. Click Setup > Setup > Administration > User > Bank Details > Lock Box.

8. On the Lock Box sub screen, you can create lock box files for the bank listed in the Banks
screen. Perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 3-66 Lock Box
|

Field Do this

Lock Box Identifier Specify the lock box ID provided by bank. This
field is used in the lock box files to identify the
bank.

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list.

Enabled Check this box to enable the lock box.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.11 Standard Payees

The Standard Payees screen defines the third parties that are frequent payees for checks
issued within your organization. These payees are then available on the Consumer Lending
screen’s Advance Entry screen. When you select the Payee # in the Advance Allocation
section, the system completes the remaining fields in this screen with information from the
Standard Payees screen.

@® Note

The Payee # field on the Advance Payment forms is a non-validated field. This allows
you to select an entry or enter one of your own.

To set up the Standard Payees

1. Click Setup > Setup > Administration > User > Standard Payee. The system displays
the Standard Payees screen.
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In the Payee Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

Figure 3-47 Standard Payee

ORACLE’

Financial Services Lending and Leasing

# Welcome ABSHEKAR ~  ESIOINON

Payee # 1001
* Name ACH
*Pmt Mode | ACH
% * Enabled
* Country UNITED STATES
Address Line 1 LINEL
Address Line 2 LINE2
Zip 85587

Standard Payees 3 Close
Payee Definition 4k Add |/ Edit View ¥ Audit
View v Formatv [ Freeze i Detach Wrap W
Payee # Name Pmt Mode Enabled Country Gity State Address Line 1 Address Line 2 7Zip Extn P
1001 ACH ACH ¥ UNITED STATES LEXINGTON ILLINOIS LINE1 LINE2 85587 (012)-34
1002 ACH ACH Y UNITED STATES NEW JERSEY NEW JERSEY LINEL LINE2 59868 (012)-34
< >
Payee Definition
[ saveand stay | [ Save and Retum | (3 Retun

Extn

City LEXINGTON
State ILLINOIS =
Phone 1 (012)-345-6789 BIC 3

Phone 2

Bank Name BANK OF VISA CARD
Routing # 53847658
Account Type CHECKING M

ACH Account # 767554588
* Company ALL =2
*Branch ALL 2

IBAN
Start Dt 06/28/1997
Comment

A brief description of the fields is given below:

Table 3-67 Payee Definition

Field Do this

Payee # Specify the payee number (Identifier for the
payee).

Name Specify the payee name.

Pmt Mode Select the payment method for the payee from
the drop-down list.

Enabled Check this box to enabled the payee.

Country Select the country where the payee is located
from the drop-down list.

City Specify the city where the payee is located.

State Select the state where the payee is located from

the drop-down list.

Address Line 1

Specify the address line 1 for the payee
(optional).

Address Line 2

Specify the address line 2 for the payee
(optional).

Zip Select the zip code where the payee is located
from the drop-down list.

Extn Specify the extension of the zip code where the
payee is located.

Phone 1 Specify the primary phone number for the payee.

Phone 2 Specify the alternate phone number for the

payee.
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Table 3-67 (Cont.) Payee Definition

Field Do this

Bank Name Specify the payee ACH bank name used by the
standard payee.

Routing # Specify the payee ACH bank routing number of
bank used by the standard payee.

Account Type Select the payee type of ACH bank account
maintained by the Standard Payee from the drop-
down list.

ACH Account # Specify the payee ACH bank account number.

Company Select the company from the drop-down list. The

list is populated with Company definitions based
on the Country selected.

Branch Select the branch drop-down list. The list is
populated with Company branch based on the
Country selected.

BIC Select the Business Identifier Code from the
drop-down list. The list displays the BIC codes
defined in the system.

IBAN Specify the IBAN (International Bank Account
Number). IBAN is used for identifying bank
accounts across national borders with a minimal
of risk of propagating transcription errors.

Ensure that value entered satisfies the check-
digit validation based on modulo 97. On save,
system automatically validates the IBAN number
length based on country code, characters, white
spaces, and checksum. Validation is also done
during posting non-monetary transaction (ACH
Maintenance).

You can maintain the IBAN length and other
details required as per the country code in the
user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for NL country code
(IBAN_FORMAT_NL) is defined by default with
length of IBAN as 18.

Start Dt Specify the payment mode start date, the date
the current payment method was implemented
(defaults on Pmt Mode change). you can also
select from the adjoining calendar icon.

Comment Specify a comment for this advance allocations.
This is the default comment to include with
payments to this Payee.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.12 Check Details

The Check Details screen allows you to set up check details.

To setup the Check Details

1. Click Setup > Setup > Administration > User > Check Details. The system displays the
Check Details screen.
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2. Inthe Check Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

Figure 3-48 Check Details
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A brief description of the fields is given below:

Table 3-68 Check Definition

Field Do this

Company Select the company from the drop-down list.
Branch Select the branch from the drop-down list.
Payee Type Select the payee type from the drop-down list.
Check # Specify the check number (required).

Printer Name Specify the printer name (required).

Enabled Check this box to enable the check details entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.13 Currencies

The Currencies link allows you to set up currency details.
Navigating to currencies

Click Setup > Setup > Administration > User > Currencies. The system displays the
Currencies screen. In this screen, you can set up:
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e Currency Definition

e Currency Pair link

3.13.1 Currency Definition

The Currency Definition screen allows you to set up currency details.

To set up the currency definition information

1. Click Setup > Setup > Administration > User > Currencies > Currency. The system
opens the Currency Definition tab by default.

2. Inthe Currency section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 3-49 Currencies

ORACLE 1 £ Welcome, PRAKRRAQ ~ o
Financial Services Lending and Leasing
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Zip Codes
Products
Asset Types
Index Rates

Currency Exchange
Scoring Parameters
Products

Pricings

Contract

Edits

Cycles

Scoring Models
Fees
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A brief description of the fields is given below:

Table 3-69 Currency Definition

'
Field Do this

Currency Select the currency you want to define, from the
drop-down list.

Currency Name The system displays the currency name based
on the currency selected.

Country Select the country for which the currency is
defined, from the dropdown list.
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Table 3-69 (Cont.) Currency Definition

|
Field Do this

Enabled Check this box to enable the currency entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.13.2 Currency Pair link

The Currency Pair Definition link allows you to set up currency pair details.

To set up the currency pair definition information:

1. Click Setup > Setup > Administration > User > Currencies > Currency Pair. The
system displays the Currency Pair Definition screen.

2. Inthe Currency Pair Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-50 Currency Pair
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A brief description of the fields is given below:

Table 3-70 Currency Pair Definition

Field View this

Currency Code Select the currency code from the drop-down list.

Currency Pair Code Select the currency pair code from the drop-
down list.

Line Origination Setup Guide
G42451-01 September 11, 2025
Copyright © 2022, 2025, Oracle and/or its affiliates. Page 93 of 100



ORACLE’

Table 3-70 (Cont.) Currency Pair Definition

Chapter 3
Zip Codes

Field

View this

Through Currency

Check this box to set the selected currency as a

through currency.

Through Currency Code

Select the through currency code from the drop-

down list.

Enabled

Check this box to enable the currency pair entry.

Perform any of the Basic Actions mentioned in Navigation chapter.

3.14 Zip Codes

To set up the zip codes information

The Zip Codes screen allows you to set up zip code details.

Click Setup > Setup > Administration > User > ZipCodes. The system displays the Zip

Codes screen.

In the Zip Codes section, perform any of the Basic Operations mentioned in Navigation

chapter.

Figure 3-51 Zip Codes
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A brief description of the fields is given below:
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Table 3-71 Zip Codes

Field View this

Country Select the country from the drop-down list.
State Select the state from the drop-down list.
Zip Code Specify the zip code (required).

City Specify the city.

County Specify the county.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.15 Payment Hierarchy

The Payment Hierarchy screen facilitates to define hierarchy definition along with payment
appropriation, excess payment handling, account selection criteria and sort order. These
details are required by the system to allocate payments to the matching accounts of a
customer, when customer based payments are being processed in Payment Entry screen.

Below is an illustration on how payment hierarchy is used to post customer based payments.

Figure 3-52 Payment Hierarchy - lllustration

hJ

Payment Hierarchy Setup

ry Order By / Appropriation Sequence

bl e Customer |
(U1 / Service Call) > Customer «

Y >

4 Master Account

v Spreads
{Funds appropriation sequence by

(Generic Payment Upload

balance type i.e. Charges, Interest,
Principle and so an)

Any Payment transaction generated in the system either from Ul / Web Service Call or through
a Payment Batch (Generic Payment Upload) can be directly posted to an Account or at
Customer level.

* If payment is posted directly to an Account, the funds are allocated based on the defined
spread with funds appropriation sequence of balance type i.e. Charges, Interest, Principle
and so on.

* If payment is posted at Customer level having two accounts and if the payment amount is
less than the due, then appropriation sequence is required. Else, one of the account can
have a short fall with payment allocation.

In such case, the Payment Hierarchy determines the sequence of payment as to which
account is to be appropriated first and which is to be appropriate next. This is based on order
by clause and appropriation sequence defined.

Also the Balance Type determines the distribution type as one of the following:

e Equally to all the accounts
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* Prorated by Due amount (i.e. highest due or lowest due first)

e Prorated by Outstanding Amount.

Once the account is narrowed down and payment amount is decided, then based on spread
the payment is appropriated. This gives additional flexibility for defining payment modes at the
master account level.

If Payment Hierarchy is not defined while funding an application or needs correction, the same
can be done by posting MASTER ACCOUNT PAYMENT HIERARCHY MAINTENANCEnon-
monetary transaction in Servicing > Maintenance > Transaction Batch Information section. At
Customer level, Payment hierarchy can be updated by posting CUSTOMER MAINTENANCE
transaction.

This section consists of the following topics:

«  Payment Appropriation Methods

 Excess Payment Appropriation

3.15.1 Payment Appropriation Methods

While creating Hierarchy definition in the Payment Hierarchy screen, you can use any of the
following payment appropriation methods available in Hierarchy Type field. On selecting the
specific Hierarchy definition at Application or Account level, the defined method is used to
allocate payments to corresponding accounts.

However in all the methods, the payment criteria is also used for identifying the due accounts
and careful consideration is required while defining the same.

Table 3-72 Payment Appropriation Methods
]

Method Description
EQUAL AMOUNT To allocate payment equally to all the accounts
picked.

This is traditional method of payment allocation in
which the total payment amount received is divided
and adjusted equally to all customer linked
accounts.
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Table 3-72 (Cont.) Payment Appropriation Methods
]

Method

Description

DUE AMOUNT RATIO

To allocate payment based on the ratio of amount
due on all accounts.

In this method, the due accounts are identified
based on the defined selection criteria and the
payment appropriation is done on the ratio of
amount due on each account using the below
formula.

Amount Due + Payment Amount
Total Due Amount

Following is an illustration on payment allocation:

Amount Due [o]
Master Account 30 200
Associated Account 1 50 250
Associated Account 2 100 400

‘Due A Ratio ‘f‘ ding A 1t Ratio ‘Equil Amnunt‘
Payment Amount ‘ $90 ‘ $90 ‘ $90 ‘

Master Account 515 $21.18 530
Associated Account 1 $25 $26.47 $30
Associated Account 2 $50 $42.35 $30

OUTSTANDING BALANCE RATIO

To allocate payment based on the ratio of total
outstanding due on all accounts.

Similar to above, even in this method the due
accounts are identified based on the defined
selection criteria and the payment appropriation is
done on the ratio of outstanding amount due on
each account using the below formula.

Outstanding Balance + Payment Amount
Total Outstanding Balance

This method can be selected if the received
payment amount is equal to total outstanding due
on all linked accounts indicated in Customer
Service > Transaction History > Balances screen.

ACCOUNT COLUMN BASE

To allocate payment based on hierarchy order.

In this method, the due accounts are identified
based on the defined selection criteria and the
payment appropriation is done as per the sequence
of due accounts defined either in ascending/
descending order.

During payment appropriation, system allocates the payment amount only up to the total of
resulted accounts and remaining amount (if any) are processed based on the excess payment

method value.

While onboarding accounts through web services, system considers the value of system
parameter PMT_HIERARCHY_CODE to default the payment allocation in Customer/ Business

Details screen after account activation.
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Also while onboarding if the Payment Hierarchy is not passed as part of the request (Applicant/
Application), then system parameter value is considered.

3.15.2 Excess Payment Appropriation

During or after payment appropriation, there can be a residual amount pending for allocation.
For example, $0.01 remains when $100 is equally paid to 3 accounts. In such case the
residual amount is transferred to last account in the hierarchy sequence. However, note that
system performs this residual payment allocation only once.

In other case where there in an excess payment received which is more than account dues,
the same can be processed for payment allocation using any of the following Excess
Handling Method while defining the Hierarchy Definition.

Table 3-73 Excess Handling Method

______________________________________________________________________________|]
Method Description

SUSPENSE To post the excess amount as suspense on
Customer or Master account.

HIERARCHY BASED To allocate the excess payment based on any of
the Hierarchy Definitions maintained in the system.

Based on the selection, system re-allocates the excess amount to corresponding accounts.

To set up payment hierarchy
1. Click Setup > Setup > Administration > User > Payment Hierarchy.

2. In the Hierarchy Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 3-53 Hierarchy Definition

ORACLE’ # Welcome ABSHEKAR ~ =)
Financial Services Lending and Leasing
s
Payment Hierarchy [3] Close
Hierarchy Definition P Add | ZEdt | 5] View | o Audit
View v Format v [[5% Freeze i Detach wap @R
Name Description Hierarchy Type Excess Handling Method ~ Excess Hierarchy Name Enabled
TEST_PH1 TEST_PH1 ACCOUNT COLUMN BASED HIERARCHY BASED PH1 ¥ ~
PAYMENT3 PAYMENT3 DUE AMOUNT RATIO SUSPENSE Y
PAH_TEST2 PAH_TEST2_DESC EQUAL AMOUNT HIERARCHY BASED TEST_PH2 Y
OUTSTANDING BALANCE OUTSTANDING BALANCE OUTSTANDING BALANCE RATIO HIERARCHY BASED PAYMENT_COLUMNBASED Y
N M_PH2 M_PH2 OUTSTANDING BALANCE RATIO SUSPENSE Y N
* >

Account Selection Criteria  Hierarchy Order

Account Selection Criteria P Add | ZEdit | 5] View | o Audit
View v Format~ 5 Freeze i Detach Wrap M o Check Criteria

Comparison o Logical
Operator Cetal il ) Operator
0 DELINQUENT DAYS LESS THAN OR EQ... 0 x

Seq ( Parameter Enabled

A brief description of the fields is given below:
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Field View this

Name Specify an unique name for the hierarchy
definition.

Description Specify the description for the hierarchy
definition.

Hierarchy Type Select one of the following type of payment

allocation method from the drop-down list. The
list is populated based on the
PMT_HIERARCHY_TYPE_CD lookup.

e EQUAL AMOUNT

«  DUE AMOUNT RATIO

OUTSTANDING BALANCE RATIO

«  ACCOUNT COLUMN BASED

For more information on the above methods,
refer to Payment Appropriation Methods section.
You can define multiple Hierarchy definitions with
same Hierarchy type.

Excess Handling Method

Select one of the following type of excess
payment allocation method to be used with
payment hierarchy definition from the drop-down
list. The list is populated based on
PMT_HIERARCHY_EXCESS_METHOD_CD
lookup.

¢ SUSPENSE

¢ HIERARCHY BASED

For more information on the above methods,
refer to Excess Payment Appropriation section.

Excess Hierarchy Name

This field is enabled and is mandatory if the
Excess Handling Method is selected as
Hierarchy Based.

Select the Hierarchy Definition from the drop-
down list. This list is populated with all the pre-
defined and enabled hierarchy definitions
maintained in the system.

For more information on the above methods,
refer to Excess Payment Appropriation section.

Enabled

By default this check box is enabled for new
hierarchy definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Account Selection Criteria

This sub tab facilitates to define the account selection criteria that is used to identify due
account for payment allocation. Atleast one valid account selection criteria is required for all

the Hierarchy Types.

1. Inthe Account Selection Criteriasection, perform any of the Basic Operations mentioned

in Navigation chapter.
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Although system allows to define customized selection criteria, the execution of
additional selection criteria requires additional processing at server level and can
have significant performance impact delaying the EOD processing/web services.
Hence it is recommended to have careful consideration while defining the
additional selection criteria (like using user-defined tables and columns) and/or get
approval from your database administrator before using any selection criteria.

A brief description of the fields is given below:

Table 3-75 Account Selection Criteria

Field Do this

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.

The list is populated based on the values
maintained in CUSTOMER PAYMENT
HIERARCHY ORDER PARAMETERS user
defined table.

Comparison Operator

Select comparison operator from the drop-down
list.

Criteria Value

Specify criteria value.

)

Specify right bracket.

Logical Expression

Select logical operator from the drop-down list.

Enabled

Check this box to enable the selection criteria.

Perform any of the Basic Actions mentioned in Navigation chapter.

You can click Check Criteria for system to validate the query and display the results.

Hierarchy Order

This sub tab facilitates you to define hierarchy order that is used to sort the due account for
payment allocation. This sub tab is enabled only for ACCOUNT COLUMN BASED Hierarchy

type.

1.

2.

In the Hierarchy Order section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of the fields is given below:

Table 3-76 Hierarchy Order

Field Do this

Seq Specify sequence number.

Sort Field Select sort field from the drop-down list. The list
is populated based on values maintained in
CUSTOMER PAYMENT HIERARCHY ORDER
PARAMETERS user defined table.

Order Select sort order as either Ascending or

Descending from the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.
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Under the Setup master tab’s drop-down link bar, the product Setup link opens screens that
enable you to configure the basic business guidelines necessary to support one or more
products in the system. This includes defining the types of collateral your company supports,
creating lending instruments, and determining what is included in credit bureau reporting.
Setting up the Products screens requires a thorough understanding of the current rules of your
business and must be completed before you can use Oracle Financial Services Lending and
Leasing. The Products drop-down link opens screens to record data of all the products
supported by the system and contains the following links:

Navigating to Products

In the Setup > Setup > Products link enables you to setup the options related to the following
closed ended products that your company offers. Below sections explain how to setup the
screens associated with each one.

* Asset Types
* Index Rates

e Currency Exchange

e Scoring Parameters

e Products

e Pricings

»  Contract

+ Edits

+ Cycles

e Scoring Models
* Fees

* Asset Billing Rate

e QOrigination Fees

e |nsurance

e Checklists
e  Stipulations
e Letters

Promotions

4.1 Asset Types

In Assets types you can setup the asset types that can serve as an application or account’s
collateral.

The information on the Assets screen is used by the system to automatically display the
appropriate collateral screen (Vehicle, Home, or Other) on the Application Entry screen.
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The system recognizes the following four types of collateral:

Table 4-1 Collateral

Collateral Type

Description

Home collateral

Homes, manufactured housing, or any real estate
collateral.

Vehicle collateral

All vehicle types, such as cars, trucks, and
motorcycles.

Household goods and other collateral

All other collateral types not defined as home,
vehicle, or unsecured; for example, household
items such as water heaters, televisions, and
vacuums.

Unsecured collateral

All unsecured lending instruments. (This collateral
type makes the collateral tabs on the system forms
unavailable.)

The Asset Sub Type section allows you to further categorize an asset; for example, the asset
type VEHICLE might be categorized as CAR, TRUCK, or VAN.

The Attributes/Addons and Makes and Models sub screens continue to further detail the asset
both in description and value. For example, a VEHICLE asset might include addons such as

LEATHER SEATS and CRUISE CONTROL.

@® Note

Neither asset types nor asset sub types can be deleted. As they may have been used
in the past, the display and processing of that data is still dependent on the existing

setup.

To set up the Asset Types

You can either define new Asset Type or specify a new name in the New Asset Type field and
click Create Copy to create a copy of selected asset with details.

1. Click Setup > Setup > Products > Asset Types.

2. Inthe Asset Type section, perform any of the Basic Operations mentioned in Navigation

chapter.
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Figure 4-1 Asset Type

Chapter 4
Asset Types

ORACLE"
Financial Services Lending and Leasing

Asset Types

Asset Type
View > Format~ [ Freeze i Detach ol Wrap W New AssetType
Asset Type Description
BUS BUS
BUS_TEST BUS_TEST
CAR. CAR.
CAR_CP CAR_CP
CAR_CP2 CAR_CP2
Asset Sub Type
View v Formatv [y Freeze [ Detach Wrap 5]

AssetSubType  Description
MINI BUS MINTBUS

»
Asset Sub Type
Asset Sub Type  MINIBUS

*Description. MINI BUS

* Asset Property Type - INDERMINATE

Asset Attributes
View = Fomatv [ Freeze pfiDetach | ol wrap W
Attribute/Addon Description

No data to display.

Attributes [ Addons | Makes and Models | Usage/Rental Detalls | Usage Charge Matrix | Rental Charge Matrix

 Welcome, ABSHEKAR ¥ o
[Elciose
dpadd || Leit | Guen || o audt
[ create Copy

Colateral Type Company Branch Enabled

VEHICLE COLL ATERAL AL AL Y -
VEHICLE COLLATERAL AL AL Y

VEHICLE COLLATERAL AL AL Y

VEHICLE COLLATERAL AL AL N

VEHICLE COLLATERAL AL AL N -

Feadd | LEdt | [EVen | 2 Audt

Asset Property Type Ensbled
INDERMINATE ¥

i saveand stay || [ seve andRetun || CaRetum

*Enabled [

ok add || LEdt | [Evew | o2 Audt

Default Velue Enabled

A brief description of the fields is given below:

Table 4-2 Asset Type

Field

Do this

Asset Type

Specify the asset type.

Description

Specify the description for the asset. (This is the
asset type which will appear throughout the
system).

Collateral Type

Select the collateral type (the general category
that the asset type falls within) from the drop-
down list.

Note: There is no need to define an asset for
UNSECURED COLLATERAL, as by definition
there is no asset on such account.

Company

Select the portfolio company to which the asset
type belongs, from the drop-down list. These are
the companies within your organization that can
make Line using this asset type. This may be
ALL or a specific company.
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Table 4-2 (Cont.) Asset Type

|
Field Do this

Branch Select the portfolio branch to which the asset
type belongs, from the drop-down list. This is the
branch within the selected company that can
make Line using this asset type. This may be
ALL or a specific branch. This must be ALL if in
the Company field you selected ALL.

IMPORTANT: By selecting which asset type to
use, the system searches for a best match using
the following attributes:

1. Company
2. Branch

Hence, the system recommends creating one
version of each asset type where ALL is the
value in these fields.

Enabled Check this box to enable the asset type and
indicate that the asset type is currently in use.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Asset Sub Type section, perform any of the Basic Operations mentioned in

Navigation chapter.
A brief description of the fields is given below:

Table 4-3 Asset Sub Type
|

Field Do this

Asset Sub Type Specify the asset sub type.

Description Specify the description for the asset subtype.

Asset Property Type Select the type of property from the drop-down
list.

Enabled Check this box to enable the asset sub type.

Perform any of the Basic Actions mentioned in Navigation chapter.
Click Setup > Setup > Products > Assets > Attributes/Addons.

In the Attributes/Addons section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-4 Attributes/Addons
|

Field Do this

Attribute/Addon Displays the asset attribute or addon name for
the selected asset).

Description Select the description for the asset attribute/
addon from the dropdown list.

Default Specify the default text to be copied or displayed

when the asset attributes and addons fields are
completed on an application for this asset.
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Table 4-4 (Cont.) Attributes/Addons

|
Field Do this

Value Specify the default monetary value to be copied
or displayed when the asset attributes and
addons fields are completed on an application for
this asset.

Enabled Check this box to enable the asset attribute/
Addon and indicate that it is available for this
type of asset.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
9. Click the Setup > Setup > Products > Assets > Makes and Models.

10. In the Makes and Models section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-5 Makes and Models
|

Field Do this

Make Specify asset make.

Model Specify asset model.

Style Specify asset style type.

Model Year Specify asset model year.

Enabled Check this box to enable the asset make and

model and indicate that it is included on fields for
this asset type.

11. Perform any of the Basic Actions mentioned in Navigation chapter.
This section consists of the following topics:

» Usage/Rental Details

* Usage Charge Matrix

* Rental Charge Matrix

4.1.1 Usage/Rental Details

The Usage / Rental Details sub tab allows you to define Usage/Rental definition details to
categorize the incoming asset usage/rental data based on different parameters. The details
maintained here are populated in Origination screen for billing calculation and can also be
modified based on requirement.

1. Inthe Usagel/Rental Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

2. A brief description of the fields is given below:

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 5 of 81



ORACLE’

Table 4-6 Usage/Rental Details

Chapter 4
Asset Types

Field

Do this

Agreement Type

Select the agreement type as one of the
following from the drop-down list. The selected
Agreement Type defines the criteria for pricing
selection during billing calculation.

« USAGE

« RENTAL

« USAGE RENTAL

Note: Based on the above selected option, the
other fields are either enabled or disabled for
selection as indicated below:

For Usage Agreement Type, the following fields
are editable:
e Calc Method

e Usage Cycle

e Min Usage

¢ Max Usage

*  Discount %

e Usage Rollover / Advance

e Usage Term Calc Method

For Rental Agreement Type, the following fields

are editable:
. Discount %

e Discount Amount

e Security Deposit

For Usage Rental Agreement Type, the following
fields are editable:

* Usage Cycle

¢ Max Usage

e Discount %

e Discount Amount

e Security Deposit

Calc Method

Select the calculation method as one of the

following from the dropdown list.

e TIERED (billing is based on the defined
Usage/Rental Charge Matrix)

*«  NON-TIERED (system automatically
chooses the applicable slab based on the
final usage value)

Usage Cycle

Select the frequency of billing the asset usage
from the drop-down list. This field is disabled for
RENTAL agreement type.

Min Usage

Specify the minimum usage value of the allowed
range. This field is disabled for RENTAL
agreement type.

Max Usage

Specify the maximum usage value of the allowed
range. This field is disabled for RENTAL
agreement type.

Discount %

Specify the percentage of discount exempted
from final billing.
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Field

Do this

Usage Rollover / Advance

Select the type of asset usage calculation as one

of the following:

* ROLLOVER (remaining usage balance is
carried forward to next cycle)

¢ NO-ROLLOVER (remaining usage balance
is not carried forward)

*  ROLLOVER AND ADVANCE (remaining
usage balance is carried forward to next
cycle + total usage limit for current cycle can
be utilized upfront)

*  ADVANCE (total usage limit for current cycle
can be utilized upfront)

Note: This field is disabled for RENTAL and

USAGE RENTAL agreement type and NO-
ROLLOVER option is applicable by default.

Reset Frequency

Specify the reset frequency of the billing cycle.
This field is disabled for RENTAL and USAGE
RENTAL agreement types and is available for
ROLLOVER, ADVANCE and ROLLOVER AND
ADVANCE methods of asset usage billing.

Usage Term Calc Method

Select the type of asset usage term for billing
calculation as one of the following from the drop-
down list:

*  ACTUAL - here the current details updated/
received is treated as the final record for
usage term calculation.

*  AVERAGE - here system takes the average
of usage details received in previous cycles
for usage term calculation.

The calculation method selected here is
populated to Elastic Term Calc Method field in
Origination/Servicing Collateral screen. This field
is disabled for RENTAL and USAGE RENTAL
agreement type.

Discount Amount

If you are defining Usage/Rental Details for
RENTAL or USAGE RENTAL type of
agreements, specify the discount amount
allowed upfront from the final billing. This field is
disabled for USAGE agreement type.

Security Deposit

If you are defining Usage/Rental Details for
RENTAL or USAGE RENTAL type of
agreements, specify the security deposit amount
paid upfront for the term. This field is disabled for
USAGE agreement type.

Excess Rent Collection Method

If you have selected the Agreement Type as
USAGE RENTAL, select one of the following type
of Charge Matrix to be used to derive the Excess
Rent Collection Method from the drop-down list.
*  USING USAGE MATRIX

*  USING RENTAL MATRIX

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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The Usage Charge Matrix sub tab allows you to define and maintain different chargeable slabs
based on the combination of Billing Cycle and Charge Type. The details maintained here are
used for billing calculation based on a particular asset usage.

1. Inthe Usage Charge Matrix section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 4-7 Usage Charge Matrix

Field

Do this

Billing Cycle

Select the frequency of the billing cycle for the
asset from the drop-down list.

Units From

Specify the minimum number of units from which
the current usage charge matrix is applicable.

Charge Per Unit

Specify the amount to be charged for every unit.

Charge Type

Select the Charge Type as one of the following

from the drop-down list. The list is displayed

based on CHARGE_TYPE_CD lookup.

e BASE (Units considered as base and
chargeable at base rate)

 EXCESS CYCLE (Units beyond base units
and chargeable considering excess cycle)

e EXCESS LIFE (Units exceeding the total
contracted units and chargeable considering
excess life cycle)

Excess life is not applicable for Rental agreement
type.

Enabled

Check this box to enable the charge matrix for
usage calculation.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.1.3 Rental Charge Matrix

The Rental Charge Matrix sub tab allows you to define and maintain different chargeable slabs
based on the combination of Billing Cycle, Rental Duration, Charge Per Cycle and Charge
Type. The details maintained here are used for billing calculation based on a particular asset

usage.

1. Inthe Rental Charge Matrix section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 4-8 Rental Charge Matrix

Field

Do this

Billing Cycle

Select the frequency of the billing cycle for the
asset from the drop-down list.

Rental Duration From

Specify the minimum duration for which the
rental charge is applicable.
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Table 4-8 (Cont.) Rental Charge Matrix
|

Field Do this

Charge Per Cycle Specify the amount to be charged for every
rental cycle.

Charge Type Select the Charge Type as one of the following

from the drop-down list. The list is displayed

based on CHARGE_TYPE_CD lookup.

e BASE (Chargeable units exceeding from
base units allowed)

e EXCESS CYCLE (Chargeable units
exceeding from billing cycle units)

e EXCESS LIFE (Chargeable units exceeding
the total contract term)

Excess life is not applicable for Rental / Usage,
Rental agreement types.

Enabled Check this box to enable the charge matrix for
usage calculation.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

4.2 Index Rates

The Index Rates screen maintains your organization’s history of periodic changes in index
rates. It allows you to define index rates to support variable rate lines of credit. The index rate
provides the base rate for a credit line where:

interest rate = index rate + margin rate.

The Index section displays the currently defined indexes on the Lookups screen. You may
create additional user-defined lookup codes for this lookup type as needed.

® Note

You cannot tie an index rate to a product rate.

You can also record any index rate change on the Index Rates screen. During nightly batch
processing, all the accounts with that index type are included when posting the RATE
CHANGE transaction. After the system processes the batch, the interest rate of the account is
changed. The system will use this new interest rate when computing all future interest
calculations.

To set up Index Rates
1. Click Setup > Setup > Products > Index Rates.

2. Inthe Index section, perform any of the Basic Operations mentioned in Navigation
chapter.:
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Figure 4-2 Index Rates
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3. A brief description of the fields is given below:

Table 4-9 Index
]

Field Do this

Index Type Select the type of index from the drop-down list.
Short Description Specify a short description of the index.
Description Specify the index description.

Enabled Check this box to activate the index type.

Perform any of the Basic Actions mentioned in Navigation chapter.
The Index Details section allows you to define multiple index values using the Start Dt and
Rate fields.

@® Note

The history appears in descending order, with the most current record at the top.

In the Index Details section, perform any of the Basic Operations mentioned in Navigation
chapter.
A brief description of the fields is given below:

Table 4-10 Index Details

|
Field Do this

Start Dt Specify the effective start date for the index rate.
You can even select the date from the adjoining
Calendar icon.

Rate Specify the new index rate effective from above
mentioned date as a percentage.

Note: For the FLAT RATE index there should be

only one entry with a Start Dt. = 01/01/1900 and
a RATE = 0.0000.
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Table 4-10 (Cont.) Index Details

|
Field Do this

Enabled Check this box to activate the index rate effective
from start date mentioned above.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

@® Note

Variable rate functionality is not extended to pre-compute accounts.

4.3 Currency Exchange

The Currency Exchange screen maintains currency exchange rates. You can define the
currency exchange details and schedule a batch job (SET-IFP- ICEPRC_BJ 100 _01 -
CURRENCY EXCHANGE RATE FILE UPLOAD) which in-turn pulls the currency exchange
rates from desired source at scheduled intervals through input file processing.

To set up the Currency Exchange
1. Click Setup > Setup > Products > Currency Exchange.

2. Inthe Currency Exchange Rates section, perform any of the Basic Operations mentioned
in Navigation chapter.

Figure 4-3 Currency Exchange Rates
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Queues EUR PY 12/23/2015 05:50:49 AM 3.5000 ¥
Printers ! EUR Pr 12/23/2015 05:50:49 AM 3.6000 ¥
Bank Detais g ER OMR. 12/23/2015 05:52:38 AM 5.1000 ¥
Check Detais EUR Fr 12/24/2015 12:16:26 AM 45000 ¥
Standard Payess EUR Fr 12/24/2015 12:48:25 AM 3.3000 ¥
Currencies
oo duip e Currency Exchange Rates
Asset Types [ Save andStay. || [ Save andRetum || GaRetun
Index Rates 3
Currency Exchange Currency ELR Rate 0.0000
Scoring Parameters Currency Pair JPY *Enabled [7]
Products Effective Dt and Time  12/23/2015 05:50:49 AM
Pricings
Contract
Edits
Cydes
Scoring Models
Fees
Origination Fees
Compensation
Commission
Insurance
Checklists

Stipulations

A brief description of the fields is given below:
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Scoring Parameters

Table 4-11 Currency Exchange Rates
|

Field Do this

Currency Select the currency being exchanged from the
drop-down list.

Currency Pair Select the currency to be paired with from the
drop-down list.

Effective Date and Time Specify date and time of the exchange rate. You

can even select the date from the adjoining
Calendar icon.

Rate Specify the exchange rate (required).
Enabled Check this box to activate the currency exchange
rate.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.4 Scoring Parameters

With the Scoring Parameters, you can define the scoring parameters of a company’s credit
scorecard and behavioral scoring.

The system’s pricing scores apply to applications and are based on information recorded
during origination.

Credit Scoring

Parameters define the factors that can be used when scoring an application during
underwriting and generating an initial decision on whether you wish to fund an amount. The
combination of the flexible definition of these parameters, along with the scoring set up on the
Scoring Models screen, allows you to automate much of the initial decision process in
underwriting accounts.

The Formula Definition section on the Scoring Parameters screen allows you to build a
mathematical expression to express the scoring parameter, test its validity, and locate specific
information with the resulting scoring parameters. The system calculates scoring parameters
using application data, credit bureau information, and applicant details.

To set up the Scoring Parameters

You can either define new Scoring Parameters or specify a new name in the New Parameter
field and click Create Copy to create a copy of selected parameter with details.

1. Click Setup > Setup > Products > Scoring Parameters.

2. Inthe Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.
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Figure 4-4 Parameters

ORACLE' ls i, Welcome, vaVAIDYA + =
Financial Services Lending and Leasing

Close
> DashBoard Scoring Parameters x —

> Origination
> Servidini

Parameters dadd | At | Elview | o audt

Data Type Scoring Type Enabled
NUMEER BEHAVIORALSCO... Y
FICO_SCORE FICO SCORE HUMEER. CREDITSCORING Y
AL x x NUMEER. CREDITSCORING N
Setup TesT TesT CHARACTER CREDITSCORING N

> WEP

Parameters
0 Soveand tay || ) save and etum || G etun

= Scoring Type  BEHAVIORAL SCORING
= Enabled @)

Formula Definition F a0 || Lt | Elvien | & auit
Viewv Formatv [ Freeze i Detach rap o
sea ( variable Constantvaiue Hitfematical Enabled

1 Acc_pug_pavs ¥

A brief description of the fields is given below:

Table 4-12 Parameters

'
Field Do this

Parameter Specify the name of the scoring parameter. The
system recommends entering a name that in
some way reflects how the parameter is used; for
example, use FICO_SCORE instead of
PARAMETER_1.

Description Specify a description of the parameter. Again,
Specify a name that reflects how the parameter
is used; for example, use FICO SCORE and
WEIGHTED FICO SCORE instead of FICO
SCORE NUMBER 1 and FICO SCORE
NUMBER 2.

Data Type Select the data type of the scoring parameter
being defined from the drop-down list. This
determines how the system handles the values.
(While DATE and CHARACTER are available
data types, generally only NUMBER should be
used when defining a scoring parameter.

Scoring Type Select the scoring type from the drop-down list:
CREDIT SCORING or BEHAVIORAL SCORING.
Enabled Check this box to enable and indicate that the

scoring parameter is available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The Formula Definition section allows you to define a mathematical expression of the
scoring parameter you want to define. The expression may consist of one or more
sequenced entries. All arithmetic rules apply to the formula definition. If errors exist in the
formula definition, the system displays an error message in this section when you choose
Show Expression.

4. In the Formula Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Table 4-13 Formula Definition

|
Field Do this

Seq Specify the sequence number (the order in which
the formula definition variable will be assembled
and evaluated).

( Specify a left bracket, if you need to group part of
your formula definition.
Variable Select the variable from a validated field based

on the user-defined table

SCR_CRED_SUMMARY: SCORING

PARAMETERS, from the drop-down list.
Constant Value Specify the constant value (optional).

You can specify varchar values which includes
Numbers, Alphabets/ letters, special character/

symbols.

Mathematical Operator Select the math operator to be used on the
adjacent formula definition rows, from the drop-
down list.

) Specify a right bracket, if you are grouping part

of your formula definition.

Enabled Check this box to enable the formula and
indicate that it is included when building a
definition for the scoring parameter.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Parameters section, click Show Expression.
The mathematical expression appears in the Formula Expression section (in sequential
order) in the Expression field.

4.5 Products

The Product screen defines the closed ended products your organization offers. This screen is
enhanced to support Islamic along with the conventional.

A product is based on the following attributes:

*  The collateral type and sub type

e The billing cycle

*  Whether the amount is paid directly or indirectly to the customer

The Product Definition section records details about the product such as the description, start
and end dates, collateral type and sub type, credit bureau reporting attributes, billing cycle,
index and rate calculation attributes.

System supports Biennial (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle frequency can be defined:

e BILL_CYCLE_CD
e LOC BILL_CYCLE_CD - for Line of Credit accounts.

The Product Itemization section is used to define itemized entries for a product. This
information is used on the Itemization sub screens of the Application Entry and Application
screens.
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The Rate Adjustments section is used to define the frequency of rate change allowed during
interest rate calculations.

To set up the Product

You can either define new Product details or specify a new product code in the New Product
field and click Create Copy to create a copy of selected product with details.

1. On the Oracle Financial Services Lending and Leasing home screen, Setup > Setup >
Administration > User > Products > Products > Line.

2. Inthe Product Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-5 Product Definition

ORACLE’

# Welcome ABSHEKAR v o
Financial Services Lending and Leasing
Products x 3 Close
Loan Line  Lease
Line Product P Add |/ Edit View Audit
View v Format v Freeze [ Detach Wrap W NewProduct Create Copy
. N Close Account After  Customer Credit . Skip Credit BL
Product Description Start Dt End Dt Direct o e Same Billing Cycle  Enabled Resorting
CREDIT LINE REVOLVING CREDIT LINE 07/30/1987 12/31/4000 Y [ Y N 7 N
LINE AUS AUS LINE UNSECURED (VR) 12/17/1997 12/31/4000 Y Y N N Y N
LINE WEEKLY BIL LINE WEEKLY BILLING 01/01/2019 12/31/4000 Y Y N N N N
LINE-BI-WEEKLY LINE-BI-WEEKLY 12/17/1997 12/31/4000 Y Y N N Y N
LINE-BIENNIAL LINE-BIENNIAL 12/17/1997 12/31/4000 Y Y N N Y N
LINE-TRIENNIAL LINE-TRIENNIAL 12/17/1997 12/31/4000 Y Y N N id N
LINE-WEEKLY LINE-WEEKLY 12/17/1997 12/31/4000 Y Y N N Y N
LINE_CRB_SKIP LINE CRB SKIP 01/01/2019 12/31/4000 Y Y N L4 Y Y >
»
Line Product
[ save and Stay. || [ Save and Return || Ga Retum
Product CREDIT LINE * Customer Credit Limit @ * Credit Bureau Portfolio Type | LINE OF CREDIT v
* Description | REVOLVING CREDIT LINE * same Billing Cycle % Cradit Rureau Account Type | LINE OF CREDIT v
*start Dt 07/30/1987 B *Enabled @ Check to enable/disable Skip Credit Bureau Reporting | x jing cycle | MONTHLY 5
*End Dt 12/31/4000 | @ * Skip Credit Bureau Reporting @ * Category | STANDARD =
* Direct @ * Collatera] Type (VEHIQLE OO ATERAL r Index Rounding | NO ROUNDING TO INDEXRATE ¥
* Close Account After Paid-Off @) * Collateral Sub Type ' PERSONAL PROPERTY VEHICLE ¥
Product Itemizations 4 Add |/ Edit View 7 Audit
View v Format v B Freeze i Detach Wrap @
Ttemization Disc Rate Sort Sign Enabled
ITM ADMINISTRATION / ACQUISITION FEE 0 +ve (vely
ITM CASH SALES 1 +ve @-ve y .

A brief description of the fields is given below:

Table 4-14 Product Definition

|
Field Do this

Product Specify the product code as defined by your
organization (in other words, how you want to
differentiate the products). For example, products
can be differentiated according to asset. The
product code, or name, is unique.

Description Specify the description of the product. (This is
the product description as it appears throughout
the system).

Start Dt Specify the start date for the product. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for the product. You can
even select the date from the adjoining Calendar
icon.
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Table 4-14 (Cont.) Product Definition

Chapter 4
Products

Field

Do this

Direct

Check this box, if you need the product to be
originated directly to customer. (In this case, the
compliance state is the state listed in the
customer’s current mailing address.) If
unchecked, the product is an indirect lending
product; that is, payment is made to the
producer. (In this case, the compliance state is
the state listed in the producer’s address.)

Close Account After Paid- Off

Check this box to allow the account to be closed
once the account is paid off i.e. system closes
the account after the number of days specified in
the system parameter has elapsed. This option is
selected by default.

If not selected, system ignores the system
parameter and does not close the account even
if the account is paid off i.e. system keeps the
accounts active so that the equity can be traded
with other accounts. For information on accounts
trading, refer to Appendix - Trading of
Accounts chapter.

Note: If the business practice of a financial
institution is not to close the accounts then this
Indicator need to be unchecked. Mainly in the
Vacation Ownership where a Timeshare product
can be traded anytime even if the account is
paid-off, this feature is used.

Customer Credit Limit

Check this box to enable Customer Credit Limit
tab in Origination module. Using the Customer
Credit Limit tab, an underwriter can define a
specific credit limit for the customer while funding
the first application and based on that credit limit,
subsequent applications can be funded.

For more information, refer to Customer Credit
Limit details in User Guide.

Same Billing Cycle

Check this box to set the same billing cycle
(supported only billing cycles Monthly and
Weekly) for all the future applications funded for
an existing customer.

Enabled

Check this box to activate the product.

Note: You can check this box only when Rate
adjustment schedule is maintained, i.e., All the
products should be variable rate products.
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Table 4-14 (Cont.) Product Definition

Chapter 4
Products

Field

Do this

Skip Credit Bureau Reporting

Check this box to skip credit bureau reporting of
all Accounts funded with this product type - i.e.
on funding an application, that particular account
is enabled with this parameter and is excluded
when the metro Il batch job is run for credit
bureau reporting.

This option can also be enabled/disabled at
individual account level in Servicing by posting
Skip Credit Bureau Reporting Maintenance
nonmonetary transaction.

However note that existing behaviour of Stop
Bureau Account condition would still be
applicable.

Collateral Type

Select the collateral type for the product, from the
drop-down list. This field identifies what type of
collateral is associated with the and assists the
system in identifying the correct screen(s) to
display.

Collateral Sub Type

Select the collateral sub type for the product,
from the drop-down list.

Credit Bureau Portfolio Type*

Select the credit bureau portfolio type for the
product, from the dropdown list.

Credit Bureau Account Type*

Select the account type for the product, from the
drop-down list.

*Note: The Credit Bureau Portfolio Type and
Credit Bureau Account Type fields determine
how the portfolio is reported back to the credit
bureaus.

Billing Cycle Select the billing cycle for the product, from the
drop-down list.
Category Select the category as Standard for the

conventional product and Islamic for the Islamic
product, from the drop-down list. This serves to
group products for reporting purposes.

Index Rounding

Select the index rate rounding factor for the
product, from the drop-down list.

Note: For more information, refer Appendix C:
Rounding Amounts and Rate Attributes.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

This section consists of the following topics:

e Product Itemizations

4.5.1 Product Itemizations

1. Click Setup > Setup > Administration > User > Products > Products > Line > Product

Itemizations.

2. Inthe Product Itemization sub screen, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:
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Table 4-15 Product Itemization

|
Field Do this

Itemization Select the itemization type for the product
selected in product definition section, from the
drop-down list.

Discount Rate Specify the discount rate.
Sort Specify the sort order.
Sign Select +ve for a positive number and -ve for a

negative number.

Note: The +ve and -ve buttons determine
whether the values will increase or decrease the
itemization total for the product based on the
selected product. Together the contents of the
Product Itemization sub screen, positive and
negative, add up to the amount.

Enabled Check this box to indicate that this product
itemization is currently available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.6 Pricings

The Pricing screen records pricing information related to your products. the system uses the
information in the Pricing Definition section to identify the correct pricing for an application,
depending upon the product and the specific application parameters. the system will always
search for a unigue match.

When you choose the Select Pricing while making a decision on the Underwriting window,
the system displays the best match and completes the Pricing and Approved sections under
Summary sub tab. The information in the Approved section cite the minimum amounts for the
selected product, though the user can edit these figures.

The system determines the best match by looking at all enabled pricing strings on the Pricing
screen that meet the following criteria:

e Exactly match the application values for the Promotion and Billing Cycle fields.

e Are less than or equal to the application values for the Term, Amount, Age, and Start Date
fields.

e Match either the application value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches of ALL. The returned
rows are then ranked based on the weighted values and the hierarchical position of the field
(see above). They are then ranked by start date. The system recognizes the first row returned
as the best match.
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*  You should set up a default pricing for each billing cycle and pricing that the
system can select to ensure error-free performance. Oracle Financial Services
Software recommends creating a single version of each edit type, where ALL is
the value in the selection criteria fields listed above. If the system cannot find a
pricing match, it will display an error message.

* The system supports the bulk uploading of product pricing setup data. This allows
you to upload multiple setup data, avoid re-entering setup data, and more
importantly, reduce data entry mistakes. The system currently supports uploading
using a fixed-length format only, where each data is at a pre-fixed position. You
can run batch jobs with the Set Code SET-BLK to upload pricing and GL data.

System supports Biennial (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle frequency can be defined:

BILL_CYCLE_CD

LOC _BILL _CYCLE_CD - for Line of Credit accounts

To set up the Pricing

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Pricings > Line.

In the Pricing Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

Figure 4-6 Pricings

ORACLE’
Financial Services Lending and Leasing

Pricings x.

lozn  Line Lesse

Line Pricing Definition

SKSK_TEST

m

Line Pricing Definition

Prigng CN_LN_O_01
* Description DEFAULT PRICINGLOC
*StartDt 05/12/1994 (B
*EndDt 123174000 B

* Enabled [¥]
Result

*DrawPeriod 7
*RepmtPeriod 12
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View = Formatv [ Freeze  [fiDetach Wrap )
Priang Desarption Start Dt End ot
CNINOE DI  DEFALLTPRICING.. 05/12/1394 12/31/4000
CN_LN_OE D1 _TEST DEFALLT PRICING... 12/14/2000 132/31/4000
CN_LN_OE 01 TE... DEFAULTPRICING... 12/17/2006 12/31/4000
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*Index PRIME RATE [+
* Margin From  4.9900
*MarginTo 24.9900

* Maturity Index PRIVE RATE =

# Mahwity Marrin Rt From | 4.9000
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i

v
¥
7

pE——
24.9500 4.9900
24.9900 4.8900

Selection Criteria

* Company AL

*Branch
ALL l
*Biling Cyde Y

*Product AL

*State AL

*ProGroup AL
*ProType AL
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* Producer Territory AL
* Channel AL
*Producer ALL

*Grade ALL

Maturity Index

PRIME RATE
FRIME RATE
PRIME RATE
FLAT RATE

[=]
=
=
=

=
=
=
=
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24,5500 43500 PRIME RATE 100000 1
24,8900 48500 FLATRATE 100000 1
,
[ saveandstay || [ saveandRetum || GaRetum
* AssetType ALL [=]
*5ubType ALL [=]
* Assct Make | ALL =l
= AssetModel | ALL =
*age o
Tradedn | ALL [~]
Mieage 0
*=Cumency ALL [+]
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A brief description of the fields is given below:
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Pricings

Field

Do this

Pricing*

Specify the code for the pricing.

Description*

Specify the description for the pricing.

* Together these two fields define the name of the pricing.

Start Dt Specify the start date for this pricing. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for this pricing. You can
even select the date from the adjoining Calendar
icon.

Enabled Check this box to enable the pricing.

Result section

Draw Period Specify the draw term for which this pricing is

valid.

Repmt Period

Specify the repayment term for which this pricing
is valid.

Max Credit Specify the maximum credit Limit for this pricing.

Index Select the index type associated as FLAT/PRIME
RATE from the drop-down list.

Margin From Specify the minimum margin rate for the selected
index type.

Margin To Specify the maximum margin rate for the

selected index type.

Maturity Index

Select the maturity index type associated as
FLAT/PRIME RATE from the drop-down list.

Maturity Margin Rt From

Specify the minimum margin rate for the selected
maturity index type.

Maturity Margin To

Specify the maximum margin rate for the
selected maturity index type.

Selection Criteria

Company

Select the portfolio company for this pricing, from
the drop-down list. This may be ALL or a specific
company.

Branch

Select the portfolio branch for this pricing. This

may be ALL or a specific branch. (This must be
ALL if in the Company field you selected ALL),

from the drop-down list.

Billing Cycle

Select the billing cycle for this pricing, from the
drop-down list.

Product

Select the product for this pricing, from the drop-
down list. This may be ALL or a specific product.
The available values come from a validated field
based on the selected billing cycle and the
product setup.

State

Select the state for this pricing, from the drop-
down list. This may be ALL or a specific state.

Pro Group

Select the producer group for this pricing, from
the drop-down list. This may be ALL or a specific
producer group.

Pro Type

Select the producer type for this pricing, , from
the drop-down list. This may be ALL or a specific
producer type.
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Pricings

Field

Do this

Producer Region

Select the region of the producer.

Producer Territory

Select the territory of the producer.

Producer

Select the producer from the drop-down list. This
may be ALL or a specific producer. The available
values come from a validated field based on the
product group and product type.

Grade

Select the credit grade for this pricing, from the
drop-down list. This may be ALL or a specific
grade.

Credit Limit

Specify the minimum credit limit for which this
pricing is valid.

Asset Class

Select the asset class from the drop-down list.
This may be ALL or a specific asset class. The
available values come from a validated field
based on the collateral type. You may create
additional user-defined lookup codes for these
lookup types as needed.

Asset Type

Select the asset type from the drop-down list.
This may be ALL or a specific asset type. The
available values come from a validated field
based your assets setup.

SubType

Select the asset sub type from the drop-down
list. This may be ALL or a specific asset sub
type. The available values come from a validated
field based your assets setup, and is linked to the
selected asset type.

Asset Make

Select the asset make from the drop-down list.
The available values come from a validated field
based your assets setup and is restricted based
on the selected Asset Type and Asset Sub Type.
For example, If ALL was selected for either Asset
Type or Asset Sub Type, then ALL will be the
only available selection for the asset make.

Asset Model

Select the asset model from the drop-down list.
The available values come from a validated field
based your assets setup, and is restricted based
on the selected Asset Type and Asset Sub Type.
If ALL was selected for either Asset Type or
Asset Sub Type, then ALL will be the only
available selection for the asset model.

Age

Specify the asset age (the minimum age for the
selected pricing).

Note: If your entry in this field is based on the
number of years of age of the asset and not the
actual year of make, you must update this entry
annually to ensure that the proper pricing is
available.

Trade-In

Specify if there is a trade in of an asset by
selecting Yes/No.

Mileage

If there is a Trade-In of an existing asset, then
specify its mileage in km.

Currency

Select the currency for this pricing, from the
drop-down list.
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4.7 Contract

Table 4-16 (Cont.) Pricing Definition

Chapter 4
Contract

Field Do this

Promotion Select the promotion applicable to this pricing
from the dropdown list. The available values
come from a validated field based on the
promotions setup.

Asset Value Specify the asset value.

LTV Specify the loan to value ratio.

Existing Customer

Select one of the following options from the drop-
down list to define the applicability of the current
pricing definition:

ALL - Applicable to both existing and new
customers

YES - Applicable to existing customer only

NO - Applicable to new customer only.

Based on the selection criteria, system defaults
the first pricing for applications with Existing
customer flag = Y at primary applicant details.

Existing Customer Since (In Years)

Specify the duration from when customer
account was created in the system up to the
current date in years.

Selection Criteria : Business - allows you to indicate the age of business by evaluating the total

number of years elapsed.

Years In Business

Specify the total number of years in business.

Perform any of the Basic Actions mentioned in Navigation chapter.

The Contract screen allows you to define the instruments used within your system. A
instrument is a contract used by a financial organization with specific rules tied to it. When
processing an application, an instrument associated with the application informs the system of
the type of contract being used for the approved product. This ensures that all parameters tied
to the instrument are setup for the account as it is booked - without requiring you to do it.

Instruments can be setup at different levels:

Company
Branch

Product
Application state

Currency

The following groups of parameters are setup at the instrument level (Each has its own section
on the Contract screen):

Selection Criteria
Accrual
Capitalization
Scheduled Dues
Billing
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*  Delinquency

e Extension

* Advance Details

* Rate Cap And Adjustments
e Other

Items defined in the contract are locked in when you choose Select Instrument on the Funding
form’s Contract link.

The Contract screen’s Instrument and Description fields allow you to enter the financial
instrument’s name and description, .

System supports Biennial (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle frequency can be defined:

e BILL_ CYCLE_CD
e LOC_BILL_CYCLE_CD - for Line of Credit accounts

To set up the Contract

You can either define new Contract Definition details or specify a new name in the New
Instrument field and click Create Copy to create a copy of selected contract with details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > Products > Contract > Line.

2. Onthe Contract Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-7 Contract

ORACLE’ # Welcome ABSHEKAR + (=)
Financial Services Lending and Leasing

Contract x [3] Close

Loan | Line | Lease

Contract Definition P add || ZEdit || B view || & Audit
View v Format v B Freeze [ Detach Wrap W) New Instrument [ create copy

Instrument Description Start Dt End Dt Enabled Capitalize Company Branch Billing Cycle Product State
AUS_ANLY_INS ~ AUS_ANNUALLY_INS 03/03/2000 12/31/4000 [ ¥ AUSOL AL MONTHLY ALL ALL
AUS_ANLY_INS AUS_ANNUALLY_INS 03/03/2020 12/31/4000 b i AUSO01 ALL MONTHLY ALL ALL
AUS_LINE_FIRST_... AUS_LINE_FIRST_PAY 03/03/2020 12/31/4000 Y 0 AUSO01 ALL MONTHLY ALL ALL
INS-CAP-MONTHLY  CAP MONTHLY 03/10/2018 12/31/4000 Y 0s ALL ALL MONTHLY ALL ALL
INS-CAP-QUATERLY CAP QUATERLY 01/01/2018 12/31/4000 Y Y ALL ALL MONTHLY AL ALL
INS-LINE-BIENNIAL INS-LINE-BIENNIAL 12/17/1997 12/31/4000 Y N SAUDI SARL BIENNIAL ALL ALL
INS-LINE-HE-MET... INS-LINE-HE-METROIL 12/17/1997 12/31/4000 Y N SAUDI ALL MONTHLY ALL ALL
INS-LINE-TRIENNL... INS-LINE-TRIENNIAL 12/17/1997 12/31/4000 Y N SAUDI SARL TRIENNIAL ALL ALL
INSLOC LINE OF CREDIT UNSECURED  12/17/1997 12/31/4000 Y N ALL ALL MONTHLY ALL ALL
INS-LOC-CREDIT-... LINE OF CREDIT UNSECURE... 03/11/2020 12/31/4000 Y Y ALL ALL MONTHLY ALL ALL -

Balances  Amortized Balances | Itemizations | Fees

Contract Balances Z kdit || [E view || 2 Audit
View v Format v [ Freeze [ Detach Wrap @ < Load Balances

Balance Type Chargeoff Method  Witeoff Method ~ Reschedule Method  Sort Billed Accrued Capitalize Frequency Grace Days gg;l‘os
ADVANCE / PRINCL.. CHGOFF BALANCE  WAIVE ROLLOVER BALANCE 100 Y Y N UNDEFINED 0 N
INTEREST CHGOFF BALANCE WAIVE ROLLOVER BALANCE 200 ¥ N Y QUARTERLY 2 N
FEE LATE CHARGE CHGOFF BALANCE WAIVE ROLLOVER BALANCE 301 N N Y QUARTERLY 2 N
FEE NSF CHGOFF BALANCE WAIVE ROLLOVER BALANCE 302 N N Y QUARTERLY 2 N
FEEEXTENSION  CHGOFF BALANCE  WAIVE ROLLOVER BALANCE 303 N N Y QUARTERLY 2 N
FEE ADVANCE CHGOFF BALANCE  WAIVE ROLLOVER BALANCE 304 N N Y QUARTERLY 2 N
FEE OVER CREDIT ... CHGOFF BALANCE  WAIVE ROLLOVER BALANCE 305 N N ¥ QUARTERLY 2 N
FEEMEMBERSHIP  CHGOFF BALANCE  WAIVE ROLLOVER BALANCE 306 N N ¥ QUARTERLY 2 N
CLUB FEE CHGOFF BALANCE  WAIVE ROLLOVER BALANCE 309 N N Y QUARTERLY 2 N
HOA FEE CHGOFF BALANCE ~ WAIVE ROLLOVER BALANCE 310 N N Y QUARTERLY 2 N 2

A brief description of the fields is given below:
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Table 4-17 Contract Definition
]

Field Do this

Instruments section

Instrument Specify the code identifying the instrument.

Description Specify the description of the instrument being
defined.

Start Dt Specify the start date for the instrument. You can
even select the date from the adjoining Calendar
icon.

End Dt Specify the end date for the instrument. You can
even select the date from the adjoining Calendar
icon.

Enabled If you check this box, the system will consider

this contract definition when selecting a
instrument for an application.

Note: Once the field is enabled load balances
button in balances sub tab will be disabled.

Selection Criteria section

Company Select the company for the instrument from the
drop-down list. This may be ALL or a specific
company.

Branch Select the branch within the company for the

instrument from the drop-down list. This may be
ALL or a specific branch. This must be ALL, if
you have selected ALL in the Company field.

Billing Cycle Select the billing cycle selected from the drop-
down list.

Product Select the product for the instrument from the
drop-down list. This may be ALL or a specific
product.

State Select the state in which the instrument is used

from the drop-down list. This may be ALL or a
specific state.

Currency Select the currency for the instrument from the
drop-down list.

IMPORTANT: By selecting which type to use, the
system searches for a best match using the
following attributes:

a. Billing Cycle
b. Start Date

c. Company
d. Branch

e. Product
f. State

Hence, Oracle Financial Services Software
recommends creating one version of each type,
where ALL is the value in these fields.

Pricing Select the pricing in which the instrument is used
from the dropdown list. This may be ALL or a
specific pricing.
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Table 4-17 (Cont.) Contract Definition

Chapter 4
Contract

Field

Do this

Accrual section

Accrual Post Maturity

Check this box to indicate that this is the post
maturity default rate.

Extensions allow you to extend the maturity of
the contract by one or more terms by allowing
the customer to skip one or more payments. The
skipped terms are added to the end of the
contract.

Accrual Method

Select the accrual method used to calculate
interest accrual for this instrument from the drop-
down list.

Start Dt Basis

Select to define the start date from when the
interest accrual is to be calculated for this
instrument from the drop-down list.

Note:
If you select the Effective Date, then the interest
is calculated from the Contract date.

If you select the Payment Date, then the interest
is calculated based on (first payment date minus
one billing cycle).

Base Method

Select the base method used to calculate
interest accrual for this instrument from the drop-
down list.

Accrual Start Days

Specify the number of days for which the interest
accrual is to be calculated.

Int Amortization Freq

Select one of the following interest amortization

frequency from the drop-down list:

. DAILY - if selected, the interest amortization
(TAM) GL entries hand-over happens every
day.

e EVERY BILLING CYCLE MONTH END - if
selected, the interest amortization (TAM) GL
entries hand-over happens on month end of
the account billing cycle. For example, if
account billing cycle is quarterly, the GL
handover happens on month end of the
quarter.

Capitalization section

This section allows you to define capitalization parameters which helps to capitalize the
corresponding account balances to the principal balance of the account based on specific
frequency. For example, you can capitalize the accumulated Interest or Late Fees to principal

balance of the account.

You can either capitalize all the balances based on same frequency or define different frequency for

each type of balance.

Note: Capitalization parameters can also be updated by posting CAPITALIZATION

MAINTENANCE monetary transaction.

Capitalize

Check this box to enable capitalization
parameters for the contract. By default, this
option is un-checked.

The option is available only for Average daily
balance Method Line of Credit.
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Chapter 4
Contract

Field

Do this

Frequency

Select the required capitalization frequency from
the drop-down list. The list contains the following
types of frequency to either capitalize all the
balances based on same frequency or define
different frequency for each type of balance.

e Based on specific intervals such as Monthly,
Quarterly, Annual and so on.

e Based on contract Billing Frequency, Billing
Date, or Due date.

«  Specifically on every Month End.

-Or-

*  Based on Balance Frequency to define
different capitalization frequency for each
balance. This can further be defined in
Balances sub tab.

Capitalization Start Basis

Select the capitalization start date from the drop-
down list as either Contract Date or First
Payment Date to calculate the capitalization
frequency accordingly.

However, this field is not enabled for Billing date
or Due Date type of capitalization frequency.

Grace Days

Specify the grace days allowed in the frequency
(minimum 0, maximum 31) before capitalizing the
balances to account. This is also the deciding
factor for executing the capitalization batch job
which is based on Capitalization Frequency +
Grace Days.

However, note that Grace Days are not
accounted for Month End type of capitalization
frequency and is ignored even if specified.

Cap Tolerance Amt

Specify the capitalization tolerance amount
which is the minimum amount to qualify for
capitalization. Any amount less than this is not
considered for capitalization of balances.

This helps to avoid capitalization of nominal or
decimal amounts.

Note: There is no specific accounting maintained
for non-capitalized decimals with reference to
setup.

Scheduled Dues section

Max Due Day Change Days

Specify the maximum number of days a due date
can be moved.

Due Day Min Specify the minimum value allowed for the due
day for this instrument.
Due Day Max Specify the maximum value allowed for the due

day for this instrument.

Note: If billing cycle is selected as weekly, then
Due Day Max field value cannot be greater than
7.

Max Due Day Change / Year

Specify the maximum number of due day
changes allowed within a given year for this
instrument.
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Table 4-17 (Cont.) Contract Definition

|
Field Do this

Max Due Day Change / Life Specify the maximum number of due day
changes allowed over the life of a product funded
with this instrument.

Billing section

Pre Bill Days Specify the prebill days. This is the number of
days, before the first payment due, that accounts
funded with this instrument will be billed for the
first payment. Thereafter, the accounts will be
billed on the same day every month. If an
account has a first payment date of 10/ 25/2003
and Pre Bill Days is 21, then the account will bill
on 10/04/ 2003, and then bill on the 4th of every
month.

Billing Type Select the billing type for accounts funded using
this instrument from the drop-down list.

Draw Period Billing Method Select the draw period billing method for
accounts funded using this instrument from the
drop-down list.

Repmt Billing Method Select the billing method for the repayment
period from the dropdown list.

Draw Billing % Enter the payment percentage for the draw
period.

Repmt Term Payment % Enter the payment percentage for the repayment
draw period.

Multiple Billing Asset Rate Check this box to indicate if multiple asset rates

are applicable for one billing period.

System considers billing period from current due
date to the next due date. Multiple rates are
fetched only when rate end date (rate start date
+ rate frequency) ends one or more cycle(s)
before the next due date i.e. current rate record
does not cover the entire billing period.

Delinquency section

Late Charge Grace Days Specify the number of grace days allowed for the
payment of a due date before a late charge is
assessed on the account.

Stop Accrual Days Specify the number of days a contract can be in
delinquent state, after which the interest accrual
must stop for an account.

A Batch Job is run daily to select accounts in
delinquent status for a pre-defined number of
days and post No Accrual transaction for such
accounts on current date. When the account
recovers from Delinquency, the system will then
post a Start Accrual Transaction on the date
the account is recovered from delinquency.

Delq Grace Days Specify the number of grace days allowed for the
payment of a due date before an account is
considered delinquent. This affects DELQ
Queues, the system reporting, and the
generation of collection letters.
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I
Field

Do this

Time Bar Years

Specify the total number of years allowed to
contact the customer starting from the first
payment date and beyond which the account is
considered delinquent. You can specify any value
between 0-999.

Cure Letter Gen Days

Specify the number of delinquency days to
initiate cure letter generation.

Cure Letter Valid Days

Specify the number of days during which the
issued cure letter is valid. Usually financial
institutions will start the collection activities after
the lapse of cure letter validity date.

Delq Category Method

Select the delinquency category method to
determine how the system populates
delinquency counters on the Customer Service
form.

Note: This value does not affect credit bureau
reporting.

Cycle Based Fees - This section allows to define the parameters for calculating cycle based fees at
individual account level. Using the below parameters, system derives the Cycle Base Fees and
updates the account balances on processing the following batch jobs - TXNCBC_BJ_ 100 01
(CYCLE BASED COLLECTION LATE FEE PROCESSING) and TXNCBL_BJ_100_01 (CYCLE
BASED LATE FEE PROCESSING). For more information, refer to Fee Consolidation
Maintenance section in Appendix chapter.

System calculates the below type of fee in combination of associated and master account and is
assessed only when total due crosses Threshold amount (that is defined in Setup > Products >
Contract > Fees tab and Setup > Products > Fees screen):

Fee Late Charge (FLC)

Percentage of sum of payment due
Percentage of sum of standard payment
Percentage of sum of billed amount

Cycle Based Collection Late Fee

Flat amount

Percentage of sum of payment due
Percentage of sum of standard payment
Percentage of sum of billed amount
Percentage of payment due

Percentage of standard payment
Percentage of billed amount
Percentage of total due amount
Percentage of sum of total due amount

Cycle Based Late Fee

Flat amount

Percentage of sum of total due amount
Percentage of sum of payment due
Percentage of sum of standard payment
Percentage of sum of billed amount
Percentage of total due amount
Percentage of payment due

Percentage of standard payment
Percentage of billed amount
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Field

Do this

Cycle Based Collection Late Fee

Check this box to enable cycle based collection
late fee assessment on the account.

If selected, the balance type CYCLE BASED
COLLECTION LATE FEE is made available in
the Balances tab which further allows to define
how system should derive the balances when an
account is booked and funded.

If unchecked (default), system does not display
the Cycle based Collection Late Fee balance in
Contract >Balances tab on clicking Load
Balances button.

Cycle Based Late Fee

Check this box to enable cycle based late fee
assessment on the account.

If selected, the balance type CYCLE BASED
LATE FEE is made available in the Balances tab
which further allows to define how system should
derive the balances when an account is booked
and funded.

If unchecked (default), system does not display
the Cycle Based Late Fee balance in Contract
>Balances tab on clicking Load Balances
button.

Cycle Based Collection Late Fee Grace Days

Specify the number of grace days allowed before
cycle based collection late fee is assessed on
the account. This field is enabled only if the
Cycle Based Collection Late Fee option is
checked above.

Cycle Based Late Fee Grace Days

Specify the number of grace days allowed before
cycle based late fee is assessed on the account.
This field is enabled only if the Cycle Based Late
Fee option is checked above.

Fee Consolidation - If Cycle Based Late Fee is assessed based on above parameters, this section
allows to enable/disable the option to consolidate the late fee at Master Account level.

Late Charge at Master Account

Check this box to allow system to consolidate the
late charge assessment at master account level.

Cycle Based Collection Late Fee at Master

Account

Check this box to allow system to consolidate the
cycle based collection late fee assessment at
master account level.

Ensure that, the option Cycle Based Collection
Late Fee is also checked for fee consolidation at
Master Account level.

Cycle Based Late Fee at Master Account

Check this box to allow system to consolidate
cycle based late fee assessment at master
account level.

Ensure that, the option Cycle Based Late Fee is
also checked for fee consolidation at Master
Account level.

Extension section

Max Extn Period / Year

Specify the maximum number of terms that the
contract may be extended, within a given rolling
calendar year.
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Field

Do this

Max Extn Period / Life

Specify the maximum number of terms that the
contract may be extended, within the life of the
line of credit.

Max # Extn / Year

Specify the maximum number of extensions that
may be granted within a given rolling calendar
year.

Max # of Extn / Life

Specify the maximum number of extensions that
may be granted within the life of the line of credit.

Minimum # Payments

Specify the minimum number of payments that
must be made before extension.

Extension Gap in Months

Specify the gap between previous extension
provided in the account and current one as
specific number of months.

Advance Details section

Min Initial Advance

Specify the minimum initial advance amount
allowed. This is the smallest possible initial
advance that can be disbursed to the borrower
after funding.

Max Initial Advance

Specify the maximum initial advance amount
allowed. This is the largest possible initial
advance that can be disbursed to the borrower
after funding.

Min Advance

Specify the minimum advance amount. This is
the smallest advance amount that a borrower
may subsequently request after the initial
advance.

Max Advance

Specify the maximum advance amount. This is
the largest advance amount that a borrower may
subsequently request after the initial advance.

Rate Cap & Adjustments section

Max Rate Increase / Year

Specify the maximum rate increase allowed in a
year.

Max Rate Increase / Life

Specify the maximum rate increase allowed in
the life of the line of credit.

Max Rate Decrease / Year

Specify the maximum rate decrease allowed in a
year.

Max Rate Decrease / Life

Specify the maximum rate decrease allowed
during the life of the line of credit.

Max # Adjustments / Year

Specify the maximum number of rate changes
allowed in a year.

Max # Adjustments / Life

Specify the maximum number of rate changes
allowed during the life of the line of credit.

Min Interest Rate (Floor)

Specify the minimum rate.

Max Interest Rate (Ceiling)

Specify the maximum rate.
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Field

Do this

Statement section

This section allows to define the preferences for Mock Statement generation at Master Account
level. Generating a Mock Statement helps to mock the asset billing process with a future date and
to get an upfront statement indicating future dues of Master and Associated Accounts. In Vacation
Ownership industry, such statements are required to forecast future dues based on current

Timeshare holdings.

The selected preference here are propagated to Application > Contract screen when the instrument

is loaded.

Mock Statement Req

Select this check box to indicate if the account is
to be include in Mock statement Generation.

Note: Based on this selection, others fields
related to Mock Statement below are enabled
and becomes mandatory for providing details.

Mock Start Month

Select the start month of Mock Statements
period from the dropdown list.

Note: During the Mock Statement Next Run
Date validation if next run date is less than
Contract Date or GL Date, system moves the
Mock Start Month to same month of next year.
For more information, refer to Mock Statement
Maintenance in Appendix - Non Monetary
transactions sections.

Mock Statement Cycles

Select the total number of billings (between 1-12)
that are to be generated post Mock Statement
Start Date.

Mock Pre Statement Days

Specify the number of Pre hill days for Mock
Statements generation.

Other section

Refund Allowed

Check this box to indicate that refunding of
customer over payments are allowed.

Refund Tolerance

Specify the refund tolerance amount. If the
amount owed to the customer is greater than the
refund tolerance, the over payment amount will
be refunded if Refund Allowed box is selected.

WriteOff Tolerance Amt

Specify the write off tolerance amount. If the
remaining outstanding receivables for accounts
funded using this instrument is less or equal to
the write off tolerance amount, the remaining
balance on the account will be waived.

Pmt Tolerance Amt*

Specify the payment tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered PAID or
DELINQUENT. If (Payment Received + Pmt
Tolerance: $Value) >= Standard Monthly
Payment, the Due Date will be considered as
satisfied in terms of delinquency. The amount
unpaid is still owed.
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Field

Do this

Pmt Tolerance%*

Specify the payment tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
PAID or DELINQUENT. If Payment Received >=
(Standard Monthly Payment * Pmt Tolerance% /
100), the due date will be considered satisfied in
terms of delinquency. The amount unpaid is still
owed.

The system uses the greater of these two values.

Promise Tolerance Amt*

Specify the promise tolerance amount. This is
the threshold amount that must be achieved
before a due amount is considered KEPT or
BROKEN. If (Payment Received + Promise
Tolerance: $Value) >= Promise Amount, the Due
Date will be considered KEPT (satisfied).

Promise Tolerance %*

Specify the promise tolerance percentage. This
is the threshold percentage that must be
achieved before a due amount is considered
KEPT or BROKEN. If Payment Received >=
(Promised Amt * Promise Tolerance%), the due
date will be considered KEPT (satisfied).

The system uses the greater of these two values.

Adv Tolerance

Enter the advance tolerance amount.

Adv Tolerance %

Enter the advance tolerance percentage

Default Pmt Spread

Select the default payment spread to be used
when receiving payments for this account if one
is not explicitly chosen, from the drop-down list.

Min Finance Charge

Enter the minimum finance charge amount.

Minimum Pmt

Enter the minimum billed amount.

Anniversary Period

Enter the anniversary term.

Repmt Currency

Select the currency from the drop-down list.

PDC Security Check

Check this box to indicate that post dated checks
are the method of repayment for this contract.

ACH Fee Ind

Check this box to indicate that direct debit fee is
included.
Note: The ACH Fee/Direct Debit Fee balance will

be displayed in Balances sub tab only when this
checkbox is selected.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Extension of Terms

The system facilitates extension of terms, provided the following conditions are satisfied:

*  Specified number or more payments made in the account

* Gap between the previous and current extension provided in the account must be a
specific number of months that could be specified

If the above conditions are not satisfied, then the system displays an appropriate error

message.
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A new transaction Force Extension will be available. This transaction will be posted when you
want the system to bypass the extension validations defined at the contract level.

When a backdated transaction with TXN Date exists before the transaction date of extension,
all the transactions are reversed and posted again. If extension transaction is posted again,
then the validation rules are not validated again.

This section consists of the following topics:

Balances

Amortized Balances

Iltemizations

Fees

4.7.1 Balances

The Balances sub screen lists the balances that will be established when an account is booked
and funded.

CAUTION: Please contact your Implementation Manager for changes to this section.

To set up the Balances

1.

Click Setup > Setup > Administration > User > Products > Contract > Line >

Balances.

On the Balances sub screen, perform any of the Basic Operations mentioned in Navigation

chapter.
A brief description of the fields is given below:

Table 4-18 Balances

Field

Do this

Balance Type

Displays the balance type.

Displays the balance type.

Select the charge off method to determine how
the outstanding amount of this balance type will
be handled from the drop-down list, if the
account becomes uncollectable and the product
is charged off.

Writeoff Method

Select the write off method to determine how the
outstanding amount of this balance type will be
handled from the drop-down list, if the account is
within the write off tolerance of being PAID.

Reschedule Method

Select the reschedule method to determine how
the outstanding amount of this balance type will
be handled from the drop-down list, if the
account is rescheduled.

Sort Specify the sort order of how account balances
will appear on the Customer Service form’s
Balance screen.

Billed Check this box to indicate that outstanding

amounts for this balance type are considered a
part of the billed amount. This also determines
whether payments applied to this balance type
are considered when satisfying outstanding
amounts due.
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Accrued Check this box to indicate that outstanding
amounts for this balance type will be included
when interest is accrued against the account.

Non Performing Rollover Check this box to indicate that non-performing
is used as an intermediary status on your
general ledger prior to charge off and want to
create balances for non-performing accounts for
this balance type.

Note: (The Non-Performing Rollover box applies
only to Balance Types of ADVANCE/PRINCIPAL
and INTEREST. For all other Balance Types, this
box would be cleared).

Non Performing Balance Type Select the balance type you want to rollover from
drop-down list, if you select the Non-Performing
Rollover box (Advance/ Principal).

Enabled Check this box to indicate that this balance type
will be created when the account is booked and
funded.

This section is applicable if the capitalization frequency is selected as Balance Frequency for the
contract and allows you to define capitalization parameters for a specific type of account balance
such as Interest.

Note: The value of parameters defined in this section supersedes the values defined in header
section.

Capitalize Check this box to enable capitalization
parameters for the selected balance type. By
default, this option is un-checked.

Note: The option is disabled for Advance /
Principal type of Line contracts.

Frequency Select the capitalization frequency from the drop-
down list. Frequency can be selected using any
of the following options:

e Based on specific intervals such as Monthly,
Quarterly, Annual and so on.

« Based on contract Billing Frequency, Billing
Date, Due date.

e Specifically on every Month End.

Grace Days Specify the grace days allowed in the frequency
(minimum 0, maximum 31) before capitalizing the
balances to account. This is also the deciding
factor for executing the capitalization batch job
which is based on Capitalization Frequency +
Grace Days.

However, note that Grace Days are not
accounted for Month End type of capitalization
frequency and is ignored even if specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The system loads the currently defined balances for accounts.

If your organization maintains additional balances, contact your Implementation Manager
for information regarding those balances.
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With the Amortize Balances sub screen, you can select one or more balances to be amortized
over the life of the Line of Credit. You can also define the amortization method.

To set up the Amortization Balances

1. Click Setup > Setup > Administration > User > Products > Contract > Line >

Amortized Balances.

2. In the Amortization Balances section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 4-19 Amortization Balances

Field

Do this

Amortize Balance Type

Select the amortize transaction type from the
drop-down list.

Amortization Method

Select the amortization method used to calculate
the net amortization amount from the drop-down
list.

Cost/Fee method

Select the amortization cost/fee method.

Sort

Specify the sort sequence to define the order of
the amortize balances.

Enabled

Check this box to enable the amortize balance to
be created when the account is booked and
funded.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.7.3 ltemizations

On the Itemizations sub screen, you can define the itemized components for each type of
contract, indicate if it is required, and determine whether it has a positive or negative bearing
on the contract itemization math. You can establish the following groups of itemization

transactions:

Advance

[Total amount of the product that is not a part
of financed fees; in other words, the total
amount the customer requested to be
advanced.

Financed Fees

Fees rolled into the principal balance of the
product. Financed fees are also considered to
be a part of the finance charge.

Pre-Paid Fees

Fees that are paid by the consumer prior to
the funding of the Line of Credit. These fees
are not rolled into the balance of the product
but are considered as part of the finance
charge and are included in the calculation of
the APR.
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Line of Credit; for example, a fee that is being
charged to the producer. These transactions
will affect proceeds.

Escrow Allows you to connect the actual escrow

itemization with the escrow type and the
funding transaction.

To set up the Itemizations

1.

Click Setup > Setup > Administration > User > Products > Contract > Line >
Itemizations.

On the Itemization sub screen select the option button to indicate the type of itemization
you are working with: Advance, Financed Fees, Pre-Paid Fees, Producer, or Escrow.

On the Itemization sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-20 Itemizations
]

Field Do this

Itemization Select the itemization from the drop-down list.

Disbursement Type Select the disbursement type from the drop-down
list.

Transaction Select the funding transaction type from the
drop-down list.

Itemization Type Select the itemization type from the drop-down
list.

Note: On selecting the Prefunding Txns as
itemization type, it indicates that this particular
itemization expects a payment from the customer
prior to funding.

Sort Specify the sort order to define the order of the
itemization transactions.

Sign If the itemized transaction increases the group
balance, click +ve.

_Or-
If the itemized transaction decreases the group
balance, click -ve.

Enabled Check this box to enable the itemization and
indicate that this itemization transaction will be
created when the account is booked and funded.

Amortize Balance Select the amortize balance affected by this
itemization transaction from the drop-down list.
Note: Advance itemizations do not affect
amortize balances.

Refund Calculation Method Select the refund calculation method from the
drop-down list.
Taxable Check this box, if the itemization type is taxable.

However, note that the taxable option defined in
Setup > Administration > System > Sale Tax
screen will supersede with this preference.
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Table 4-20 (Cont.) Itemizations
|

Field Do this

Seller Pmt Check this box to enable seller payment.

Escrow Select the escrow from the drop-down list.

Itemization Formula Select the itemization formula description from
the drop-down list.

Refund Calculation Method Check this box to enable Refund calculation
Method.

Escrow Required If this is an escrow account, check this box to

indicate that an escrow is required during the
application process (though at that time the user
can choose Opt Out to decline.)

Discount Rate Specify the discount rate for the itemization.

Perform any of the Basic Actions mentioned in Navigation chapter.

Any fees that are defined in the contract are set up on the Fees sub screen. The system
currently supports the following contract fees:

Late charges

Non sufficient funds
Extensions
Prepayment penalties
Delay Fee

ACH Fee

The Fees sub screen allows you to define those fees whose value and method of calculation
are set at the time of the Line of Credit. As these amounts cannot be changed after the product
is booked and funded, you should only set up fees here that will not change over the life of the
Line of Credit. Individual contract fee types may be defined multiple times in order to create
graduated fees.

@® Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such
cases, the contract fee, if present, is used first.

To set up the Fees

1.
2.

Click Setup > Setup > Administration > User > Products > Contract > Line > Fees.

In the Fees section, perform any of the Basic Operations mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 4-21 Contract Fees

|
Field Do this

Type Select the fee type from the drop-down list.
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Table 4-21 (Cont.) Contract Fees

|
Field Do this

Txn Amt From Specify the lowest transaction amount or balance
amount against which this contract fee definition
may be applied.

Credit Limit From Specify the minimum value of credit limit for the
pricing.

Method Select the method of calculating the fee to be
assessed from the dropdown list.

Frequency Select the frequency of calculating the fee to be

assessed from the drop-down list.

Threshold Amt This field is enabled only if the Contract Fee type
is either CYCLE BASED COLLECTION LATE
FEE or CYCLE BASED LATE FEE.

Specify the threshold amount which is less than
or equal to minimum fee amount to be assessed.
Based on this amount, system calculates and
posts the Cycle Based Collection Late Fee or
Cycle Based Late Fee based on the account.

If calculated fee amount is less than threshold
amount, fee is posted with transaction amount =
0.

If calculated fee amount is greater or equal to
threshold amount, fee is posted based on
existing min amt and max amt comparing logic.

Min Amt Specify the minimum fee amount to be assessed.

Max Amt Specify the maximum fee amount to be
assessed. If you selected FLAT in the Method
field, then this field is not used and is normally
populated as $0.00.

Percent Specify the fee percentage of the outstanding
transaction amount to be assessed as a fee. This
amount will be adjusted to fall within the Min
Amount and the Max Amount.

Enabled Check this box to create the selected contract fee
when the account is booked and funded.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.8 Edits

Edits ensure your organization’s guidelines are properly followed and that all exceptions are
sent to the appropriate personnel to review.

You can configure your system so that during the origination process, at each change to an
application’s status, the system will perform a set of edits on the Verification link’s Edits screen
(found on the Application Entry, Underwriting, and Funding windows).

Edits ensure your organization’s guidelines are properly followed and that all exceptions are
sent to the appropriate personnel to review. If the edits check fails, then the system will not
allow the change of status, and the application will remain in its current status. This screen
allows you to define the validations the system must perform on the Verification master tab, as
the status of application changes.

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Page 38 of 81



ORACLE’

Chapter 4
Edits

Origination edits are used to validate applications entered through the standard Application
Entry and Applications windows. The Edits screen contains two sections, the Edit Type
Definition section and the Edit Sub Type Definition section.

To set up the Edits

You can either define new Edit Type Definition details or specify a new name in the New Edit
Type field and click Create Copy to create a copy of selected edit type definition with details.

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup

> Administration > User > Products > Edits > Line.

Navigation chapter.

Figure 4-8 Edits
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A brief description of the fields is given below:

Table 4-22 Edit Type Definition

Field

Do this

Edit

Specify the edit name.

Description

Specify the description for the edit.

Edit Type

Select the edit type code from the drop-down list.

System Defined

Select Yes, if the entry is system defined.
System defined entries cannot be modified.
Select No, if the entry is not system defined and
it can be modified.

Enabled

Check this box to enable the edit.

Company

Select the portfolio company associated with this
edit, from the drop-down list. This may be ALL or
a specific company.
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Edits

Field

Do this

Branch

Select the portfolio branch within the company
associated with this edit, from the drop-down list.
This may be ALL or a specific branch. This must
be ALL if you selected ALL in the Company field.

Channel

Select the channel from the drop-down list, This
can be ALL or a specific channel.

Product

Select the product associated with this edit, from
the drop-down list. This may be ALL or a specific
product.

State

Select the state with this edit from the drop-down
list. This may be ALL or a specific product.

Currency

Select the currency associated with this edit,
from the drop-down list. This may be ALL or a
specific branch.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Inthe Edit Sub Type Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 4-23 Edit Sub Type Definition

Field

Do this

Edit Sub Type

Select the edit sub type for the edit, from the
drop-down list.

Edit

Select the description for the edit, from the drop-
down list.

Result

Select the result type for the edit, from the drop-
down list.

Enabled

Check this box to enable the edit.

Value

Specify the expected value for the first edit. The
Value field records the threshold value for the
edit. The actual function of the entered value is
dependent on the edit category.

Override Responsibility

Select the responsibility that can override the
edit, from the drop-down list, if the edit result is
an override. Designates the user responsibility
level required to continue processing applications
that fail the edit based on the Value field. You
may define the same edit multiple times with a
Result = OVERRIDE and different Value and
Override Responsibility combinations to
encompass various results.

System Defined

Select Yes, if the entry is system defined.
System defined entries cannot be modified.
Select No, if the entry is not system defined and
it can be modified.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
Using the Edit Type field of the Edit Type Definition section, you can define when you
want the edits check to occur by selecting from the following list of edit types:
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Edits

Edit type

Description

APP ENTRY EDITS

Edits that normally run on Application Entry form.

APP PRESCREENING EDITS

Edits that run between application entry and the
pulling of a credit bureau. These edits determine
whether the application should be reviewed
further, and whether a credit bureau should be
pulled.

PRE Qualify Edits

Edits that run to check whether the minimum
details which are required to prequalify the
application are satisfied or not.

APP AUTOMATIC APPROVAL EDITS

Edits that run after a credit bureau has been
pulled and scored. These edits determine
whether an application should be automatically
approved or declined.

APP APPROVAL EDITS

Edits that run whenever an application is
manually changed to a status/sub status that
indicates the application (in its current state)
should be approved.

APP DECLINE EDITS

Edits that run whenever an application is
manually changed to a status/sub status that
indicates the application (in its current state)
should be declined.

APP CONTRACT EDITS

Edits that run whenever an APPROVED or
CONDITIONEDAPPROVED application is about
to be funded. These edits ensure the validity of
the contract data.

Each entry in the Edit Sub Type field is grouped into the following categories:

Table 4-25 Edit Sub Type field

Origination edit sub types

Description

ORIGINATION APPLICANT EDITS

Edits that pertain to data entered for an applicant
on an application.

ORIGINATION APPLICATION EDITS

Edits that pertain to data entered for the
requested line of credit.

ORIGINATION ASSET EDITS

Edits that pertain to data entered for asset
entered on the application.

ORIGINATION CONTRACT EDITS

Edits that pertain to data entered for the contract
on the application.

ORIGINATION CREDIT BUREAU EDITS

Edits that pertain to data gathered from the credit
bureau reports for the applicants on the
application.

ORIGINATION DECISION EDITS

Edits that pertain to data required to make a
decision on the application.

Each entry in the Edit Sub Type field can be set up with more than one entry in the
Description field. The purpose of specific edits fall into the following types:
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Description starts with

(Edit Category) Description of Edit Category

CHD:

(RECORD POPULATION EDITS) Check for the
existence of an entire data record.

DUPLICATE:

(DUPLICATION EDITS) Check for duplication of
existing data.

RANGE:

(VALUE RANGE/TOLERANCE EDITS) Check to
determine whether data entered for a specific
data field is within the specific tolerance.

REQUIRED:

(REQUIRED FIELD EDITS) Check to determine
whether a specific data field has been populated
within a data record.

FLK:

(LOOKUP VALUE EDIT) Check API entered data
against the existence of that value in the related
lookup types lookup codes.

XVL:

(CROSS VALIDATION EDIT) Check to determine
whether specific field, or set of fields, value
corresponds to a value obtained by calculating
them from another field or set of fields (for
example, Total Payments = Terms * Standard
payment amount).

An Edits check can produce one of three results: an ERROR, a WARNING, or an

OVERRIDE.

Table 4-27 Edits check

Edit type

Results

ERROR

The system will prevent you from proceeding
when an edits check fails. The only option is to
change the source data. The application will
revert to its previous status/sub status. The user
will be directed to correct the specific error. Until
the edits that return an ERROR value are
addressed, the user cannot continue processing
the application.

Warning

When an edits check fails in these cases, the
system allows the process to continue. Warnings
serve as informational messages and can be
ignored. The user will be notified that an edit
failed, but the failure need not stop the current
processing of the application. The user can
either ignore the error, or have the application
revert to its previous status/sub status and
address the error before processing the
application further.

Line Origination Setup Guide
G42451-01
Copyright © 2022, 2025, Oracle and/or its affiliates.

September 11, 2025
Page 42 of 81



ORACLE Chapter 4
Cycles

Table 4-27 (Cont.) Edits check

|
Edit type Results

Override The edit check has failed; however, the system
allows users with the responsibility specified in
the Override Responsibility field to continue.
Multiple override levels can be setup depending
upon the resulting value of the edit. If the user
has override responsibility, the application will
process as if the edit had not failed. If the user
does not have override responsibility, the
application will revert to its previous status/sub
status and the sub status changes to OVERRIDE
REQUIRED. The system will then direct the
application to a user with the authority to process
the application. (See the Queues chapter for
more information).

@® Note

Do not set the Result field to Override for credit application edits.

This section consists of the following topic:

¢ Interfacing OFSLL with Oracle Rule Author

4.8.1 Interfacing OFSLL with Oracle Rule Author

Oracle Business Rules is a component of Oracle Application Server that enables applications
to rapidly adapt to regulatory and competitive pressures. This increased agility is possible due
to the adoption of Oracle Rule author wherein a lending Institution can create or change a
business rule without having to indulge in coding and also without stopping the business
process. Also, externalizing business rules allows to manage business rules directly, without
involving programmers. It provides best of breed solutions that would help in configuring the
rules very quickly by a business analyst or user with some insight on the database.

4.9 Cycles

The Cycles screen allows you to define the origination workflow process of your organization.
As you delineate the steps in the origination process, you will also define:

* The user responsibilities that have access to perform the steps

* Any edits you want the system to perform between changes in status/sub status.

The following diagram displays the general concept of workflow:
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Figure 4-9 Application Entry - Flowchart
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Cycle code definitions drive the application cycle. The following pairs of status/sub status
define status/sub statuses that have system defined meanings and should be included in your
origination workflow, if they are not already included.

After entering the basic details of the applicant, you can check whether the application
prequalifies or not. If the pre-qualified edits are satisfied, the status is changed to NEW-
PREQUALIFY APPROVED and you can modify or update any further details in the Application
Entry screen. If the edits are not satisfied, the application will be pushed to the REJECTED
APPLICATIONS queue with a status update to REJECTED-PREQUALIFY REJECTED, then
you can also view the rejected pre-qualification in the Underwriting window.

@® Note

The system status and sub status lists are predefined and cannot be changed by the
administrator. If you require additional sub status codes, please contact Oracle
Financial Services Software to determine whether they can be added.

Table 4-28 Cycle code definitions

_________________________________________________________________________________|
Status/Sub status Description

NEW-BLANK

This is the status/sub status of applications during
data entry. Applications remain NEW-BLANK until
you choose the Next Application on the
Application Entry form and the system successfully
performs the application edits check.

The system processes the prescreen edits to
determine whether a credit report should be pulled
for this application or not.

NEW-PRESCREEN
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Status/Sub status

Description

NEW-PRESCREEN APPROVED

Applications in this status/sub status have passed
the prescreen edits. The system will now request a
credit bureau pull.

NEW-PREQUALIFICATION

The system checks the applicant details whether it
is qualified or not.

NEW-PREQUALIFY APPROVED

If the pre-qualified edits are satisfied, the status is
changed to NEW-PREQUALIFY APPROVED and
you can modify or update any further details in the
Application Entry screen.

REJECTED-PREQUALFY REJECTED

If the edits are not satisfied, the application will be
pushed to the REJECTED APPLICATIONS queue
with a status update to REJECTED-PREQUALIFY
REJECTED.

REJECTED-PRESCREEN REJECTED

Applications in this status/sub status failed the
prescreen edits. These applications will receive no
further processing. The producer will be sent a
decision fax and the consumer will receive an
adverse action letter.

NEW-REVIEW REQUIRED

Either based on the scoring of the application’s
credit bureau(s) pull, or the fact that a credit bureau
report was not successfully obtained, the
application needs to be reviewed by an underwriter.

NEW-RECOMMEND APPROVAL

Based on the scoring of the application’s credit
bureau(s) pull, the application should be reviewed
by an underwriter. However, based on the current
setup, the system recommends approving this
application.

NEW-RECOMMEND REJECTION

Based on the scoring of the application’s credit
bureau(s) pull, the application should be reviewed
by an underwriter. However, based on the current
setup, the system recommends rejecting this
application.

APPROVED-AUTO APPROVED

Based on the scoring of the application’s credit
bureau(s) pull, the system automatically approves
the application. The producer will be sent a
decision fax, and the application will be passed to
funding.

REJECTED-AUTO REJECTED

Based on the scoring of the application’s credit
bureau(s) pull, the system automatically rejects the
application. The producer will be sent a decision
fax and the consumer will receive an adverse
action letter.
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Status/Sub status

Description

APPROVED-BLANK

Application has been manually approved. Normally
this occurs when an application is in the NEW-
RECOMMEND APPROVAL, NEWRECOMMEND
APPROVAL status/sub status, or less often in the
NEW- RECOMMEND REJECTION status/sub
status. Any cycle code definition with next values of
APPROVED-BLANK should have a lookup value of
APP APPROVAL EDITS to ensure that all of the
required data has been gathered in making the
decision to approve the application (unless the
application is currently in a status/sub status that
assures the APP APPROVAL EDITS have been
run).

NEW-OVERRIDE REQUIRED

A user without sufficient override authority
attempted to approve an application, which, based
on setup, required a higher over-ride authority to
approve.

APPROVED-VERIFYING

Contract has been received from the producer.

APPROVED-FINAL DOCUMENT CHECK

The contract has been reviewed and the data is
correct. Normally this occurs when an application is
in APPROVED-FINAL DOCUMENT CHECK OR
CONDITIONED-FINAL DOCUMENT CHECK
status/sub status. Any cycle code definition with
next values of APPROVED-FINAL DOCUMENT
CHECK or CONDITIONED-FINAL DOCUMENT
CHECK should have a value of APP CONTRACT
EDITS to ensure that all of the required data has
been gathered in making the decision to approve
the application, unless the application is currently in
a status/ sub status that assures the APP
CONTRACT EDITS have run.

APPROVED-VERIFIED

The application has been processed and is
awaiting funding.

APPROVED-FUNDED

The application has been funded, and a check
requisition has been created. If Customer Service
form is being used, then an account is also created
at this time.

REJECTED-BLANK

The application for whatever reason is being
manually rejected regardless of its current
status/sub status. Any cycle code definition with
Next values of REJECTED-BLANK should have a
lookup value of APP DECLINE EDITS to ensure
that all of the required data has been gathered in
making the decision to approve the application
(unless the application is currently in a status/sub
status that assures the APP DECLINE EDITS have
run).

WITHDRAWN-BLANK

The applicants have indicated that they are no
longer pursuing this line of credit.

CONDITIONED -<ANY>

These status/sub status pairs are analogous to the
corresponding APPROVED-<ANY> pair and
indicate that the application has had additional
conditions placed on its approval.
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Table 4-28 (Cont.) Cycle code definitions

_________________________________________________________________________________|
Status/Sub status Description

<ANY>-<ANY OVERRIDE> Requires OVERRIDE approval. The meaning of the
sub status is analogous to the corresponding
OVERRIDE sub status, and may require that
specific EDITS run before proceeding.

<ANY>-AGED APPLICATION These applications have been decisioned but no
contract has been received after a period of time
determined by setup. If not acted on, these
applications will become VOID.

<ANY>-AGED CONTRACT Contracts have been received after a period of time
determined by setup. If not acted on these
applications will become VOID.

<ANY>-VOID Indicate application previously had a sub status of
AGED CONTRACT or AGED APPLICATION.
These applications have not been completed and
were made VOID after another period of time had
passed.

Using these status and sub status, let us re-examine the early workflow diagram in this section.

Figure 4-10 Application Entry - Flowchart 2
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In the Cycles setup screen, you can also define how Status change of an application is to be
permitted in the system i.e. you can configure the system to validate and allow a specific user /
responsibility to perform the subsequent status change of the application.
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It is like either same User/Responsibility is Permitted or Not Permitted to perform
subsequent cycle changes of an application. This can be achieved in Cycle Code Definition
section in Validate Successive Change field.

® Note

It is extremely important that the APP CONTRACT EDITS run prior to an application
being funded. All cycle code definitions should be reviewed to ensure that there are no
paths through the origination cycle that bypass this EDIT type.

To set up the Cycles

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Cycles > Line.
2. Inthe Cycle Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

Figure 4-11 Cycle Definition
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A brief description of the fields is given below:

Table 4-29 Cycle Definition

Field Do this

Cycle Specify the cycle code.

Type Displays the cycle type.

Product Select the product from the drop-down list.

3. Inthe Cycle Code Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:
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Field

Do this

Current Code

Select the current code to transition FROM, from
the drop-down list.

Current Sub Code

Select the current sub code to transition FROM,
from the dropdown list.

Next Code

Select the current code to transition TO from the
drop-down list.

Next Sub Code

Select the next sub code to transition TO, from
the drop-down list.

Origination Stage Code

Select the origination stage code of the
application from the adjoining drop-down list.

Edit Type

Select the edit type to associate to the cycles,
from the drop-down list.

Validate Successive Change

Select the type of user / responsibility who is
permitted to perform application status change.
The following options are available in the drop-
down list as maintained in the Lookup Type
STATUS_ CHANGE_VALIDATION_CD.

NONE: (Default option) Here system does not
validate for User / Responsibility while making
status change.

USER - SAME: Here system validates for same
User while making the status change.

USER - DIFFERENT: Here system validate for
different User while making the status change.

RESPONSIBILITY - SAME: Here system
validates for same Responsibility of the Current
User while making the status change.

RESPONSIBILITY - DIFFERENT: Here system
validates for different Responsibility of the
Current User while making the status change.

Note that, the application status change is further
controlled by Sub Code value defined in cycle
setup for Lookup Type STATUS
CHANGE_VALIDATION_CD. For example, if Sub
Code =2 for USER - SAME Lookup Code, then
the previous 2 cycles of status change has to
performed by the same user.

When a wrong user/responsibility is trying to
change the status of the application, system
validates with above selection and displays an
error indicating User/Responsibility must be
same or different between current and
previous status change.

During such cases, to know which User or
Responsibility has performed the previous
application status change, refer to appropriate
columns in Underwriting / Funding > Verification
tab > History sub tab.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Inthe Cycle Code Responsibility Definition section, you can define the responsibilities that
are authorized to change the code. If you have selected a specific user / responsibility in
the Validate Successive Change field in the above section, it is recommended to define
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the user responsibility in this section. Perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-31 Cycle Code Responsibility Definition

Field Do this

Responsibility Select the responsibility that will be capable of
executing this transition, from the drop-down list.

Allowed Select Yes to allow change to the status
responsibility and No to disallow.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

4.10 Scoring Models

The Scoring screen allows you to setup individual and multiple scoring models. You can define
different scoring models by company, branch, currency and product. Scoring models are used
to automate the decisioning process during underwriting and grade applications.

When you complete the Application Entry process, the system determines which scoring model
to use by finding a best match. The system searches the Company, Branch, Currency and
Product fields of all enabled scoring models that contain either the exact value on the
application or ALL. (Exact matches for each field are given a higher weight than matches to
ALL.) The system then ranks the returned matches in descending order, based on the
weighted values and the hierarchical position of the field and then by Start Date. The system
recognizes the first row returned as the best match. This scoring model information is then
used to determine the next status and sub status of the application.

If you use a standard bureau score as a scoring model, you can set up the system to use the
adverse action reasons provided by the standard bureau score on the Stipulations sub screen.

To set up the Scoring

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Scoring Models > Line. You can set the following
categories of scoring models:

e Credit Score Models

4.10.1 Credit Score Models

You can either define new Credit Score Model or specify a new name in the New Credit Model
field and click Create Copy to create a copy of selected score model with details.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Line >
Credit Score Models.

* Inthe Score Models section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-12 Score Models
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A brief description of the fields is given below:

Table 4-32 Score Models

Field Do this

Model Specify the code for the scoring model.

Description Specify a description of the scoring model.

Start Dt Specify the start date for the scoring model.
You can even select the date from the
adjoining Calendar icon.

End Dt Specify the end date for the scoring model.
You can even select the date from the
adjoining Calendar icon.

Enabled Check this box to enable the scoring model.

Results section

Max Score Specify the maximum score allowed. (This is

normally the sum of the Max Value fields within
the scoring parameters.).

Selection Criteria section

Company

Select the company for the scoring model,
from the drop-down list. This may be ALL or a
specific company.

Branch

Select branch within the company for the
scoring model, from the drop-down list. (This
may be ALL or a specific branch. However, if
you have selected ALL in Company field, then
you must select ALL for this field).

Product

Select the product for the scoring model, from
the drop-down list. This may be ALL or a
specific product.

Currency

Select the currency for the scoring model, from
the drop-down list. This may be ALL or a
specific currency.
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Field

Do this

Bureau Score Reasons

Check this box to use the score reasons
supplied by the credit bureau. If unchecked,
then automatically rejected applications scored
using this scoring model display the Adverse
Action Reasons from the Parameters sub
screen.

Auto Decision

Check this box to assign an application, a
status/sub status based on the grade
associated with the score returned for this
scoring model. If not selected, the system
assigns applications scored using this scoring
model a status/sub status of NEW-REVIEW
REQUIRED.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Parameters

The Parameters records the parameters used to determine the score calculated by the scoring
model. You can define multiple parameters and adverse action reason associated with each
parameter in a scoring model. Each scoring parameter can have maximum values set. The
score range is based upon the information in the Range Definition section on the Parameters

sub tab.

The system calculates a final score by adding the score for each parameter in the scoring
model. A parameter weighted value is used to find the four adverse action reasons, if bureau

reasons are not used.

@® Note

» A character parameter range definition should contain the exact value of the

parameter.

» Each scoring parameter should have range definitions defined that encompass all

of the values that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Line >

Credit Score Models > Parameters.

2. Inthe Parameters section, perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Table 4-33 Parameters

Field

Do this

Parameter

Select the parameter from the field, from the
drop-down list.

Max Value

Specify the maximum value allowed for the
selected parameter.
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Field

Do this

Adverse Action Reason

Select the adverse action reason, from the drop-
down list. (If, on the Scoring Models screen, the
Bureau Screen check box is checked for the
scoring model, you cannot update this field).

Weighted Value

Specify the adverse action weighted value. This
indicates the priority of this parameter when
determining which adverse action reasons to use
on the application. The top ten adverse action
reasons based on the weighted value of the
parameter will be populated.

Enabled

Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Range Definition section allows you to translate the calculated value for a scoring
parameter into the value to be used, depending on the returned value of the parameter.

5. In the Range Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 4-34 Range Definition

Field

Do this

Value From

Specify the lowest calculated value to apply the
specific translation. The ceiling of the range
definition is based on the range definition with
the next highest Value From or the Max Value of
the scoring parameter (whichever is less).

Value From

Select the following options to determine how
values for a scoring parameters are translated:

% Max Value — If selected, then the calculated
values within the range definition receives a
value based on a percentage of the Max Value of
the scoring parameter.

% Param — If selected, then the calculated
values within the range definition receives a
value based on a percentage of the calculated
value of the scoring parameter.

Value — If selected, then the calculated values
with in the range definition receives a specific
value.

Percent / Value

Specify the percent or value to be used in the
translation of the calculated value of the scoring
parameter.

Enabled

Check this box to consider this range definition
while translating values for this scoring
parameter.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Grades

The Grades sub screen allows you to define how the system translates the scoring model
scores into your organization’s grade. The system uses these grades in the auto-decisioning
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process. Each grade has a specific status/sub status that informs the system what to do with
the application of a particular grade as it continues through the origination cycle.

@® Note

Each scoring model should have grade definitions defined that encompass all of the

values that might result.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Line >

Credit Score Models > Grades.

2. Inthe Grade Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.
A brief description of the fields is given below:

Table 4-35 Grade Definition

Field

Do this

Score

Specify the score the application receives.

Credit Grade

Select the grade to assign to an application, from
the dropdown list.

Application Status

Select the status to assign to applications with a
score starting with the value of this grade
definition, from the drop-down list.

Sub Status

Select the sub status to assign to applications
with a score starting with the value of this grade
definition, from the dropdown list.

Credit scoring allows you to select the following
status/sub status pairs:

APPROVED - AUTO APPROVED
REJECTED - AUTO REJECTED
NEW - REVIEW REQUIRED

NEW - RECOMMEND APPROVAL
NEW - RECOMMEND REJECTION.

Enabled

Check this box to indicate that this grade
definition will be considered when grading an
application using this scoring model.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.11 Fees

The Fee screen allows you to define fees that may be automatically assessed by the system.
The Fee Definition section records fees not defined within the Contract screen’s Fees sub

screen.

The following fee types are currently supported for automatic assessment:

e Late charge
* NSF
e Extension

« Advance
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Over Credit Limit
Membership
Prepayment penalty
Phone Pay

Payoff Quote
Periodic Maintenance
Rental Fee

ACH Fee

Delay Fee

Other Fee and Tax

Fees can be calculated as either a flat amount or a percentage of payment due based on fee
type.

You can specify minimums and maximums for fee amounts in the Min Amt and Max Amt fields.
Different fee rules can be setup at the company/branch level.

When Fees are assessed, the system determines the best match using all enabled fee
definitions that meet the following criteria:

Exactly match the fee type being assessed.
Have an effective date that is greater than or equal to the start date.

Have a Txn Amt From that is greater than or equal to the outstanding amount related to the
fee assessment.

Match either the value or ALL for all other criteria (Exact matches for each field are given a
higher weight than matches to ALL.)

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of the following criteria:

1.

2
3
4
5.
6
7
8

Company

Branch

Product

Application state
Transaction amount
Start date

End date

Currency

On the ranked rows, the first row is returned as the best match.

@® Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such
cases, the contract fee, if present, is used first. Only if the contract fee is not present in
the state fee used.

To set up the Fee
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1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Fees > Line.

2. Inthe Fee Definition section, perform any of the Basic Operations mentioned in Navigation
chapter.

Figure 4-13 Fee Definition
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A brief description of the fields is given below:

Table 4-36 Fee Definition

|
Field Do this

Fee Rule Specify the fee rule used to identify the particular
fee definition.

Fee Type Select the fee type from the drop-down list. The
system computes these drop-down values from
the TXN_TYPE_CD Lookup, with FEE as the sub

type.

Start Dt Specify the start date. You can even select the
date from the adjoining Calendar icon.

End Dt Specify the end date. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to enable the fee.

Calc Method Select one of the following method of calculating

the fee, from the drop-down list.

If Flat Amount is selected, then minimum fee will
be charged.

If Percentage is selected, then the amount
charged will be based on percentage defined
subject to minimum and maximum amount (i.e.
Txn Amt From).
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Table 4-36 (Cont.) Fee Definition

|
Field Do this

Threshold Amt This field is enabled only if the Contract Fee type
is either CYCLE BASED COLLECTION LATE
FEE or CYCLE BASED LATE FEE.

Specify the threshold amount which is less than
or equal to minimum fee amount to be assessed.
Based on this amount, system calculates and
posts the Cycle Based Collection Late Fee or
Cycle Based Late Fee based on the account.

If calculated fee amount is less than threshold
amount, fee is posted with transaction amount =
0.

If calculated fee amount is greater or equal to
threshold amount, fee is posted based on
existing min amt and max amt comparing logic.

Min Amt Specify the minimum amount for the fee.

Max Amt Specify the maximum amount for the fee. If you
selected FLAT AMOUNT in the Calc Method
field, then this field is not used and is normally
populated as $0.00.

Percent Specify the percentage value of the outstanding
transaction amount to be assessed as a fee. This
amount will be adjusted to fall within the Min
Amount and the Max Amount.

Selection Criteria section

Company Select the portfolio company from the drop-down
list. This may be ALL or a specific company.

Branch Select the portfolio branch from the drop-down
list. This may be ALL or a specific branch. (This
must be ALL, if you have selected ALL in the

Company field).

Channel Select the channel from the drop-down list, This
can be ALL or a specific channel.

Product Select the product from the drop-down list. This

may be ALL or a specific product. The available
values come from a validated field based on the
selected Billing Cycle setup and the Product

setup.
State Select the state for this fee, from the drop-down
list. This may be ALL or a specific state.
Currency Select the currency for this fee, from the drop-

down list. This may be ALL or a specific currency.
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Field

Do this

Txn Amt From

Specify the transaction or balance amount. The
fee is calculated using the specifications of this
record only if the transaction amount is greater
than the value specified in this field (and less
than this field in another record for the same fee).

IMPORTANT:

When you select the fee to use, the system
searches for a best match using the following
attributes:

a. Company

b. Branch
c. Product
d. State

e. Amount (Txn Amt From)
f. Effective/start date (Start Dt)

Hence, Oracle Financial Services Software
recommends creating a version of each fee,
where ALL is the value in these fields.

It is also recommended that you define a default
printer for an Organization, Division and
Department.

Credit Limit From

Specify the minimum value of credit limit for the
pricing.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.12 Asset Billing Rate

In Asset Billing Rate screen you can setup the various parameters associated with Home
collateral which serves as the input for Asset Billing batch job to process and post the dues

on to respective accounts in the system.

This section consists of the following topics:

e Asset Billing Rate Definition

» Asset Billing Rate Details

» Asset billing Calculations

* Asset Billing Rate Setup - File upload

» Asset Billing Batch Job

4.12.1 Asset Billing Rate Definition

In the Asset Billing Rate Definition tab you can create and maintain Timeshare specific Home
collateral and account details of an account which are used as a selection criteria.

To set up Asset Billing Rate Definition
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On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Asset Billing Rate.

Figure 4-14 Asset Billing Rate
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In the Asset Billing Rate Definition section, perform any of the Basic Operations mentioned
in Navigation chapter. A brief description of fields are given below:

Table 4-37 Asset Billing Rate Definition

In this field Do this

Name Enter a unique name for Asset Billing Rate
definition. This field is not editable after saving
the record or during EDIT.

Description Enter the description for Asset Billing Rate
definition.

Enabled Check this box to enable the record.

Selection Criteria

Company Select the portfolio company from the drop-down
list. This list is populated based on Enabled
Company definitions maintained in the system.

Branch Select the portfolio branch from the drop-down
list.

Product Select the type of product associated with the
collateral from the drop-down list.

State Select the state to which the account operates
from the drop-down list.

Channel Select the channel from the drop-down list.

Asset Type Select asset type from the drop-down list. The

list is populated based on assets setup.

Asset Sub Type

Select the asset sub type from the drop-down
list.

Club Name

Select the Club Name from the drop-down list.

Phase Number

Select the Phase Number from the drop-down
list.

Site of Inventory

Select the Site of Inventory from the drop-down
list.
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Table 4-37 (Cont.) Asset Billing Rate Definition
|

In this field Do this

Building Select the Building from the drop-down list.
Unit Select the Unit from the drop-down list.
Week Select the Week from the drop-down list.

Room/Unit Type

Select the Room/Unit Type from the drop-down
list.

Usage Type

Select the Usage Type from the drop-down list.

Resort Identifier

Select the Resort Identifier from the drop-down
list.

Min Points Specify the minimum points for the asset hilling
definition.
Max Points Specify the maximum points for the asset billing

definition.

Association Id

Select the Association Id from the drop-down list.

Club Indicator

Check this box to indicate Club Indicator.

Plus Membership Type

Check this box to indicate Plus Membership
Type.

PR Marking

Check this box to indicate PR Marking.

Signature Grand Father

Check this box to indicate Signature Grand
Father.

Additional Attributes - This section consists of
additional 15 configurable fields as indicated
below.

5 check boxes - Membership 1-5 Opt
5 drop-down lists - Other Attribute 1-5
5 Calendar fields - Other Attribute 5-10

Perform any of the Basic Actions mentioned in Navigation chapter.

4.12.2 Asset Billing Rate Details

In the Asset Billing Details sub tab, you can define Transactions, their Calculation Method, and
other parameters which are posted by Billing Batch Job.

Note that once a record is created in this section, the same is available in Read-Only mode
and you can only Enable or Disable the record in Edit mode.

To set up Asset Billing Rate Details

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Asset Billing Rate.

In the Asset Billing Rate Details section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of fields are given below:

Table 4-38 Asset Billing Rate Details

In this field

Do this

Start Date

Select the date of asset billing from adjoining
calendar.
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Table 4-38 (Cont.) Asset Billing Rate Details

|
In this field Do this

Transaction Select the transaction from the drop-down list.

This list is populated with transactions where the
Transaction code = FOTH%.

Calc Method Select one of the following calculation method
from dropdown list.
*  Flat Amt

. Rate

. Flat Amt + Rate

« Tiered Rate

e Slab Formula

For more information on above calculation

methods, refer to Asset billing Calculations
section.

Flat Amt Specify the flat amount or fixed amount to be
charged during asset billing calculation.
This field is available if the Calc Method is Flat
Amt, Flat Amt + Rate, and Slab based Formula.

Rate Specify the rate for asset billing calculation. This
field is available if the Calc Method is Rate and
Flat Amt + Rate.

Frequency Select the frequency of asset billing calculation
from the drop-down list. The list is populated
based on frequency maintained in lookup code.

% of Calc Amt Specify the percentage of amount for calculation.
By default, this is set to 100.
Base Points Specify the base points for asset billing

calculation. By default this is set to 1 since a
value is required system does not allow to enter
0.

This field is available if the Calc Method is Rate,
Flat Amt + Rate, Tiered Rate, and Slab Formula.

Slab Points Specify the slab points for asset billing
calculation. This field is available if the Calc
Method is Slab Formula.

% Increase Specify the percentage increase in each slab for
asset billing calculation. This field is available if
the Calc Method is Slab Formula.

Min Amt Specify the base minimum amount to be
configured for the resulted transaction amount.

If the resulted Transaction Calculation Amount is
less than the Min Amt defined here, system
posts the transaction with Min Amt.

Max Amt Specify the maximum amount to be configured
for the resulted transaction amount.

Billing Year Specify the year in which the Rate is applicable.
The Billing Year is stamped in billing amount
transaction description only for FOTH%
transactions.

Enabled Check this box to enable the Asset Billing Rate.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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This section consists of the following topics:

Tiered Rate Details sub tab

4.12.2.1 Tiered Rate Details sub tab

The Tiered Rate Details sub tab you can define points specific tiers with different rates. This
sub tab is enabled only if the transaction calculation method is selected as Tiered Rate in
Asset Billing Rate Details section. For calculation details, refer to Tiered Rate Calculation
section.

To set up Tiered Rate Details

1.

3.

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
Administration > User > Products > Asset Billing Rate.

In the Tiered Rate Details section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of fields are given below:

Table 4-39 Tiered Rate Details

In this field Do this

From Points Specify the points from where the respective rate
is applicable.

Rate Specify the rate for defined points range.

Enabled Check this box to enable Tiered Rate detail.

Perform any of the Basic Actions mentioned in Navigation chapter.

4.12.3 Asset billing Calculations

This section explains the following calculation methods based on which the Asset Billing is
processed in the system:

Flat Amount Calculation

Rate Calculation

Flat Amt + Rate Calculation

Tiered Rate Calculation

Slab Formula Calculation

4.12.3.1 Flat Amount Calculation

In Flat Amount calculation, system calculates the Transaction Amount using below formula:

Table 4-40 Flat Amount Calculation
]

Frequency Billing Cycle Transaction Amount
Calculation

Annual Monthly (Flat Amt/12)

Monthly Annual (Flat Amt*12)

Annual Quarterly (Flat Amt/4)

Quarterly Annual (Flat Amt*4)
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Table 4-40 (Cont.) Flat Amount Calculation

Frequency Billing Cycle Transaction Amount
Calculation

Annual Semi Annual (Flat Amt/2)

Semi Annual Annual (Flat Amt*2)

Annual Annual (Flat Amt /1)

Consider the above calculation as reference for other combinations of Rate Frequency and
Billing cycle.

4.12.3.2 Rate Calculation

In Rate calculation, system calculates the Transaction Amount using below formula:

Table 4-41 Rate Calculation
]

Frequency Billing Cycle Transaction Amount
Calculation
Annual Monthly (Rate/12)*(Billing Points at
collateral / Base Points)
Monthly Annual (Rate*12)*(Billing Points at
collateral / Base Points)
Annual Quarterly (Rate/4)*(Billing Points at
collateral / Base Points)
Quarterly Annual (Rate*4)*(Billing Points at
collateral / Base Points)
Annual Semi Annual (Rate/2)*(Billing Points at
collateral / Base Points)
Semi Annual Annual (Rate*2)*(Billing Points at

collateral / Base Points)

Annual Annual (Rate/1)*(Billing Points at
collateral / Base Points)

Consider the above calculation as reference for other combinations of Rate Frequency and
Billing cycle.

4.12.3.3 Flat Amt + Rate Calculation

In Flat Amt + Rate calculation, system calculates the Transaction Amount using below
formula.

Transaction Amount = Flat Amt + Rate * (Billing Points at Collateral/Base Points)

@ Note

The Rate and Flat amount are adjusted based on Frequency and Billing Cycle.
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4.12.3.4 Tiered Rate Calculation

In Tiered Rate calculation, system selects the Asset Billing Rate Details using the Billing
Points at Asset and other asset parameters and calculates the transaction amount by deriving
the rate from Tiered Rate table.

Transaction Amount = (Tiered Rate) * (Tiered Points /| Base Points)

For example, if an Asset has 1.5 million points and the range is maintained as - for first million
points rate=0.66 with Base Points =1000 and for remaining points rate=0.60 with Base Points =
1000, the Transaction Amount = 1million * (0.66/1000) + 0.5 million * (0.6/1000) = 660 + 300 =
960.

Note the following:

» If the range for specific points are not maintained correctly, the same is considered as 0
rate and in-turn the Transaction Amount derived also becomes 0.

For example, if Billing Points are 8000 but if range maintained points is from 10000 with
Rate = 0.55 and Base Points = 1, the transaction amount results as (0*(8000/1) =0).

* Rate is adjusted based on Frequency and Billing Cycle as mention in Rate Method.

4.12.3.5 Slab Formula Calculation

In Slab Formula calculation, system calculates the Transaction Amount using below formula.

Transaction Amount = [Flat Amt] + Ceil[\{Billing Points - Base Points)/Slab Points}*\
{%Increase | 100)*Flat Amt}]]

The resultant amount will always be rounded-up.

For example,

Transaction Amount = [491.32+[{(61000-5000)/2500}*{(30.4/100)*491.32}]]
= [491.32+ [Round-up {22.4}*{149.36}]]

= [491.32+3435.28]

Transaction Amount = 3926.6

@® Note

The Rate and Flat amount are adjusted based on Frequency and Billing Cycle.

4.12.4 Asset Billing Rate Setup - File upload

The data in Asset Billing Rate screen can also be created and updated from an external file
through SET-IFP input file upload process. While doing so, ensure that the file format of
Header and Details record are maintained in required order and the input file is placed in
upload area.

During the scheduled batch job run, the asset billing batch job picks-up the data in input file
and loads on to the system to create Asset Billing Rate setup records.

However, before processing the details, system performs the following validations:
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If Name of the record is unique and duplicate record is not being updated.

For Tiered Rate, the details are added only if the Calc Method = Tiered Rate. If not, system
displays an error indicating Tiered Rate Details are not required for <Calc Method> and
the record is added in bad file.

For update to existing record details, only Enable/Disable option is supported. If there is a
mismatch in the name of the record, batch job errors out with message Record not found
and the record is added in bad file.

For new records, all the fields are mandatory and default values are applicable.

Values provided in fields which are of lookup type are validated with lookup code. In case
of mismatch, batch job errors out with message Lookup value not matching and the
record is added in bad file.

Negative values is not added for number fields.

Base Point's field does not contain negative, 0, or decimal values.

4.12.5 Asset Billing Batch Job

The billing batch job TXNDDT_BJ_100_01 (BILLING/DUE DATES PROCESSING) facilitates to
process the asset billing dues on account for Home collateral and posts the corresponding
transactions.

Listed below is the sequence of processing steps:

Billing batch job picks-up the Vacation Ownership (VO) parameters from Servicing >
Account > Collateral (Home) > Vacation Ownership tab.

e The required accounts for Asset billing batch job processing is selected based on the
type of account selected in Due Amt Account Type field. l.e. in Vacation Ownership
Details section if the Billing option is checked and the Due Amt Account Type is
selected as Current or Linked or Master Account, then the billing batch job posts the
transactions based on Asset Billing Rate setup in Current account or Linked Account
of current Account or Master Account of current Account respectively.

e In addition, system includes the asset billing points of Linked Account/Associated
Account only if the status of those accounts are in any of the status defined in lookup
code ACC_STATUS_BILLING_CD (ACCOUNT STATUS FOR ASSET BILLING
CODES). Account statuses which are not maintained in the lookup code are excluded
for asset billing calculation. However, If no statuses are maintained in the lookup, then
system will consider all statuses for consolidation.

— If billing flag is checked and Due Amt Account Type = Current Account, billing
batch job posts the transactions based on Asset Billing Rate setup in Current
account.

— If billing flag is checked and Due Amt Account Type = Linked Account, billing batch
job post the transactions based on Asset Billing Rate setup in Linked Account of
current Account.

— If billing flag is checked and Due Amt Account Type = Master Account, billing batch
job post the transactions based on Asset Billing Rate setup in Master Account of
current Account.

Before the due calculation, batch job validates VO parameters with the following:

e If the selected Usage Type sub code is FULL, system considers Full points for rate
derivation and Billing points is considered for Transaction Amount calculation.
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If the selected Usage Type sub code is HALF, system considers Billing Points for
Transaction Amount calculation but rate is derived using full points.

If the First Year Proration check box is selected, then the rate is derived using full
points and the Transaction Amount is calculated based on prorated points (nhot on full
points).

The prorated points are calculated based on Asset Usage Start Date.

— If the usage start date year is equal to first due year, then system prorates the
points as indicated in example below:

If First Due Date = 01/01/2018, Usage Start Date = 01/10/2018,
Prorated Points = Billing Points * (13-1)/12= Billing Points *1

If First Due Date = 01/01/2018, Usage Start Date = 03/10/2018

Prorated Points = Billing Points * (13-3)/12= Billing Points*10/12
Note: Number 13 here is used as constant.

If the usage start date year is before the due date year, system considers the full
points for calculating the Transaction Amount and no proration is required here.

2. Batch job looks of best matching Asset Rate details and Asset Billing definition in Setup.

3. Batch job checks for status (Y/N) of Multiple Billing Asset Rate indicator at Account
Details > Contract > Billing level to decide if multiple asset rates are applicable for one
billing period or not.

If N, system picks the latest rate which is less than or equal to DUE DATE. In this case
only one best match record is fetched to derive Transaction Amount and no multiple
asset rates are applicable for one billing period.

If Y, system fetches multiple rates only when rate End Date (i.e. rate start date + rate
frequency) ends with one or more cycle(s) before the next due date. This implies that
current rate record does not cover the entire billing period.

However, if Multiple Billing Asset Rate is set to Y but there is no Rate available for
Due period beyond the Rate End date, system applies the same rate that is picked for
Due Period which is Less than or Equal to Due End Date.

4. Batch job posts the matched transactions at account level based on calculation method.
The following Asset Billing Rate Details are stamped on the transaction posted:
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On posting the transactions, following validations and outcome are handled:

« If the respective balance for transaction is missing, batch job fails with an error
message indicating Account #: Transaction posting failed Balance not available in
Batch > Request Results block and does not process the account due amount
calculation.

— This can be rectified by posting Add balance to Account non-monetary
transaction. For more information, refer to Appendix - Non-Monetary transactions
section in Servicing User Guides.

* If the transaction posting failed due to an issue in Access grid configuration or Product
configuration at transaction codes, batch job displays error indicating Account #:
Transaction posting failed <Reason> and does not process the account due amount
calculation.

« If the Resulted transaction amount is less than Min Amount defined, batch job
considers the Min amount and posts the transaction.

« If the Resulted transaction amount is greater than Max Amount defined, batch job
considers the Max amount and posts the transaction.

4.13 Origination Fees

The system supports the auto computation of origination itemized fees. System administrators
can define and maintain the itemization formula on the Origination Fees screen.

An itemization formula can be set up as a computation of other itemizations (such as adding or
subtracting one itemization from another) and can consist of multiple itemizations. An
itemization formula will have a minimum and maximum value. You can set up a formula value
range to be used as the final value.

Itemizations are linked to a product with the Products screen’s Product Itemizations subtab.

One itemization can be based on one formula, while the same formula can be attached to
multiple itemizations. If a formula is attached to a contract itemization and that formula requires
an itemization not present in Formula Definitions screen, then the system displays an error
message.

The system will search for any circular dependency at the time the contract is enabled. An
example of a circular dependency is when Itemizationl has Formulal attached requiring
Itemization2 for computation and Itemization2 has Formula2 attached requiring Itemizationl for
computation.

To set up the Origination Fees

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Origination Fees > Line.

2. Inthe Formula Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
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Figure 4-15 Origination Fees
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A brief description of the fields is given below:

Table 4-42 Formula Definitions

Field Do this

Formula Specify the formula code to define computation.

Description Specify the description for the formula.

Min Amt Specify the minimum value that should be
considered to compute the final value of formula.

Max Amt Specify the maximum value that should be
considered to compute the final value of formula.

Enabled Check this box to allow the origination fees.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Formula Details section of Setup > Setup > Administration > User > Products >
Origination Fees > Line > Detail, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 4-43 Formula Details

Field Do this

Itemization Select the itemization based on which the
itemization formula will derive its computed
value, from the drop-down list.

Percentage Specify the percentage value that should be
considered while computing value for itemization
formula.

Sort Specify the sort sequence for the itemization to
be considered while computing the value of the
itemization formula.

Sign Select the +ve or -ve sign that needs to be

considered between two itemizations for
computing the value of the itemization formula.
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Table 4-43 (Cont.) Formula Details

|
Field Do this

Enabled Check this box to allow the itemization details to
be used by the system.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Range Details section of Setup > Setup > Administration > User > Products >
Origination Fees > Line, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Table 4-44 Range Details

'
Field Do this

Amt From Specify the value up to which the percentage of
final value of the itemization formula to be
considered for the final value of itemization
formula.

Percent Specify the percentage value that should be
considered while computing the value for the
final value of the itemization formula.

Enabled Check this box to allow the range details to be
used by the system.

Perform any of the Basic Actions mentioned in Navigation chapter.

4.14 Insurance

Most financial institutes offer financing for insurance to the borrowers; examples include credit
life, credit disability, and GAP. The insurance product offer permits the customer to cancel the
insurance in mid term or automatically end when the product matures or is paid-off. The
system supports financing of insurance products during origination and automatically end the
insurance when the product is paid-off. The system also can compute the rebate premium
based on Rule of 78 or Actuarial method. As the customer might cancel the insurance in mid
term of the line, the system computes the premium rebate on a prorate basis. This also applies
to additional insurance purchase during the life of the line. Normally, mid term insurance
cancellations have associated fees and grace period. In such cases, the customer may cancel
the insurance during the grace period without accruing any fees. However, when a customer
cancels after the grace period, the result is a predefined fees which the system deducts from
the computed rebate.

The system supports mid term insurance cancellation with and without grace period and
cancellation fees. With this enhancement of insurance processing, you can define the premium
rebate computation with a prorate basis.

You can define financed insurance related itemizations in the Origination Fees screen, as you
have in previous releases with the Insurance screen. You can also set the refund method to
Pro Rate Basis in the Refund Method field in the Contract Itemization section on the
Itemization sub screen during setup with the on the Contracts screen.

To set up the Insurances

You can either define new Insurance details or specify a new code in the New Insurance field
and click Create Copy to create a copy of selected insurance with details.
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On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Products > Insurance > Line.

In the Insurance Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

Figure 4-16 Insurance
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A brief description of the fields is given below:

Table 4-45 Insurance Definition
]

Field Do this

Code Specify the code associated with the insurance
product.

Description Specify a brief description of the insurance
product.

Start Dt Specify the date from which you can start
offering the product to customers. You can even
select the date from the adjoining Calendar icon.

End Dt Specify the date from which to stop offering the
product to customers. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to allow the offering of this

insurance product.

Result section

Insurance Type

Select the insurance types available for
financing, from the drop-down list.

Insurance Company

Specify the name of the company through which
the insurance product is offered.

Calculation Method

Select the insurance calculation method from the
drop down list.
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Table 4-45 (Cont.) Insurance Definition
|

Field Do this

Max Age Enter the maximum age allowed by the
insurance.

Cancellation /Refund Allowed Check this box to allow the insurance rebate or
refund for cancellation or paid-off.

Grace Days Specify the number of grace days allowed for
cancellation without charging a cancellation fee.

Tier Select the tier from the drop-down list.

Base Select the base from the drop-down list.

Category Select he category from the drop-down list.

Days Enter the number of category days.

Selection Criteria Section

Company Select the portfolio company that can offer the
insurance product, from the drop-down list.
Select ALL if offered by all companies.

Branch Select the branch of the specified portfolio
company that can offer the insurance product,
from the drop-down list. Select ALL if offered by
all the branches of the specified portfolio
company.

Product Select the product for which you can offer the
insurance product, from the drop-down list.
Select ALL if offered for all the products.

State Select the state for which you can offer the
insurance product, from the drop-down list.
Select ALL if this is offered for all the states.

Currency Select the currency for which you can offer the
insurance product, from the drop-down list.
Select ALL if this is offered for all the states.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click Create Copy button in the Insurance Definition section to create copy of selected
record with details.

5. Inthe Insurance Details section, perform any of the Basic Operations mentioned in
Navigation chapter.
A brief description of the fields is given below:

Table 4-46 Insurance Details

|
Field Do this

Insurance Sub Type Select the insurance sub type you want to define
for the entry in the Insurance section, from the
drop-down list. For example SINGLE.

Term From Specify the minimum term for the insurance sub
type.

Rate Specify the rate for premium calculation
per $1,000.00 for the insurance sub type.

Max Coverage Amt Specify the maximum coverage amount covered
by the insurance sub type.

Enabled Check this box to enable the insurance.
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6. Perform any of the Basic Actions mentioned in Navigation chapter.

4.15 Checklists

A checklist is an optional set of steps to follow when completing a task in the system, such as
the underwriting and funding processes.

Checklists can be used as guidelines to help ensure that the system users follow your
business’s standard operating procedures and enter all required data. Some checklists are
optional, but others such as those related to application decisions or contract verification, may
be required depending on the edit sets defined in your system. The Checklists screen allows
you to specify the contents of the checklist.

You can define additional checklists for your organization. You can set up multiple checklists for
a single type of checklist. These checklists can be differentiated by:

*  Company
¢ Branch
*  Product

e Account state
To set up the Checklists

You can either define new Checklist Type Definition details or specify a new code in the New
Checklist field and click Create Copy to create a copy of selected checklist type definition with
details.

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Checklists > Line.

2. Inthe Checklist Type Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

Figure 4-17 Checklists
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A brief description of the fields is given below:

Table 4-47 Checklist Type Definition

Chapter 4
Checklists

Field

Do this

Checklist Code

Specify the checklist code that identifies checklist
being defined.

Description

Specify the description for the checklist.

Checklist Type

Select the checklist type from the drop-down list,
to define where the specific checklist will be
available in the system.

Company

Select the portfolio company associated with the
checklist from the drop-down list. This may be
ALL or a specific company.

Branch

Select the portfolio branch associated with the
checklist from the drop-down list. This may be
ALL or a specific branch. This must be ALL if in
the Company field you selected ALL).

Channel

Select the channel from the drop-down list, This
can be ALL or a specific channel.

Product

Select the product associated with the checklist
from the drop-down list. This may be ALL or a
specific product. The available values come from
a validated list based on the selected Billing
Cycle setup and the Product setup.

State

Select the state associated with the checklist
type from the drop-down list. This may be ALL or
a specific state.

IMPORTANT: By selecting which edits type to
use, the system searches for a best match using
the following attributes:

1 Company
2 Branch

3 Product
4 State

Hence, Oracle Financial Services Software
recommends creating one version of each
checklist type where ALL is the value in these
fields.

Currency

Select the currency associated with the checklist
from the drop-down list. This may be ALL or a
specific currency.

Enabled

Check this box to enable the checklist.

Perform any of the Basic Actions mentioned in Navigation chapter.
Checklist actions are steps (a set of one or more tasks) related to the checklist you are
creating. They are loaded on the Checklist Action Definition section.

In the Checklist Action Definition - Regular section, perform any of the Basic Operations

mentioned in Navigation chapter
A brief description of the fields is given below:

Line Origination Setup Guide

G42451-01

Copyright © 2022, 2025, Oracle and/or its affiliates.

September 11, 2025
Page 73 of 81



ORACLE Chapter 4
Stipulations

Table 4-48 Checklist Action Definition
]

Field Do this

Action Code Specify the action code for the checklist.

Description Specify the description for the action type.

Sort Specify the sort order to define the placement of
the action type on the Checklist sub screen.

Enabled Check this box to include this action in the
checklist.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Inthe Checklist Action Definition - Document section, perform any of the Basic Operations
mentioned in Navigation chapter.
A brief description of the fields is given below:

Table 4-49 Checklist Action Definition
|

Field Do this

Action Code Specify the action code for the checklist.

Description Specify the description for the action type.

Document Type Select the document type from the drop-down
list.

Document Sub Type Select the document sub type from the drop-
down list.

Document Mandatory Check this box to indicate that the document is
mandatory.

Sort Specify the sort order to define the placement of
the action type on the Checklist sub screen.

Enabled Check this box to include this action in the
checklist.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

4.16 Stipulations

The system supports the automatic generation of default stipulations for line of credit during
origination on the Underwriting window’s Stipulation sub screen (Decision link). The default
stipulations can be maintained by company, branch, product, state, application status and
application sub-status on the Stipulations screen.

To set up the Stipulations

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Stipulations > Line.

2. Inthe Stipulation Setup section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Table 4-50 Stipulation Setup

Field Do this

Company Select the portfolio company associated with the
default stipulations, from the drop-down list.

Branch Select the portfolio branch associated with the
default stipulations, from the drop-down list.

Product Select the product associated with the default
stipulations, from the drop-down list.

State Select the state associated with the default
stipulations, from the drop-down list.

Currency Select the currency associated with the default

stipulations, from the drop-down list.

Application Status

Select the application status associated with the
default stipulations, from the drop-down list.

Application Sub-Status

Select the application sub status associated with
the default stipulations, from the drop-down list.

Enabled

Check this box to allow the default stipulations to
be used.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Stipulation Details section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Table 4-51 Stipulation Details

Field Do this
Stipulations Select the stipulation from the drop-down list.
Sort Specify the sort sequence for the stipulation.
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Field

Do this

Enabled

Check this box to allow the stipulations details to
be used by the system.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

4.17 Letters

The Letters screen allows you to define letters that the system automatically generates when
the application or the account for a products meets certain conditions, or trigger events. Each
letter has its own trigger event. For example, you can configure the system to automatically
send a welcome letter when an application becomes an account or send a collection letters

when an account becomes delinquent.

The system supports the following types of letters:

Table 4-52 Types of letters

Type of letter

Definition

ACCOUNT STATEMENT

Generated when account is to receive a billing
statement (this time is defined in contract setup).
Letter is sent to customer.

ADVERSE Action letter

Generated in nightly batch jobs for applications that
were declined. This letter is sent to the consumer
to indicate the reasons why the application was
declined.

CONDITIONAL ADVERSE

Generated in nightly batch jobs for applications that
were declined.

ACTION LETTER

This letter is sent to the consumer to indicate the
reasons why the application was declined. This
letter also indicates steps that the consumer may
take to gain approval of the application.

COLLECTION LETTER 1

Generated when an account becomes delinquent.
This is the first dunning letter sent to the customer.

COLLECTION LETTER 2

Generated when an account remains in
delinquency for an extended period. This is the
second dunning letter sent to the customer.

COLLECTION LETTER 3

Generated when an account remains in
delinquency for an extended period, even after
having received previous notices. This is the final
dunning letter sent to the customer.

CONTRACT FUNDING fax/ email

Generated when an application is APPROVED:
FUNDED or CONDITIONED: FUNDED. This letter
is sent to the producer.

DECISION FAX/ EMAIL

Generated when an application is APPROVED,
CONDITIONED, or REJECTED. This letter is sent
to the consumer or producer, depending on the
product.

PAID IN FULL LETTER

Generated in nightly batch jobs when the account
pays off. This letter is sent to the customer.

PAYOFF QUOTE LETTER

Generated when a payoff quote is created for an
account. This letter is sent to the customer.
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Table 4-52 (Cont.) Types of letters

_________________________________________________________________________________|
Type of letter Definition

WELCOME LETTER Generated when an application is APPROVED:
FUNDED. This letter is sent to the consumer.

STATEMENT PAST MATURITY Generated when
an accounts are matured but unpaid.

This letter is sent to the account holders as a
reminder to make their payments.

When the system generates letters, it searches the Letters screen for letter definitions that
meet the following criteria:

»  Definition is enabled.
» Definition is an exact match of the letter code being generated.

« Definition is a match of either the application/account value or ALL for all other criteria.
Exact matches for each field are given a higher weight than matches to ALL.

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of these fields:

1. Company

2. Branch

3. Product
4. State

5. Currency

On the ranked rows, the first row is returned as the best match.

To set up the Letters

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Letters > Line.

2. Inthe Letter Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Table 4-53 Letter Definition
|

Field

Do this

Letter Code

Specify the code for the letter.

File Name

Specify the file name of the Oracle report used to
generate the letter. The file should be named
<File Name>.rep on your server.

Letter Type

Select the type of letter you want to generate
from the drop-down list.

Channel

Select the application source (channel) for the
letter from the drop-down list. This may be ALL
or a specific channel.

Enabled

Check this box to enable this letter definition.

Result section

Batch Printer

Select the batch printer being used to generate
the letter from the drop-down list.

Batch User

Select the user who will submit this letter from
the drop-down list. This will normally be set to
BATCH.

Selection Criteria section

Company

Select the portfolio company for which this letter
will be used from the drop-down list. This may be
ALL or a specific company.

Branch

Select the portfolio branch for which this letter
will be used from the drop-down list. This may be
ALL or a specific branch. This must be ALL if in
the Company field you selected ALL).

Product

Select the product for which this letter will be
used from the drop-down list. This may be ALL or
a specific product.
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Table 4-53 (Cont.) Letter Definition

|
Field Do this

State Select the state for which this letter will be used
from the drop-down list. This may be ALL or a
specific state.

Currency Select the currency for which this letter will be
used from the drop-down list. This may be ALL or
a specific currency.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.18 Promotions

The Introductory tab of Promotions screen allows you to set up the promotions that a financial
institution can offer its customers. Promotion details defined here can be selected during
Application Entry and Application processing.

You can define multiple promotions for a product, then select the appropriate promotion at the
time the application is processed. Promotions also serve as a selection criteria on the Pricing
screen.

CAUTION: The system supports promaotions selected only when a product is funded.
Same as Cash promotions

In the case of the same as cash promotion:

< If the outstanding amount at the end of the promotional period is within the tolerance
amount, then the customer receives the full benefit of the promotion and the system will
not charge any interest on the borrowers’ account.

* If the outstanding amount is higher than the authorized tolerance amount, then the
customer loses the benefit of the promotion and the system computes and charges the
borrower interest from the date the product was funded.

Interest & Payments

Interest still continues to accrue for a account that is funded using the SAME AS CASH
promotion. However, the interest accrued during the promotion period is not charged or
collected on the account until the end of the promotion period.

Any repayment made by the customer during the promotion period is applied towards the line
receivables amount. The system then calculates the interest accrual using the reduced line
receivables amount, if applicable.

If the product remains unpaid after the end of the promotion period and the line receivables
balance is above any stated tolerance amount, then the system starts collecting interest
earned and accrued during the promotion period.

Reduced Rate Introductory Promotions

Oracle Financial Services Lending and Leasing’s promotion method PROMOTIONAL RATE
allows you to create and specify promotions where customers can be charged lower interest
rates during a specific promotional period of time. You may define the length of the promotion
in either terms or days. Also, you will be able to set the specific interest rate you want to attach
to the promotion. During the promotional period, interest on an account is accrued at the
promotional rate. When the promotional period expires, the system changes the interest rate of
the product to the contractual interest rate to accrue interest. The promotion expires on the
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promotion end date defined by the length of the promotion. However, the system allows you to
set a grace period for extending the automatic cancellation of the promotion due to
delinquency, similar to the grace period associated with a payment date.

To set up the Line Introductory

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Promotions > Line Introductory.

In the Promotion Definitions section, perform any of the Basic Operations mentioned in

Navigation chapter.
A brief description of the fields is given below:

Table 4-54 Promotion Definitions

Field

Do this

Code

Specify the code identifying the promotion.

Description

Specify a description of the promotion being
offered.

Type

Select the promotion type from the drop-down
list. Oracle Financial Services Lending and
Leasing supports the following promotion types
for lines of credit:

NO PAYMENT DUE ANY INTEREST DUE (No
payments are required and no interest is accrued
on the outstanding accrual balances for x terms).

Term

Select the promotion term from the drop-down
list.

Index

Select the promotion index from the drop-down
list.

Margin

Specify the promotion margin rate.

Cancel Delg Days

Specify the promotion cancellation delinquency
days.

Cancel Overlimit%

Specify the promotion cancellation over limit
percentage.

Enabled

Check this box to enable the promotion.

Perform any of the Basic Actions mentioned in Navigation chapter.

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Promotions > Line Incentive.

In the Promotion Definitions section, perform any of the Basic Operations mentioned in

Navigation chapter.
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Figure 4-20 Promotions-Line Incentive

ORACLE -
Financial Services Lending and Leasing

Chapter 4
Promotions

Promotions .

> DashBoard

> Origination Loan Introductory | Line Introductory | Line Incentive

> Servicing

SIS Promotion Definition

— Views Fomatv | B | [frecre BfiDetach | cdwrp | @

~ Code Description Start Dt End Dt Enabled
> Tools oayn2p2016

234234505
LINE INCERTIVE

12/12/2015 1
12/17/2015 N
231 213213 12/12)2015 N
TESTINCENTIVE  TEST 12/16/2015 N

LInE_INCEN

Promotion Definition

* Code

= Description

Pricings
Contract. “startot 02/12/206 [
ot End Dt B

* Enabled

Result

2 Welcome, VAVAIDYA + [S]
B close
Faud | Leie | Eview | e
Type Term Index Margin  Cancel Delq Days Cancel Over limit % Company Branch
o o000 o
PRONOTIONAL R o FLATRATE o000 o 00000 ALL AL
PRONOTIONAL R o FLATRATE ca0c0 o 00000 AL au
PROMOTIONAL R o FLATRATE 10000 o 00000 ALL au
PRONOTIONAL R 10 PRIME RATE o000 . 00000 Us01 ust

3

B seve sndacd || [ save and sty || [ save and Retum || GaRetun

Selection Criteria

Company AL
FLAT RATE v

*Branch ALL
L Product AL

“state ALL
Wit 0.0000

A brief description of the fields is given below.

Table 4-55 Promotion Definitions

Field

Do this

Code

Specify the code identifying the promotion.

Description

Specify a description of the promotion being
offered.

Start Date Select the start date from the drop-down list.

End Date Select the end date from the drop-down list.

Enabled Check this box to enable the promotion.

Result section

Type Select the promotion type from the drop-down
list.

Term Specify the promotion term.

Index Select the promotion index from the drop-down
list.

Margin Specify the promotion margin rate.

Cancel Delg Days

Specify the promotion cancellation delinquency
days.

Cancel Overlimit%

Specify the promotion cancellation over limit
percentage.

Selection Criteria section

Company Select the portfolio company from the drop-down
list.

Branch Select the portfolio branch from the drop-down
list.

Product Select the product from the drop-down list.

State Select the state from the drop-down list.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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Appendix : Summary of the Application Credit
Scoring Parameters

This section consists of the following topics:

e Glossary
e Credit Scoring Parameters by Category

A.1 Glossary

Table A-1 Glossary
]

Term Description

DEROG / DEROGATORY Account has had chargeoffs, collections,
bankruptcy, or repossession.

MINOR DELINQUENCY Less than or equal to 60 days delinquent.

MAJOR DELINQUENCY Greater than 60 days delinquent.

DEBT RATIO Debt / Available credit.

DEBT TO INCOME RATIO Debt / Income.

APPLICANT STATED Parameter is pulling information stated or in any

other way provided by the applicant on the
application on the Application Entry form in the
system.

APPLICANT CREDIT BUREAU Parameter is pulling information from the credit
bureau, as opposed to another source, such as the
Application Entry form.

FINANCE Refers to companies that provide the finance but
are not selling the actual object financed, if any.

Example: An independent auto finance company.

SALES FINANCE Refers to companies that provide the object being
financed in addition to the financing.

Example: Marshall Fields card.

A.2 Credit Scoring Parameters by Category

This section consists of the following topics:

*  Applicant Details / Debt Ratios

¢ Line of Credit Details

¢ Auto Trades / Inquiries

 Bank Trades / Inquiries

e Card Trades / Inquiries

¢ Installment Trades / Inquiries
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» Line of Credit Finance Trades / Inquiries

Mortgage Trades / Inquiries

e Retail Trades / Inquiries

 Revolving Trades

» Sales Finance Trades / Inquiries
e Other Trades

*  Bankruptcy Information

* Delinqguency Information

 Derogatory Trade Information

A.2.1 Applicant Details / Debt Ratios

Applicant Credit Bureau Auto Debt Ratio

This is the sum of all automobile type line of credit balances and the sum of all automobile type
credit limits. For installment line of credit, the credit limit is normally equal to the original line of
credit amount. This applies to open tradelines only.

Applicant Credit Bureau Bank Debt Ratio

This is the sum of all bank type line of credit balances and the sum of all bank type credit limits.
For installment line of credit, the credit limit is normally equal to the original line of credit
amount. This applies to open tradelines only.

Applicant Credit Bureau Card Debt Ratio

This is the sum of all travel card type line of credit balances and the sum of all travel card type
credit limits. This applies to open tradelines only.

Applicant Credit Bureau Debt Ratio

This parameter provides a value for all debt divided by all available credit as shown on the
bureau.

Applicant Credit Bureau FICO Score

This is the FICO score provided for the applicant in the bureau pull. There are usually several
different types of FICO scores available at the bureau. The different score models are set up to
give certain attributes different, weighting based on if the person is buying a car, or a house,
and so on. The type of FICO score pulled is based on credit bureau setup.

Applicant Credit Bureau Inst Debt Ratio

This is the sum of all installment line of credit balances and the sum of all installment line of
credit credit limits. For installment line of credit, the credit limit is equal to the original line of
credit amount. This applies to open tradelines only.

Applicant Credit Bureau Line of credit Fin Debt Ratio

This is the sum of all line of credit finance type balances and the sum of all line of credit
finance type credit limits. For installment line of credit amount, the credit limit is normally equal
to the original line of credit amount. This applies to open tradelines only.

Applicant Credit Bureau Mortgage Debt Ratio
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This is the sum of all mortgage type line of credit balances and the sum of all mortgage type
credit limits. For installment line of credit, the credit limit is normally equal to the original line of
credit amount. This applies to open tradelines only.

Applicant Credit Bureau Open Public Records

This parameter indicates if there are any open public records in the credit bureau associated
with the applicant. This is a numeric counter covering the full period of time available in the
bureau.

Applicant Credit Bureau Public Records

This parameter indicates, if there are any public records, open or closed, in the credit bureau
associated with the applicant. This is a numeric counter covering the full period of time
available in the bureau.

Applicant Credit Bureau Retail Debt Ratio

This is the sum of all retail type line of credit balances divided by the sum of all retail type credit
limits. For installment line of credit, the credit limit is normally equal to the original line of credit
amount. This applies to open tradelines only. This is expressed as a percent: 50% shows as
50.

Applicant Credit Bureau Rev Debt Ratio

This is the sum of all revolving type line of credit balances and the sum of all revolving type
credit limits. This applies to open tradelines only. This is expressed as a percent: 50% shows
as 50.

Applicant Credit Bureau Sales Fin Debt Ratio

This is the sum of all sales finance type line of credit balances and the sum of all sales finance
type credit limits. For installment line of credit, the credit limit is normally equal to the original
line of credit amount. This applies to open tradelines only. This is expressed as a percent: 50%
shows as 50.

Applicant Debt Ratio Stated After Requested Line of credit Amount

This is the debt divided by available credit based on the values stated by the applicant after
factoring in the requested line of credit amount - this information is not taken from the bureau.
This is expressed as a percent: 50% shows as 50.

Applicant Debt Ratio Stated Before Requested Line of credit Amount

This is the debt divided by available credit based on the values stated by the applicant before
factoring in the requested line of credit amount - this information is not taken from the bureau.
This is expressed as a percent: 50% shows as 50.

Applicant Debt To Income Ratio Stated After Requested Line of credit Amount

This is the debt divided by income based on the values stated by the applicant after factoring in
the requested line of credit amount - this information is not taken from the bureau. This is
expressed as a percent: 50% shows as 50.

Applicant Debt To Income Ratio Stated Before Requested Line of credit Amount

This is the debt divided by income based on the values stated by the applicant before factoring
in the requested line of credit amount - this information is not taken from the bureau. This is
expressed as a percent; 50% shows as 50.

Applicant Payment To Income Ratio Stated
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This is the total amount of all monthly payments divided by monthly income. These values are
stated by the applicant and not taken from the bureau. This is expressed as a percent: 50%
shows as 50.

Applicant Prior Customer

This parameter indicates whether the applicant is a prior customer. It is populated when the
application is passed to Underwriting for a decision. If the SSN given by the applicant already
exists then the applicant is marked as a prior customer and the parameter value is Y (Yes).

Applicant Revolving Debt Ratio Stated

This is the sum of all revolving type line of credit amount balances / sum of all revolving type
credit limits. This applies to open tradelines only. This is expressed as a percent: 50% shows
as 50.

Applicant Stated Employment Period (In Months)

This parameter looks at the number of months of stated employment for the most recently
entered current employment.

For example, the applicant states that she has been working at her current place of
employment for 3 years and 5 months. This parameter would be populated with (3years * 12
months/year) + 5 months which calculates to 41 stated months. If the applicant enters another
current employment and enters 1 year and 2 months then this parameter will be populated with
14 months, even though the other employment is still current.

Applicant Stated Monthly Income

This is the monthly income stated by the applicant on the application. It combines the income
for all employment marked as current in the system. If the income is stated as anything other
than monthly, the income will be converted to monthly for this parameter.

For example, the applicant states that he is paid $50,000 with a frequency of ANNUALLY. This
parameter is populated with $50,000/12, which calculates to $4166.67 stated monthly income.

Applicant Stated Monthly Liability
This is the stated monthly liability as provided by the applicant on the Application Entry screen.
Applicant Stated Residence Period (In Months)

This parameter looks at the stated residence period for the most recent current address.

A.2.2 Line of Credit Details

Approximate Cash Price

This is the Approximate Cash price taken from the Approx Price field on the Application Entry
form’s Line of Credit screen in the system.

Requested Advance Amount

This is the Requested Advance Amount value taken from the Application Entry form’s Line of
Credit screen in the system.

A.2.3 Auto Trades / Inquiries

Applicant Credit Bureau 6month Auto Trades
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This is the number of auto trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 12month Auto Trades

This is the number of auto trades that have been opened in the last 12 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 24month Auto Trades

This is the number of auto trades that have been opened in the last 24 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Auto Inquries
This is the number of automobile-related credit inquiries the have been made to the bureau.
Applicant Credit Bureau Auto Trades

This is the number of auto trades, both open and closed. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Current Auto Trades

Total number of auto trades that are paid on time right now. These trades may or may not have
been delinquent in the past.

Applicant Credit Bureau Open Auto Trades

This is the number of open auto trades on the account. Note that these trades may be paid as
agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Auto

Total number of auto trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Auto Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.4 Bank Trades / Inquiries

Applicant Credit Bureau 12month Bank Trades
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This is the number of bank trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 24month Bank Trades

This is the number of bank trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 6month Bank Trades

This is the number of bank trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Inquiries

This is the number of bank inquiries against the bureau in the applicant's recorded bureau
history.

Applicant Credit Bureau Bank Trades

This is the number of open bank trades on the account. Note that bank trades can be
considered a sub type to installment, mortgage, and / or revolving Line of Credit.

Applicant Credit Bureau Bank Trades

Total number of bank trades that are paid on time right now. These trades may or may not
have been delinquent in the past.

Applicant Credit Bureau Bank Trades

This is the number of bank trades that are open right now. Note that these trades may now be
open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Trades

This parameter shows the current revolving bank balance. If the revolving credit is owned by a
bank, then it will show up here.

Applicant Credit Bureau Bank Trades

This parameter shows the highest cumulative balance among all revolving bank credit over the
bureau history.

@® Note

If the applicant had $5,000 on one account 2 years ago and $10,000 on another
account 4 years ago, this parameter would return $15,000. The parameter is of
questionable utility in many situations.

Applicant Credit Bureau Bank Trades

Total number of bank trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Bank Trades

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current
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2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.5 Card Trades / Inquiries

Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 12 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 24 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Trades

This is the number of card trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Bank Trades

This is the number of card inquiries that have been made against the bureau for the applicant
in the bureau's recorded history.

Applicant Credit Bureau Card Trades

This is the number of card trades, both open and closed, in the bureau history. Note that these
trades may be paid as agreed, delinquent, derogatory, and so on. The parameter makes no
distinction.

Applicant Credit Bureau Current Card Trades

Total number of card trades that are paid on time right now. These trades may or may not have
been delinquent in the past.

Applicant Credit Bureau Open Card Trades

This is the number of open card trades on the account. Note that these trades may be paid as
agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Card

Total number of card trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Card Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:
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1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.6 Installment Trades / Inquiries

Applicant Credit Bureau 12month Inst Trades

This is the number of installment trades that have been opened in the last 12 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 24month Inst Trades

This is the number of installment trades that have been opened in the last 24 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 6month Inst Trades

This is the number of installment trades that have been opened in the last 6 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Current Inst Trades

Total number of installment trades that are paid on time right now. These trades may or may
not have been delinquent in the past.

Applicant Credit Bureau Inst Trades

This is the number of installment trades, both open and closed. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Open Inst Trades

This is the number of open installment trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Inst Trades

Total number of installment trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Inst Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current
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2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.7 Line of Credit Finance Trades / Inquiries

Applicant Credit Bureau 12month Line of Credit Fin Trades

This is the number of Line of Credit finance trades that have been opened in the last 12
months. Note that these trades may now be open or closed, paid as agreed, delinquent, or
derogatory, and so on.

Applicant Credit Bureau 24month Line of Credit Fin Trades

This is the number of Line of Credit finance trades that have been opened in the last 24
months. Note that these trades may now be open or closed, paid as agreed, delinquent, or
derogatory, and so on.

Applicant Credit Bureau 6month Line of Credit Fin Trades

This is the number of Line of Credit finance trades that have been opened in the last 6 months.
Note that these trades may now be open or closed, paid as agreed, delinquent, or derogatory,
and so on.

Applicant Credit Bureau Current Line of Credit Fin Trades

Total number of Line of Credit finance trades that are paid on time right now. These trades may
or may not have been delinquent in the past.

Applicant Credit Bureau Line of Credit Fin Trades

This is the number of Line of Credit finance trades, both open and closed. Note that these
trades may be paid as agreed, delinquent, derogatory, and so on. The parameter makes no
distinction.

Applicant Credit Bureau Line of Credit Finance Inquiries

This is the number of Line of Credit finance inquires listed on the credit report. The bureaus
have their own limits as to how long they keep an inquiry on the credit report, but this
parameter will show whatever total is shown for that bureau.

Applicant Credit Bureau Open Line of Credit Finance Trades

This is the number of open Line of Credit finance trades on the account. Note that these trades
may be paid as agreed, delinquent, derogatory, and so on. The parameter makes no
distinction.

Applicant Credit Bureau Satisfactory Line of Credit Fin
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Total number of Line of Credit finance trades paid as agreed (no delinquencies) for the entire
life of the trade. This could be a few months or several years- the parameter makes no
distinction.

Applicant Credit Bureau Worst Line of Credit Fin Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.8 Mortgage Trades / Inquiries

Applicant Credit Bureau 12month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 24month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 6month Mortgage Trades

This is the number of mortgage trades that have been opened in the last 6 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Current Mortgage Trades

Total number of mortgage trades that are paid on time right now. These trades may or may not
have been delinquent in the past.

Applicant Credit Bureau Mortgage Trades

This is the total number of mortgage trades, both open and closed. Note that these trades may
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Open Mortgage Trades

This is the number of open mortgage trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Mortgage

Total number of mortgage trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.
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Applicant Credit Bureau Worst Mortgage Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.9 Retail Trades / Inquiries

Applicant Credit Bureau 12month Retail Trades

This is the number of retail trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 24month Retail Trades

This is the number of retail trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 6month Retail Trades

This is the number of retail trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Current Retail Trades

Total number of retail trades that are paid on time right now. These trades may or may not
have been delinquent in the past.

Applicant Credit Bureau Open Retail Trades

This is the number of open retail trades on the account. Note that these trades may be paid as
agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Retail Inquiries

This is the number of retail inquires listed on the credit report. The bureaus have their own
limits as to how long they keep an inquiry on the credit report, but this parameter will show
whatever total is shown for that bureau.

Applicant Credit Bureau Retail Trades

This is the number of retail trades, both open and closed. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Retail
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Total number of retail trades paid as agreed (no delinquencies) for the entire life of the trade.
This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Retail Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 =90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.10 Revolving Trades

Applicant Credit Bureau 12month Rev Trades

This is the number of revolving trades that have been opened in the last 12 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 24month Rev Trades

This is the number of revolving trades that have been opened in the last 24 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 6month Rev Trades

This is the number of revolving trades that have been opened in the last 6 months. Note that
these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Current Rev Trades

Total number of revolving trades that are paid on time right now. These trades may or may not
have been delinquent in the past.

Applicant Credit Bureau Open Rev Trades

This is the number of open revolving trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Rev Balance

This is the total revolving credit balance shown on the applicant's credit bureau. This applies to
all open revolving trades.

Applicant Credit Bureau Rev High Balance

This parameter shows the highest cumulative balance among all revolving credit over the
bureau history.
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@® Note

If the applicant had $5,000 on one account 2 years ago and $10,000 on another
account 4 years ago, this parameter would return $15,000. The parameter is of
questionable utility in many situations.

Applicant Credit Bureau Rev Retail Balance

This is the current revolving retail trade balance shown on the applicant's credit bureau. This
applies to all open retail trades. It shows current, not historical, information.

Applicant Credit Bureau Rev Retail High Balance

This parameter shows the highest cumulative balance among all revolving retail credit over the
bureau history.

@ Note

If the applicant had $5,000 on one account 2 years ago and $10,000 on another
account 4 years ago, this parameter would return $15,000. The parameter is of
guestionable utility in many situations.

Applicant Credit Bureau Rev Trades

This is the number of revolving trades, both open and closed. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Satisfactory Rev Trades

Total number of revolving trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Rev Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off
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A.2.11 Sales Finance Trades / Inquiries

Applicant Credit Bureau 12month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 12 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 24month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 24 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
so on.

Applicant Credit Bureau 6month Sales Fin Trades

This is the number of sales finance trades that have been opened in the last 6 months. Note
that these trades may now be open or closed, paid as agreed, delinquent, or derogatory, and
SO on.

Applicant Credit Bureau Current Sales Fin Trades

Total number of sales finance trades that are paid on time right now. These trades may or may
not have been delinquent in the past.

Applicant Credit Bureau Open Sales Finance Trades

This is the number of open sales finance trades on the account. Note that these trades may be
paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Sales Fin Trades

This is the number of sales finance trades, both open and closed. Note that these trades may
be paid as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Sales Finance Inquiries

This is a count of the number of sales finance inquiries that have been made against the
Applicant's bureau information in the bureau history.

Applicant Credit Bureau Satisfactory Sales Fin

Total number of sales finance trades paid as agreed (no delinquencies) for the entire life of the
trade. This could be a few months or several years- the parameter makes no distinction.

Applicant Credit Bureau Worst Sales Fin Trade

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late
5 =120-149 days late
6 = 150- days late
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7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.12 Other Trades

Applicant Credit Bureau 12month Trades

This is the number of all trades that have been opened in the last 12 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 24month Trades

This is the number of all trades that have been opened in the last 24 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau 6month Trades

This is the number of all trades that have been opened in the last 6 months. Note that these
trades may now be open or closed, paid as agreed, delinquent, or derogatory, and so on.

Applicant Credit Bureau Avg Open Trade Age

This is the average trade age in months as calculated using all open trades in the bureau. This
is based on taking all of the open tradelines, then dividing by the age.

Applicant Credit Bureau Avg Trade Age

This is the average trade age in months as calculated using all trades, open and closed, in the
bureau.

Applicant Credit Bureau Chargeoff Trades

This parameter is a count of the total number of charged off trades for that applicant in the
bureau.

Applicant Credit Bureau Collections

This is the total number of trades in collections for that applicant in the credit bureau. This
refers to accounts assigned to collections agencies.

Applicant Credit Bureau Current Trades

This is the total number of trades that are paid on time right now. These trades may or may not
have been delinquent in the past.

Applicant Credit Bureau Inquiries

This is the number of inquires listed on the credit report. The bureaus have their own limits as
to how long they keep an inquiry on the credit report, but this parameter will show whatever
total is shown for that bureau.

Applicant Credit Bureau Inquiries 12m

This is the total number of inquiries that have been made against the credit bureau for that
applicant in the last 12 months.

Applicant Credit Bureau Inquiries 24m

This is the total number of inquiries that have been made against the credit bureau for that
applicant in the last 24 months.
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Applicant Credit Bureau Inquiries 6m

This is the total number of inquiries that have been made against the credit bureau for that
applicant in the last 6 months.

Applicant Credit Bureau Judgments

This is a count of the number of judgments against the applicant in the credit bureau.
Applicant Credit Bureau Liens

This is the total number of liens shown for the applicant in the credit bureau for that applicant.
Applicant Credit Bureau Newest Inquiry

This is the number of months since the most recent inquiry in the credit bureau for that
applicant. This of course excludes the pull from the immediate past used to do the scoring in
this particular situation in the system.

Applicant Credit Bureau Newest Trade

This is the number of months between now and the newest trade in the bureau for that
applicant.

Applicant Credit Bureau Oldest Inquiry

This is the number of months between now and the oldest inquiry in the bureau for that
applicant.

Applicant Credit Bureau Oldest Trade

This is the number of months between now and the oldest trade in the bureau for that
applicant. Oldest is determined by looking at the oldest date on any tradeline, and then
showing that.

Applicant Credit Bureau Open Collection Trades

This is the number of open trades in collections shown in the bureau for that applicant. This
refers to any accounts assigned to in-house collections departments (as compared to 5.12.7).

Applicant Credit Bureau Open Collections
This is the number of open collections in the bureau for that applicant.
Applicant Credit Bureau Open Judgments

This is the total number of open (unsatisfied) judgments against the applicant as indicated in
the bureau for that applicant.

Applicant Credit Bureau Open Liens

This is the total number of open liens against the applicant as indicated in the bureau for that
applicant.

Applicant Credit Bureau Open Trades

This is the number of all open auto trades on the account. Note that these trades may be paid
as agreed, delinquent, derogatory, and so on. The parameter makes no distinction.

Applicant Credit Bureau Past Due 30

This is the number of trades that have been 30 or more days past due at some point in the
recorded history of the bureau. Note that these trades may be delinquent, derogatory, and so
on. The parameter makes no distinction.
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Applicant Credit Bureau Past Due 30 12m

This is the number of trades that have been more than 30 days past due in the last 12 months.
The past dues could be for the same or different trades. If one trade has been late 3 times, this
parameter would show 1 if there are no other trades.

Applicant Credit Bureau Past Due 30 24m

This is the number of times the applicant has been more than 30 days past due in the last 24
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

Applicant Credit Bureau Past Due 60

This is the number of times the applicant has been more than 60 days past due in the recorded
history of the bureau. The past dues could be for the same or different trades. If one trade has
been late 3 times, this parameter would show 1 if there are no other trades.

Applicant Credit Bureau Past Due 60 12m

This is the number of times the applicant has been more than 60 days past due in the last 12
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

Applicant Credit Bureau Past Due 60 24m

This is the number of times the applicant has been more than 60 days past due in the last 24
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

Applicant Credit Bureau Past Due 90

This is the number of trades that are 90 or more days past due in the recorded history of the
bureau. Note that these trades may be delinquent, derogatory, and so on. The parameter
makes no distinction that one trade has been late 3 times; this parameter would show 1 if there
are no other trades. If one trade has been late 3 times, this parameter would show 1 if there
are no other trades.

Applicant Credit Bureau Past Due 90 12m

This is the number of times the applicant has been more than 90 days past due in the last 12
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

Applicant Credit Bureau Past Due 90 24m

This is the number of times the applicant has been more than 90 days past due in the last 24
months. The past dues could be for the same or different trades. If one trade has been late 3
times, this parameter would show 1 if there are no other trades.

Applicant Credit Bureau Past Due Now

This is the number of trades on which the applicant is currently past due, according to the
bureau.

Applicant Credit Bureau Repossessions

This is the number of repossessions shown on the bureau for the applicant in the history of the
bureau.

Applicant Credit Bureau Satisfactory Trades
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This is the total number of trades of all types, paid as agreed (no delinquencies) for the entire
life of the trade. This could be a few months or several years- the parameter makes no
distinction.

Applicant Credit Bureau Too New Trades

This shows the number of trades that have been reported where a lender is reporting a brand
new account, but has not even billed the applicant yet.

Applicant Credit Bureau Trade Collections

This is the number of trades in collections assigned to collections agencies shown on the
bureau for the applicant in the history of the bureau.

Applicant Credit Bureau Trades

This is the number of trades in the history of the credit bureau for that applicant. Note that
different bureaus store information for varying amounts of time.

Applicant Credit Bureau Worst Trades

The rating code used for this parameter is the same rating code system displayed for the
tradelines. The different bureaus use different systems so Oracle Financial Services Lending
and Leasing changes them to a common format that is used in the scoring:

1 = current

2 = 30-59 days late

3 = 60-89 days late

4 = 90-119 days late

5 =120-149 days late

6 = 150- days late

7 = involved in a bankruptcy
8 = repossession, foreclosure

9 = charge-off

A.2.13 Bankruptcy Information

Applicant Credit Bureau 11 Bankruptcies

This parameter provides a count of the number of Chapter 11 Bankruptcies the applicant has
filed in the stored history of the bureau.

Applicant Credit Bureau 13 Bankruptcies

This parameter provides a count of the number of Chapter 13 Bankruptcies the applicant has
filed in the stored history of the bureau.

Applicant Credit Bureau 7 Bankruptcies

This parameter provides a count of the number of Chapter 7 Bankruptcies the applicant has
filed in the stored history of the bureau.

Applicant Credit Bureau Bankruptcies

This parameter provides a count of the number of bankruptcies of any type the applicant has
filed in the stored history of the bureau.
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Applicant Credit Bureau Bkrp Score

The bureaus offer two basic types of scores, a FICO type, and a bankruptcy type. The term
FICO score is sometimes used as a generic term for a credit score, but it is supposed to mean
that the score is based on an algorithm purchased or licensed from Fair Isaac Corp. In the
system, if a score is listed as a FICO score, it is based on a Fair Isaac model. A bankruptcy
score is a score that is used to predict the likelihood of a consumer to file bankruptcy. It is
provided much like a FICO score.

Applicant Credit Bureau Open 11 Bankruptcies

This parameter provides a count of the number of open Chapter 11 Bankruptcies associated
with the applicant in the bureau.

Applicant Credit Bureau Open 13 Bankruptcies

This parameter provides a count of the number of open Chapter 13 Bankruptcies associated
with the applicant in the bureau.

Applicant Credit Bureau Open 7 Bankruptcies

This parameter provides a count of the number of open Chapter 7 Bankruptcies associated
with the applicant in the bureau.

Applicant Credit Bureau Open Bankruptcies

This parameter provides a count of the number of bankruptcies of any type the applicant X has
open currently.

Applicant Credit Bureau Recent 11 Bankruptcy

For this parameter, Recent refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for
Chapter 11 bankruptcy in the last X months.

Applicant Credit Bureau Recent 13 Bankruptcy

For this parameter, Recent refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for
Chapter 13 bankruptcy in the last X months.

Applicant Credit Bureau Recent 7 Bankruptcy

For this parameter, Recent refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for
Chapter 7 bankruptcy in the last X months.

Applicant Credit Bureau Recent Bankruptcy

For this parameter, Recent refers to the number of months since the subject's most recent
bankruptcy filing. One would use this parameter to determine if the subject has filed for any
kind of bankruptcy in the last X months.

Applicant Has A Prior Bankruptcy

This parameter tracks whether the applicant has indicated a prior bankruptcy based on the
checkbox in the system’s Origination module. The prior bankruptcy is set to Y if the checkbox
is checked otherwise it has a value of N.

A.2.14 Delinquency Information

Applicant Credit Bureau Longest Since Major
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This parameter reflects the longest period (in months) a tradeline has been open since the last
derog.

Applicant Credit Bureau Longest Since Minor

This parameter reflects the longest period (in months) a tradeline has been open since the last
minor delinquency.

Applicant Credit Bureau Open Longest Since Major

This parameter considers the greatest amount of time (in months) between now and the
corresponding major delinquency for all of the open parameters with major delinquencies, and
reflects the greatest value returned.

Applicant Credit Bureau Open Longest Since Minor

This parameter considers the greatest amount of time (in months) between now and the
corresponding minor delinquency for all of the open parameters with minor delinquencies, and
reflects the greatest value returned.

Applicant Credit Bureau Open Shortest Since Major

This parameter considers the least amount of time (in months) between now and the
corresponding major delinquency for all of the open parameters with major delinquencies, and
reflects the least value returned.

Applicant Credit Bureau Open Shortest Since Minor

This parameter considers the least amount of time (in months) between now and the
corresponding minor delinquency for all of the open parameters with minor delinquencies, and
reflects the least value returned.

Applicant Credit Bureau Shortest Since Major

This parameter considers the least amount of time (in months) between now and the
corresponding major delinquency for all of the parameters (open and closed) with major
delinquencies, and reflects the least value returned.

Applicant Credit Bureau Shortest Since Minor

This parameter considers the least amount of time (in months) between now and the
corresponding minor delinquency for all of the parameters (open and closed) with minor
delinquencies, and reflects the least value returned.

A.2.15 Derogatory Trade Information

Applicant Credit Bureau Derog 12m Trades

Provides the number of trades that were derogatory in the last 12 months. This includes open
and closed trades. These trades may or may not be derogatory now.

Applicant Credit Bureau Derog 24m Trades

Provides the number of trades that were derogatory in the last 24 months. This includes open
and closed trades. These trades may or may not be derogatory now.

Applicant Credit Bureau Derog Now Trades
Provides the number of trades that are derogatory right now. Does this include closed trades?

Applicant Credit Bureau Derog Trades
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This parameter addresses the number of derogatory trades associated with the applicant. This
includes open and closed trades.

Applicant Credit Bureau Longest Since Derog
This parameter covers the longest period (in months) since last derog.
Applicant Credit Bureau Open Longest Since Derog

This parameter covers the longest period (in months) a tradeline has been open since the last
derog.

Applicant Credit Bureau Open Shortest Since Derog

This parameter considers the least amount of time (in months) between now and the
corresponding derog for all of the open parameters with derogs, and reflects the least value
returned.

Applicant Credit Bureau Shortest Since Derog

This parameter considers the least amount of time (in months) between now and the
corresponding derog for all of the parameters (open and closed) with derogs, and reflects the
least value returned.
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Appendix : Rounding Amounts and Rate
Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of the
computed amounts has to be carried out using different methods. Oracle Financial Services
Lending and Leasing supports the rounding, raising of or cutting off calculated amount.

* Rounding will increase the resulting amount to next number up to the second decimal,
based on values of third decimal.

* Raising will always increase the resulting amount to next number up to the second
decimal.

e Cutting off will always cut the number after the second decimal.

@® Note

The system rounds only calculated amounts (calculated fees, calculated payment, and
so on) and not user-entered amounts.

You can choose the rounding method you want to use by setting the parameter value for
system parameter CMN_AMOUNT_ROUND_METHOD on the Administration form (Setup
menu > Administration master tab > System drop-down link > System Parameters link >
System tab).

You can choose the rounding factor you want to use by setting the parameter value for system
parameter CMN_AMOUNT_ROUND_FACTOR on the Administration form. Currently, Oracle
Financial Services Lending and Leasing supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Table B-1 Example 1: Amount: 234.136
]

Method Result
Round 234.14
Raise 234.14
Cut off 234.13

Table B-2 Example 2: Amount: 234.134
]

Method Result
Round 234.13
Raise 234.14
Cut off 234.13
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Table B-3 Example 3: Amount: 234.1319999

Method Result
Round 234.13
Raise 234.14
Cut off 234.13

Rate Attributes

The system supports rounding of index rate to keep the rate calculation as simple as possible
for the customers. The general practice is to round the rate to nearest eighth (1/8th) (to keep
index rate in the multiple of 125) or fourth (1/4th) (to keep index rate in the multiple of 25). The
system rounds only index rate and not the margin or final rate. You can define the index
rounding method on the Product tab’s Product Definition screen for variable rate product.

The system currently supports the following rounding of methods.
1. NO ROUNDING TO INDEX RATE

2. INDEX RATE ROUNDED TO NEAREST.25

3. INDEX RATE ROUNDED TO NEAREST.125

NO ROUNDING TO INDEX RATE:

Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST 0.25:

Select this method to round up to 1/4th (to keep the index rate in the multiple of 0.25).

Examples:

Table B-4 Example 1

Type Value
Current rate: 5.125
Round of rate: 5.25

Table B-5 Example 2

Type Value
Current rate: 5.124
Round of rate: 5.00

INDEX RATE ROUNDED TO NEAREST 0.125:
Select this method to round up to 1/8th (to keep the index rate in the multiple of 0.125).

Examples:

Table B-6 Example 1

|
Type Value

Current rate: 5.325
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Table B-6 (Cont.) Example 1

_________________________________________________________________________________|
Type Value

Rate rounded to: 5.375

Table B-7 Example 2
]

Type Value
Current rate: 5.312
Rate rounded to: 5.250
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Appendix : System Parameters

This topic consists of the following sections:

e Introduction

e System Parameters

e QOrganization Parameters

¢ Company Parameters

e Other Parameters

C.1 Introduction

System defined parameters help in configuring system specific data, User-access, location of
system files; reports related URLs and other administration controlled data. These are
essential to be configured during installation and some of them by nature of application will
have to be reviewed and maintained in a regular and periodic manner.

Following are the types of parameters are used in OFSLL system depending on the areas of
the system that these would apply and impact:

 System Parameters

* QOrganization Parameters

e Company Parameters

e Other Parameters

@ Note

All the above parameters can be controlled (enabled/disabled) only by System
Administrators, and users with Admin/Super User privileges who would be involved in
setting-up OFSLL system.

C.2 System Parameters

System parameters apply to the entire system. They relate to the overall processing of the
system like application server file locations, data purging configurations and so on.

Table below details the list of system parameters with their description and pre-defined values.

Table C-1 System Parameters

Parameter Description

ACA_DLQ_AMT_EXCLUDED This parameter is used to exclude delinquency
amount for account ACH
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System Parameters

Parameter

Description

ACA_PAYMENT_AUTO_ LOAD

This parameter is used to control posting directly
from the ACH file that has been created for
customer payments. Input parameter value is
Boolean (Yes/No). If the parameter is setto Y, the
system automatically creates payment batches for
the payments in the ACH file and posts them on the
day of payment.

ACA_PRENOTE_DAYS

This parameter is used to define the number of
days the prenote should be initiated for customer
ACH (Automated Clearing House) accounts. Input
parameter value is numeric.

ACA_PRE_PROCESS_DAYS

This parameter is used to specify the number of
days before draft day for Account ACH process.
Input parameter value is numeric.

ACH_PAYEE_PRENOTE_DAYS

This parameter is used to define the number of
days for prenote to occur for Producer or Vendor
ACH accounts. Input parameter value is numeric.

ADMIN_SERVER_URL

This parameter is used to define the admin server
URL.

ADR_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for ADR file location.

ADR_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for ADR file location.

AGE_APPROVED_CONDITIONED_ DAYS

This parameter is used to specify the number of
days by which an application in Approved or
Conditioned status is treated as Aged Application.
Input parameter value is numeric with no upper
limit.

AGE_CONTRACT_DAYS

This parameter is used to specify the number of
days by which a contract is treated as Aged
Contract. Input parameter value is numeric with no
upper limit.

ASC_COL_SER_ENABLED_ IND

This parameter is used as the Collection Servicing
Enabled Indicator.

CAC_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for CAC file location.

CAC_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
Directory Object Name for CAC file location.

CHECK_PRINT_PREVIEW

Using this parameter we can allow preview of
application in pdf form before printing. Input
parameter value is Boolean (Yes/No).

CMN_AMOUNT_ROUND_ FACTOR

This parameter is used to define the rounding
factor for applicable fields (in this case calculated
amounts). Input parameter value is ROUND
AMOUNT TO 2 DECIMALS. Currently system
supports rounding factor 2 only.
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Table C-1 (Cont.) System Parameters

_________________________________________________________________________________|
Parameter Description

CMN_AMOUNT_ROUND_METHOD This parameter is used to define the amount round
method during system set-up and would be
applicable for all calculated amounts (calculated
fees, payment etc.) across the application. Input
values are ROUND, RAISE and CUTOFF:

ROUND: Rounded to nearest humber higher or
lower

RAISE: Rounded to the nearest higher number

CUTOFF: Truncate the digits without rounding or
raising

CMN_APP_ACC TITLE_FN_LN This parameter is used to set the Application or
Account title in one of the formats — First/Last
Name or Last/First Name. Input parameter value is
Boolean (Yes/No). If Yes is chosen, title would be in
the format — First/Last Name, else the other option.

CMN_APP_SERVER_HOME This parameter is used to set the Application
Server Home Directory. Input parameter value is
user defined.

CMN_CURRENT_MODEL_YEAR This parameter is used to default the Current Model
Year.

CMN_DEBUG_LEVEL This is the Common Debug Level

CMN_DEBUG_METHOD This parameter allows to define the location to

which generic debug logs (other than Alert/Warning
and GRI) are to be written. If set to
ADVANCE_QUEUE, system writes the logs in
Logs table and if set to UTL_FILE, system
generates the alert log file.

CMN_FILE_PROCESS_TO_LOB This parameter allows to define the location from
where the incoming or outgoing files/documents
are to be processed. If set to Y, system processes
the data to/from LOB and if set to N, system
processes the data to/from FILE.

The same is used by the batch jobs available in
SET-IFP (input file processing) Batch Job Set.

CMN_GL_POST_DT This parameter is used to specify the General
Ledger Posting date. If scheduler is enabled, it
automatically updates this to current system date.
Else Admin User would need to set this date
manually to ensure correct posting dates in GL.

CMN_HTTP_PROXY_ PORT This parameter is enabled to specify the port to be
used for outgoing HTTP connections. Input
parameter value is user defined.

CMN_HTTP_PROXY_SERVER This parameter is enabled to specify the proxy
server to be used for outgoing HTTP connections.
Input parameter value is user defined. There exists
an interdependency of this parameter with
CMN_HTTP_PROXY_PORT mentioned above.
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Parameter

Description

CMN_INT_360_ACCRUAL_DAYS_MTHD

This parameter is used to specify the interest
accrual method for 360 days, to be used by the
System for all calculations with interest. Currently
two methods are supported. Input parameter value
is US or EU representing American and European
method of interest accrual for 360 days.

CMN_TEST_TOOL_LOGGING

This parameter is used to set testing tool logging
parameter

CMN_SCHEMA _ID

This is used to specify the schema identifier for all
users.

CMN_SCHEMA_NAME

This is used to specify the Oracle User Name for a
specific schema. Input parameter value is user
defined.

CMN_SCHEMA_PASSWORD

This captures the password for Oracle, for the
specific schema. Input parameter value is user
defined. This parameter need not be enabled when
in Oracle Network.

CMN_SERVER_HOME

This parameter captures the Server Home
Directory. Input parameter value is user defined.

CMN_SERVER_TEMP_DIR

This parameter is used to specify the temporary
directory on the server along with the path. Input
parameter value is user defined.

CMN_SER_ENVIRONMENT_ FILE

This parameter captures the environment file (and
its path) for running the Operating System
commands from Job Service. Input parameter
value is user defined.

CMN_WALLET_PASSWORD

This parameter is used to specify the common
wallet password. Input parameter value is user
defined.

CMN_WALLET_PATH

This parameter is used to specify the common
wallet path for oracle database. Input parameter
value is user defined.

CPP_NO_OF_PROMISES

This parameter is used to define the maximum
number of promises/chances allowed for a
customer who is delinquent and promises to pay.
Input parameter value is numeric with no upper
limit.

CPP_PROMISE_HELD_DAYS

This parameter is used to define the maximum
number of days after the promises made by the
customer to pay are broken to initiate further
actions. Input parameter value is numeric with no
upper limit.

CRD_CHS_BIN

This parameter holds the value of the credit card
BIN (Bank Identification Number for Credit Cards),
for CHASE interface. Input parameter value is user
defined. (P.S: OFSLL supports CHASE interface for
credit card payments processing)

CRD_CHS_CUR_CODE

This parameter is used to specify the currency
code of the transacting currency for CHASE
interface. Input parameter value is user defined.
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Parameter

Description

CRD_CHS_DIR_PATH

This parameter is used to specify the directory path
for CHASE payment interface for Credit Cards.
Input parameter value is user defined.

CRD_CHS_IND_TYPE

This is used to specify the industry type for CHASE
payment interface for Credit Cards. Input parameter
value is user defined.

CRD_CHS_MERCHANT_ ID

This captures the merchant ID number for CHASE
payment interface for Credit Cards. Input parameter
value is user defined.

CRD_CHS_REMOTE_HOST_NAME

This captures the remote host name for seeking
approvals for CHASE payment interface. Input
parameter value is user defined.

CRD_CHS_SEC_REMOTE_HOST_NAME

Similar to the previous parameter this captures the
secondary remote host name of CHASE interface
for seeking approvals for credit card payments.
Input parameter value is user defined.

CRD_CHS_TIMEOUT

This parameter is used to define the timeout limit
when polling the interface for processing credit card
payments. Input parameter value is numeric.

CRD_CHS_USR_ID

This parameter captures the user id for CHASE
interface which is required whenever the System
needs to access/ seek authorizations/process
payments for credit cards etc. Input parameter
value is user defined.

CRD_PTB_REMOTE_HOST_NAME

This is the Protobase Remote Host Name

CRD_PTB_REMOTE_HOST_PORT

This is the Protobase Remote Host Port

CRD_PTB_TIMEOUT

This is the Protobase Timeout Value

CRD_SOURCE_TYPE_CD

This is the Source Type Code

DDT_CREATE_DUE_ DATE_HISTORY

This parameter must be enabled to create a due
date history for any account. Due date history sub
tab under Transaction history displays the
delinquency history of an account in a tabular
format detailing Due date, Due Amount, Last
Payment date, Payment Amount, Balance Amount,
Days past due and Payment received flag. The
input parameter value for this parameter is Boolean
(Yes/ No).

DECISION_ BUY_RATE_TOLERANCE

This parameter is used to define the variance in
buy rate

EDF_DIALER_ACCT_TYPE

This parameter is used to set up the account
number reference for the dialer file to pick-up
records for Auto dialer interface. Input parameter
value is account number.

FLL_BPEL_PROCESS

This parameter is set to use BPEL process in
OFSLL. Input parameter value is Boolean (Yes/No).

ICA_INPUT_FILE_FORMAT

This parameter is used to define the input call
activity file format

IFD_DIRECTORY

This parameter is used to define the Oracle
directory object name for IFD file location

IFD_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for IFD file location
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Parameter

Description

INCOMING_ LOB_PURGE_DAYS

This parameter is used to define the incoming
process file table purge days

INPUT_DIRECTORY

This parameter is used to define the Oracle
directory object name for INPUT file location

ITU_DIRECTORY

This parameter is used to define the Oracle
directory object name for ITU file location

ITU_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for ITU file location

IVR_DIRECTORY

This parameter is used to define the Oracle
directory object name for IVR file location

IVR_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for IVR file location

JSC_TIMEOUT

This parameter is used to set the polling interval for
job scheduler. Input parameter value is numeric. To
check whether it represents minutes/seconds.

JSV_ARCHIVE_SERVER_CONFIG

This parameter is used to set the configuration file
for reports archive server. Input parameter value is
user defined.

JSV_ARCHIVE_SERVER_URL

This parameter is used to specify the archive
server url. Input parameter value is user defined.

JSV_BI_PASSWORD

This parameter is used to define the Bl Publisher
Password

JSV_BI_USER

This parameter is used to define the Bl Publisher
User ID

JSV_TEMPORARY_DIRECTORY

This parameter is used to define Oracle directory
object name for Job Service Temp file location

JSV_BI_PASSWORDJSV_REPORTS_RUNTIME

This parameter is to specify the reports runtime
program. Input parameter value is user defined.

JSV_REPORTS_RUNTIME_CMDFILE

This parameter is used to specify the reports
runtime command file. Input parameter value is
user defined.

JSV_REPORTS_SERVER_CONFIG

This parameter is used to specify the configuration
file for reports server. Input parameter value is user
defined.

JSV_REPORTS_SERVER_URL

This is used to specify the URL for the reports
server. Input parameter value is user defined.

JSV_REPORT_ARCHIVE_DIRECTORY

This is used to specify the path and directory of
Reports archive, input parameter value being
numeric.

JSV_SMTP_SERVER

This parameter specifies the SMTP server used by
job service for sending email messages. Input
parameter value is user defined.

JSV_TIMEOUT

This is to specify the polling interval for the job
service during time out. Input parameter value is
numeric. To check whether it represents minutes/
seconds.

JSV_USE_BI_PUBLISHER

This parameter defines whether Bl publisher
should be used to process reports are not. Input
parameter value is Boolean (Yes/No).
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Parameter

Description

JSV_USE_REPORTS_SERVER

This parameter is used to specify whether reports
server from job service should be used or not.
Input parameter value is Boolean (Yes/No).

LBX_TXN_GROUPING_CNT

This parameter is used to specify the no. of records
per batch for payment transactions and lock box
batch records. Input parameter value is numeric.

LCO_COL_LETTER1_GEN_DAYS

This parameter specifies the number of days post
which first collection letter should be generated for
accounts with dues unpaid. Input parameter value
is numeric.

LCO_COL_LETTER2_GEN_DAYS

This parameter specifies the number of days post
which second collection letter should be generated
for accounts with dues unpaid. Input parameter
value is numeric.

LCO_COL_LETTER3_GEN_DAYS

This parameter specifies the number of days post
which third collection letter should be generated for
accounts with dues unpaid. Input parameter value
is numeric.

LIEN_RELEASE_DAYS

This parameter is used to define the Lien Release
Days

LOCKBOX_DIRECTORY

This parameter is used to define the Oracle
directory object name for Lockbox file location

LOCKBOX_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for processed Lockbox file
location

LOR_ADVERSE_ACTION_GEN_DAYS

This parameter is used to specify the number of
days after the third collection letter post which the
adverse action letter is to be generated. Input
parameter value is numeric.

LOG_LOB_PURGE_DAYS

This parameter is used to log files header table
purge days

MAX_AGED_TXN_AUTHORIZE_ DAYS

This parameter is used to specify the maximum
number of days within which a transaction should
be authorized. Input parameter value is numeric
and represents the number of days.

MAX_VOID_TXN_AUTHORIZE_DAYS

This parameter is used to set the maximum days to
authorize transaction

OCP_CUSTOMER_PMT_SITE_ID

This parameter is used to set the customer
payment extract file site id

OCP_INCLUDE_ACH_ACC

This parameter is used to set the customer
payment extract including ach accounts

OUTGOING_LOB_PURGE_DAYS

This parameter is used to define the outgoing
process file table purge days

OUTPUT_DIRECTORY

This parameter is used to define Oracle directory
object name for OUTPUT file location

PAC_ARCHIVE_DAYS

This parameter is used to define number of days
for periodic archiving of account. Input parameter
value is numeric.

PAC_OARCHIVE_DAYS

This parameter is used to define the number of
days for archiving accounts from O tables i.e. old
tables. Input parameter value is numeric
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Description

PAP_ARCHIVE_DAYS

This parameter is used to define the number of
days for archiving applications on a periodic basis.
Input parameter value is numeric.

PAP_OARCHIVE_DAYS

This parameter is used to define the number of
days for archiving applications from O tables. Input
parameter value is numeric.

PCU_CHECK_REFUND_DAYS

This parameter is used to specify the maximum
number of days within which an overpayment from
the customer can be refunded. Input parameter
value is numeric.

PDC_PRE_PROCESS_DAYS

This parameter value will define the number of
days prior to the due day, regular account PDC
process should be initiated. Input parameter value
is numeric.

PENDING_PDC_DAYS

This parameter value will define the number of
days before the initiation day for pending PDC
accounts.

PGL_ARCHIVE_DAYS

This parameter defines the number of days, post
which the transactions in GL would be archived.
Input parameter value is numeric.

PGL_OARCHIVE_DAYS

This parameter is used to define the number of
days, post which the transactions in GL will be
moved to the O tables. Input parameter value is
numeric.

PJR_PURGE_DAYS

This parameter is used to specify the days post
which the job requests are to be purged. Input
parameter value is humeric.

POD_PURGE_DAYS

This parameter is used to define the number of
days after which the Output data file headers are to
be purged. Input parameter value is numeric.

PPA_ARCHIVE_DAYS

This parameter is used to specify number of days
after which pools and its transactions archiving is to
be done to O tables. Input parameter value is
numeric.

PPA_OARCHIVE_DAYS

This parameter is used to specify number of days
after which pools and its transactions archiving is to
be done to OO tables. Input parameter value is
numeric

PPR_ARCHIVE_DAYS

This is used to specify the days for archival of
producers details on a regular basis. Input
parameter value is numeric.

PPR_OARCHIVE_DAYS

This is used to specify the days after which the
producers details from O tables need to be
archived. Input parameter value is numeric.

PPX_ARCHIVE_DAYS

This is used to specify the days after which
producer transactions are to be archived. Input
parameter value is numeric.

PPX_OARCHIVE_DAYS

This is used to specify the days after which the
producer transactions are to be moved from O
tables. Input parameter value is numeric.

PJR_COPY_PURGED_DATA

This parameter is used to copy data into purge
tables.
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PST_ARCHIVE_DAYS

This parameter specifies the number of days for
which the statements are to be archived. Input
parameter value is humeric.

PST_OARCHIVE_DAYS

This parameter specifies the number of days for
which the statements are to be archived in the O
tables. Input parameter value is numeric.

PTT_PURGE_DAYS

This is used to specify the number of days after
which the PTT table is to be purged. Input
parameter value is numeric.

PTX_ARCHIVE_DAYS

This parameter is used to specify the number of
days the transactions are to be archived. Input
parameter value is humeric.

PTX_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the archived transactions from O
tables are to be moved. Input parameter value is
numeric.

PUL_PURGE_DAYS

This parameter is used to specify the number of
days post which the User login details are to be
purged. Input parameter value is numeric.

PVA_ARCHIVE_DAYS

This parameter stores the number of days for
archival of regular vendor assignments. Input
parameter value is numeric.

PUP_ARCHIVE_DAYS

This parameter stores the number of days for
archival of transaction upload. Input parameter
value is numeric.

PUP_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the archived transactions from O
tables are to be moved. Input parameter value is
numeric.

PVA_OARCHIVE_DAYS

This parameter value specifies the number of days
for archival of vendor assignments from O tables to
OO tables. Input parameter value is numeric.

PVI_ARCHIVE_DAYS

This parameter is used to specify the number of
days for which the regular vendor invoices are to be
archived. Input parameter value is numeric.

PVI_OARCHIVE_DAYS

This parameter is used to specify the number of
days post which the regular vendor invoices are to
be moved from O tables to OO tables. Input
parameter value is numeric.

RAC_LOAD_FREQUENCY

This parameter is used to specify Accounts RDH
Load Frequency

RAP_LOAD_FREQUENCY

This parameter is used to specify Applications RDH
Load Frequency

RAT_LOAD_FREQUENCY

This parameter is used to specify Asset Tracking
RDH Load Frequency

RBK_LOAD_FREQUENCY

This parameter is used to specify Bankruptcy
Details RDH Load Frequency

RCA_LOAD_FREQUENCY

This parameter is used to specify Call Activities
RDH Load Frequency

RCH_LOAD_FREQUENCY

This parameter is used to specify Deficiency
Details RDH Load Frequency
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RCO_LOAD_FREQUENCY

This parameter is used to specify Contracts RDH
Load Frequency

RFO_LOAD_FREQUENCY

This parameter is used to specify Repo-
Foreclosure RDH Load Frequency

RPR_LOAD_FREQUENCY

This parameter is used to specify Producers Rdh
Load Frequency

RST_LOAD_FREQUENCY

This parameter is used to specify Setup Data RDH
Load Frequency

RTX_LOAD_FREQUENCY

This parameter is used to specify Txns RDH Load
Frequency

SALESAGENT_MAIL_SEND_IND

This parameter is used to specify whether decision
fax needs to be sent to sales agent (yes/no)

SCORING_PARAMETER_ ALERT

This parameter is used to set the scoring
parameter alert

SQL_DIRECTORY

This parameter is used to set the Oracle directory
object name for SQL file location

TES_ANA_PRE_PROCESS_CYCLES

This parameter is used to specify the pre-process
cycles required for Escrow analysis. Input
parameter value is numeric.

TES_DSB_ANALYSIS_PERCENT

This parameter is used to specify the percentage
for escrow disbursements. Input parameter value is
numeric.

TES_DSB_PRE_PROCESS_DAYS

This is used to specify the number of days for pre-
process for escrow disbursements. Input parameter
value is numeric.

TPE_AMORTIZE_ACCRUED_INT_ONLY

This parameter is used to specify that system has
to amortize accrued interest at month end

TPE_APPLY_LTC_FROM_CURR_DUE_DT

This parameter is used for pyramid law fee method
to apply late charge from current due date

TPE_ESC_ANALYSIS_ DELQ_AMT

Parameter considers billed but uncollected amount
for escrow analysis

TPE_EXCESS_PAYMENT_TO_MEMO

Excess payment on the account will be moved to
memo payment.

TPE_EXCLUDE_ESC_LTC

This parameter defines whether escrow should be
included or excluded while calculating late charge.
Input parameter value is Boolean (Yes/No).

TPE_EXT_CYCLES_BACKDATED

This parameter is used to define the maximum
extension cycles allowed for back dating. Input
parameter value is numeric with no upper limit

TPE_FUTURE_PAYOFF_DAYS

The value specified in this parameter validates the
Valid Up to Date with Payoff quote during
monetary transactions posting.

TPE_GL_REFUND_ HOLD_DAYS

This parameter is used to define the number of
days the non-refunded amount can be held in GL.
Input parameter value is numeric.

TPE_MAX_CYCLES_BACKDATED

This parameter is used to define the maximum
cycles that are allowed for back dating in OFSLL.
Input parameter value is numeric.
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TPE_MIN_1098_INT_AMT_PAID

This parameter is used to specify the lower limit or
minimum interest amount paid for 1098 i.e.
Mortgage Interest Statement. In the US, Fls need
to report mortgage interest of $600 or more
received from individuals, during the course of their
business. Input parameter value is 600, the
minimum value above which reporting by Fl is
required in form 1098 for each mortgage account.

TPE_OLDEST DUE_DT_NEW_MTHD

This parameter is enabled to specify whether new
method for calculation of oldest due date based on
given data should be used or not. Input parameter
value is Boolean (Yes/No).

TPE_PAID_TO_CLOSE_DAYS

This parameter is used to specify the number of
days allowed post which a paid account would be
closed. Input parameter value is numeric.

TPE_PAYMENT_TO_MULTI_ACCOUNTS

This parameter is enabled to allow one payment for
dues in multiple accounts. Input parameter value is
Boolean (Yes/ No).

TPE_PAYOFF_VALID_THRU_DAYS

This parameter is used to specify the number days
the pay-off quote is valid by default. i.e. if the
parameter is set as 7, the payoff quote is valid for 7
days and customer can pay the quoted amount as
final closure amount within those days. Input
parameter value is numeric.

TPE_PMT_POST_EOD

This parameter is used to allow payments when the
batch process for End of Day is running. Input
parameter value is Boolean (Yes/No). If this is set
to Y, payments can be allowed during EOD.

TPE_SCHGOFF_DLQ_DAYS

This parameter is used to define the number of
delinquent days to treat an account for SCHGOFF
(charge — off). Input parameter value is numeric.
(To verify)

TPE_SCHGOFF_REVIEW_DAYS

This parameter is used to define the number of
days allowed for review of SCHGOFF accounts.
Input parameter value is humeric.

TPE_SCRA_DEFAULT INTEREST_RATE

This parameter is used to define the default interest
rate that is to be applied for customers who are in
military duty. OFSLL will apply the lower of the
prevailing interest rate or SCRA default interest rate
specified through this parameter. Input parameter
value is numeric (in this case 6, which is interest
rate to be applied for SCRA accounts.

TPE_SHOW_BACKDATE_WARNING

This parameter is used to define whether a warning
message is to be shown if monetary transaction is
backdated.

TPE_STM_INC_ALL_TXNS

This parameter is enabled to define whether all
transactions should be included in the statements
or otherwise. Input parameter value is Boolean
(Yes/No).

TPE_STOP_COMP_DELQ _DAYS

This parameter is used to stop computation when
delq days > 60

TPE_TXN_POST_DEFAULT_GLDATE

This parameter is used to default GL date in date
type parameters during txn posting (y/n)
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TPE_VOID_TO_CLOSE_DAYS

This parameter is used to define the number of
days allowed for closing Void accounts. Input
parameter value is humeric.

UIX_DEFAULT IMAGE_PATH

This parameter is used to define the default image
directory maintained for the purpose of online
attachment of document images to an application
using documents maintenance section under
Account documentation. Input parameter value is
user defined.

UIX_INCOMING_FILE_PATH

This parameter is used to specify incoming file path
of app server

UIX_LOCAL_COUNTRY_CD

Through this parameter we can set the local
country where an FI has multiple branches across
different geographies. Input parameter value is user
defined.

UIX_LOCK_UNLOCK_AND_COPY

This parameter is used to enable the user interface
lock / unlock and copy features. Input parameter
value is Boolean (Yes/No).

UIX_MAX_ACC_SEARCH_ROWS

This parameter is used to specify the maximum
number of account rows to be returned for search
functionality. Input parameter value is numeric.

UIX_MAX_APP_SEARCH_ROWS

This parameter is used to specify the maximum
number of application rows to be returned for
search functionality. Input parameter value is
numeric.

UIX_OUTGOING_FILE_PATH

This parameter is used to specify outgoing file path
of app server

UIX_REPORTS_SERVER_CONFIG

This parameter can be used to specify the user
interface reports server configuration file. This is
not required for OFSLL.

UIX_REPORTS_SERVER_URL

This parameter sets the URL for Reports server.
Input parameter value is user defined.

UIX_UTILITIES_SERVLET_URL

This parameter can be used to specify the User
Interface utilities servlets URL. This is not required
for OFSLL.

UPR_PRO_NBR_SYS_GENERATED

This parameter can be used to specify whether
producer number should be system generated or
seek input from user. Input parameter value is
Boolean (Yes/No). Generally this is set to yes for
system generation.

VEV_NADA_TOKEN_URL

This parameter is used to set the token URL for
vehicle evaluation interface NADA. Input parameter
value is user defined.

VEV_NADA_UPDATE_DAY

This parameter is used to specify the day of the
month to update the vehicle evaluations every
month. Input parameter value is numeric.

VEV_NADA_URL

This parameter is used to set the URL for vehicle
evaluation interface NADA. Input parameter value
is user defined.

VEV_NADA_USER_ID

This parameter is used to specify the User id for
login to the NADA interface. Input parameter value
is user defined.
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VEV_NADA_USER_PASSWORD This parameter is used to specify the password for
login to the NADA interface. Input parameter value
is user defined.

VEV_VALUATION_REGION This parameter is used to define the default region
for vehicle evaluation. Input parameter value is the
region name, and is user defined.

VEV_VALUATION_SOURCE_CD This parameter is used to specify the default
vehicle evaluation source code. Input parameter
value is user defined. A number of parameters are
possible in OFSLL as below:

1. Appraisal Company

2. Broker

3. BUC GUIDE

4. DATA QUICK

5. NAMS/SAMS SURVEY — USED
6. REALTOR

7. NADA INTERFACE USED CARS

8. BLACKBOOK INTERFACE USED CARS
9. KELLY INTERFACE

10. NADA — NEW

11. NADA - USED

12. KELLY NEW BLUE BOOK

13. KELLY USED BLUE BOOK

14. INVOICE

15. BLACK BOOK

16. NADA INTERFACE COMMERCIAL TRUCKS
17. COMPANY INVOICE

18. GOLD BOOK

19. GALVS

20. OTHER

21. ALG

WFP_DIRECTORY This parameter is used to specify the Oracle
directory object name for WFP file location.

WFP_MAX_CYCLES_BACKDT This parameter is used to specify the back dated
cycles date for WFP.

WFP_PROCESSED_DIRECTORY This parameter is used to define oracle directory
object name for wfp file location.

WFP_REVERSE_TXN_IND This parameter is enabled to define the WFP

reversal indicator. Input parameter value is Boolean
(Yes/No).
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XAE_DEALUPD_MAX_ALLOWED_DAYS

This parameter is used to define the max allowed
days for Deal Update.

XAE_DEALUPD_ALLOWED_IND

This parameter is used to indicate whether deal
update is allowed or not.

OUTBOUND_CALL_Q

This parameter is used to generate reports
(including emailing statements/letters) using
Application Server instead of Database server.

ACA_PRE_PROCESS_DAYS_FIRST

This parameter is used to configure the number of
days before the debit day for ACH process in first
time/ one-time case.

IPR_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for processed IPR file
location

IPR_DIRECTORY

This parameter is used to define the Oracle
directory object name for IPR file location

UIX_PWD_MGMT_EXTERNAL_URL

This parameter is used to set external password
management url, if applicable.

UIX_PWD_MGMT_EXTERNAL

This parameter is used to define the parameter if
password management is external. (SET Y IF
PASSWORD MANAGEMENT IS EXTERNAL (Y/

N)).

ICU_PROCESSED_DIRECTORY

This parameter is used to define the Oracle
directory object name for processed ICU file
location

ICU_DIRECTORY

This parameter is used to define the Oracle
directory object name for ICU file location

UIX_BILL_CYCLE_ALLOWED_IND

This parameter is used to indicate whether Billing
cycle is allowed at the application level

CMN_EOD_SLEEP_MINS

This parameter is used to set in minutes the EOD
sleep time

CMN_CORE_BANK_TXN_CD

This parameter is used to set code for OFSLL and
Core Banking integration

ICC_DLQ_AMT_EXCLUDED

This parameter enabling will exclude delinquency
amount for CASA account

CMN_CORE_BANK_IND

This parameter is used to set whether OFSLL can
integrate with Core Banking.

BKRP_FILE_REC_LIMIT

This parameter is used to set the limit of total
number of records allowed to be added in the Input
Data File shared from external interface.

Note: If the number of records exceeds the set
limit, multiple Input Data Files are to be created.

UVN_VEN_NBR_SYS_GENERATED

This parameter is used to validate if Vendor
Number has to be auto generated (if set to Y) or to
be specified manually in the Vendor details screen.
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METRO_WITHOUT_COLL_IND

This parameter indicates whether Metro Il reporting
is handled without OFSLL Collections module
being used. If the parameter value is setas Y i.e.
collection module is not used, system updates the
collateral status directly as part of REPO call
activity.

However when Collections module is being used,
the Collateral status is tracked with the
repossession details updated in Repo/Foreclosure
screen of Collections module.

METROIl_FIRST_DELQ_DT_ADD_DAY

This parameter is used to calculate the first
delinquency date that needs to be reported in the
Metro Il reporting file.

By default the parameter is disabled indicating that
the initial delinquency date calculated by the
system is used for Metro Il reporting. The same
needs to be enabled to add the parametrized
number of days to the system calculated first
delinquency date for the Metro Il reporting purpose.

DAYS_TO_PULL_CRB_ REPORT

This parameter is used to configure the number of
days permitted to pull a Bureau report from the
same company and for the same customer.

XWS_ACS_RESP_MULTI_RECORD_IND

This parameter is used to indicate if multiple
records exist in the response file received for
account search.

Accordingly, when there are multiple records found
and this parameter is enabled and set to No
(default), system displays an error message Too
Many Records Found. Please Refine Search by
Adding One More Parameter.

However, when this parameter is set to Yes,
system only indicates that there are multiple
records/rows in response file.

GRI_DLQ_DAYS_AUTO_STATUS_CHG

This parameter is used to define the delinquency
days which inturn is used to automatically update
the status of a work order to PENDING ON HOLD
status.

TPE_PMT_POSTING_CLS_ACCOUNT

This parameter is used to define the payment
posting criteria for Closed - Paid Off/ Charged-off
accounts.

Accordingly, OFSLL accepts payment posting on
closed accounts only when the parameter is set to
Y and all the payments received through Payment
Entry screen or Payment Upload file are posted to
a Suspense account.
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TPE_BACKDT_PMT_ POSTING

This parameter is used to define the payment

posting criteria for backdated payments for the

following type of account conditions:

e Paid off

e Charged-off

* Account under activation

*  Account under conversion

*  Non-performing Account

*  PC2 Sl (Pre-computed to Simple Interest)
Reschedule

Accordingly, OFSLL accepts backdated payment
posting only when the parameter is setto Y and all
the payments received through Payment Entry
screen or Payment Upload file are posted to a
Suspense account.

EXP_PA_SOFT_PULL_IND

This parameter when enabled allows Soft Pull
Credit Bureau request, specifically for Experian
Premier Attribute Consumer Report without
impacting the consumer FICO score.

PMT_BATCH_POSTING

This parameter (PAYMENT BATCH POSTING
PREFERENCE) is used to define the status of
payment transactions which are uploaded in bulk
through a batch process.

POOL_ACTIVE_ACCOUNTS_ONLY

This parameter controls the type of accounts that
can be added to a Securitization Pool and allows
adding only Active status accounts since the same
is enabled (value set to Y) by default. To add
accounts with other status such as Active, Paid Off,
Charged Off, Void, Terminate. and so on, set the
value of system parameter to N.

AUTO_GEN_ACC_NBR_CONV

This parameter is used for conversion accounts to
decide option of account number generation. If the
value of parameter is set to Y the account number
is automatically generated in OFSLL during
conversion and if the value is N, then external
reference number (generated in third party system)
itself is appended as the account number.

OUTBOUND_DLR_ TRACK_Q

This parameter defines the settings for batch job
SET_XPR to either use MDB (Message Driven
Bean) flow (if value set to Y) or existing work flow
(if value set to N) to dump producer details
maintained in the system into Dealer Track.

MDB flow generates outbound JMS message
though the configured MDB interface and can avoid
current database outbound calls and session
timeout.

In the existing workflow, the database makes
synchronous outbound calls to producer data dump
web service, to dump the data and acknowledge
the database with the status (success or failure).
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OUTBOUND_ROUTEONE_Q

This parameter defines the settings for batch job
SET_XPR to either use MDB (Message Driven
Bean) flow (if value set to Y) or existing work flow
(if value set to N) to dump producer details
maintained in the system into ROUTEONE.

MDB flow generates outbound JMS message
though the configured MDB interface and can avoid
current database outbound calls and session
timeout.

In the existing workflow, the database makes
synchronous outbound calls to producer data dump
web service, to dump the data and acknowledge
the database with the status (success or failure).

GRI_WEBSERVICE_LOG_IND

This parameter is used to decide on logging GRI
(Generic Recovery Interface) communications. If
enabled, system logs all the GRI related web
service communications between OFSLL and
external interfaced system.

The recorded logs can be viewed in Dashboard >
System Monitor > Database Server Log Files tab
by selecting Interfaces view option.

PVE_ARCHIVE_DAYS

This parameter stores the number of days for
archival of regular vendors. Input parameter value
is numeric.

PVE_OARCHIVE_DAYS

This parameter is used to specify the number of
days post which the regular vendors are to be
moved from O tables to OO tables. Input parameter
value is numeric.

LBX_DR_CR_VALIDATE_AMT_IND

This parameter (VALIDATE LOCKBOX DR/CR
BATCH TOTALS) is used to facilitate NACHA file
validation. Based on the status of the parameter,
system is either allowed to validate the file or
process without validation.

PAP_PURGE_DAYS

This parameter allows to define the number of days
after which the application data from archival
folders are to be deleted permanently. Purging
happens based on elapsed number of days i.e. if
value is set to 60 days, only those records which
are older by 60 days in archival folder are deleted.

PAC_PURGE_DAYS

This parameter allows to define the number of days
after which the accounts data from archival folders
are to be deleted permanently. Purging happens
based on elapsed number of days i.e. if value is set
to 60 days, only those records which are older by
60 days in archival folder are deleted.

CMN_SED_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing seed data is to be
processed. If setto Y, system processes the data
to/from LOB and if set to N, system processes the
data to/from FILE.
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CMN_EDF_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing data from Dialer
Interface is to be processed. If setto Y, system
processes the data to/from LOB and if set to N,
system processes the data to/from FILE.

The same is used by the batch jobs
EDFADR_BJ_100_01 and EDFIVR_BJ_100_01
which are available in SET-EDF Batch Job Set.

CMN_FAX_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing Fax data is to be
processed. If setto Y, system processes the data
to/from LOB and if set to N, system processes the
data to/from FILE.

CMN_RED_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the outgoing details of Data Masking Policy
(i.e. Redaction policy output file) is to be
processed. If setto Y, system processes the data
from LOB and if set to N, system processes the
data from FILE.

CMN_WFP_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing WFP Unit details
are to be processed. If set to Y, system processes
the data to/from LOB and if set to N, system
processes the data to/from FILE.

The same is used by the batch job
WUPPRC_BJ_132_01 available in SET-WFP Batch
Job Set.

CMN_AUD_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the outgoing Audit scripts are to be
processed. If setto Y, system processes the data
from LOB and if set to N, system processes the
data from FILE.

CMN_LBT_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the incoming or outgoing Lockbox files are to
be processed. If set to Y, system processes the
data to/from LOB and if set to N, system processes
the data to/from FILE.

The same is used by the batch jobs
LBXPRC_BJ 100 01 and LBXSEP_BJ 100 01
available in SET-LBT Batch Job Set.

CMN_ODD_FILE_PROCESS_TO_LOB

This parameter allows to define the location from
where the outgoing ODD or Output Data Dump
files are to be processed. If setto Y, system
processes the data from LOB and if set to N,
system processes the data from FILE.

The same is used by the batch job
ODDPRC_BJ_000_01 available in SET-ODD3
Batch Job Set.
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CMN_ALERT_DEBUG_ METHOD This parameter allows to define the location to
which Alert and Warning logs are to be written. If
set to ADVANCE_QUEUE, system writes the logs
in Logs table and if set to UTL_FILE, system
generates the alert log file.

CMN_GRI_WS_DEBUG_ METHOD This parameter allows to define the location to
which GRI (Generic Recovery Interface) web
service logs are to be written. If set to
ADVANCE_QUEUE, system writes the logs in
Logs table and if set to UTL_FILE, system
generates the log file.

UIX_CUSTOMER_BASED_PMT_IND If this parameter is set to Y and is Enabled, system
accepts posting direct payment to an account and
also accepts customer based payments to all linked
accounts.

To facilitate customer based payments, Customer/
Business # and Payment Hierarchy fields along
with Populate Accounts button are enabled in
Payment Entry screen to specify required values.

PMT_HIERARCHY_CODE In this parameter, you can specify a payment
hierarchy which is populated by default in Customer
Details and Business Details (if applicable) screen
after account activation.

However, the specified value is selected by default
only if there is a matching hierarchy definition
enabled record maintained in Setup >
Administration > User > Payment Hierarchy screen.
Else, Equal Amount value is selected which in-
turn adjusts the payment equally to all customer/
business linked accounts.

Note: System does not consider this parameter
value while creating account using existing
customer/business details since the default
selection is done during the creation of existing
customer / business account.

EVI_MAX_RETRY_COUNT This parameter records and controls the maximum
attempts to re-trigger FAILED Webhook requests
which cannot exceed more than 5 times. However,
this parameter can be modified if the maximum re-
trigger attempts is to be less than 5 times.

UIX_CUSTOM_LABEL_ENABLED_IND This parameter indicates if the field label
customizations are allowed i.e. ability to change
label and provide access to fields in Label
Configuration and Security User Access Definition
Details screens.

If setto Y, system refers data from database
If set to N, system refers data from XLIB file.
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UIX_MASTER_ACC_BASED_PMT_IND

If this parameter is set to Y and is Enabled, system
accepts posting direct payment to a master
account and also accepts master account based
payments to all linked accounts.

To facilitate master account based payments,
Master Account # field is enabled in Payment
Entry screen.

TPE_PMT_REFUND_CURRENCY_SRC_CD

This parameter indicates the currency in which
payment refund has to be processed in the system
as either Payment Currency or Account
Currency. The same is considered during payment
refund operation in Payment Maintenance screen.

AUTO_GEN_ACTIVE_TXN_CONV

This parameter if enabled, auto posts a dummy
ACTIVE transaction on all migrated accounts
during the schedule batch job run. This in-turn
allows to post RESCISSION / VOID transaction
specifically for migrated accounts by selecting the
dummy transaction from Customer Service >
Maintenance screen or Transaction History
transactions tab,

For more information, refer Voiding an Account
section Servicing user guides.

FLL_CMN_JET JWT ENABLED_IND
(JET JWT TOKEN ENABLE INDICATOR)

This parameter if set to Y, enables the Account
Dashboard screen in Servicing LHS menu. This
screen is based on Oracle JET framework and
facilitates to view Account summary details
maintained in the system. For information on
screen functionality, refer to Servicing User
Manuals and for details on deployment and
configuration, refer to Installation Manuals.

FLL_CMN_JET JWT_TOKEN_URL
(JET JWT TOKEN GENERATION URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell/< token>

FLL_SER_JET_ACC_CREATE_URL
(JET SIMPLE ACCOUNT CREATE URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?
root=accountonboarding

FLL_SER_JET_ACC_DASHBOARD_URL
(JET ACCOUNT DASHBOARD URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?
root=accountdetailsdashboard

FLL_SET JET_INTELLIGENTSEG_URL
(JET INTELLIGENT SEGMENTATION URL)

Define the value of the O-JET URL (app-shell
application URL) in the format https://
<hostname>:<port no>/ofsll-appshell?
root=queuecreation
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ACCOUNT_PROCESSING_THRESHOLD This parameter allows to restrict the number of
(ACCOUNT ON-BOARDING ASYNCHRONOUS  accounts that can be created synchronously
PROCESSING THRESHOLD) using Account onboarding WebService.

However, creating accounts asynchronously in the
system is further processed by the below batch
jobs based on valued defined in this parameter.

SET-API2 (ASYNCHRONOUS ACCOUNT

CREATION)

< ACXVAL_BJ_100_01 (VALIDATE IAPP TABS)

< ACXAAI_BJ_100_01 (ASYNCHRONOUS
ACCOUNT CREATION)

VTX_OUTBOUND_URL (OUTBOUND CALL URL This parameter defines the URL of the external

FOR VERTEX) adapter (Vertex) that is used to integrate with
OFSLL.

VTX_VERSION (VERTEX VERSION) This parameter defines the version of Vertex
adapter that is required to be configured by the
system.

AUTO_GEN_AGREEMENT_NBR (AUTO This parameter defines the mode by which

GENERATE AGREEMENT NUMBER FOR agreement number is generated to an account. If

ACCOUNT ONBOARDING) set to Y, system generates the agreement number.

If set to N, system accepts the external agreement
number provided in Account on-boarding payload.

Note: When system parameter is set to Y, the
agreement number is also used as an identifier to
validate the contract details and decide on which
accounts should get same Agreement number.

C.3 Organization Parameters

Organization parameters control the functions related to User login, password expirations,
responsibilities and accessibility limits in the OFSLL system. Individual parameters can be
created with different values for uniquely defined organizations, divisions, and responsibility
combinations.

There are three more dimensions other than parameter name, description and enabling
(similar to system parameters) as indicated below:

1. Organization
2. Division
3. Responsibility

These dimensions help to define the applicability of the responsibility for specific User in an
Organization across selected Divisions/departments.

When determining which parameter to use, OFSLL system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

While the system allows for Organization parameters to be defined at all three hierarchical
levels (organization, division, and responsibility), not all will be applicable to each parameter.
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MAX_PASSWORD_HISTORY_CHECK

This is used to set limit for number of times a
password has been repeated during password
change. This can be set for specific branches of the
Organization, Divisions and Users based on
responsibilities. Numeric value to be input to
specify the limit.

UCS_GROUP_FOLLOWUP_DAYS

This parameter is used to set up the number of
days range for Group follow-up field in customer
service screen which displays the set of accounts
that share same account condition as the selected
account and bear the same customer ID. The pre-
requisite for this is Group Follow-up indicator
should be enabled in queue setup. Input value is
numeric.

UCS_REVIEW_QUEUE_ALLOWED

This is used to specify whether review can be done
by the specific responsibility (user group) without
entering details in call activities/activities.
Parameter value to be input is Boolean (Yes/No).

UIX_APP_VIEW_ALL_APPS

The system uses this parameter to determine
which users have the ability to view all applications.
The system selects the best match based on a
hierarchical sort by Organization, Division and
Responsibility fields, with values of ALL being a
lower order match than an exact match. Input
parameter value is Boolean (Yes/No).

UIX_HIDE_RESTRICTED_DATA

This is used to hide sensitive data relating to the
Contract / Applicant to a specific group/
responsibility etc. Suppose there is a need to hide
data relating to SSN, Bank account details etc. to a
specific user responsibility who will not need such
data, this parameter can be enabled with input
value Boolean (Yes/No). If this parameter is set to
Y, the details appear in a masked format (for e.g.
SSN — XXXXX- 456)

UIX_SMTP_SERVER

This parameter is used to set up the email server
for user interface. The input value would be SETME
and check the Enable flag.

UIX_VIEW_SECURED_ACCOUNTS

This is used to specify whether an account can be
viewed by a specific responsibility (users).
Parameter value is Boolean (Yes/No) and when
flagged as Yes, such accounts would be viewable
only by users defined in the Organization, Division
hierarchy with the specified responsibilities. For
example, all employee accounts may not be
viewable by all users and should be made available
only to the HR department with specific
responsibility levels.

Note: While creating application, selecting
appropriate applicant’s classification would be
essential for this parameter to be effective.
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Table C-2 (Cont.) Organization Parameters

Appendix C
Organization Parameters

Parameter

Description

UIX_VIEW_SECURED_APPLICATION

This is used to specify whether an application can
be viewed by a specific responsibility (users).
Parameter value is Boolean (Yes/No) and when
flagged as Yes, such applications would be
viewable only by users defined in the Organization,
Division hierarchy with the specified
responsibilities. For example, all employee
accounts may not be viewable by all users and
should be made available only to the HR
department with specific responsibility levels.

Note: While creating application, selecting
appropriate applicant’s classification would be
essential for this parameter to be effective.

ULG_DAY_END

This is used to specify the upper limit time in day
for a user to be able to work in the System.
Parameter value is numeric and range is 1-24, else
system will throw error.

ULG_DAY_START

This is used to specify the lower limit time in day for
a user to be able to work in the System. Parameter
value is numeric and range is 0-24, else system will
throw error.

ULG_FAILED_LOGIN_TRIALS_MAX

This parameter is used to specify the maximum
number of login trials allowed before disabling the
User ID due to security reasons. Input parameter
value is numeric with upper limit of 999999999999.

ULG_INACTIVITY_DAYS_MAX

This parameter is used to specify the maximum
number of days the User ID can be without
utilization before disabling the User ID due to
security reasons. Within the specified number of
days the User Id must be utilized for sign in at least
once. Input parameter value is numeric with upper
limit of 999999999999.

ULG_PWD_CASE_SENSITIVE_REQ

This is used to allow all passwords to be case
sensitive or otherwise. Input parameter value is
Boolean (Yes/No). When this parameter is set as
NO, password would be stored in Upper case. If
this parameter is set to N then the
ULG_PWD_LOWER_CHAR_REQ parameter
should also be set to N.

ULG_PWD_CHANGE_DAYS_ACTUAL

This is used to set the maximum number of days
after which system will force a password change, in
cases where the User has not changed the
password. Input parameter value is numeric with
upper limit of 999999999999.

ULG_PWD_CHANGE_DAYS_PROMPT

This is used to set the maximum number of days
after which system will prompt the User for
password change, in cases where password has
not been changed within the set period. Input
parameter value is numeric.

ULG_PWD_LENGTH_MIN

This is used to set the minimum length of password
string that is required. If this criterion is not met,
system would throw an alert specifying minimum
character length required to be input.
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Table C-2 (Cont.) Organization Parameters

_________________________________________________________________________________|
Parameter Description

ULG_PWD LOWER_CHAR_REQ This is used to allow at least one lower case
character in password strings. Input value is
Boolean (Yes/No). Setting this as NO would mean
passwords would be allowed in uppercase only.

ULG_PWD_NBR_REQ This parameter allows setting password with at
least one numeric character. Input value is Boolean
(Yes/No) and setting this as YES would require
passwords to have at least one numeric character.

ULG_PWD_SPECIAL_CHAR_REQ This parameter is used to allow special characters
like ‘'$’, ‘#, ‘@’, in passwords. Input value is
Boolean (Yes/No) and setting this as YES would
require passwords to have at least one special
character.

ULG_PWD_UPPER_CHAR_REQ This is used to allow at least one upper case
character in password strings. Input value is
Boolean (Yes/No). Setting this as NO would mean
passwords would be allowed in lowercase only.

ULG_WEEK_END This parameter enables to set the last day of the
week when a user can have access to the system.
Input parameter value is numeric ranging from 1 to
7. This is useful in business requirements where
the Organization does not need a specific set of
responsibilities (users) to not access the system on
a weekend / week-off day etc.

ULG_WEEK_START This parameter is used to set the start day of the
week when a user is allowed to access the system.
Input parameter value is humeric.

CRB_ERROR_VALIDATION_IND This parameter is used to validate the Credit
Bureau report generation request depending on the
number of days permitted to pull a Bureau report
from the same company and for the same
customer and report as either warning/error.

When the number of days is less than or equal to
the permitted days (as defined in parameter
DAYS_TO_PULL_CRB_REPORT), system
displays an Error message stating Bureau Report
exists for the same Customer from the same
Bureau for Account# XYZ along with list of
account number(s) and/or application number( s). If
not, a Warning message is display and request is
accepted for processing.

Note: Both CRB_ERROR_VALIDATION_IND and
DAYS_TO_PULL_CRB_REPORT are to be
enabled for Credit Bureau report processing.

OCP_CUST_PMT_PREF This parameter MASTER ACCOUNT ROLLUP
FOR PMT EXTRACT FILE is used to decide the
basis of dues consolidation at master account level
based on the parameter values selected. For more
information, refer to Outbound Customer
Extracts To Payment Agencies Batch section.

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Appendix C-24 of C-30



ORACLE’

C.4 Company Parameters

Appendix C
Company Parameters

Company parameters control the processes associated with functions that vary for different
companies and branches. These parameters address credit scoring, credit bureau interfaces,

fax services, and fax generation.

Individual parameters may be set up with different values for uniquely defined company and
branch combinations (i.e. these can be defined to the level of branches in each company or a

group of companies in terms of applicability).

Table C-3 Company Parameters

Parameter

Description

AUD_ADV_REASON_MODEL

This parameter is used to set-up default adverse
action reasons for scoring models during set-up in
the Parameters sub page. Whenever the flag
Bureau Score Reasons is unchecked during
credit bureau scoring model set-up, then
automatically rejected applications scored using
this scoring model picks up the Adverse Action
Reasons from the Parameters sub page.

AUD_SCORING_METHOD

This parameter is used to set when/where the
application scoring method has to be applied within
the company. So when the parameter value is
chosen as primary applicant only, the system will
perform the application scoring for the primary
applicant only and according to other applicable
parameters specified. Other parameter input values
are Minimum Score, Maximum Score, Minimum
Tier (Grade), Maximum Tier (Grade).

AUD_SCORING_METHOD_IN_BUREAU

This parameter is used to define what value to be
picked up for application scoring from the scores
returned from the various bureaus. The input
parameter values are Maximum Score and
Minimum Score. If Maximum score is setup in
company parameters, then for all applications
where a bureau report is pulled, the system will
pick-up the Maximum score from the different
bureaus.

CBU_DATA_SET _SIZE

Parameter to define the metro 2 file data selection
criteria, option values are monthly, Daily, weekly,
semi monthly.

CBU_FILE_FORMAT

Metro 2 file format definition, user need to select
from the parameter value drop down.

CMN_ASE_VALIDATE_MAKE_MODEL

This parameter is set up to specify to the system
whether it needs to validate the asset make and
model at the time of data entry. In parameter value
is Boolean (Yes/No).

CMN_CMB_DEFAULT_PRINTER

This is used to define the default printer for printing.
The input parameter value is the printer name.
There is no LOV for this field. If no default printer is
defined and the parameter enabled, the system
would display Undefined.
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Table C-3 (Cont.) Company Parameters

Appendix C
Company Parameters

Parameter

Description

CMN_WEEKLY_NONBUSINESS_DAYS

This parameter is used to set-up the weekly
holidays at the company level. The input parameter
value is character string; if no details specified and
parameter is enabled, system would display
UNDEFINED.

COR_STORAGE_DIRECTORY

This parameter is used to specify the path/location
for Oracle directory object template for
correspondence documents. Input parameter value
is SETME; if none is specified and parameter
enabled, UNDEFINED.

DBR_JOINT_INC_DEBT_WITH_2NDRY

This parameter defines whether system should
consider income and debt details of the Spouse
and Secondary Applicant along with that Primary
Applicant. Input parameter value is Boolean (Yes/
No).

DBR_JOINT_INC_DEBT_WITH_SPOUSE

This parameter is used to define whether system
should consider the income and debt details of
Spouse alone along with that of Primary applicant
details. Input parameter value is Boolean (Yes/No).

DDP_CRB_EXPIRATION_DAYS

This parameter is used to define the credit bureau
report expiration days. So if this is set as 30,
system will use all available credit bureau reports
pulled which are not older than 30 days from
current day, during de-dupe. Input value is numeric
with no upper limit.

DDP_DEDUP_ DEBT_WITH_2NDRY

This parameter defines whether the system should
dedupe credit bureau liabilities for Spouse and
Secondary Applicants, in addition to de-duping
Primary applicant’s liabilities. Input parameter value
is Boolean (Yes/No).

DDP_DEDUP_ DEBT WITH_SPOUSE

This parameter defines whether the system should
dedupe credit bureau liabilities for Spouse, in
addition to deduping Primary applicant’s liabilities.
Input parameter value is Boolean (Yes/No).

DOT_STORAGE_DIRECTORY

This parameter is used to define the location/path
of the Oracle Directory Object name for Account
Document Loading. Input parameter value is
SETME.

ECB_EDIT_FAIL_ANY_APL

This parameter is used to set the credit bureau edit
to fail in case the bureau report for any of the
applicant fails. Input parameter value is Boolean
(Yes/No). So if this parameter is set to YES, the
edit will fail even if one of the applicant’s bureau
score fails to qualify.

ECB_USE_APL_CURRENT_SCORE_CRH

This parameter is used to define whether the
system should run the credit bureau edits only on
the current scored applicant bureau. Input
parameter value is Boolean (Yes/No).
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Table C-3 (Cont.) Company Parameters

Appendix C
Company Parameters

Parameter

Description

LOR_AUTOMATIC_CON_FUND_FAX

This is used to define the decision fax generation
when an application is funded. The input parameter
value is Boolean (Yes/No), and when this is set as
YES, system automatically generates the fax
approval in the predefined template whenever an
application is approved.

LOG_STORAGE_DIRECTORY

This parameter is used to define the Oracle storage
directory. Input parameter value is user (System
Administrator) defined.

LOR_AUTOMATIC_APPROVAL_FAX

This is used to define the decision fax generation
when an application is approved. The input
parameter value is Boolean (Yes/No), and when
this is set as YES, system automatically generates
the fax approval in the predefined template
whenever an application is approved.

LOR_AUTOMATIC_REJECTION_FAX

This is used to define the decision fax generation
when an application is rejected. The input
parameter value is Boolean (Yes/No), and when
this is set as YES, system automatically generates
the rejection fax in the pre-defined template
whenever an application is declined.

MAX_LEAD_DAY_AGE

This parameter is used to define the maximum no.
of days, post which the sales lead would be
considered cold. Input parameter value is numeric
with no upper limit.

MULTI_OFFER

Through this parameter the multiple offers (sub-tab)
in pricing can be enabled or disabled for a
Company/Branch. Input parameter value is
Boolean (Yes/No). If the flag is set as Y, the
underwriter can view multiple offers and select one
of them to be applied for the specific application.

MULTI_OFFER_MAX_NUMBER

This parameter is used to specify the maximum
number of multiple offers that can be permitted for
an application. Input parameter value is numeric
with no upper limit. If MULTI_OFFER company
parameter is set as N, this parameter can be
ignored as there is no use specifying a value.

MULTI_OFFER_MAX_TERM

This company parameter sets the maximum term
(as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter value
is numeric.

MULTI_OFFER_ MIN_TERM

This company parameter sets the minimum term
(as in no. of instalments, whichever billing cycle is
selected) for which multiple offers are calculated
and displayed during pricing. Input parameter value
is numeric.

MULTI_OFFER_PMT_TOLERANCE

For Multi offer variance in payment is defined in this
parameter.

MULTI_OFFER_TERM_VAR

For multi offer Term variance will be defined in the
parameter.

PRESENT_VALUE_COMPUTE_RATE

This parameter will perform Present Value
Computation Rate (Inflation/Discounting Rate).
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Table C-3 (Cont.) Company Parameters

Appendix C
Company Parameters

Parameter

Description

RATE_CHG_LTR_PRE_PROCESS_DAYS

This parameter is used to set up the number of
days prior to rate change effective date to generate
rate change letters in order to provide advance
intimation to customers. Input parameter value is
numeric with no upper limit.

STM_GEN_AFTER_MATURITY_IND

This parameter is used to enable the statement
generation for an account after the maturity date
but Account remains unpaid. Input parameter value
is Boolean (Yes/No). If this is set to Y, statements
will get generated for accounts that remain unpaid
even after maturity.

UIX_RUN_AAI_ACT

This parameter is used by the system to determine
whether to create and activate an account online.
Input parameter value is Boolean (Yes/No).

UIX_UCS_CAC_MAX_FOLLOWUP_DAYS

This parameter is used to set up the maximum
number of days for follow up when the account is in
delinquent state. Input parameter value is numeric
with no upper limit.

UIX_UCS_CAC_MAX_PROMISE_DAYS

This parameter is used to set up the maximum
number of days allowed for customers who promise
to pay when following up for delinquent accounts.
Input parameter value is numeric.

AUD_QUEUE_INITIAL_CRB_FAILED

This parameter enabling will Queue the application
if any bureau failed.

UIX_UCS_CUA_MAX_FOLLOWUP_DAYS

This parameter will allow the user to maintain the
Collections maximum follow-up days that are
allowed in the system.

XSL_TAX_INTERFACE

This parameter is used to specify the sales tax
interface in OFSLL. Input parameter value is user
defined. In this case it is held as Manual.

CMN_SYSTEM_UNDER_MAINTENANCE

This parameter specifies whether the system is
under maintenance or not. Input parameter value is
Boolean (Yes/No).

CMN_GL_POST DT

This parameter is used to define the GL Post Date
of Company in MM/DD/YYYY format. The same is
also updated by Scheduler if ENABLED.

PTX_TXN_LAST_PURGE_DT

This parameter stores the date when transactions
were purged last in the OFSLL system. Input
parameter value is date.

PUP_TUP_LAST_PURGE_ DT

This parameter stores the date when transactions
upload were purged last in the OFSLL system.
Input parameter value is date.

JSC_START_OF BUSINESS_TIME

This parameter is used to set the start of business
time. Input parameter value is time in 24 hour
format.
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Table C-3 (Cont.) Company Parameters

_________________________________________________________________________________|
Parameter Description

CMN_PROMISE_FUTURE_MTHD This parameter helps to define the future promise
handling method in the system.

When multiple Promise to Pay records are defined

on an account and if any one of the promise is not

satisfied i.e. if there is no credit / Payment

transaction of the corresponding amount on the

promise date, then system uses any of the

following method defined in this parameter to

update the future promises.

*  No Action on future promises (default)

*  Mark current and future promises as broken

e Mark current as broken but future promise as
cancelled

C.5 Other Parameters

The following additional set of parameters are also available to control system specific data
and other administration process.

Table C-4 Other Parameters

Parameter Description

CRB_MAX_BUREAU_PULL This parameter is used to determine the number of
credit reports automatically per applicant. Input
parameter value is numeric.

CRB_ALL_APL_BUREAU_PULL This parameter is used to set up whether credit
bureau reports should be pulled for the primary
applicant only or to all other applicants also (for
joint applications), regardless of their relationship
with the primary applicant. Input parameter value is
Boolean (Y/N).

CBU_FILE_FREQUENCY This parameter is used to set the Metro Il File
Frequency and determine whether output file is to
be generated daily or monthly. If this is monthly,
then output file is written with daily data but
generated monthly.

JOINT_DEDUP_ SPOUSE_LIABILITIES This parameter is used to determine duplicate
liabilities in the Spouse’s liabilities in de-duping
logic. Input parameter value is Boolean (Yes/No).

JOINT_DEDUP_ALLAPL_LIABILITIES This parameter is used to determine duplicate
liabilities of all applicants’ liabilities in de-duping
logic, irrespective of whether they are related to
each other. Input parameter value is Boolean (Yes/
No).

ASC_COL_SER_ENABLED_IND This parameter is used for enabling the Collection
Servicing Indicator. Input parameter value is
Boolean (Y/N).

CMN_TEST_TOOL_LOGGING This parameter is used to set the testing tool
logging to enable or disable testing tool log in. Input
parameter value is Boolean (Yes/No).
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Parameter

Description

ICA_INPUT_FILE_FORMAT

This parameter is used to specify the Input format
for call activity file. Two Parameter values are
possible — US format and OFSLL format.

JSV_BI_USER

This parameter is used to define the Bl publisher
User ID. Input parameter value is user defined
(Admin user).

JSV_BI_PASSWORD

This parameter is used to define the Bl publisher
User password. Input parameter value is user
defined (Admin user).

PJR_COPY_PURGED_DATA

This parameter is used to specify whether data
should be copied into the purge tables or not. Input
parameter value is Boolean (Yes/No).

PUP_ARCHIVE_DAYS

This parameter is used to specify the number of
days after which the transactions upload details are
to be archived. Input parameter value is numeric.

PUP_OARCHIVE_DAYS

This parameter is used to specify the number of
days after which the transactions upload details are
to be moved from O tables. Input parameter value
is numeric.

TPE_APPLY_LTC_FROM_CURR_DUE_DT

This parameter is used to specify whether late
charge should be applied from current due date for
Pyramid Law fee method. Input parameter value is
Boolean (Yes/No).

TPE_EXCESS_PAYMENT_TO_MEMO

This parameter will make excess payment to the
memo payment by marking this Parameter as YES.

TPE_STOP_COMP_DELQ _DAYS

This parameter is enabled to stop computation if
the account is delinquent for more than 60 days.
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Appendix : Configuration at Company Level

This section consists of the following topics:

e Introduction

e Existing Configuration

e Configuration at Company Level

e Setup Company Definition

e Setup Multiple Companies in Same/Different Time Zone

* Impact on Defining Configuration at Company Level

D.1 Introduction

OFSLL supports defining multiple Portfolio Companies in an Organization and facilitates to
configure these Portfolio Companies to operate in different time zones. The nightly batch jobs
for processing can also be configured to run as per the operating hours of the Portfolio
Companies.

Using this, system can be configured in Setup to either process at Organization level or at
Company level. To process at Organization level, no specific change is required since it is the
default setup.

The below details in this section is intended to give an overview of the changes required to
setup the system to process at Company level.

D.2 Existing Configuration

In the default setup, there is no definition of GL date at company level and this implies that
organization can define the independent companies to which accounts belongs. But the EOD
scheduling and job run happens at organization level and ‘not’ at each company level. Also the
GL date is defined at System Parameters Level.

Figure D-1 Existing Configuration

s Batch Jobs
Organization

Holiday Setup
Schedule EOD

Company 1 Company 2 COTHE?W
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Configuration at Company Level

D.3 Configuration at Company Level

In the configuration at Company level (not Branch level), the following options are supported:

To configure only one EOD schedule for one or all companies - Configure batch jobs at
ALL level with or without having multiple company definitions. If OFSLL is upgraded from
earlier to current release version, this helps to continue with existing ALL company level
scheduling of batch job run.

To configure EOD for each company independently - Define GL date at each Company
level to schedule and run batch jobs at each company level. The scheduler changes the
GL date of specific company, after successful completion of batch job run.

However in this setup, note that:

It is advised to Enable flag at ALL GL date level, but disable batch jobs at ALL level so that
scheduler does the rollover of date but does not pick-up batch jobs for EOD run.

After EOD run, system rollovers the GL date or ALL company entry, after completion of run
of other specific company GL date rollover.

Ensure the Company parameter System Under Maintenance is also set to Y for
corresponding company during EOD run of same company.

Company Start of Business Time can be configured at company level. If the parameter
value is set to 0500, it implies that scheduler rollovers the GL date based on this time.

System refers the Company Time Zone (new field at company definition page) to identify
the time zone in company parameter.

Figure D-2 Configuration at Company Level

Organization

Company 1 Company 2 Company “n”

Batch Jobs Batch Jobs Batch Jobs

Holiday Setup Holiday Setup
Schedule EOD Schedule EOD

Holiday Setup
Schedule EOD

D.4 Setup Company Definition

In this setup, define the company and company parameters.

1.

Define Company and date format
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« Define the company in Companies Definition screen and ensure to maintain
Company Time Zone.

« Define company code with Alphanumeric characters only.

* Ensure to define the Display Format organization Definition Division Definition
Display Formats.

@® Note

Fixed simple date format definition is one time setup for each company and Admin
user is not expected to change it again in life time. Currently it is allowed to select
only MM/DD/YYYY format.

2. Define the following company parameters:
The default shipped seed data of Company level GL date is set to All.

* GL POST DATE - COMPANY IN MM/DD/YYYY FORMAT (UPDATED BY
SCHEDULER IF ENABLED)

*  CMN_SYSTEM_UNDER_MAINTENANCE - SYSTEM UNDER MAINTENANCE

« JSC_START_OF_BUSINESS_TIME (COMPANY START OF BUSINESS TIME (24HR
FORMAT)

e PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS
*  PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD

Example: The following is an illustration on how 3 companies are defined with 3 different
time Zones in USA, UK and Australia.

Figure D-3 Setup Company Definition

B el B

Bnén(:ﬁ 1 Branch 2. Branéh 3 Branch 1  Branch 2 Branch 3
(APPLICATIONS/ACCOUNTS)

Table D-1 Company Parameters

|
Parameter USA UK AUS

GL Post Date 31 Dec 2019 02 Jan 2020 02 Jan 2020
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Table D-1 (Cont.) Company Parameters
]

Parameter USA UK AUS
CMN_SYSTEM_UNDER Y N N
_MAINTENANCE

JSC_START_OF_BUSIN 0500 0500 0500
ESS_TIME

PTX_TXN_LAST_PURG 01/01/2019 01/01/2019 01/01/2019
E_DT

PUP_TUP_LAST_PURG 01/01/2019 01/01/2019 01/01/2019
E DT

This section consists of the following topics:

Holiday Setup and Processing

Batch Jobs Processing

D.4.1 Holiday Setup and Processing

The holiday defined in setup is processed as indicated below:

Scheduler picks up the jobs for EOD run based on Next Date and time' set at each batch
job level.

After successful completion of job run for the individual company, system rollovers the date
for respective company.

Once the EOD run and date rollover is completed for individual company, system verifies
the Enabled indicator for All company. If none of batch jobs are enabled - rollovers the
ALL GL date.

If 01 Jan 2020 is recorded as holiday in setup, scheduler will/will not execute the batch
jobs based on the Batch job holiday maintenance and subsequently rollovers the next date
to 02 Jan 2020, at proper start of business time for the company.

D.4.2 Batch Jobs Processing

The default shipped seed data of Batch Jobs is set to All. Define the company and copy the
batch jobs. Note that the Copy option copies all the batch jobs at one go.

D.5 Setup Multiple Companies in Same/Different Time Zone

Define company level time zone using the field Company Time Zone at Companies
Definition screen.

This parameter is used to consider the Company level and Start of Business Time. The
same can be configured to the same time zone or different time zone for scheduler to
process EOD / BOD.

Company wise file upload facility is supported as follows:
As part of creating company, following are automated:

— Directory objects in db is created

— System parameter is created for directories
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This section consists of the following topics:

Appendix D
Impact on Defining Configuration at Company Level

— External table is created for selected uploads - collateral and txn upload automatically

— Physical directories are not created

— Directory permissions is to be defined manual

If Company specific file upload jobs are used, the file upload process happens from

company specific folders.

Setup for New Company Added Subseguently

D.5.1 Setup for New Company Added Subsequently

For New Company Added Subsequently (not on Day zero), follow the same steps to be
followed on Day zero setup. Raise SR to execute script of directory creation of new company
for file upload.

D.6 Impact on Defining Configuration at Company Level

System displays the following details at each configured Company level.

Company Level Configuration Settings

Scheduler

Debug Logs
Setup Screens

File Uploads
Transactions

Web Services

Letters, Correspondence
Reports

Credit Bureau & Metro Il
GL

ODD1, ODD2, ODD3

Migration
Conversion

Archive
Purge

Standard Payees

Data Masking
WEP Module

Batch Jobs and File uploads
Assumptions
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D.6.1 Company Level Configuration Settings

Company level LOV selection is available at following screens to configure:

e System Monitor > Batch Jobs

e System Monitor > Jobs > Batch

e System Monitor > Jobs > Background

e System Monitor > Jobs > Credit Request

e System Monitor > JMS Queues > Messages
e System Monitor > Events

e Data Files > Input folder

D.6.2 Scheduler

Once the batch jobs are completed for that specific company, scheduler picks-up the company
specific scheduled batch jobs and updates the GL Post Date of that specific company.

® Note
e No two companies should be configured to run jobs by scheduler at the same
time.

e Ensure to setup the Parent and child batch jobs with marginal difference in time
setup to get picked-up by the scheduler.

D.6.3 Debug Logs

* Batch level Debug logs are maintained at system parameter level and allowed to enable /
disable debug batch job logging at system parameter level only.

»  System allows to enable batch job level debug jobs by enabling in User Defined Table.
* The debug log file generated is appended with Company Name.

e The date format in debug logs is MM/DD/YYYY - standard format only, irrespective of logs
generated for any company.

D.6.4 Setup Screens

All setup screens refers to system date for validation. Example: Start and End Date.

D.6.5 File Uploads

If only ALL Company Definition is used, the file upload process continues to use the existing
folder and infrastructure.

e As part of creating company, following are automated:
— Directory objects in db is created

— System parameter is created for directories
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— External table is created for selected uploads - collateral and txn upload automatically
— Physical directories are not created
— Directory permissions is to be defined manual

* If Company specific file upload jobs are used, the file upload process happens from
company specific folders.

This section consists of the following topics:

e Input File
e Output File

D.6.5.1 Input File

The Input File is processed based on the following conditions:

* Changes are accepted in same file structure and input file has to be placed under input/
directory/company specific folder.

* In case certain file does not have company definition like Asset Upload, the same can be
placed in any company folder to process and upload records.

* Some input files are not programmed to refer Data Files > Input file definitions and hence
any date in the file will follow MM/DD/YYYY format. For example, Call activity posting,
promise date are to be given in the same format.

e Some input files are programmed to refer Data Files > Input file definitions and hence
system expects the date in the file as defined as date format in definition.

D.6.5.2 Output File

Output file name is appended with Company Name and is generated in one folder.

@® Note

A script crt_company_directories.sh is provided with installer in the path

core_db\ of sl I db. zi p\ dba_ut i | s\ to create directories and to create folders for
each defined Company. The same is to be run during installation. Also, the CLOB
indicator is retained at system parameter level.

D.6.6 Transactions

* Monetary transaction refers to the company specific GL date.
* Non-Monetary transactions refers to system date.

e Transactions data in the account continues to show the dates with reference to Fixed
simple date format maintained at company level.

D.6.7 Web Services

* GL date of service refers to company level GL date.

e Company has to be passed for certain web services to take reference of corresponding
company GL date.
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D.6.8 Letters, Correspondence

» Letters are generated based on company level batch job run.

- Date format in letter is not controlled by company level display format and refers to the
letter template.

D.6.9 Reports

e Changes are done to report template and reports are generated with Company Name
appended to file and generated data for specific company, where the job is run.

- Date format in report is not controlled by company level display format and refers to the
report template.

D.6.10 Credit Bureau & Metro Il

e Bureau pull does not have any impact to handle because user has to select the specific
company and then bureau triggers the pull from Ul.

* Metro Il - No impact. System generates file for all companies; but based on product level
flag and with configured setup.

D.6.11 GL

Current GL Setup (Attributes, Translations and Transaction Links and so on) is at Company
level and hence there is no impact.

D.6.12 ODD1, ODD2, ODD3

If job is run at company level,

« ODDL1 (Producer ACH, Adverse Action letters, Adverse Action Condition Letter file) job
generates the data at company level.

e« ODD2 (Account ACH, Vendor ACH, Statement, Letter File and so on) job generates the
data at company level.

« ODD3 job generates the data at company level.

D.6.13 Migration

For all screens where company has been added, the default value ALL is provided and user is
expected to enable this in seed data screen.

D.6.14 Conversion

No specific impact since API tables have definition of company. User can upload the
conversion files based on company.

D.6.15 Archive

Parameter to specify the archive days are defined at system level but user can run the Archive
batch jobs at each company level and the same archives data for that specific company.

Line Origination Setup Guide
G42451-01 September 11, 2025

Copyright © 2022, 2025, Oracle and/or its affiliates. Appendix D-8 of D-10



ORACLE Appendix D
Impact on Defining Configuration at Company Level

D.6.16 Purge

Parameter to specify the purge days and following parameters are moved to company level.

e PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS
*  PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD

D.6.17 Standard Payees

e User would be able to define payee bank account for each company / branch combination.

e AP Requisition batch job generates the requisition considering the account number defined
at company level.

D.6.18 Data Masking

Not handled and hence data masking can be configured at organization level only.

D.6.19 WFP Module

Not handled.

D.6.20 Batch Jobs and File uploads

For list of batch jobs and File uploads handled to run at company level, refer to product release
notes.

D.6.21 Assumptions

System considers the criteria defined for company in Queues > Criteria Based Condition
screen and ignores the branch level differentiation across application. Hence, even if user
defines multiple records (as indicated below), system considers the combination as same and
executes records are company level.

Company = AUS and Branch = ALL

Company = AUS and Branch = Sydney
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